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1 Welcome to Prism 8 User Guide

Use this guide to learn more about Prism's features and how to most
effectively use them! Browse the topics on the left to learn more about
each!

Just getting started with Prism?

Check out some tips on How to learn Prism  and the best ways to Get
Started !

New to Prism 8?

See What's New  in this version!

More Guides!

You're currently browsing the Prism User Guide. We also have two other
guides focused on Statistical Analysis and Curve Fitting! Both of these
guides do more than just explain how to use Prism. They also explain
important concepts about data analysis!

· Switch to the Prism 8 Statistics Guide

· Switch to the Prism 8 Curve Fitting Guide

2 How to learn Prism

Browse the Statistics and Regression guides

This Prism Guide is only one of three guides. Check out the other two.
Both do more than explain how to use Prism. They also explain the
concepts of data analysis. 

· GraphPad Statistics Guide

· GraphPad Curve Fitting Guide

Step by step tours

Read this one page tour , which will take about five minutes to follow.

12

108

15

108
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Then follow longer detailed tutorials focused on statistical analysis and
curve fitting with step-by-step instructions.

Work with tutorial data sets

 Choose these from the Welcome (File..New) dialog. After choosing one of
the eight kinds of tables, choose "Start with sample data to follow a
tutorial". Each sample data set comes with brief instructions, and links to
longer explanations. 

     

Descriptive statistics

Column statistics

Frequency distribution

Compare two groups

Unpaired t test from raw data

Paired t test

Mann-Whitney test

Wilcoxon matched pairs test

Categorical outcomes
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Contingency table analysis

Survival analysis

Diagnostic lab tests

ROC curve

Bland-Altman plot

Nonlinear regression

Fitting an enzyme kinetics curve

Comparing two enzyme kinetics models

Automatic outlier elimination (exponential decay)

Global nonlinear regression (dose-response curves)

Ambiguous fit (dose-response)
 

Explore the graph portfolio

Choose the Portfolio tab at the bottom of  the Welcome (File..New) dialog
to browse dozens of polished graphs, each of which demonstrates several
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Prism features. When you open a portfolio graph, you'll see a brief
explanation of how that graph was made, and can explore the details.
Many of these portfolio graphs are linked to step-by-step instructions.
Others give brief explanations. Exploring these files will help you master
graphing with Prism.

3 Prism Labs

With Prism 8.2, we introduced a new concept: Prism Labs. Features
released as part of Prism Labs are new, and we welcome feedback to
make them better. 

Prism Labs features are fresh from the GraphPad bakery. We think they
are fully baked, but label them as a "Labs" because there is some chance
they'll turn out to be only half-baked. These features represent our latest
and most innovative features, and while they've been extensively tested,
they can still be considered "experimental".

The first (and only as of 8.2) Prism Labs feature is a new way to detect
"bad" fits during nonlinear regression. The new method detects
"unstable" parameters rather than "ambiguous" fits. It seems to work
better. Choose it on the Confidence tab of the nonlinear regression
dialog. 

4 What's new in Prism 8?

What do you need to know before starting?
More kinds of graphs
Better looking graphs
Smoother sailing
More efficient
More compatible
More versatile
Multiple regression
Huge improvements in ANOVA
Nested t test and nested one-way ANOVA
More analysis choices: Statistics
More analysis choices: Regression

16

19

22

28

32

34

34

36

38

39

40

42

https://www.graphpad.com/guides/prism/8/curve-fitting/reg_confidence_tab.htm
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4.1 What do you need to know before starting?

Prism is still Prism

Prism works as it always did. If you know Prism 6 or 7, you can discover
most of the new features as you use Prism. It won't be hard to adjust. But
there are four things you should know before you start. 

Switch between analysis pages using analysis tabs

Many analyses in Prism present results on multiple pages (sometimes
called subpages or views). With earlier versions of Prism, you would
navigate between them using subpages indented under the analysis name
in the navigator. The Prism 8 navigator does not show subpages. Instead,
they are shown as analysis tabs above the results. The results on some
tabs are designed for graphing, not viewing. These are hidden by default
but can be shown using the drop down menu. 

Here is the look in Prism 8.0 and 8.1.

Prism 8.2 introduces a new look that should make analysis tabs easier to
discover.
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New family pane at the bottom of the navigator

The navigator in Prism 8 always shows a panel showing the family of
sheets related to the current sheet, making it easier to move among
related sheets. This replaces the old Family folder, which few people
used. Chains of analyses are automatically indented, replacing the old
Data+Results folder.

Beginning in Prism 8.2, the Navigator can be toggled between separate
"Data" and "Results" sections and a single "Data with Results" view by
right clicking in the Navigator.
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The complicated column statistics analysis has been split into three
focused analyses

The  column statistics analysis was complicated because it combined
distinct analyses in one complicated dialog. Prism 8 makes things easier
by offering three focussed analyses: Descriptive statistics, Normality (and
lognormality) testing, and one-sample t test (and Wilcoxon) tests.

The Welcome dialog has a new explicit choice for starting with tutorial
data or with a blank table

Prism 7 and earlier mixed the choices for starting with a blank table or
with tutorial data in a sometimes long set of choices. Prism 8 is more
explicit. You need to first choose to begin with a blank table or tutorial
data. When you first use Prism 8, it will be set to show you a list of
tutorial data sets. You need to make an explicit choice to start with a
blank table.  
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Windows only: No more child windows in parent windows

With prior versions of Prism for Windows, there was one master (parent)
window that could contain multiple child windows each with its own
project file. With a trick, you could create two separate parent windows. 

With Prism 8 Windows, the concept of parent or master window is gone.
Each open file has its own window. This is the modern way of working
(which almost all applications use) and makes it much easier to work with
multiple displays.  But it is a change, and may take a while to get used
to. 

Prism Mac always showed each open file in its own window, so there is no
change with Prism 8.

4.2 More kinds of graphs

Subcolumn graphs

Prism 8 offers a new kind of data table for nested data where values
stacked in each subcolumn are related, and creates subcolumn graphs
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of these data. In this example, there are two treatments given to three
rats each and the outcome variable was measured four times in each rat.
Each subcolumn can be plotted as a scatterplot (below), or mean or
median with error as point or bar.

Violin plots

Violin plots show data distributions much more clearly than do box-
whisker or bar graphs. Prism 8 can create violin plots (right graph below)
of Column, Grouped or XY data. 

Grouped graphs that show both individual points (scatter) and bar with
error bar. 

You could make the graph below in Prism 7, but only if you knew a trick.
With Prism 8, it is easy.
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Smoothing and Akima splines

Prism has offered a spline analysis since version 1. These spline curves
went through every point, so wiggled so much they were rarely useful.
Prism 8 adds two more useful forms of splines (created using the Spline
analysis).

· Smoothing splines. These track the general trend of the data without
going through every point. You choose how many "knots" to use, which
controls how many inflection points the curve has.  

· Akima splines go through every point like cubic splines, but Akima
splines make tighter turns so look better in many situations. 
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4.3 Better looking graphs

Label bar graphs 

Bar graphs can include the mean, median or sample size on top, or
within, the bars.
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Place bar labels within the bars rather than under the bars. 

You can choose the color for the text, or choose auto choice so the text is
either black or white depending on the background (added in Prism 8.1).

It is now easier to create Grouped graphs that combine bar graphs with
also plotting each point as a symbol. 

Draw lines and brackets with centered text (with an easy way to write
asterisks)

   

Scatter plots with - or without - "smiles"

Scatter graphs plot every value, moving points left or right to avoid
overlap. Prism 7 sometimes ended up arranging the points in a way that
created "smiles" as shown in the graph on the left below.  Prism 8 (right
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graph below) is much smarter about this, so the default graphs look
better, and do a much better job showing the distribution of the data.

However, we've listened to your feedback, and in Prism 8.2 we introduced
the ability to select from three different scatter plot styles:

The three graphs below show the same data, plotted using each of the
three options above:
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Improved importing or pasting of images 

· Crop an image that has been imported or pasted onto a graph or
layout.
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· Resize an imported image without accidentally distorting it. Check an
option to allow distortion if you really want to change the aspect ratio.

· Import pdf and eps images onto a graph or layout (new for Prism
Windows; Prism Mac could already do this).. 

Adjust color of any block of values

· Color code spaghetti graphs. Select a subcolumn of data, right click and
choose a different color for those points or lines.

· Color code before-after graphs. Select range of rows in a column table,
or subcolumns in a Grouped table, right click and choose a different
color for those before-after points and lines. Prism 7 could do this in
some cases, and Prism 8 extends this to all graphs. 

Axis numbering

· Powers-of-ten numbering on axis no longer adds silly leading zeroes.
The label for when X or Y equals 5 is now 105 not 1005. 

· In preferences, choose an ordinary minus sign or a longer en-dash to
show negative numbers on axis numbering.
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· For axis numbering, the decimal point can be middot, also known as
interpunkt.  The decimal point is aligned with the middle of the digits,
not their bottom. Some journals request this.

Other improvements

· Better default graphs, with more choices made automatically.

· New command to reverse the order of data sets in the legend.

· You can now add up to 100 additional ticks, grid lines and labels to an
axis (Prism 7 allowed only 30). 

· New choice on XY graphs to include a line of identity (used automatically
for QQ plots and ROC curves)

· Choose fill patterns on parts-of-whole graphs.

· Change which data set is plotted in a parts-of-whole graph.

· Choose line spacing for text objects.

· New color schemes, including a "Colorblind Safe" color scheme, with
colors designed to be distinguishable by individuals with a variety of
different color vision deficiencies. (Added in version 8.1)
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4.4 Smoother sailing

Find related sheets easily

Moving from one sheet to a linked one is a key part of working with Prism,
but sometimes was too hard. The family folder was useful but had to be
repeatedly reopened. 

With Prism 8, the bottom of the navigator now contains a panel showing
the family of sheets related to the current sheet. It's always there. You
don't have to specially open it as you did in prior versions of Prism.  Click
to go to a related sheets. Chains of analyses are automatically indented,
so you no longer need to open the separate Data+Results folder.

However, we heard your feedback, and some of you prefer to have your
Data and Results sheets organized together in the Navigator. In Prism
8.2, you can toggle between separate "Data" and "Results" sections and
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a combined "Data with Results" section by right-clicking in the
Navigator (you can also set a default in Prism's preferences).

Easily jump between multiple results tables for one analysis (and hide the
ones you don't want to see)

Many Prism analyses generate several tables of results. These were
shown as subsheets, and all were listed -- even the ones only used to
make graphs but are rarely actually looked out. Prism 8 shows the
multiple results tables for an analysis as tabs across the top of the
window. Results tables designed for graphing (XY coordinates of curves;
residulas; QQ plots...) are hidden by default, but you can choose to view
them.

Snapping that actually works

When you move one object on a graph or layout, Prism 7 tried to help by
"snapping" the object you are moving into alignment with other objects on
the page. However, this was sometimes more of a hindrance than a help.
The problem was that Prism would sometimes try to snap to an object you
are moving away from. 

 For Prism 8, we've totally revamped snapping so only tries to snap to
objects that you are moving towards. This makes it  much more helpful
and way less intrusive. You can still turn it off if you want to, but you
won't want to!

Snapping now also works when rotating an object, with snapping at 0, 90,
180 and 270 degree.
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Simpler nonlinear regression dialog

We reorganized the nonlinear regression dialog to make it easier to use. 
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· The first tab, now renamed to Model, is simpler as it no longer has
choices about outliers or robust fitting. 

· A new tab, Method, takes the place of the Weights tab which had only a
few choices. The Method tab includes choices for weighting, and also
includes these choices: Whether  to perform least-squares, robust or
Poisson regression, or to show the curve generated by the initial values;
whether to count, exclude, or ignore outliers; and how to define
convergence. 

· The Diagnostics tab is less cluttered as some options were moved to the
Method tab. Added to the Diagnostic tab is a choice of four kinds of
residual graphs. 

The complicated column statistics analysis has been split into three
focused analyses

The  column statistics analysis was complicated because it combined
distinct analyses. Prism 8 makes things easier by offering three distinct
analyses: Descriptive statistics, Normality (and lognormality) testing, and
one-sample t test (and Wilcoxon) analyses. 

Change size of graph more easily

The commands to enlarge a graph and reduce the graph size were not in
synch in Prism 7. If you clicked twice to increase the graph size, then
clicked twice to reduce graph size, you wouldn't end up where you
started. The problem is that if you first increase size by 25% and then
decrease by 25%, you don't end up where you started. You need to
reduce by 20%. We fixed this for Prism 8. 

Less intrusive warnings about graphs

Prism 7 often presented warnings on graph about data points that are off
scale, error bars that can't be shown, etc. These tended to be wordy and
were often annoying. Prism 8 shows much shorter messages, with a link
to a longer explanation. And you can turn these off entirely with a new
setting in Preferences.

Easier searching

Searching for sheets is easier, and you can now search for sheets with
highlights or notes of a specified color. 
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4.5 More efficient

Prism offers many methods to speed your work. Prism 8 goes even
further.

Repeat graphing and analyses easily

· The Wand (wizard to analyze data) lets you analyze and graph a new
table exactly as you already analyzed an existing table. Now you can
selected several tables at once and use the Wand to analyze and graph
all of them at once. 

· When using New..Graph of existing data to make one graph per data
set, enter a Y axis title to appear on all the new graphs. You no longer
need to enter the Y titles one at a time. 

Better magic

Two new choices in "Magic" (Make Graphs Consistent):

· Change the axis and graph titles to match the sample graph. Magic
always changed the font (and point size and color) to match. Now you
can optionally (default is off) ask Prism to change the wording of the
axis and graph titles.

· If you've individually changed the color (etc.) of some points/bars in the
sample graph, you now have the choice to have the same changes made
to the other graphs by "magic". This choice only makes sense, so is only
available, when both the sample and target graphs have the same
number of points/bars. 
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Faster!

We've sped up many parts of the program. 

· Many analyses are faster. Overall, we can run our set of thousands of
test cases about twice as fast on Prism 8 than Prism 7. 

· On average, nonlinear regression is 50% faster. But it depends on the
data set and equation. Some fit 50 times faster. A few are a bit slower. 

· Exact nonparametric tests are faster. 

· Switching between sheets is much faster in some cases. So is displaying
graphs and saving/opening pzfx files. 

64-bit Windows version can do more

· Bigger data sets. Prism 8 64-bit can handle millions of values.

· importing larger Excel, TXT and XML files. "Disk or memory error
occurred” alerts appear on importing large Excel and XML files (more
than 20 000 000 values) in Prism 7 and “Not enough free space’ alert
appears in Prism 7 during importing large TXT file (more than 20 000
000 values) while Prism 8 64-bit can successfully import these files
(slowly).

· Exporting large amount of data to TXT, CSV and XML file formats.
"There is too much text to copy" and "There is not enough memory for
normal operations" alerts appear in Prism 7 on exporting large amount
of data to TXT, CSV and XML file formats (more than 10 000 000 values)
while Prism 8 64-bit can successfully export these files file formats,
though, it takes considerable time.

· Exporting large graphs or layouts to TIF format (Prism 7 exports graph
to TIFF format when maximum width is up to 11 inches, while Prism 8
64-bit successfully exports graph to TIFF format when width if up to 25
inches).
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4.6 More compatible

Infrastructure (Windows only)

·  Prism looks much better on a high resolution displays, even if you drag
a Prism window from one display to the another with a different
resolution or if you change display settings while Prism is running.

· Each open Prism Windows project now has its own window with its own
toolbar and menu bar.  This is the way all modern programs work. No
more master Prism window containing the project windows.

· Prism Windows now comes in separate versions for 32- and 64-bit
versions of Windows. The 64-bit version handles big data sets and big
image imports better, and is more compatible with 64-bit versions of
Office.

· Export (or copying) of graphs or layouts to EMF+ format is improved for
greater compatibility with Office and other programs.

Unicode

Unicode. We did lots of work to the innards of Prism so all text is encoded
in Unicode. This makes things much easier when handling mathematical
characters, Greek letters, and text in Japanese, Mandarin, etc. Unicode is
now the standard for handling text, and transferring text from one
application to another, and Prism (Win and Mac) now supports it fully.

4.7 More versatile

Heat maps

· Rainbow heat maps now use red for the highest value and blue for the
lowest. A new "Reverse rainbow"  uses the opposite convention to
match Prism 7.

· Specify axis and graph titles on heat maps.
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· On heat maps, when you choose to not label every row or column, but
rather label every second (or third...) row or column. Prism now lets
you choose which row or column to start from.

· You can make heat maps even with many thousand rows of data (Prism
will average rows, when necessary).

More choices in preferences

· Turn off warning messages on graphs (about error bars, etc.). But those
warnings are much shorter in Prism8, so you'll probably want to leave
them on.

·  Set the default tick length.

· Choose an ordinary minus sign or a longer en-dash to show negative
numbers on axis numbering.

· Choose how long a column or row title should be before Prism switches
to labeling with "Row 4" or "Column D". 

· When to use scientific format to report P values -- always, never, or it
depends.
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4.8 Multiple regression

New kind of table

Prism 8 offers a new kind of data table, multiple variables. It is arranged
like most statistical programs. Each row represents a different subject or
experiment or unit. Each column is for a different variable. 

Multiple linear regression

The word "multiple" means that there are several independent (X)
variables. Multiple linear regression fits an equation that predicts Y
based on a linear combination of X variables. This is a standard analysis
that you can read about in many books. Options:

· If the Y values are numbers of objects or events actually counted, Prism
can do Poisson regression. If Y is a continuous variable, Prism does
multiple linear regression.

· Include (or not) the intercept, two-way interactions between selected
variables, and three-way interactions between selected variables.  

· Include transforms of the parameters in the model.

· Weight all the points equally or weight by 1/Y2 or some other weighting
functions.  Weighting is useful when variability is larger for points with
larger Y values than for points with smaller Y values. 
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· Fit two alternative models and compare the goodness of  fits. 

· Graph actual vs. predicted (from the model) Y values.

· Graph the residuals in four ways. 

· Test for normality of the residuals, and for multicollinearity of the
parameters. 

Multiple logistic regression

New in version 8.3.0, Prism can now perform Multiple logistic
regression. As with multiple linear regression, the word "multiple" here
means that there are several independent (X) variables, or predictors.
Multiple logistic regression allows you to fit a model to your data when
your outcome variable (Y) is binary: yes or no, 1 or 0, alive or dead, etc.

New analysis to extract and rearrange data 

A new "Extract and rearrange" analysis lets you extract data from a
portion of a multiple variable table and use it to create another kind of
table. For example, you can move two columns in to a new XY table. Or
put data from one column into a Column table using another column to
define which data set each value goes into. Or cross-tabulate onto a chi-
square table. 

New analysis to select and transform and combine

Another analysis (Select and Transform) creates a new multiple variable
table from an existing one. For example, you could select rows 1-100. Or
if one of the columns is age, you could select only the rows of people
older than 75.  This analysis can also create new variables by
transforming variables or by combining variables (for example take the
ratio of two columns).  
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4.9 Huge improvements in ANOVA

Analyze repeated measures data with missing values. 

Repeated measures ANOVA cannot be computed when even a single value
is missing. This is a huge problem, and many people have asked us to do
repeated measures ANOVA with missing values. This is not actually
possible, but we did it anyway!

Prism 8 can now analyze repeated measures data (one-, two- and three-
way) by fitting a mixed effects model. The analysis works differently
than ANOVA but gives the same main results when there are no missing
values and gives useful results when there are missing values.  Of course,
the results can be interpreted only if you assume that the values are
missing for random reasons. 

Other improvements in repeated measures ANOVA

· Analyze three-way ANOVA with repeated measures in any or all of
the three factors. Prism 7 was much more restrictive.

· Name the repeated measures factor.  Earlier versions always used
the name "subject". Now you can choose "litter" or "animal" or "patient"
or ....

· Correct for lack of sphericity with the Geisser-Greenhouse
correction. Prism 7 could already do this with one-way ANOVA. Prism 8
can do it also with two- and three-way ANOVA.

More options in regular ANOVA

· View a table of cell, row, column and grand means 

When values are missing (sample sizes are unequal), Prism shows the
predicted LSmeans (least square means).
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· Test for homogeneity of variance by calculating the nonparametric
correlation between the predicted  Y values and the absolute value of
the residuals.

· One-way ANOVA without assuming the data were sampled from
populations with equal standard deviations. Prism will calculate the
Brown-Forsythe and Welch ANOVA, followed by appropriate multiple
comparisons tests: Games-Howell, Tamhane T2, DunnettT3 tests.

· With two-way data with only two columns and/or two rows, view the
difference between the two column (or row) means along with its
standard error and 95% confidence interval. If your table has two rows
and two data sets, also view the interaction confidence interval.

4.10 Nested t test and nested one-way ANOVA

Prism 8 offers a new kind of data table for nested data where values
stacked in each subcolumn are related, and creates subcolumn graphs
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of these data. In this example, there are two treatments given to three
rats each and the outcome variable was measured four times in each
rat. 

The different rats (different subcolumns) are actual replicates in the
experiment, while the multiple measurements (different rows) are
technical replicates. If you combined these and entered twelve replicates
for each group into a t test, the results would be wrong. This is the error
of pseudoreplication. 

With two treatments (as in the example above), Prism 8 analyzes these
data with what we are calling a nested t test. With three or more groups,
Prism 8 offers the nested one-way ANOVA. 

Note that "nested t test" and "nested one-way ANOVA" are not (yet!)
standard terms. Prism actually runs the appropriate mixed-effects model,
and this works even different subcolumns have different number of
values, or different treatments have data in different number of
subcolumns.

4.11 More analysis choices: Statistics

Test column data for normality and lognormality

· We've added one more normality test (Anderson-Darling). So now
Prism can test for normality with four tests.
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· The normality test  of column data is now a separate analysis, rather
than being an addon to column statistics.

· In addition to (or instead of) testing for normality, test for
lognormality, and test whether your data were more likely to have
been sampled from a Normal (Gaussian) or lognormal distribution. 

· Plot a QQ plot as part of normality testing. 

New transforms

· Round data to a specified number of digits after the decimal point.

· Logarithm base 2, and its inverse (2^Y)

· Inverse statistical functions to compute a P value from a statistical ratio
(and degrees of freedom) : zinv, tinv, chiinv, Finv (to be used when
writing a user-defined equation or transform).

t tests

· The multiple t test analysis now automatically makes a volcano plot
(difference vs. P value). 
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· The t test can now plot the confidence interval for the difference
between means.

· The one-sample t test can be used with data entered on a grouped table
as mean, n and SD or SEM.

Other improvements

· Grubbs test reports the value of G when an outlier is found.

· With grouped, nested, or XY tables, individually test each subcolumn for
outliers. 

· The row statistics can compute mean and confidence interval. 

· When creating a ROC curve, choose the confidence level you want (i.e.
99% instead of 95%) and the method used to compute it. 

· The binomial test is much faster.

· Calculating asymmetrical confidence intervals for nonlinear regression is
two-three times faster.

· Descriptive statistics include harmonic mean and quadratic mean with
their confidence intervals.

· The correlation matrix analysis can create a heat map of R2 values (new
in 8.1).

4.12 More analysis choices: Regression

Plot residuals and test them for normality

A residual is the difference between the actual and predicted value of Y.
Prism 7 let you plot one kind of residuals from regression. 
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Prism 8 expands this to tabulate residuals also from ANOVA (one-, two-
or three-way), t tests and multiple regression. For each of these
analyses, test for normality of residuals in four ways and plot the
residuals in four ways (including a QQ plot). 

Poisson regression

When the Y values represent an actual number of counts of objects or
events (not normalized in any way), the residuals are not expected to
follow a  Gaussian distribution, but  rather to follow a Poisson
distribution. 

Prism now lets you specify that you expect Poisson residuals for both
nonlinear and multiple regression, and the calculations are done
accordingly. 

Logistic regression

When the outcome variable (Y values) are binary (yes/no, 1/0,
alive/dead, etc.), you can use logistic regression to fit a model to your
data. New in Prism 8.3.0, you can now perform simple logistic regression
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with a single predictor variable (X variable), or multiple logistic regression
with many predictor variables.

More built-in equations for nonlinear regression

· Pade(1,1) approximant equation, useful for interpolating when the
standard curve plateaus at large concentrations (it is similar to a
rectangular hyperbola). 

· Family of growth equations. These are used for everything from the
growth of cell number in culture to the growth of economies. Equations
offered are  exponential growth, exponential plateau, Gompertz,
logistic, and beta (growth then decay).

· Several forms of the linear quadratic equation used to model cell
death after exposure to radiation. 

· Hinge function. It is the same as segmental linear regression, except
that the two lines connect with a gentle curve instead of a hard angle. 

· Fit straight lines to two data sets and find the intersection point and
both slopes.

· In Prism 8.2, we expanded our equation library such that all dose-
response equations now have forms for when X represents
concentration and when X represents log(concentration).

Asymmetrical (profile likelihood) confidence intervals

· Computing asymmetrical profile likelihood confidence intervals is 2-3
times faster. 

· With difficult equations, Prism sometimes reported "???" rather than a
value for one or both of the confidence limits. This can still happen, but
much less often. 

New choices

· When you choose to remove outliers in nonlinear regression, you can
now ask Prism to create a results table with the "clean" data (without
outliers).
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· Detect "Unstable" parameters in nonlinear regression: a new "Prism
Labs" feature introduced in Prism 8.2 as an alternative to the method
Prism uses to detect bad fits. Earlier versions detected "ambiguous fits".
With the optional setting (on the Confidence tab of the nonlinear
regression), Prism detects "unstable" parameters. In our experience,
this method is better as the "ambiguous' method sometimes doesn't
show results in cases where the new method can.

5 What was new in earlier versions?

Version 7 of GraphPad Prism introduces many

improvements in graphs , nonlinear regression ,

statistical analyses  and much more . 

5.1 What was new in Prism 7?

5.1.1 Highlights of what was new in Prism 7

Heat maps

Three-way ANOVA

45 56

60 68
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FDR approach to multiple comparisons

More accurate (asymmetrical, likelihood) confidence intervals from
nonlinear regression
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Label subcolumns

Color code sheet names, and selected cells in tables

 

   

Semitransparent colors
 so you can see overlap
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Enter dates (or elapsed times) as X values

 

5.1.2 What was new: Graphs

Heat maps, semitransparent colors, dates and

more. 

5.1.2.1 Heat maps
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Heat maps are a new way to plot grouped data. The plotting area is
divided into squares. The columns corresponds to different data sets in
your table, and the rows in the graph correspond to different rows in the
data table. Each square in the graph is color coded to denote the value
entered into that cell of the table. Features:

· Reverse the direction of either axis, or transpose the X and Y axes.

· Color scales can encode continuous data with one scale, continuous data
with two scales (perhaps one for positive numbers and another for
negative numbers) or discrete categories (1=blue, 2=red, ...).
Monochrome or color.

· Specify special colors for values that are "off the map" or for excluded
values. Optionally put "X" through those cells.

· If you entered replicate values, base the heat map on the mean, median
or geometric mean of the replicates. Or base it on the SD, SEM or CV
among replicates to make a heat map of variation.

· Introduce more structure to the graph by inserting gaps to the right of
any column or below any row.  

5.1.2.2 Semitransparent colors to see overlapping points

When choosing any color, you can now specify that is be
semitransparent  (or on a Mac, "semiopaque"). 

When symbols are semitransparent, this lets you see when several
symbols are superimposed (they get darker).

368
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Semitransparent colors are also useful when shading under a curve. 

 

5.1.2.3 Enter dates or elapsed time as X values

Prism lets you format the X column for entry of numbers , elapsed time in
hh:mm:ss, or dates. Choose on the Welcome (File..New) dialog: 
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If you choose elapsed time, enter time as hh:mm or hh:mm:ss. For
example, enter 1:12:30.2 to enter an elapsed time of 1 hour, 12 minutes,
30.2 seconds. 

If you chose to enter dates, you can enter dates in almost any format.
Prism will figure out what you meant and display the date on the table in
a standard format (that you cannot change).

XY graphs can now label the X axis with the dates or elapsed times you
entered. 
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When performing XY analyses (or making graphs with numerical X axis),
the dates or elapsed times you entered are converted to numbers using
units and a starting date that you choose in the Format Data Table dialog.

5.1.2.4 Three way grouped graphs

To go along with three-way ANOVA, Prism can also create three way
grouped graphs. 

Enter your data on a grouped table like this. 

Two of the factors must have only two levels (e.g. male/female; low
fat/high fat), but the the third factor (designated by different rows) can
have more levels (more than two rows). 

Here is the three way graph, with labels produced automatically.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_what_is_three-way_anova_used_f.htm
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5.1.2.5 Improvements with error bars

New error bar calculations

· When plotting medians, Prism offers a new choice of error bars: Median
with 95% CI 

· When plotting the geometric mean, Prism now offers to plot error bars
showing the geometric SD. It also shows the geometric SD factor on the
Column statistics results page. 

New warnings

· If any error bar is smaller than the symbol, Prism now places a floating
note on the graph explaining why the error bars are not shown.

· Prism will warn you if you mix SD and SEM error bars on the same
graph, as this is usually not intentional. 

New default

· Prism 6 always defaulted to SD error bars. A new preference lets you
choose whether you prefer to default to SD or SEM error bars.

5.1.2.6 Other improvements in graphing

New graphing options

· Add major grid lines on the categorical axis of Column and Grouped
graphs.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_the_geometric_mean_and_geometr.htm
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· Some box-and-whisker graphs plot individual points for large and small
values. Prism 6 always plotted these points using solid circles. Prism 7
lets you choose any type of symbol.

· Prism lets you plot replicates on an XY graph as box-and-whiskers.
Prism 6 always plotted these with the whiskers extending down to the
minimum and up to the maximum value. Prism 7 now offers five choices
for defining the whiskers (same choices that Prism 6 offered for Column
box-and-whisker graphs).

· When plotting individual replicates on a XY plot, in addition to
connecting the means, you can now draw lines that connect the median
or geometric means.

· On grouped graphs, specify how large a gap you would like to see when
a data table row is blank, and specify gaps before the first data set and
after the last.

· On column graphs, specify how large a gap you would like to see before
the first data set and after the last.

· When you make one graph per data set, Prism uses the column title of
each data set as the graph title. Now this is a live link, so if you change
the column title, the corresponding graph title will update.

· For bar graphs, the choice to use (or not use) a fill pattern is now more
obvious in the Format Graph dialog. With prior versions you had to
choose a solid fill pattern to get no fill pattern. Now just uncheck the
option if you don't want a fill pattern.

Exporting

· Prism 7 Windows uses a superior library for exporting and importing
bitmap (tiff, jpeg, png) images creates better image files compatible
with more applications.

· When exporting color graphs in tiff or jpg format, Prism Windows now
lets you choose grayscale, where colors are converted to various shades
of gray (Prism Mac already offered this choice).
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Axes

· Use a comma as decimal separator in axis numbering.

· Discontinuities in the X or Y axis can now be shown with either
perpendicular or angled gaps. 

More versatility when drawing lines, boxes, etc. 

· Rotate any line, rectangle, text object or imported image. 

· When moving lines, arrows or objects, Prism shows more information in
the tool tip (length, angle, position...).

· Set a default for the line width of lines and arrows you draw.

Legends

· Choose square (new) or rectangular legends for bar graphs.

· New command on the Change menu reverses the order of a set of
legends.

Text

· You can now use flush justification.

Add information to graphs

New file constants let you add file name, and dates to graphs or layouts. 
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5.1.3 What was new: Nonlinear regression

More accurate asymmetrical confidence intervals,

test for homoscedasticity and more. 

5.1.3.1 More accurate (asymmetrcial) confidence intervals from nonlinear regression

With all prior versions of Prism, the confidence intervals for parameters fit
by nonlinear regression were always symmetrical around the best-fit
value. These are called asymptotic intervals or approximate intervals.
These are are what most nonlinear regression programs report. But the
true uncertainty in a parameter's value, in many cases, is asymmetrical.
In these cases, the symmetrical confidence intervals do not really express
the precision of a parameter's estimate very well. 

Prism 7 lets you choose to create asymmetrical confidence intervals
instead. Based on the method used to compute these intervals, they are
sometimes called profile likelihood intervals. These almost always do a
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better job of expressing the precision of the parameter estimate, and in
some cases a much better job. 

The initial default is to show the asymmetrical intervals, but you can
change this default (in the Confidence tab of the nonlinear regression
dialog). Since the only purpose of the standard errors of the parameters
is to compute the approximate confidence intervals, we suggest that you
stop showing these once you get used to the new asymmetrical intervals. 

The only disadvantage of this new way of computing the confidence
interval is that the calculations are slower. But with modest data sets
(few dozen data points), standard models, and reasonably fast
computers, you won't notice. Prism 7 computes nonlinear regression
more quickly than prior versions (about ten times faster if you choose a
built-in equation), so you are unlikely to notice the slow down.

The availability of these new asymmetrical confidence intervals let us add
new dose-response equations  where X is dose or concentration, rather
than the logarithm of dose or concentration. 

59
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5.1.3.2 Test for homoscedasticity

Nonlinear regression assumes that the average distance of points from
the curve is the same for all parts of the curve (homoscedasticity) or that
you have chosen an appropriate option on the weights tab to correct for
this problem. 

Prism 7 can test for homoscedasticity or appropriate weighting. To do
this, Prism 7 computes nonparametric correlation between the absolute
values of the weighted residuals and the Y value of the curve. A low P
value from this test means that the weighted residual is correlated with
the Y value of the curve, and this suggests  the weighting choice was not
ideal.

5.1.3.3 Flag bad fits

Some scientists run many fits, perhaps using a script, or review many fits
run by others. Prism 7 provides a way to flag poor fits, so you you know
which data sets and results to inspect more carefully. 

· Define "poor" fits on the new Flags tab on the parameters dialog of
nonlinear regression. Flag a fit because the R2 is too low (you define
how low that is), when the number of outliers is too high (you define
how high that is), when a dependency is too high, or when the residuals
fail a normality test, or the runs or residual test.  

http://www.graphpad.com/guides/prism/7/curve-fitting/index.htm?reg_test_for_homoscedasticity.htm
http://www.graphpad.com/guides/prism/7/curve-fitting/index.htm?reg_flags_tab.htm
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· When running Monte Carlo simulations choose to skip any results from
fits that were flagged as being poor.

· When comparing two models, you can tell Prism to skip formal
comparisons when one fit is flagged as being poor, and always choose
the other fit in that case.  

5.1.3.4 More choices for user-defined equations

· When editing an equation, the innermost parentheses around the
insertion point are always highlighted to help you avoid mistakes that
can occur when you are lost in a sea of parentheses.

· New choices for rules rules for initial values. You can now compute the
initial value as a constant value multiplied or divided by the initial slope,
the final slope, or the slope at the middle of the graph.

· When defining an equation, you can enter equations to report values
calculated from the parameters. Enter "Y[logEC50]" to report the Y
value when X=logEC50, or "X[B]" to report the X value when Y=B. 

· Three improvements when fitting a model defined by a differential
equation:  

o Set X0 to any value (Prism 6 always set it to 0.0).

oUse the <A> or <B> notation to define different equations for different

data sets.

o Choose to share or not share the value of Y0 among data sets. 

5.1.3.5 Improved built-in equatons

· A new set of dose response equations fit data where X is dose or
concentration, to complement the existing set of equations where X is
the logarithm of dose or concentration.
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· Faster. When you choose a built-in equation, nonlinear regression is
more than ten times faster than it was with Prism 6, with improved
precision. This is because the derivatives (and second derivatives) are
now evaluated analytically rather than numerically. This will even work
when you clone a built-in equation and change parameter names.  This
extra speed is noticeable when you have lots of data, do Monte Carlo
simulations, ask for Hougaard's measure of asymmetry, or ask for
asymmetric likelihood confidence intervals (which require more
computation). 

· The rules for initial values have been improved for the parameter Width
in the log(Gaussian) distribution, for all three parameters in the
equation for enzyme substrate inhibition, and for the Amplitude of a sine
wave.

· New equation for sine wave with nonzero baseline.

· Renamed "One-site --- specific binding with Hill slope" equation to
"Specific binding with Hill slope", because with a Hill Slope that doesn't
equal 1.0, this equation really necessarily describe binding to one site. 

5.1.4 What was new: Statistical analyses

Three way ANOVA, analyze a stack of P values,

control the FDR and more. 

5.1.4.1 Three way ANOVA

Prism has been able to perform one- and two-way ANOVA for many
versions, and now can also perform three-way ANOVA. 

Enter your data on a grouped table like this. 

http://www.graphpad.com/guides/prism/7/curve-fitting/index.htm?reg_sine_wave_nonzero_baseline.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_what_is_three-way_anova_used_f.htm
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Two of the factors must have only two levels (e.g. male/female; low
fat/high fat), but the the third factor (designated by different rows) can
have more levels (more than two rows). 

The three-way ANOVA dialog is similar to the dialog for one- and two-way
ANOVA, but the choices for multiple comparison goal are a bit different:

Here is a portion of the results table, showing all seven P values. Yes,
seven! Three-way ANOVA is complicated.  

Prism 7  provides a new kind of three-way graph to display data entered
into three-way ANOVA:
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5.1.4.2 Analyze a stack of P values

Enter a stack of P values that were computed elsewhere into a column A
of a Prism Column table, and choose this new analysis to determine which
of those P values are small enough for the corresponding comparison to
be worth investigating further. Use the approach of statistical significance
with multiple comparisons or the method of controlling the false-discovery
rate. 

This analysis also lets you plot the rank of each P value vs. the actual P
value, a common way to visualize the distribution of a set of P values. 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_key_concepts_analyzing_a_stack.htm
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5.1.4.3 Control the false discovery rate (FDR)

Correct for multiple comparisons by controlling the False Discovery Rate

Controlling the False Discovery Rate (FDR) is a great method for coping
with multiple comparisons. Prism 6 offered this as part of the multiple t
test analysis. Prism now offers it in three places. 

As a followup to ANOVA

Prism has long offered multiple comparisons tests after ANOVA to control
the Type I error rate for the family of comparisons. Now Prism 7 lets you
use an alternative strategy for multiple comparisons following ANOVA
(one-, two- or three-way): controlling the False Discovery Rate (FDR). 

Multiple comparisons for P values computed elsewhere

Prism offers an analysis to analyze a stack of P values computed
elsewhere. You enter a set of P values into a column and choose this
analysis. Prism graphs the rank of each P value vs. the P value itself. This
is a standard way to visualize the distribution of a set of P values.

Which P values are small enough so the corresponding finding should be
flagged as "statistically significant"? Choose to control the False Discovery
Rate or the familywise Type I error rate using the method of Bonferroni,
Sidak or Holm. 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_the_false_discovery_rate_appro.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_false_discovery_rate_from_mult.htm
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Multiple t tests, one per row

Prism 6 introduced an analysis to run multiple t tests, one per row. If you
choose the method that controls the  Prism 7 also reported q values (also
called adjusted P values) for each comparison.

Three algorithms for using the FDR method

Whenever you choose to use the FDR approach to decide which P values
are small enough to be a "discovery", Prism lets you choose one of three
methods for controlling the FDR.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_pros_and_cons_of_the_three_met.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_pros_and_cons_of_the_three_met.htm
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5.1.4.4 New analysis to transform concentrations

This analysis can do any or all of these tree things:

· Handle zero concentrations differently. Zero concentrations are
sometimes a problem because the  logarithm of zero is not defined, so
zero concentrations are lost in a log transform. With this analysis, you
can specify that zero be substituted with a low value (say 10-9) before
taking the logarithm.

· Change units, for example from molar to nanomolar. Simply tell Prism
what constant to multiply or divide by.

· Transform to logarithms, often needed prior to fitting a curve. 

5.1.4.5 Choose how to report P values

Most of Prism's analyses report P values, and now all these analyses let
you choose how to report P values. 

Prism gives you four choices:

· The APA (American Psychological Association) style, which shows three
digits but omits the leading zero (.123). P values less than 0.001 shown
as "< .001". All P values less than 0.001 are summarized with three
asterisks, with no possibility of four asterisks.

http://www.graphpad.com/guides/prism/8/statistics/index.htm?stat_decimal_formatting_of_p_values.htm
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· The NEJM (New England Journal of Medicine) style, which shows three
digits and includes the leading zero (0.123). P values less than 0.001
shown as "< .001". All P values less than 0.001 are summarized with
three asterisks, with no possibility of four asterisks.

· The now classic GraphPad method which reports four digits after the
decimal point with a leading zero (0.1234). P values less than 0.0001
shown as "< .0001". P values less than 0.001 are summarized with
three asterisks, and P values less than 0.0001 are summarized with four
asterisks.

· Choose how many digits you want to see after the decimal point, up to
15. P values less than 0.001 are given three asterisks, and P values less
than 0.0001 are given four asterisks.

5.1.4.6 Improved analyses of 2x2 contingency tables

More complete analyses 

Prism now reports the reciprocal of the relative risk and odds ratio, and
their confidence interval. Depending on the meaning of the rows and
columns, the reciprocal may be more meaningful to you. 

When you choose to report the difference between proportions, its
reciprocal called the Number Needed to Treat (NNT) is also computed
along with  its confidence interval.

Choice of algorithms

Prism offers new algorithms when computing the confidence interval of a
proportion, the difference between two proportions, the relative risk, or
the odds ratios. 

The methods used by prior versions were simple approximations, and the
improved methods Prism now offers produce narrower intervals that still
provide the desired confidence level. We suggest you use them routinely.

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_three_methods_for_computing_th.htm
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5.1.4.7 Other improvements in statistical analyses

· The Row Statistics analysis can now report means only without SD or
SEM.

· One-way ANOVA now works even if any of the data set columns has only
a single value.

· Two-way ANOVA can now do multiple comparisons comparing every cell
with every other cell if the data are repeated measures in both factors.

· The Normalize analysis can now normalize each subcolumn separately,
using its own definition of 100% and 0%. 

· The correlation matrix analysis now reports a third page of results
showing number of XY pairs for each pair of variables (missing values
can lead to different n for different variable pairs). 

· Enter starting and ending dates for each subject in a survival analysis
instead of entering number of days (or weeks..). 

· If you enter data with replicates (or enter mean, n and SD or SEM), the
Area under the curve (AUC) analysis will now report the AUC with a
standard error and 95% confidence interval. 

· The multiple t test analysis now reports multiplicity adjusted P values. 

· The Shapiro-Wilk normality test now works with a sample as small as
n=3. 

· The Remove Baseline & Column Math analysis now gives you choices for
reporting the column titles. If the column titles in your data table are
"Control" and "Treated" and you ask the analysis to subtract one from
the other, you can have the second results column labeled as "B-A" or
"Treated-Control" or just "Treated". 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_area_under_the_curve.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_area_under_the_curve.htm
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5.1.5 What was new: General

Color code sheet names or cells, label subcolumns,

and more. 

5.1.5.1 Label subcolumns

By default subcolumns are labeled Y1, Y2, Y3, etc. You can enter your
own subcolumn titles. Double click on a subcolumn title to bring up the
appropriate dialog. 

Apply one set of subcolumn titles  to all data sets, or label each
subcolumn in each data set uniquely.

5.1.5.2 Color code selected cells in tables

Highlight selected cells  of data or results tables with a choice of colors. 

Use one color to mark values that you want to double check, and color for
cells you want to discuss with a colleague, another for key results you
want to find again. Or color code different parts of an experiment.

246

255
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5.1.5.3 Color code sheet names

Choose from nine color when highlighting a sheet name . 

You might want to choose one color to highlight the most important
results, another color to mark sheets you need to discuss with a colleague
or mentor, and yet another color to mark the graphs that were included in
a paper.   

5.1.5.4 New Family menu

Working with families of linked sheets is an important method for working
efficiently in Prism, but the commands that worked with families of sheets
have been scattered around the program, and many people never
discovered them. 

A new Family menu  in Prism 7 consolidates all these commands,
making it easier to view, delete, duplicate, highlight, save or print all
related sheets in a family. It also offers a new command to highlight all
sheet names in the family. 

192

154



GraphPad Prism 8 User Guide70

© 1995-2020 GraphPad Software, LLC

5.1.5.5 New shortcuts to work more efficiently

We know that some people use Prism almost every day, so we work hard
to provide time savers for frequent users. Improvements in Prism 7:

· Create a new data table without a linked graph.

· When creating a layout , assign a series of graphs so you don't have
to add them one at a time.

549
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· Set a preference to make bar graphs without bar borders.

· Reverse the order of legends instantly.

· With parts-of-whole graphs you can now choose which data set to graph
(these graphs can only plot one data set). Prism 6 only plotted data set
A.

· The script editor shows line numbers, making it easier to edit long
scripts.

· New script command to save all graphs or all layouts in a single pdf file. 

· The Wand  graphs data on a new table just like you have already
graphed another table (even if that table was not analyzed).

· When editing an equation, the innermost parentheses around the
insertion point are always highlighted to help you avoid mistakes that
occur when you are lost in a sea of parentheses.

178
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5.1.5.6 Uses OS X Versions and Resume (Mac only)

Prism 7 uses the Versions and Resume features of OS X to make it easier
to get your work done without thinking about saving files. Your work is
saved as you go, with no need to ever click the Save button (although
you can). Automatic backup is handled by the Mac Versions and Resume
feature, and is no longer handled by code we wrote. 

This is a change Apple introduced a few years ago. If you use iWork
(Pages, Numbers, Keynote), you already know about Versions and
Resume. If you don't use iWork, spend a minute reading about these
features  to avoid frustration. 

5.1.5.7 Enter data with more digits

Prism 7 lets you enter data with 13-14 digits for each value (double
precision). In contrast, Prism 6 allowed to to enter only 6-7 digits (single
precision). 

Allowing more digits prevents round off errors when importing or pasting
data with more than 6 or 7 digits of precision. 

Additionally, all calculations now use doubles instead of integers. This
allows Prism to avoid integer overflow and as a results work better with
large data sets (large N). Prism already use double-precision floating
point math. 

5.1.5.8 Looks better on high resolution displays

Many people now use computer displays with high resolution. Apple calls
these retina displays. 

Prism 7 Windows works much better on high resolution displays. 

Prism 6 Mac already worked well on retina displays, but Prism 7 looks
even better with high resolution icons. 

5.1.5.9 Work with larger files

We improved how Prism manages computer memory, so it can now work
with larger files than before.

138
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5.2 What was new in Prism 6?

When creating Prism 6, our goals were ambitious:

· To simplify Prism so it is easier to learn and even more
efficient to use.

· To greatly improve its statistical clout and graphical
versatility. 

· To make Prism 6  appeal to a wider group of scientists
and students.

· To make the transition from Prism 5 (or earlier) to Prism 6
be graceful,  and for people who make the switch to
rapidly discover that Prism 6  simply works better.

Links to the full lists of new features:

Highlights
Statistics
Multiple comparisons
Regression
Data tables
Working with other programs
Parts-of-whole data
Column graphs
XY Graphs 
Grouped graphs
Layouts
Time savers

5.2.1 What's new? Highlights

Prism 6 is a big upgrade with many
improvements. It has more statistical
clout, can make more kinds of graphs, and
is even more efficient to use. But Prism is
still Prism. The basic interface and
organization of the program has not
changed, so you can switch to Prism 6 with
almost no learning curve. And you can try

Zig-zag and elbow lines
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the Prism 6 demo without removing Prism
5. 

Statistics

· Two-way ANOVA with repeated measures
in both factors

· Detect outliers in a column of data using
Grubbs' test

· Calculate and graph 95% CI of median
with Wilcoxon test 

· Calculate and graph 95% CI of difference
between medians with Mann-Whitney
test 

· Greenhouse-Geisser correction in one-way
repeated measures ANOVA

· Ratio t test
· Kolmogorov-Smirnov test (alternative to

Mann-Whitney)
· Multiple tests (one-per row) with optional

correction for multiple comparisons
· Monte-Carlo analyses

Multiple comparisons

· Exact (multiplicity adjusted) P values with
Bonferroni, Tukey and Dunnett's tests.

· Graph 95% CI of difference between
means

· New approach: Fisher’s unprotected Least
Significant Difference (LSD)  

· New multiple comparisons test: Holm-
Sidak

· Test main or simple effects after two-way
ANOVA

· Dunnett's test now can handle up to 256
groups (up from 20)

Nonlinear regression
· Fit to models defined by implicit and

differential equations.
· Write more complex models
· Weight your fit by 1/YK

· Much easier interpolation

Pie charts and more

Superimpose individual data points with
bars 

Superimpose individual data points with
box-whiskers 
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Bigger data tables
· Enter data in up to 256 data set columns

(up from 52 in Prism 5)
· Create data sets with up to 256

subcolumns (up from 52) to allow
repeated measures 2 way ANOVA with
more subjects

Row and column titles
· Write two or three line titles
· Use bold and italics 
· Make titles as long as necessary
· View and edit all of your column titles at

once

Work more efficiently
· Faster in many ways: saving, graphing,

exporting and closing
· Nonparametric calculations are way way

faster!
· Format several data sets at once. Want to

plot alternating columns as dotted lines?
Now you can do it in one step.

· Paste link data or results copied from
Prism, and those values will be hot linked

· Choose the size, shape and color of
selected data points right from the data
table

· More choices when exporting
· Set defaults as you work. Many dialogs

now a have checkbox to make your
choices on that dialog (or tab) become the
defaults when you use that dialog in the
future.

· Much easier to create the graph you want
since you don't pick the graph type until
after entering data. Preview how different
graphs look with your data before
deciding.

· Search a large project to find pages that
include specified text

Separate columns with lines

Label both sides of an axis
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5.2.2 What's new? Statistics

Repeated measures ANOVA

· Two-way ANOVA with repeated measures in both factors. Prism 5 could
only compute two-way ANOVA with repeated measures in one of the
factors. Prism 6 can handle repeated measures in both factors. 

· More subjects . Prism 6 now allows up to 256 subcolumns, so can
perform repeated measures two-way ANVOA with up to 256 subjects
per treatment.

· The Greenhouse-Geisser correction allows repeated measures one-way
ANOVA to work, even when the assumption of sphericity is violated
because the repeated measurements are made in too short a time
interval, so that random factors that cause a particular value to be high
(or low) don't wash away or dissipate before the next measurement. In
this case, multiple comparisons are also computed so as to not assume
sphericity.  

Survival analylsis

· Prism now computes the hazard ratio (HR) by two methods: The logrank
method and the Mantel-Haenszel method. 

· If people in group A die at twice the rate of people in group B (HR=2.0),
then people in group B die at half the rate of people in group A
(HR=0.5). Prism now reports the hazard ratio, and its confidence
interval, both ways so you can report the one that makes most sense in
your clinical context.

· If people in group A have a median survival time three times people in
group B, then people in group B have one third the median survival of
people in group A. Prism now reports the ratio of median survival times,
and its confidence interval, both ways so you can choose which to
report.

Analyses of column data (t tests etc.)

238
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· Mann-Whitney tests reports 95% CI of difference between medians. The
Mann-Whitney test is often described as comparing the median of the
two groups. That is not precisely correct, as it is possible for two groups
to have the same median, but for the Mann-Whitney test to find that the
difference between the distribution of ranks among the two groups is
statistically significant. However, if you assume that the two
distributions have roughly the same shape, then it is fair to think of the
Mann-Whitney test as comparing two medians. Accordingly, Prism 6 can
now report the confidence interval for the difference of two medians. 

· The Wilcoxon test computes the 95% CI of the median. The Wilcoxon
matched-pairs test (nonparametric test of two paired or matched
groups) reports the confidence interval of the median of the paired
differences, and the Wilcoxon signed rank sum test (nonparametric test
to compare a median with a hypothetical median) now reports the
confidence interval of the difference between the actual sample median
and the hypothetical median.

· Ratio t test. The paired t test works by analyzing the difference between
each pair of values, testing the null hypothesis that the average
difference is zero. With some kinds of data, the difference between
before and after is not a consistent measure of effect. The differences
might be larger when the "before" values are larger, and smaller when
the "before" values are smaller. The ratio (after/before) may be a much
more consistent way to quantify the effect of the treatment. Actually, it
turns out that analyzing the logarithm of ratios works much better. 

· Kolmogorov-Smirnov test.   Like the Mann-Whitney (MW) test, the
Kolmogorov-Smirnov (KS) test, is a nonparametric method to compare
two groups. The KS test works by comparing the two cumulative
frequency distributions, and so has more power to detect subtle
differences in the two distributions. In contrast, the  MW test is better
at detecting changes in the median. The use of the KS test has become
standard in some scientific fields. Don't confuse this test with the the
other version of the KS test used for normality testing.

· Faster nonparametric tests. To avoid slow calculations, Prism reports an
approximate P value for nonparametric tests with large data sets. Prism
5 also reported approximate P values when several values were identical
and so tied for the same rank. Prism 6  performs the exact calculations
much faster (hundreds of times faster!), and so does exact calculations
even for fairly large data sets and even when several values are
identical and so tie for the same rank.
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· Identify outliers. One of our free QuickCalc web calculators identifies
outliers from a stack of values using Grubbs' method. Because this is
one of our most popular calculators, we created a new analysis in Prism
6 to identify outliers in a column of data. 

· Perform many t tests simultaneously. Computing multiple t tests can be
useful, so long as you correct for multiple comparisons. Prism 6 has a
new  analysis to perform one t test per row of a data table (with
replicates placed side-by-side). It corrects for multiple comparisons
either by using either a more stringent definition of statistical
significance or controlling the False Discovery Rate (FDR). You can also
choose not to correct for multiple comparisons.

· More graphing choices. Prism 6 offers options to automatically graph
ranks of nonparametric tests, and differences for paired t test and
repeated measures ANOVA.

· Browne and Forsythe test. To test equality of variances in one-way
ANOVA, Prism 6 computes both the Browne and Forsythe test as well as
the Bartlett test (which previous versions computed). 

· Method of Pratt. There are two ways to compute the Wilcoxon matched-
pairs test when some of the pairs are identical, so the difference is zero.
Prism 6 offers both choices. The new choice is the method of Pratt for
tied rows.

Simulations and Monte-Carlo analyses

Simulations can be useful even when you just simulate one data set, and
view the graph and analysis.Prism 5 let you simulate XY data. Prism 6
now let's you also simulate column data and 2x2 contingency tables. For
XY and Column data, Prism 6 can include not only Gaussian random
scatter, but also scatter computed from a Poisson or binomial
distribution. 

Simulations are even more useful when you repeat the simulation many
times, and tabulate the results. Prism 6 makes this possible with a new
Monte Carlo simulation analysis that makes it easy to tabulate the results
of many simulations. First simulate a data table and run an analysis to
analyze that table. Then run the new Monte Carlo analysis. Specify how
many simulations you want to run, and which analysis parameters to
tabulate. You can also define a “hit”, as perhaps a P value less than 0.05,
or a confidence interval including a theoretical value. The results of the
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Monte-Carlo analysis include a table with all the tabulated data (that you
can analyze further), and a table of the number of simulations that were
hits.

5.2.3 What's new? Multiple comparisons

· Multiplicity adjusted (“exact”) P values can be reported with Bonferroni,
Tukey, Dunnett, Dunn, or Holm-Sidak multiple comparisons testing
following one- or two-way ANOVA.  An adjusted P value is an “exact P
value” reported for each comparison, but its value depends on the
number of comparisons. 

· Fisher’s unprotected Least Significant Difference (LSD) comparisons are
a second approach to report "exact P values" following ANOVA. This
method does not correct for multiple comparisons.

· New multiple comparisons test. Holm-Sidak has more power than the
Tukey or Dunnett methods, but cannot provide confidence intervals.  

· Dunnett's test can now can be computed with 256 groups. Prism 5 was
limited to 20 groups.

· For all multiple comparisons that create confidence intervals, check an
option and Prism will create a new graph with those multiple
comparisons confidence intervals. 
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· Multiple comparisons after one-way repeated measures ANOVA, without
assuming sphericity. Prism 6 can compute confidence intervals from
repeated measures one-way ANOVA using two different methods. The
new method does not assume sphericity. Instead of using the pooled
variation from all the groups (which depends on the sphericity
assumption), the multiple comparisons are computed using only the
data in the two treatments being compared. The calculations still
account for the total number of comparisons, but don’t pool the
variation in all groups. 

· When performing multiple comparisons testing, it can make sense to
use a  overall (familywise) significance threshold higher than 0.05.
Prism 6 lets you set it to 0.1.  

·  Main and simple effects for multiple comparisons after two-way ANOVA.
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5.2.4 What's new? Regression

Simpler

· Much easier interpolating. Many people use nonlinear regression for the
purpose of interpolating values from standard curves. If that is your
goal, most of the options provided in the nonlinear regression dialog are
neither required or helpful. Prism 6 offers a new analysis just for
interpolating curves. It offers only essential  options, so is super easy to
use.

· Plot functions to understand them. Before using an equation as a model
to fit to data, it is wise to first understand it. A great way to do this is to
plot the function and see how it changes when you alter the parameters.
Prism plot functions using an analysis called Generate a family of
curves. It addition to (or instead of) plotting the function itself, Prism 6
can now also plot the first and second derivative of the function, and its
integral.

Fit more kinds of models with nonlinear regression

· Implicit and differential equations. It is no fun to struggle with algebra
and calculus to express a model as an equation that defines Y as a
function of X and parameters. It can even be impossible. Instead
express your model as a differential equation (enter the equation that
defines dY/dX) as or an implicit equation (an equation where Y appears
on both sides of the equals sign). 

· Write more complex models. Prism 5 let’s you define different models
for different data sets by designating certain lines in the equation to
only apply to a certain data set. For example, a line in the equation
preceded with <B> applies only to data set B. Prism 6 extends this
syntax  to allow more complex equations. Precede a line with <A:D> for
it to apply only to columns A-D, or with <A:K,2> to make it apply to
every second data set between A and K (A, C, E, G, I, K). 

· New weighting choice. When fitting a model to data with nonlinear
regression, it is important to weight the data appropriately. This choice
is often ignored, but it can affect the regression results. Prism always
offered several choices for weighting. Prism 6 offers a new weighting
choice, weighting by 1/YK. where K is a constant you enter on the
weighting tab of the nonlinear regression dialog. 

Additional results with nonlinear regression



GraphPad Prism 8 User Guide82

© 1995-2020 GraphPad Software, LLC

· Hougaard's skewness. When you write a user-defined equation to fit to
data with nonlinear regression, you can choose to express the
parameters in multiple ways. For example, choose between fitting a rate
constant or a half life. Hougaard's measure of skewness can help you
choose the parameterization where the uncertainty is closer to
symmetrical so the confidence intervals will be more accurate.

· Adjusted R2. Prism reports the adjusted R2 which takes into account the
number of degrees of freedom, and so can be compared between
models with different numbers of parameters.

Linear regression

· Convert from linear to nonlinear regression with one click. Linear
regression can be viewed a special case of nonlinear regression. Prism’s
nonlinear regression analysis can be used to fit a straight line, and there
are more than a dozen reasons why you might want to do so. But few
people think of using the nonlinear regression analysis to fit a straight
line.  Prism 6 makes it easier to switch – simply click the “More choices”
button on the linear regression dialog.

· Copy the linear regression equation. Prism always reported the best-fit
values for the slope and intercept, but not in the form of an equation.
Prism 6 now reports the equation for the line, ready to copy and paste
onto a graph or into a manuscript.

5.2.5 What's new? Time savers

General time savers

· Wand to analyze data.  After entering data onto an empty data table,
you may wish to analyze these new data exactly as you have analyzed
another data table. Prism has always provided a tool to do this, but you
probably never found it (it used to be called Applying a Method). Prism
6 introduces the Wand (Wizard to ANalyze Data ) button. Click it to178



What was new in earlier versions? 83

© 1995-2020 GraphPad Software, LLC

analyze (and graph) a new data table just like you already analyzed
(and graphed) an existing table. 

· Choose your own defaults. Many dialogs now a have checkbox to
make your choices on that dialog (or tab) become the defaults when you
use the dialog in the future.

· Rename while duplicating a family. A commonly used time saver is
to duplicate a sheet with a family, and then change the data in the new
copy. Prism 5 let you specify a prefix, which then preceded all the newly
created sheet names. When the family only has one data table, Prism 6
lets you entirely rename  that data table.

· Faster saving. Prism 6 Windows saves to a networked drive many
times faster than did Prism 5. Prism 6 Mac saves over a SMB connection
much more quickly.

· Faster closing. Prism 6 Windows can close a large file much more
quickly than did Prism 5.

Make graphs faster

· Easier to choose the right type of graph.  Prism 6 no longer asks
you to pick the graph type on the Welcome (File..New) dialog, which
leaves the Welcome dialog less cluttered and easier to understand.
Instead, you choose the graph type the first time you view a new graph.
Choose a graph type by choosing among a set of icons, and preview how
that kind of graph looks with your data.

· Format several data sets at once. The Format Graph dialog in Prism
5 always let you either change one data set at a time, or click the “all”
button to change all data sets at once. Prism 6  also  lets you choose a
defined subset of data sets at once. For example, you could select data
sets A, C, E, and G and change all of those data sets to use a dotted
line. Then choose B, D, F and H, and make those lines solid. 

· Click the apply button to see changes without closing the Format
Graph or Format Axes dialog. The Format Graph and Format Axes
dialogs are very powerful, and give you a huge number of options to
change the appearance of your graph. To avoid the need to click OK,
then go back to the dialog to make more changes, simply click the new
Apply button and you’ll see the effect of the changes you made without
closing the dialog.
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· View graphs faster. An XY graph with many points appear on screen
faster when you switch to it, and is regraphed much faster after you
make any changes in the Format Axes or Format Graph dialogs or if you
move the graph on a page or stretch its axes. 

· Instantly switch between black and white, colors, and shades of
gray. You can bring up the color scheme dialog if you want to choose
among many color schemes. But Prism 6 makes it super fast to switch
between color and black and white (includes shades of gray). 

Easier to navigate around Prism

· Search for sheets. Prism lets you organize projects the way you want
to, with no limit to the number of sheets that a project can contain. But
if you put hundreds of sheets into one file, you may have trouble finding
the sheet you need. Prism 6 lets you search  within a project to find all
sheets that include the specified text.

· More galleries. Prism 5 lets you view all graphs at once on a gallery.
Ditto for data tables, info tables, analysis results and layouts. Prism 6
also lets you view an entire family of linked sheets in the gallery, or to
see the entire set of search results (see above) as a gallery.

· Crisper on screen graphics. We’ve revamped how Prism Windows
handles onscreen graphics. It won’t affect how your graphs look when
exported or printed, but graphs look much crisper on screen in Prism 6.

New choices in the Welcome dialog

197
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· Graph Portfolio to help you master Prism. Click the Portfolio tab on
the Welcome dialog to browse a portfolio of polished graphs. Open any
of these graphs to explore how it was made.

· Open files you forgot to save! When you exit Prism (as with any
program), it asks you whether you want to save changes to every open
file. Have you ever clicked No by accident and lost your work? Not with
Prism 6! You can open "unsaved" files from the Welcome dialog (unless
you tell Prism not to keep them, or unless you waited more than three
days).

· Launch two instances of Prism. When you open Prism Windows, it is
limited to use on one display. If you open several projects, each project
is a window within the larger overall Prism window. With Prism 6, you
can launch a second copy of Prism with its own windows. You can’t
launch the second instance from within Prism. Instead, double-click on
the program icon.

· Open files directly from LabArchives. From the Welcome dialog of
Prism 6, you can open a file directly from LabArchives, so don't need to
first go to labarchives.com to download the file you want.With Prism 6,
you can  upload files directly to LabArchives  (introduced in Prism 5.04
and 5.0d). Prism 6 (but not Prism 5) also sends LabArchives a list of all
words used in notes, titles, text boxes, etc, so you can search within
LabArchives to find the file you need. 

· Easier to find the sample data sets. Prism 5 introduced sample data
sets as a way to learn Prism. Prism 6 makes these more obvious on the
Welcome dialog, so more people will try them.

5.2.6 What's new? Data tables

· More columns . Prism 6 allows you to enter data in up to 256 data set
columns. Prism 5 allowed only 104.

· More subcolumns.  When creating an XY or grouped table,  Prism 6
allows up to 256 subcolumns per data set (compared to only 52
subcolumns with Prism 5). This lets Prism compute repeated measures
two-way ANOVA with more subjects. 
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· Paste link data or results from Prism.  You’ve probably encountered
situations where you need to copy values from a results table, and then
paste onto a data table, perhaps using options in the Paste Special
dialog to transpose or rearrange the values. Prism 5 could paste the
values, but there was no link, so it was not possible to trace where the
values were pasted from, and the pasted values did not update when
the original data were edited or replaced. Prism 6 lets you paste link so
values pasted onto the data table are linked to their source, and will
automatically update.

· Reformat a select set of points.   Select any block of data in a data
table, right click, and choose Format Points to change the color (or size
or shape...) used to graph that subset of points.

· Long column titles . With Prism 6, the length of column titles has no
real limit. Prism 5 limited the length of column titles, and many people
bumped into that limit. 

· Multiple line titles.  Each row or column title can now have two or
more lines of text. 

· Bold, italics and underline. You may also now bold, italicize and
underline text in row and column titles (you could always use
superscript, subscripts and Greek).

· View all column titles at once . A new tab in the Format Data Table
dialog of Prism 6 lets you see and edit all the column titles. This saves
you from the  scrolling back and forth to edit titles, which was especially
tedious with XY or Grouped tables with many subcolumns. 

5.2.7 What's new? Working with other programs

· LabsArchives. Prism 6 integrates better with LabArchives. As in Prism
5, click “LabArchive it” to upload files directly to LabArchives. Now,  ,
Prism also sends LabArchives a list of all words used in notes, titles,
text boxes, etc. That mean you can search within LabArchives to find
the file you need. From the Welcome dialog of Prism 6, you can open a
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file directly from LabArchives. There is no longer a need to first go to
labarchives.com to download the file you want.

· Faster TIFF. Exporting TIFF files at 1200 dpi from Prism Windows is
much faster and more reliable (doesn't lead to out of memory
messages). 

· Smaller TIFF. Prism Windows can now compress TIFF files at 600 or
1200 dpi, and compress even when you choose the CMYK color model
(not allowed in Prism 5 Windows)

· More exporting choices. When compressing TIF files, choose between
the LZW or packbits scheme. Choose either a RGB or CMYK color model
for PNG files. Choose higher resolution output (up to 1200 dpi) with
JPG. 

· No popup dialog after exporting. After exporting a graph, layout or
table, Prism 5 would always pop up a dialog offering to open the folder
to which the file was exported. When it is done exporting, Prism 6
doesn’t show that extra dialog. Instead, Prism 6 lets you choose, in the
export dialog, whether to open the folder after exporting. You can make
that choice a default for the future. 

· More importing choices. Prism 6 Windows can import more kinds of
images onto a graph or layout. Here is the complete list:

Windows Enhanced Metafile (*.emf)
Windows Metafile (*.wmf)
TIFF (*.tif;*.tiff)
JPEG (*.jpg;*.jp2;*.j2k;*.jpx)
Portable Network Graphics (*.png;*.mng)
Windows Bitmap (*.bmp)
Graphics Interchange Format (*.gif)
Scalable Vector Graphics Format (*.svg)
PC PaintBrush (*.pcx)
TruvisionTarga Format (*.tga)
Microsoft Paint Format (*.msp)
PhotoShop 3.0 Format (*.psd)
Windows Icon and Cursor Formats (*.ico)
Macintosh Pict (*.pct;*.pict)

· Choices when copying excluded values. Prism lets you exclude
values on the data table, where they appear in blue italics. These values
are ignored when Prism makes graphs and analyzes data. Prism 6 offers
three choices for how excluded values should be copied or exported. 1.
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Like other values, ignoring the fact that they are excluded. 2.Followed
by an asterisk. 3. As a blank space instead of the value. When
exporting, this choice is set in the export dialog. When copying to the
clipboard, the choice is set in the File & Printer tab of Preferences.

· Choose whether to use period or comma as the decimal
separator. When you copy data to the clipboard, Prism 5 used the
Windows or Mac control panel settings to decide whether to use a
comma or period (point) as the decimal separator. Prism 6 lets you
choose in the Preferences dialog. This lets scientists who live in
countries where a comma is commonly used still use a period when
copying data out of Prism for pasting into a manuscript that will be read
in other countries. 

· LinkBack support. When you paste a graph or layout created with
Prism 6 Mac into  some other programs, LinkBack let's you double-click
on the embedded graph to return to Prism for editing. This works
similarly to OLE on Windows. But while OLE is part of Windows and
supported by Microsoft, LinkBack is not part of OS X and is not
supported by Apple. It only works with selected Mac apps, and does not
work with Word, PowerPoint or Keynote.

5.2.8 What's new? Parts-of-whole data

· Parts of whole tables.  Prism has always created structured data
tables, and Prism 6 adds a sixth kind of table: Parts of Whole. As the
name suggests, this  table is used for the kind of data where it makes
sense to sum all the values in a data set column, and divide each value
in the table into this total. 

· Pie charts and more.  Each data set column in the parts of whole table
can become its own pie chart, and each value represents one slice of the
pie. Prism will graph column A automatically. To graph the other
columns, use New...Graph of existing data.  Prism can also plot these
kind of data as a donut plot, stacked bar plot, or a percentage dot plot.

· A new fraction of total analysis  computes each value in a table as a
fraction or percent of its column total. In a parts of whole table, each
value represents one slice in a pie chart defined by the sum of all the
values in that column, so this analysis computes the fraction (or
percentage) of the pie represented by each slice. It can also be used
with contingency (or Column,  XY or Grouped, if needed and if there are
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no subcolumns) tables to compute each value as a fraction of its column
total, its row total, or the grand total. 

· Compare an observed categorical distribution with an expected
distribution using either the chi-square test (any number of categories)
or the binomial test (works only with two categories).

 

5.2.9 What's new? Column graphs

Superimpose individual data points with bars 

Superimpose individual points on a box-and-whiskers plot
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Separate groups of columns with a line

Control the length of the mean or median line in a scatter plot
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Connect column means with lines

5.2.10 What's new? XY Graphs

· Depth charts.  When you assign a graph to a layout, you can specify
that it be rotated 90 degrees. This essentially creates an XY graph
where the independent (X) variable is shown on the vertical axis. As the
graph's name suggests, this kind of graph is used in fields where the

558



GraphPad Prism 8 User Guide92

© 1995-2020 GraphPad Software, LLC

independent variable is depth, which is naturally shown on the vertical
axis.

· Label both sides of the axis.  Place additional ticks and labels across

the axis from the regular numbering. This is helpful, for example, when
X is time, but you also want to label particular times when an
experimental intervention was performed.

· Faster graphing.  Regenerating graphs with tens or hundreds of
thousands of points can be slow. If you are impatient, Prism 6 lets you
specify that a graph only show one out of every K points (you specify
K), to speed up graphing on screen. It also lets you work on the graph
(move things around, add text or drawings, change axis properties,
etc.) as the data points are plotted on screen. 

· Create a graphs with only a right Y axis.  Prism has always made it
easy to add a right Y axis as a second axis. But it has been difficult to
create a graph with a single Y axis positioned on the right side. To do
this with Prism 5 can requires positioning the "left" (only) Y axis in on
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the right side of the graph, and then assigning data sets to the “left”
axis, even though it is on the right side of the graph. Confusing! Prism 6
makes this more straightforward. Turn off the left Y axis, and create a
right Y axis to which you assign data sets. 

· More subcolumns. Prism 6 allows up to 256 subcolumns for replicates.
Prism 5 allowed only 52.

5.2.11 What's new? Grouped graphs

· Draw lines between groups .

· More easily create grouped low-high, box-whiskers, and scatter graphs.

446
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· More subcolumns. Prism 6 allows up to 256 subcolumns for replicates.
Prism 5 allowed only 52.

5.2.12 What's new? Layouts

· Unlinked graphs.  Prism 6 lets you assign a graph to a layout as an
unlinked picture, that won't update if the data are edited or replaced, or
if the graph is altered. One use for this is if you want to make several
versions of a graph sequentially, and place each on a layout.

· Resize graph to match length of X axis . The resize graph dialog in
Prism 5 lets you change the graph size to make the entire graph object
have a specified width. But sometimes your goal is to match the length
of axes, rather than the size of the entire graph object (including
labels). Prism 6 now lets you specify the desired length of the X axis,
and the rest of the graph changes size to meet that goal.

· Control the scaling factor on a layout . When you place a graph on a
layout, its size usually changes. For example, the total length of a graph
might be half as long on the layout as it is on the graph. We now term
this value (50%) the scaling factor . If you then add a legend, drawing
or image to the graph, Prism  6 will maintain the scaling factor, so the
graph itself won't change size on the layout (but the graph plus its
legend, drawings, etc will get larger). In contrast, Prism 5 maintained
the size of the graph placeholder, so the graph itself would get smaller
on the layout when you added a legend or text box or image to a graph.

· Enlarge or shrink an entire layout.  Enlarge or shrink an entire layout.
Prism 6 has a new tool to  as well as enlarging or shrinking an entire
graph (which you could do in Prism 5).

· Easier to place a graph from one project into the layout of another.
Prism 5 allowed you to link a graph from one project into a layout of
another. This lets you keep each project compact, and avoids the need
to put all the data and results for one layout in one file. But that feature
has been hard to discover, and used an extra popup dialog. Prism 6
makes it easier to discover and use by placing the choice on the first tab
of the layout dialog.
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· Draw elbow and zig-zag lines.

· Place borders around graphs in layouts . After assigning a graph to a
layout, you can crop it and/or define a border. 

· Thinner lines. We’ve added a new choice to make lines and curves ¼ of
a point thick.  With Prism 5, the thinnest choice was ½ point. You won’t
notice the difference on screen, but you may notice the difference on
printouts or high resolution exported files. 

5.3 What was new in Prism 5?

In case you are upgrading from Prism 4, the pictures below show the
biggest improvements in Prism 5. For details, read this 16 page pdf
document.
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6 How Prism is unique

GraphPad Prism is very different than other
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scientific graphing programs. As you start to use

Prism, be sure to notice these four unique aspects

of Prism. 

· Organized data tables

· Everything is hot linked

· A complete record of your work

· Helps you learn data analysis

6.1 Organized data tables

Formatted data tables simplify graphing

Unlike spreadsheet
programs, and other
scientific graphing
programs, Prism's data
tables are structured or
formatted. Whenever you
create a new data table,
choose one of seven table
types. This makes it much
easier to create appropriate
graphs and to choose
suitable analyses.

Enter SD or SEM values computed elsewhere
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If you computed error values
elsewhere, enter them onto
labeled (SD or SEM)
subcolumns. Prism’s
analyses (i.e. t test, ANOVA,
regression) will take into
account the SD (or SEM)
and sample size.

Create error bars from raw data

Enter the raw data (i.e.
triplicates), and Prism will
automatically compute and
plot the error bars. You can
instantly switch between
plotting the raw data, or
plotting mean with SD, SEM,
confidence interval or range.

Fit a family of curves at once

Place data for multiple data
sets side-by-side on an
organized data table, and fit
them all at once. You can fit
the same model separately
to each data set, use global
nonlinear regression to
share parameter values
among data sets, or fit
different models to different
data sets.

Easily handle missing and excluded values
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Using a command on the
View menu (or via right
clicking, or a toolbar button)
exclude selected values.
Excluded values show on the
data table in blue italics but
are omitted from analyses
and graphs. You can also
leave a cell blank to show
that its value is missing.
Prism treats missing and
excluded values identically,
and never treats a missing
or excluded value as if you
entered zero.

Computed values are kept separate from raw data

Prism includes built-in
analyses to transform or
normalize your data, or to
subtract (or divide by) a
baseline. Prism leaves your
raw data alone, and places
the calculated values on
results tables. Raw data
tables have a black grid.
Results tables have either
Green grids (when they can
be analyzed further or
graphed) or red grids.

You’ll never confuse raw
data with calculated results.
You'll never wonder how
values were computed.
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6.2 Data analysis for scientists, not statisticians

Understandable analysis dialogs  

Prism presents analysis choices in clear
language, and avoids statistical jargon.

Statistical help when you need it

Consult Prism’s
comprehensive online help
to review the basic
principles of data analysis,
and to understand your
analysis choices.

Review analysis check lists
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Once you’ve completed the
analysis, review the
accompanying analysis
checklist to confirm you
made the right choices.

6.3 Everything is hot linked

Prism links data to results,  graphs and layouts. It also lets you copy data
or results from one part of Prism and paste link onto a data table.  This
has four advantages. 

· When you fix a mistake in data entry, the results and graphs are
automatically updated. 

· If you replace the data, you;ll get new graphs and analyses of the new
data.

· When you open a Prism file, you can retrace every step of every
analysis, and review (or change) any of the choices. You’ll never see a
curve or a P value and wonder how it got there.

· After you’ve polished the analysis and graphing steps with data from
one experiment, you don’t have to repeat all those steps for a repeat
experiment. Prism provides several ways to instantly analyze and graph
a repeat experiment, without repeating any tedious steps and without
requiring any scripting or programming.  
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6.4 A complete record of your work

Annotate your experiments with floating notes

Add floating notes to data tables, results and graphs. These notes can be
color coded.

Record experimental details in Info tables

Use Info tables to record dates, lot numbers, concentrations, etc. These
values can be used as constants when transforming or analyzing data.

Highlight sheets you want to return to
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Highlight the pages that you want to review, or want a colleague to look
at. Choose a different color highlight for different purposes.

Change the background color of selected data values or results

Select any cell or range of cells in data tables or results and apply a
background color. 

Save to the cloud with LabArchives

LabArchives.com enables researchers to store, organize, and publish their
research data. Upload your Prism files directly to LabArchives, and open
them (even from a different computer) directly from Prism’s Welcome
dialog.

Anyone can view a Prism file

You can send Prism files even to colleagues who don't own Prism. They
can download the free 30-day trial. After the trial expires, it becomes a
perpetual Prism viewer that lets your colleague view all parts of your file,
including analysis choices. 
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7 Getting started with GraphPad Prism

 

Prism is designed so you can just plunge in and

use it. But you'll master Prism more quickly if you

check out the tips listed here, and the guided

examples of data analysis.
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7.1 A brief tour of Prism

This five-minute tutorial will show you a bit about how Prism is organized.

1. When you start Prism, you'll see the Welcome (File..New) dialog. You'll
see eight tabs representing the eight kinds of data tables. Click on the
Column tab. Then choose to use sample data, and choose the sample
data for an unpaired t test.

Notes:

· To use Prism effectively, you need to learn how to choose which of the
eight types of data table  to select.  

· Note the distinction between choosing sample data or creating an empty
table into which you can enter or import data.

203
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· Choosing the tutorial data for the unpaired t test only fills the table with
data. You'll choose an analysis in the next step.

2. Note that the tutorial data comes with a floating yellow note that briefly
explains the data format, and links to more detailed online help.
 

3. From the data table, click Analyze and then choose the t test analysis.
Alternatively, click the t test shortcut button above the Analyze button.
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4. On the first tab of the t test dialog, confirm that the experimental
design in unpaired and that you want to assume a Gaussian distribution
and to perform an unpaired t test. For now, you can accept all the
defaults on the second and third tabs. Click the Learn button to read
explanations of all the choices.
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5. View the results. Click the analysis checklist button to help interpret
the results. Click the Results button in the upper left corner to open the
Analysis Parameters dialog to perhaps change to a paired or
nonparametric test. 
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6. In the navigator on the left, click on "Unpaired t test data" in the
graphs section. The Change Graph Type dialog will pop up. Choose the
kind of graph you want, and see how that choice will look. We suggest
choosing a Scatter plot, and plotting a line at the mean. 
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7.2 Essential concepts

To use Prism effectively, you need to understand these essential
concepts:

Prism data tables are organized. It is essential to choose the right kind of
data table.

Unlike Excel or most statistics programs, Prism's data tables are
organized with a structure or format. To use Prism effectively, therefore,
you must learn the distinction between the eight types of data tables .
Don't try to choose the kind of table based on the kind of graph to make.
That approach doesn't always work. Choose a table based on the
organization of your data and the analyses you wish to perform. 

204
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A Prism project can contain many data tables and graphs

A Prism project (another term for a Prism file) is not limited to a single
graph or data table, but rather can contain up to 500 data tables, graphs,
analyses, and page layouts.

Prism can automatically plot error bars from raw data

One of Prism's strengths is its ability to handle replicates and error bars.
For XY and Grouped tables, replicates are placed in side-by-side
subcolumns. For Column tables, replicates are stacked in each column.If
you enter replicate values, Prism can plot either individual replicates or
error bars. It can plot error bars from the replicates you entered
automatically. You don't have to specify any calculations.

When you edit or replace data, analyses and graphs are automatically
updated

Prism remembers the logical links between data tables, info sheets,
results tables, graphs and layouts. When you edit or replace data, Prism
automatically recomputes linked analyses and redraws linked graphs.

Analyses can be chained

Results tables can be analyzed further. From any results table with green
grid lines, click the Analyze button. This lets you, say, first transform
your data, and then fit a curve (nonlinear regression) to the results. 

Results of analyses can be presented on multiple analysis tabs

Analysis tabs at the top of the results page let you see different parts of
the results.

By default, Prism creates one graph for each data table you create, but
this should not limit you. You can plot a table on multiple graphs. And you
can plot data from multiple data tables on one graph. 

Recycle your work

Once you've analyzed and graphed one data table, it is easy to repeat
your work with new data by duplicating a family  or cloning a graph .175 176
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7.3 Welcome dialog

When you launch Prism, or use File..New to begin a new
project, you'll see the Welcome dialog. 

New table & graph

Most of the time, especially when new to Prism, you'll use
one of the eight choices to create a new table  and graph.
Within each of these tabs, you have the choice of beginning
with a new empty data table or beginning with tutorial data
(with instructions).

Existing file

Open a file

Click on a folder or file to open it. Or click on "Desktop and
other folders" to browse all your files.

After you have used Prism a bit, you may see files listed
under the heading Unsaved Files. How can you open a file
that wasn't saved? When you exit Prism (as with any
program), it asks you whether you want to save changes to
every open file. If you click No, Prism still saves the file in a
special location for four days, and shows it in the list of
unsaved files. 

LabArchives 

LabArchives is an innovative web-based product that
enables researchers to store, organize, and publish their
research data. Far more than an "ELN" (Electronic
Laboratory Notebook), LabArchives stores and catalogs all of
your research for easy retrieval and publication. You can
save files to LabArchives from Prism. And you can open
Prism files saved on LabArchives from the Welcome dialog,
without going to www.labarchives.com.

Clone a graph

Cloning a graph is making a copy of it, along with the data
table and any linked analyses. At the time you clone a
graph, Prism will give you the option of deleting the data.

204
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Add your own data, and your done. From the Welcome
dialog, you can clone from any file (project) that is open,
from one you've used recently, or from projects you've save
as examples.

Portfolio

The portfolio  contains many  Prism file, with with a
polished graph, simple or complex. Explore these portfolio
graphs to learn how to get started with Prism and to learn
some of its advanced features. People who have already
learned the basics of Prism will appreciate these portfolio
files more than beginners.

.

7.4 Graph Portfolio

From the Welcome (File..New) dialog, click on the Graph Portfolio tab to
browse dozens of polished graphs. Open any of them to see how they
were made. Most come with explanations on floating notes.

7.5 Tutorial Data Sets

When you choose to create a new data table from the Welcome
(File..New) dialog, you can start with a blank table or with tutorial data.

116
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The tutorial data comes with explanations and is a great way to learn how
to use Prism.

Note that these tutorial data sets exist only to help you learn Prism.
Choose the t test tutorial data set if you want to learn how to do a t test
with Prism. Don't choose it if you want to analyze your data with a t test. 

7.6 The five sections of a Prism project

A Prism project can contain a lot more than a single graph or data table.
A  Prism project (file) has five sections. Each can contain up to 500
pages (also called sheets): 

Data tables

Enter and organize your data for analyses or graphs. Learn
more.  201
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Info tables

Keep a record of experimental details, or of constants you want to
use in analyses. Learn more .

Results

These sheets show the results of your analyses. You can copy from
here and paste parts of your results onto graphs. Learn more.

188
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Graphs

Once you enter your data in a data table, Prism automatically
creates a graph. You can customize any part of a graph. Learn
more.  392
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Layouts

Combine several graphs or other sheets in a layout for printing or
publishing. You also can send layouts directly to PowerPoint and
Word. Learn more.
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7.7 Adding new sheets to your project

Click the New button on the Sheet toolbar and choose what kind of sheet
you want to create. The first choice is used the most. It adds a new
empty data table and linked graph  to your project. You can also add a
New Data Table (No Automatic Graph), a new Info sheet , a new graph
of an existing data table , or a new layout . To be complete, this menu
also lets you add a new analysis, but you'll find it easier to start at a data
table or graph and click the Analyze button .

You can also add a new table, analysis, graph or layout by a link in the
navigator.

You can also add to your project by duplicating a family of sheets  or by
cloning a graph . 
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7.8 Tips for using Prism

 Expand all tips
      

Collapse all tips

Getting started tips

Before using Prism for the first time... 

If you are new to Prism, start by reading this one page list  of
essential concepts.

Also consider arranging on-site training .

 Pay attention to the distinctions between the eight kinds of data tables

When you create a new data table, choose between a XY ,
Column , Grouped , Contingency , Surviva ,  Parts of a
Whole , Multiple Variables  and nested table. Understanding how
these tables are used will make it much easier to use Prism
effectively.

 Learn about the various approaches to making bar graphs

Spending a few minutes reading about the various approaches to
making bar graphs  will prevent some aggravation later. Bar 
graphs can be created from Colum, Grouped, XY or Contingency
tables.

Recycle your work
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Once you've analyzed data and made some graphs with Prism, you'll
probably want to do similar analyses and make similar graphs with
new data. Don't start again from scratch.  Prism offers four ways to
recycle your work, without programming. You can duplicate a
family , clone a graph , use the Wand to repeat analyses , or
save and recycle templates . 

Navigation tips

View all sheets in the gallery

Click on the Data Table, Info, Results, Graphs or Layouts folder name
in the Navigator to open the Gallery. Or click the Gallery button on
the bottom toolbar.

The gallery  shows all sheets in a section. Double click on the one
you want to go to. Or select several sheets to work on at once .

Jump between related sheets using the Family navigator

The family folder at the bottom of the navigator lets you see all
sheets linked to the current one. Results are nested under the table
they analyze so you can see analysis chains.     

Ping pong (flip back and forth) between two sheets

Click the ping-pong button in the bottom toolbar to go to the
previously viewed sheet. Click again to return.
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Highlight or annotate sheets you want to return to

Click the highlight  button, and the sheet name will appear
highlighted in a chosen color in the navigator and gallery. You can
later search  for highlighted sheets.

Annotate any sheet with a floating note , then find all annotated
sheets by searching .

Search for sheets

If your project is large, use the search tool  above the navigator to
find all sheets that include specified text. When you click to start
entering the search term, new choices appear to restrict the search
to sheets of a certain kind of highlighted with a certain color. 
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Graphing Tips

 Use the Format Graph and Format Axes dialogs

Double-click on an axis to bring up the Forma Axis dialog. Double-click
on the main part of the graph to bring up Format Graph. 

Change the color (or size..) of just one symbol or bar

Right click  on any symbol or bar, and you can change its
appearance, apart from other symbols or bars in the same data
set. Or select a range of values in the data table, and change the
appearance of all symbols or bars plotting those  data .

Use Prism Magic to make graphs consistent

Select one (or several graphs), click the Magic  (Make Graphs
Consistent) button, choose an example graph, and all your graphs
will be changed at once.

Change colors by picking a color scheme

Rather than change colors of every graph element separately, use
color schemes . You can use ones we provide, or create your own.
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Prism can plot error bars directly from raw data

Prism can plot error bars directly from raw data. Prism lets you enter
SD or SEM if you have calculated them elsewhere, but there is no
need to do so. Enter your raw data, and let Prism do the rest. Prism
offers analyses that perform row and column descriptive statistics, but
these are only to help you understand the data. You do not need to
run these analyses to plot error bars.

To add data to a graph, drag a table from the Navigator and drop onto the graph

After you drop the data or results table onto the graph, a dialog will
pop up where you can choose which data sets to include and which
axis to plot those data on (right or left).

Data analysis tips

Don't run the analysis again -- change the analysis choices

If you made a mistake, or want to try different analysis choices, you
can always return to the analysis parameter dialogs. Don't repeat the
analysis unless you want two copies of the results. To open the
analysis parameters dialog, click the analysis parameters in the
upper left corner of any results sheet or in the toolbar.

Use the 'Learn' and 'Analysis checklist' buttons

Click Learn from any Analyze dialog to learn more about the analysis.
Our help goes beyond program help, and explains the principles
behind the analysis.

Once you've finished any analysis, click the Analysis Checklist button
in the toolbar to make sure you are interpreting the results correctly.
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Paste results onto your graph

Select any block of tabular results, copy to the clipboard, and paste
onto any graph or layout. This will be a live link. If you change the
data, or the analysis choices, the embedded results table  will
update.

Create chains of analyses, without copying and pasting

Many analyses (i. e. Transform) create results tables that can be
used as a data table. These results tables have green grids, unlike
tables with red grids that contain tabulations of results that cannot
be graphed. From any results table with a green grid, click Analyze
to analyze the results. You can make the analysis chain as long as
you want. For example, you could Transform, then Normalize, then
fit with Nonlinear regression, then transform the residuals from the
regression.

Exporting tips

Use the Send-to-Word and Send-to-PowerPoint buttons

Click one button  and you are done. No need to copy and paste,
or export and import.

Experiment with copying graphs in EMF or WMF format (Windows only)

Prism Windows can copy graphs to the clipboard in one of three
formats. You can tell Prism to only copy one format (File & Printer
tab of the preferences dialog ). If graphs pasted into other
programs don't look right, try all these settings.

Choose export formats carefully

Prism offers a variety of formats . When possible, choose formats
that include information about vectors and fonts (WMF, EMF, EPS,
PDF) over formats that only describe bitmaps (TIF, JPG, PNG).

Send your colleagues complete Prism files rather than exported images
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Anyone can view the complete Prism file, including analysis choices,
using the  Prism Viewer for Windows, Mac or iPad.

Organizing tips

Rename, reorder and delete sheets

You aren't stuck with the sheet names that Prism assigns, or their
order. Rename or reorder  your data tables (and graphs...). When
you rename data tables, linked analyses and graphs are
automatically renamed. Delete sheets  you no longer need.

Highlight sheets you want to return to

You'll see the yellow highlighting  in both the navigator and gallery.
You can choose different colors for different purposes.

Use floating notes to communicate with coworkers

Click the push-pin icon to add a color-coded floating note  to any
sheet.

     

Record experimental details on info sheets

Info sheets contain both structured information (lot numbers, page
numbers,....) and unstructured notes. Each info sheet can be linked
to a particular data table.
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Don't make projects too small or too large

Some people make the mistake of starting a new project for every
data table, not realizing that a Prism project (file) can have up to 500
data tables, analyses and graphs. You can keep an entire project in
one file.

Don't define 'project' too broadly, because a huge project can be
hard to navigate. You can always merge  projects later, or
include  a graph from one project in a layout of another.

Common mistakes

Mistake: Repeating an analysis rather than fixing it.

If you want to change your mind about analysis choices, you can do
so . You can change the parameters (options) for the analysis. Or
you can change which data table and which data sets are analyzed.
There is no need to start the analysis again, which leaves an obsolete
copy of the results in your project.

Mistake: Duplicating a table in order to make a second graph of those values.

Prism automatically makes a graph of each data table. So when you
want to make a second graph of that same data, people commonly
copy the data and paste onto a new table which is automatically
graphed. No need for that. You can make any number of graphs from
the same table. Just click the New button, and then choose Graph of
Existing Data.

Mistake: Repeatedly formatting a series of related graphs.

No need to change the fonts, colors, line thickness, etc. etc. for each
graph in a series. Instead, format one graph, and use Magic  (Make
Graphs Consistent ) to instantly fix the others. Or clone the
polished graph when you want to make a related graph.

Mistake: Making a project too large.

We call a Prism file a "project", but you can decide how large to
make it. Huge files can be hard to navigate. So it often makes sense
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to keep files of reasonable size. You can always merge  projects later,
or include  a graph from one project in a layout of another.

Mistake: Going through many steps to make the same graph from a new data set.

There is no need to repeat yourself. Once you have a graph you like,
Prism offers several ways to make that graph again with different
data.  Start by learning to clone a graph . 

Mistake: Not saving milestone backups while working on a large project.

When working on a large project, do more than backup the current
version. What happens if you mistakenly delete key data? What
happens if the file someone gets corrupted? Use Prism's Backup
command  to save interim versions as you work. Prism Mac does
this automatically, using the Versions feature of MacOS.

 Expand all tips
      

Collapse all tips

8 Differences between Windows and Mac versions of
Prism

8.1 File compatibility between Windows and Mac

Files saved on one platform can be opened on the other. In almost all
respects, this just works and you don't have to think about it. But there
can be minor changes due to differences in fonts, so we suggest not
switching platforms when you are in the final states of preparing a
complicated figure. 

Some Mac fonts families are not available on Windows, so those
characters will appear as a rectangle. For example, the following fonts
installed on Mac will not appear on Windows: cuneiform, linear, aegean,
miao, inscriptional. Similarly, so Windows fonts are not available on Mac. 

8.2 Unique to Prism Windows

8.2.1 Features in Windows but not Mac

· Object linking and embedding . This means you can paste a Prism
graph into another program and double-click to edit in Prism. We wish
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we could allow this to work on Prism Mac, but Apple and Microsoft
simply do not provide the "hooks" Prism would need.

· Excel linking and embedding . This means you can paste Excel data
into Prism, and double click to edit within Excel. We also wish this were
possible with the Mac. 

· Import and export EMF and WMF images. These formats are only used
on Windows computers.

· Send to Word with a single click .

· High contrast printing, with no grays and no colors (choice on
Preferences dialog).

· Visual Basic for Applications (VBA) commands  to launch Prism and
start a script.

8.2.2 Working with multiple files in Prism Windows

Distinguish multiple sheets in one project file from multiple files

A Prism project can have multiple pages or sheets , divided into five
sections . These are all saved in one Prism .PZF or .PZFX file. Of course,
you can export individual data tables or graphs, but this is not the same
as saving the entire project as one Prism file. 

People new to Prism often make the mistake of thinking that each Prism
file can only have one data table and one graph. Not so. Each file can
contain up to 500 data tables, info sheets, analysis results, graphs and
page layouts.

One window per file

Starting with Prism 8, each Prism window contains one Prism file. Prior
versions used one master window that could hold multiple child windows,
one for each file. This multiple document interface is no longer
recommended by Microsoft, and Prism no longer supports it. 

Since there is one window per file, you can put different windows on
different displays, and can size and position each as you see fit. 

Closing a Prism file

There are two ways to close a Prism file. 
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· Click the red X at the upper right of the Prism window. This will close
the file and also close the window. If you only have one Prism window
open, this will quit Prism. 

· Drop the File menu and choose Close. Or use the Control-W or Control-
F4 shortcut. This will close the file, but leave the window open, ready to
open or create another Prism file. 

8.2.3 Automatic back up of Prism files

This page is for Windows only. Autobackup on Macs .

Automatic backups

Choose automatic backups on the File & Printer tab of the Preferences
dialog and Prism will automatically save your work. Choose to save based
on a timer (every few minutes) and/or whenever you switch from one
sheet to another. The backup files are also saved whenever you save your
work, so the backup files can never be older than your project files.  

When you quit Prism normally, the timed backup files are deleted. In case
of computer disaster, the backup files will remain on your hard drive.
When you restart Prism, these files will automatically load so you can
continue your work. Note a potential problem: After a crash, the
automatic backup system works fine if you launch Prism as an application.
But if you double-click on the file you were working on, then you open
that saved file, not the backup that Prism saved elsewhere. 

If you need to find these files, which have the extension .PZB, their
location depends on which operating system you use:

Windows XP C:\Documents and Settings\[username]\Local
Settings\Temp\

Windows Vista,
or Windows 7-
10

C:\Users\[username]\AppData\Local\Temp\

Mac OS ~/Library/Application Support/GraphPad/Prism/8/Prism
Backups

Manual backups of Prism files

Prism provides an unusual way to save backup copies of your projects.
Click on the Save Special button in the File section of the Prism toolbar,
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and choose Save a Copy. Prism will save a copy of your project to the
location and name you specify, perhaps to a network or CD drive.

Note the difference between Save As and Save a Copy. When you use the
Save a Backup command, Prism doesn't rename the file you are working
on -- it simply saves a copy of that project with a new name.

We recommend that you backup to the .PZFX format (rather than .PZF)
because it provides a more secure backup. It is possible (with some
difficulty) to extract your data from these files without Prism, even if the
file is damaged or truncated.

Recovering files you forgot to save!

When you exit Prism Windows (as with any program), it asks you whether
you want to save changes to every open file. Have you ever clicked No by
accident and lost your work? Prism 6 saves the file anyway, in a special
location, and keeps it for four days. You can open those “unsaved” files
from the Welcome (File..New) dialog of Prism Windows. If you delete the
file, Prism will automatically delete the backup file, and not offer to
recover it. 

If you share a computer with others and don't want your unsaved work to
be recoverable, you can turn this feature off on the File & Printer tab of
the Preferences dialog.

Manual backups of Prism data tables

You can backup individual data tables using the File Export command. You
can export to plain text tables (delimited with tabs or commas) or to an
XML format. We recommend using XML format, even though it is harder
to view, because it contains more information. XML format includes
details omitted from the plain text formats, including about subcolumns,
excluded values, and floating notes.

8.3 Unique to Prism Mac

8.3.1 Features in Mac but not Windows

· Automatic saving. Prism Mac uses the OS X features Resume and
Versions , which may seem strange at first. 138
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· Spell checking of text anywhere in the project

· Quick Look lets you preview graphs within a Prism file while using
Finder.

· Color eyedropper. While setting any color, click the magnifying glass
tool, then click on any color on any window to select that color.

· Use an Automator action  to launch Prism and run a Prism Script;

· Choice of color model (RGB, CMYK, or Grayscale) when exporting in
JPEG format.

· Tabbed windows  to put several Prism projects in one document
window. 

8.3.2 Working with multiple files in Prism Mac

Distinguish multiple sheets in one project file from multiple files

A Prism project can have multiple pages or sheets , divided into five
sections . These are all saved in one Prism .PZF or .PZFX file. Of course,
you can export individual data tables or graphs, but this is not the same
as saving the entire project as one Prism file. 

People new to Prism often make the mistake of thinking that each Prism
file can only have one data table and one graph. Not so. Each file can
contain up to 500 data tables, info sheets, analysis results, graphs and
page layouts.

One window per file (usually)

Normally each Prism window contains one Prism file (but see below). If
you have used Prism for Windows (prior to Prism 8)  you used one master
window that could hold multiple child windows, one for each file. This
multiple document interface has never been supported on Macs.  

When you create or open multiple files with Prism Mac, it usually looks
like this. Each project file is in its own window with its own toolbar. 
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What are tabbed windows?

A new feature in MacOS Sierra lets you put several files into one window
and navigate between them using tabs.  This is a great way to work on
multiple files at once, especially on a small screen. Apple calls this feature
Tabbed Windows.

If you use MacOS Sierra or later, you work with multiple Prism files in 
one window. Drop the Window menu on any of the Prism files, and choose
"Merge All Windows". 
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Now there is only one Prism Window, with a set of tabs just below the
toolbar that let you choose which project file you are working on:

Putting multiple files in one tabbed window is simply a convenience to
make it a bit easier to move between files. The files are still all distinct,
saved in different names. Putting multiple files into one tabbed window
does not merge the files. 

Working with tabbed windows

To create a new tab for a new (or existing) file, click the + button to the
right of the file selection tabs which will create a new tab and bring up the
Welcome dialog so you can choose a file to open or begin to create a new
file. 

There are three ways to move a file into its own window and away from
the tabbed window:  Control-click on the tab and choose Move Tab to New
Window; grab the tab and drag it away from the joint window; or drop
the Window menu and choose Move Tab to New Window.

A window that contains only one project file usually doesn't show the tab
bar. To show it, drop the View menu (in Prism) and choose the first
choice "Show Tab Bar". When you have two or more Prism windows
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showing the tab bar, you can drag tabs from one window to another (even
on different displays).

Keyboard shortcut: Hold Control and click Tab to move to the next project
file in the tabbed window. Hold shift and control and click tab to go to the
prior project file. 

Preference for newly created or opened Prism files

When  you already have a Prism window open, what happens when you
open another file or create a new file? It depends on a setting in the Dock
tab of the system Preference dialog, "Prefer tabs when opening
documents". (Note this setting is in the system preferences dialog, not in
Prism's preference dialog.) There are three settings.

· Always.  When you open or create a file, it will be added to a new tab on
the open Prism window and will not create a new window. 

· In full screen mode only. If you have maximized the Prism window to
full screen, opening or creating files will add a new tab to the existing
window. If you are not in full screen mode, new and opened files will be
placed in new windows. 

· Manually. New files (and newly opened files) always go into new
windows unless you use the + button to the right of the last tab to
create a new one. 

Closing a Prism file

There are two ways to close a Prism file. 

· Click the red circle at the upper left of the Prism window. This will close
the file and also close the window. If you only have one Prism window
open, this will quit Prism. If that window has multiple files in tabs, all
will close. 

· Drop the File menu and choose Close. Or use the Command-W shortcut.
This will close the file you are working on but not other open files. It will
leave Prism running, ready to open or create another Prism file. when
you drop its File menu. 
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8.3.3 Overview: Resume and Versions in Prism Mac

Versions and Autosave have been part of OS X since 2011, and Apple
thinks these features are so intuitive they don't need explanation. For
those who disagree, we created a lengthy explanation .

Here are the big ideas:

· As you work, your file is automatically saved. You don't have to think
about saving. Close a project file when you are done working with it.
Open it when you want to work on it again.

· When you quit Prism, it remembers the files that were open. When you
next launch Prism, those files will open again. This means you won't see
Prism's Welcome dialog unless you closed all open files before quitting.

· If you need to, you can revert a file back to how it was an hour (or a
day...) ago.

· The File..Save command has a new purpose after its first use to specify
a file name and location. After that, use the Save command to save a
milestone you can revert to.

· The File..Save As command is gone, replaced with three new
commands: Rename, Duplicate and Move. Whatever your goal with
Save..As is probably done better with one of these three commands.

· Two settings in the General tab of Systems preferences affect how your
work flows: whether to keep changes when closing a document, and
whether to open the documents you were working on when you start an
application. These apply to all applications that use the new way of
working, not just Prism. We suggest you keep both options checked.

8.3.4 Details: Resume and Versions in Prism Mac

Note that this page only applies to Prism Mac, not Prism Windows. 

Versions and Autosave have been part of OS X since 2011, and were
introduced to GraphPad Prism in version 7. If you use iWork (Pages,
Numbers and Keynote), you are already familiar with these features.
Since we know that many Prism users will have not encountered this new
way of working before, we detail how these features work below. But note

138
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that we simply implemented the framework that Apple created, so have
no ability to fine-tune how it works. 

Important settings in the General tab of System Preferences

Two setting in the General tab of System Preferences have a huge impact
on how Prism acts when you close a file or exit Prism.

By default, both are unchecked. Both options apply to all applications that
use Autosave and Versions, not just Prism. Most of this page assumes
that you have left both options unchecked (the default), and we urge you
to use Prism for a while this way to get used to the new approach. What
happens when you check these options is explained at the bottom of this
page. 

A new mindset

When working with previous versions of Prism, as with Microsoft Office
and many other programs, you had to always remember that you were
editing a transient document in computer memory. If your computer
crashed (or lost power for a fraction of a second), your work was gone
unless you had saved it. Prism had an automatic backup feature to
recover your work when this happened. So you had to remember to
frequently save work in progress. This made sense in the days of slow
floppy disks, but those days are long gone. 
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Prism now conforms to the new paradigm that Apple created for working
with files. There are three new big ideas:

·  As you work, your file is automatically saved. You don't have to think
about it. Close a project file when you are done working with it. Open it
when you want to work on it again. You'll always be working on the
latest version and don't have to think about saving. 

· When you quit Prism, it remembers the files that were open. When you
next launch Prism, those files will open again. This means you won't see
Prism's Welcome dialog unless you closed all open files before quitting.  

· If you need to, you can revert a file back to how it was an hour (or a
day...) ago. 

· Whenever you want, you can duplicate a file, and then edit each copy
differently. 

 A new way to work

Once you get used to it, this is a much better way to work.  

The Save command has a new purpose

The File..Save command still exists, but its purpose has changed. When
creating a new project, use this command to specify its name and
location. After that, use this command when you have completed a chunk
of work, and want to save a milestone you can revert to (see below).

There is also another use of the Save command. Prism let's you copy a
graph from one project and place into a layout of another as a link. If you
change the graph, the copy of the graph in the other graphs layout ought
to update. But this only happens if you use the Save command to save
the file with the graph. Otherwise the second project doesn't get the
message that the linked graph has updated. 

No need for a File..Save as command

The File.. Save As was always annoying because it rarely did exactly what
you wanted. So Apple removed it and replaced it with three new
commands on the File menu:
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· File..Duplicate. Make a copy of the file (which you can name), and then
edit the copy while leaving the original alone.

· File..Rename. Rename the file you are working on. You'll enter the new
name at the very top of the Prism window.

· File..Move. Move the file you are working on to a different folder or
drive. 

If you really want to use the old File..Save As command, it is possible . 

Reverting files

A version of your file is saved when you open a file, when you choose the
save command, and occasionally while  you work on it. This happens with
most drives, but drives connected over a network using  AFP, SMB, or
NFS don't preserve previous versions of a document. MacOS will warn
when you save to such a drive (volume). 

The File.. Revert To command lets you revert your file back to how it was
when you opened it, to how it was the last time you explicitly saved it, or
to browse all versions to find the one you want to restore.

 When you ask to browse all versions, the Revert screen fills your display.

146
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The left side shows the current document. 

The right side shows a stack of older versions.. Use the buttons near the
bottom right to step through the versions. There is a bug (by Apple) so
sometimes these buttons appear gray/unavailable. Click them anyway --
they work. If you have lots of saved versions, use the time line on the
right side of the window to fast forward to the version you want. 

Click on a version to temporarily open it and view all of its contents. If
you don't want to revert to any older version, click Done to keep working
with the most recent version. If you do find a version you want, click
Revert to go back to that version. The current version won't be entirely
deleted, and you can fast-forward back to it, in the version browser.

Notes on reverting files:

· You are only able to browse prior versions so long as you work on a
single computer, as the information about prior versions is not saved in
the file itself, but rather is saved in hidden files on your computer. 

· To delete a version or all old versions: Select that version on the right
side of the revert screen, move the cursor to the top of the screen to
see a menu, drop the File menu, choose Revert to, and you'll see the
new command "Delete this version". Hold Option and that command
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changes to "Delete old versions" to delete all  versions (except the
current one, of course). 

· While in the revert screen, you cannot switch to other applications. To
leave the Revert screen you need to click Done (to make no changes) or
Revert.

· To save an older version while also saving the current version: Click on
the version you want, move the cursor to the top of the screen to see a
menu, drop the File menu, and choose Restore a copy. If you have
selected the current version (on the left), this command changes to
Duplicate. 

· Instead of reverting, you can select data or text (but not graphs or
layouts) from an old version, copy to the clipboard, and then paste into
the current version. In some situations, this is more useful than
restoring an old version entirely.

Rename, tag and move from the top of the Prism Window

Hold the mouse cursor over the file name at the top of the Prism window,
and you'll see a downward pointing arrow. Click that arrow, and you can
rename the file, add tags, move it to a different folder, or lock it. 

Notes:

· The full file name is shown, including the extension .pzf or .pzfx. You
cannot change the extension from here. You'd need to use the File..
Save as command (see above; you need to hold down the Option key).

· Locking is not secure. There is no password, so anyone can unlock. Its
purpose is to prevent accidental changes. No, it is not very useful!

· When you click in the Tags field, a list of current tags (including color
codes) will drop down. You can also tag files in Finder, and search there
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for files by tags. A file can have more than one tag. You can also enter a
new tag. Tagging is an OS X feature, not a GraphPad feature.

· The list of locations is limited to top-level folders, or folders you have
used recently. The last entry in the file list is Other. Double click "Other"
to open a Finder-like window that lets you choose any drive or folder. 

Settings in the System Preference dialog

As mentioned at the top of this page (with screen shot), two settings in
the General tab of the System Preferences dialog affect how Prism saves
files. 

Ask to keep changes when closing documents

With the new way of working,  Prism doesn't prompt you when you close
a named project with unsaved changes because the changes are
automatically saved. When you open that file again, you'll see the latest
version. If the project is new, and not yet named, Prism will prompt you
to name it or delete it when you close its window.

If you check the setting in General tab of System Preferences, "Ask to
keep changes when closing documents", Prism asks you what to do when
you close a document with unsaved changes:

If you click Save, Prism saves your latest work before it closes the
document. 

If you click Revert Changes, Prism reverts any automatic saves so the
document that gets saved is the same as it was the last time you
explicitly saved it. 

Since this option is in system preferences, it applies to all applications
that use the modern way of working, not just to Prism. 
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It reminds you of the old way of working, but it doesn't reset things all
the way back. We recommend not using this option, as it isn't really
helpful.

 Close windows when quitting an app

With the new way of working, when you launch Prism the projects that
were open when you exited Prism open automatically. You won't see the
Welcome dialog if any project windows were open when you exited Prism.
The idea is that you open a document when you want to work on it, and
close it when you are done (for now). Launching and quitting Prism has
nothing to do with with when project files are open. 

If you check the  setting in General tab of System Preferences (see top of
this page) "Close windows when quitting an app", then Prism will save
and close all the projects when you quit. If a project file is not yet named,
Prism will ask you to name it. When you next open Prism, you'll see the
Welcome dialog and no projects will open automatically. 

This seems like a useful personal preference. Check this option if you
want to start fresh with the Welcome dialog each time you launch Prism.
Don't check it if you like the idea of that when you launch Prism, it opens
the files you left open the last time you used Prism. 

Since this option is in system preferences, it applies to all applications
that use the modern way of working, not just to Prism.

Automatic backup

Prism has had automatic backup since version 3, but now Prism uses the
built in automatic backup feature provided by Apple, instead of using our
homegrown method. In the File tab of Preferences, choose how often you
want to save automatic backups and whether you also want a backup
made whenever you view a different sheet. We suggest saving backups
every few minutes and whenever you view a new sheet. 

The purpose of automatic backups is to restore your work if your
computer (or Prism) freezes or crashes, so you want frequent backups.
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These automatic backups do not all appear in the Revert screen (which
would be overwhelming).

Turning off autosave

Autosave is part of macOS ,which does not make it easy to turn off. But
these links tell you how to do so. GraphPad has not tried, and does not
support, this method but simply provides the links:

https://www.makeuseof.com/tag/guide-mac-file-versioning/

and

https://apple.stackexchange.com/questions/27544/how-to-completely-
disable-auto-save-and-versions-in-mac-os-x-lion/52390#52390

What if you don't want edits to be saved?

In some cases, you want a file to be a template. Edits are not saved, or at
least not saved on top of the file. You can save a template  from Prism
and it will appear on the Welcome dialog. Note that you must be on a
data table for the Save Template command to be available.  You can also
simply change the name of any file so it has the .pzt extension (not .pzf
or .pzfx). When Prism opens a file with a .pzt extension, it forgets the
original name and assigns a generic file name. When you edit the file,
changes are saved to "untitled" not to the original file. 

8.3.5 File..Save As command in Mac

Note that this page only applies to Prism Mac, not Prism Windows. 

Why there is no Save As command

Prism Mac uses the new File menu introduced by Apple. Details . It has
no File..Save As command visible. It isn't needed because the new
commands, Duplicate, Rename, Move and Save Copy do what most
people use Save as for. But you can expose the Save As command if you
really want to. 

How to get the command if you really really want it

If you really want Save As, you can get it in two ways:

· Hold the Option key, and drop the File menu. Now the "Duplicate"
command is gone, replaced with  "Save As..."

179
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· Press the Save menu button in the toolbar. You'll see "Save As"  on that
menu. 

             

What the Save..As command does

The whole idea of the new way of working is that there is only one
document. In the old way of working, there was one copy on disk and one
transient copy in working memory (RAM). If you didn't save your work
(on purpose or by accident) all your work was lost back to the last save.
If you used File..Save as, you'd save the current RAM version of the file in
the new name, while the older file continues to exist. With the new way of
work, there only is one project file. 

The Save As command makes a duplicate of the file with the name you
entered. The original file still exists and is saved with has all the edits up
to the time of Save..As. Immediately after using Save As, the two files
are identical. You can then roll one of the copies back to how it looked
before the edits.

Why you don't need to use the Save..As command

· If you want to rename, use File..Rename.

· If you want to put the file in a different folder or drive, use File..Move
to. 

· If you want to clone your file, so one copy has the older information and
the other has the edits, use File..Duplicate. That will create two copies
of the file. You can close one (to keep it as is) and edit the other. 

· If you want to save a copy of the current file as a milestone or backup,
use File.. Save a Copy (in the Save Special menu).
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· What if you have made many edits and want to save these with a new
name without changing the saved version? You can't do exactly that
because there is no distinction between the working (ram) version and
the saved version. But you can accomplish the same goal. Use
File..Duplicate. Then use File..Revert to bring one of the files back to
how it was. Then close that file if you are done with it, and work on the
other copy with all your edits. Note that File..Revert only works so long
as you are on the same computer that did the edits. The information
needed to revert is saved in hidden files on that computer's drive, not
within the Prism file. 

How is Save As different than Duplicate and Save Copy?

The  commands are very similar. After invoking any of the three
commands, you'll have two identical files with different names.

· After File..Duplicate, both files are open. 

· After File..Save As, the original file has been closed and only the newly
named copy is open.

· After File..Save Copy, you continue working on the same file with the
old name, but a milestone backup was saved with the name and location
you entered. 

The one use of Save As that has no alternative

There is one purpose of Save As that is not available with the other
commands. If you have saved the file in .pzf format and want to switch to
.pzfx. Or the other way around. The only way to change file extension is
to use File..Save As.

9 Getting around in Prism
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Prism is easy to use. Use the Navigator tree to

move between parts of a project, and toolbars to

perform tasks.

 



GraphPad Prism 8 User Guide150

© 1995-2020 GraphPad Software, LLC

9.1 Navigator -- See all sheets in your project

The navigator

The Prism Navigator tree on the left side of the Prism screen shows the
contents of your Prism file.

· The five folders (Data tables, Info Sheets, Analysis
Results, Graphs, and Layouts) define the five
sections of a Prism project. You can not create
more folders, and cannot create subfolders.

· Each folder (section) can contain up to 500 sheets
(pages).

· Click on one of the folder (section) names to view
thumbnails of all the pages in that section in a
gallery . 

· Click on any sheet name to go to (view) that
sheet. 

· Sheets can be highlighted  in various colors. To
do this, use the toolbar button or right click. 

· Results and graph sheet names in italics are
frozen  so won't update when the data are edited
or replaced. 

· At the bottom of the list of sheets in each folder is
a link for a new sheet of that type. Click to create a
new table, graph, etc. 

· Above the navigator is a search  box. 

· The current sheet (the one you are looking at) is
highlighted. All sheets linked to that sheet (the
family) are shown in bold. 

· Right click on a sheet name to rename, highlight,
freeze, duplicate, etc. 
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· Analysis sheets can spread the results over several
analysis tabs . 

The Family folder

At the bottom of the navigator is a Family folder. It shows sheets related
to the current one. Results are indented under the data they analyze.
Analysis chains (first transform, then normalize, then fit a curve..) are
shown by further indentations.

In some cases, sheets in different sections can have the same names.
Distinguish them by the icons in front of each name which indicates the
folder (section) it belongs to.

Separate folders for Data and Results or one combined Data+Results
folder

Starting with Prism 8.2, you can choose to have separate folders for Data
and Results or a single combined Data+Results folder with results nested
and indented so you can see which results came from analyzing which
data set. Flip between the two ways of working in the View tab of
Preferences or (easier) by right-clicking on the navigator. The bottom
command on the shortcut menu switches between "Show Combined
Data+Results Folder" and "Show Individual Data and Results Folders".
The combined folder is pretty useful. It is worth trying. 

300
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Hiding the navigator

If you need more room to work, click the button in the lower left corner of
the Prism window to hide the Navigator. Click it again to bring the
Navigator back.

See also:

Tips for navigating large project

 Analysis tabs

 

9.2 Gallery - View all the sheets of one type

Viewing the gallery

The gallery shows you thumbnails (small images) of all the sheets in a
section at once.
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To view the gallery, click on the folder name in the navigator. Click on
"Family, Data Table", "Info", "Results", "Graphs" or "Layouts".  

Another way to view the Gallery is to click its button on bottom toolbar.

Notes:

· Don't confuse the Gallery, which shows you all the sheets in your
project, with the Portfolio which shows you a set of polished graphs you
can use as examples. View the Portfolio from the Welcome (File..New)
dialog.

· From the gallery, double-click on any thumbnail to leave the gallery and
go to that sheet. This is the main purpose of the gallery -- to help you
quickly find a particular sheet and go to it. Alternatively, you can leave
the gallery by clicking on the gallery button in the lower toolbar shown
above.

· Use the zoom buttons  at the bottom right of the Prism window to
make the thumbnails larger or smaller.

Reordering the sheets

Drag and drop sheets to change their order. You can also do this in the
navigator, but it is easier in the gallery.

159
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Working with multiple sheets

Click on option boxes in front of the sheet names to select multiple
sheets. Once you've selected a set of sheets, right click to see all the
commands you can apply to a set of selected sheets.  Details . 

              

9.3 Working with families of sheets

What is a family?

Prism remembers the links between data tables, info sheets, analyses,
graphs and layouts. Replace or edit the data, and linked analyses and
graphs will update. We call the current sheet with all linked sheets, a
family of sheets.

Prism automatically determines which sheets are in a family. You cannot
assign sheets to a particular family.

Viewing a family of sheets in the navigator

185
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The navigator  shows you which sheets are linked to the current sheet.
Their names are bold. If you have a large project, you may have to scroll
to see all the linked sheets. Prism, therefore, lets you see them all at
once. 

Below the main navigator is the family navigator, a panel that shows
sheets in the current family. This makes it easy to move among sheets in
the family without having to scroll the navigator. You can drag this panel
larger or smaller to meet your needs. Analyses are indented under the
table they analyze so you can see analysis chains. 

The family folder shows the family of the last sheet selected in the main
navigator. If you then move from sheet to sheet in the family navigator,
the definition of family will not update (until you click on a sheet name in
the main navigator).

The Family menu

From anywhere in the program, drop the Family menu to see all the
commands that work with the entire family of sheets related to the sheet
you are now looking at. You get the same menu by right clicking on the
word Family at the top of the Family navigator. 

150
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The details of how a family is defined

 A family is the sheet you are looking at and all sheets directly related to
that sheet. So if you are looking at a graph, the family includes the data
table(s) plotted on that graph, any analyses included on that graph as
curves or embedded results tables, and any layout(s) that include that
graph. 

Possible ambiguities:

· A graph can contain data from two more more data tables. If you start
from the graph (and save or duplicate its family), both (all) those tables
are part of the family. If you start from only one of those tables, the
other table(s) are not part of the family. 

· A layout can contain many graphs. If you start at the layout, the family
contains all those graphs and all the data and results on those graphs. If
you start from a data table, the family includes the layout, but not the
other graphs (and related sheets) that are also on that layout.

· If you start from a data table, all analyses are part of the family.  But if
you go to a graph that includes that table, only analyses plotted on that
graph (directly, by pasting a table, or by using analysis constants) are
part of the family. Other analyses that are not actually on that graph are
not part of the family defined when you start on a graph.
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· Info sheets can either be declared to be linked to a particular data table
or to be global to the entire project. Prism includes an info table when
you first create a new project file, and this info table belongs to the
project  and is not linked to the first data table. To choose, go to the
table, drop the Change menu and choose "Link to data table". If an info
table is linked to a data table, then it is part of any family that includes
that table. If the info table is not linked to a particular data table, then it
will not be part of any sheet's family -- with one exception. The
exception is that when the project contains only a single info table, and
all the other sheets in that project are linked to be part of a single
family, then that info table is defined to be part of that family too.

· Don't confuse two uses of the word family. The term is also used when
Prism does multiple comparisons after one- or two-way ANOVA. The
multiple comparisons calculations are done so the probability alpha
applies to the entire family of comparisons. This use of the word family
in multiple comparisons has nothing to do with a family of sheets.

9.4 Searching for sheets in a large project

If your project is large, it can be helpful to search for the sheet(s) you
want to work on. 

At the top of the Navigator is a search box. 

1. Click in the search box at the top of the Navigator. 

2. Note that a new Restrict Row opens up.

3. Enter the term you wish to search for (or leave blank). Or  click the
downward arrow to the right of the search box to choose a search term
you used recently. Optionally restrict the search to a certain kind of
sheet (maybe only graphs), or to sheet with notes (perhaps of a
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specified color) or sheets that are highlighted (perhaps with a specified
color). 

4. A list of the hits will appear in the navigator. The main part of the
Prism window will show thumbnails of all the sheets. 

5. Go from hit to hit to find what you need. Note that the Navigator
continues to show only search results. 

6. If needed modify the search term or restrictions. 

7. When you are done searching, click the X at the top right of the search
box to go back to seeing the entire navigator. 

9.5 Graph and layout tool tips

Some of the tool tips in Prism do more than provide information. They
also provide links to take you to other parts of the project.

Hover your mouse over a symbol on a graph to see the value, and
location of the data point. Click on the name of the data (or results)
table to go right to the correct spot on the data table.
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Hover your mouse over any graph on a Layout. A tool tip will appear
with a link to the graph. Click on the link to go to the graph.

9.6 Changing the zoom

Zoom buttons

Use the Zoom buttons located on the lower right side of the Prism window
to enlarge or shrink the view of the current sheet. You can also use the
Zoom tools to make thumbnails in the Gallery  larger or smaller.

On graph and layout sheets, Zooming lets you see more or less of the
sheet, but doesn't change the size of the graph or layout when printed.
Click here to find out how to actually resize graphs  and layouts.

On data tables and analysis results sheets, the Zoom buttons not only
change what you see, but they also actually change the size of the font
Prism uses when you print. If you want to get more of your data table on
a printed page, Zoom Out to make the font smaller.
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Keyboard shortcuts

Shortcut: Hold the Ctrl key and press M to zoom larger or J to zoom
smaller.

Mac gestures

Starting with release 6.0c (and if you use Lion or later), you can zoom
Prism Mac by pinching with two fingers, but only if that gesture is turned
on in the Trackpad control panel. You can also smart zoom by double
tapping with two fingers. Depending on where you tap, that will zoom you
in to see the entire page, the graph plus all other objects on the page, or
just the graph. 
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9.7 What if the toolbar or navigator is missing?

It is possible to use Prism without the Toolbar (top) and Navigator (left),
and this can be useful on computers with  tiny screens. But it is easier to
learn Prism with both the Toolbar and Navigator showing. If someone else
using the computer has turned off either, it is easy to bring it back:

· If the toolbar is not showing on your computer, drop the View menu and
choose Main Toolbar.

· If the Navigator is not showing on your computer, drop the View menu
and choose Navigator.

· If the bottom toolbar is missing, choose Bottom Toolbar on the View
menu.

9.8 Tips for working in a small window

Working on a small screen can be difficult. To free up space to have more
working space: 

· With Prism Mac, you can click the green circle the top left of the toolbar
to run full screen. When you use the View menu to view or hide the top
toolbar, the navigator or the bottom toolbar, those choices will apply
only to the full screen view. You can make different choices for when the
Prism window does not fill the screen. 

· Hide the Prism Navigator tree. To hide the navigator, use a command in
the View menu or the leftmost button in the bottom toolbar.

· Hide the main (top) toolbar, and use the menu commands instead. To
hide the toolbar, use a command in the View menu. 

· You can also hide the bottom toolbar, but  we suggest you don't. If you
hide the navigator, you'll want to use the bottom toolbar to navigate
from sheet to sheet and section to section. 

· With MacOS Sierra and later, you can put multiple Prism files into a
single tabbed window . 134
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10 Prism files

 



Prism files 163

© 1995-2020 GraphPad Software, LLC

A Prism project file (or PZF file) contains all the

pieces of a project.

10.1 Difference between Windows and Mac

Prism Windows works as you expect. You work on a temporary copy of
the program in transient computer memory (RAM) until you save. 
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Prism Mac works differently. You don't ever need to use the Save
command, as all changes are saved automatically. Read this overview ,
these details , and this explanation about what happened to the File
Save  command. 

10.2 PZF vs. PZFX files

Two formats

When you save a Prism file, you save the entire project into one file. You
have a choice of two file formats:

· PZF format: This is a binary format that can be opened by Prism 4 or
later, but not by other applications.  

· PZFX format: This is a format that can be opened only by Prism 5 or
later. The first part of the file contains all the data tables and info sheets
in a plain-text XML format that can be viewed by other programs. After
that comes information about results, graphs and layouts in a format
that is incomprehensible to any program but Prism.

Advantages of PZFX compared to PZF

· The PZFX format is a bit more secure for long-term backing up. Even
without access to Prism, the data in the file are in plain text that can
readily be viewed.

· Files saved in PZFX format tend to be much smaller (about 10% the
size) than the same file saved as PZF. We recommend that you use
PZFX files routinely. Even though PZFX files are almost always smaller,
they may be faster or slower than PZF files to save and open, depending
on how large your data tables are and whether you included pictures in
your graphs or layouts.

· The data (and info and scripts) are in a plain text format at the
beginning of the PZFX file. It is possible to create a program that swaps
out the saved data with new data. Open that altered file, and the new
data will instantly be analyzed and graphed.

Disadvantages of PZFX compared to PZF

138
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· Prism 5 was the first version that understand the PZFX format, so these
files cannot be opened by Prism 4.

· Avoid the .PZFX format if you plan to post the file on a web site. Web
browsers sometimes detect the XML format, and try to open the file
with some program that understands XML rather than opening with
Prism. In contrast, .PZF files generally just open in Prism, as they
should.

· The PZFX format never contains analysis results, so Prism needs to
recompute the results when it opens the file (or when you view those
results pages or graphs that depend on them). If your analyses are very
slow to recalculate, choose the PZF format with the Compact option
turned off (see below). These files will contain analysis results, so Prism
will not need to recalculate anything when you open the file. 

· With large files, it takes about ten times longer to save or open a PZFX
file than a PZF file. This is because the information about graphs and
layouts is compressed in PZFX files, and compressing/decompressing
can be slow. 

Compact PZF format

Prism has an option to save PZF files in compact format. All the compact
format does is leave out analysis results. Files with lots of complicated
analyses will be smaller if saved in compact form, but all those analyses
will need to be recomputed when the file is opened, which can take time.
Choose to use, or not use, the compact format in the File tab of
Preferences. PZFX files are always saved in the compact format. 

Zipping the file with standard zipping software can do a much better job
of compression. To really make a PZF file as small as possible, save it
compact and then zip it.

Check the box in the Preferences  menu if you want to save in compact
format as a default.

194
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What if you have both a .pzf and .pzfx file with the same name?

Prism opens the file you ask it to open. It won't even "notice" that there is
another Prism file with the same name (except extension). It won't
coordinate the two files. We strongly suggest not keeping two files with
the same name (but one .pzf and the other .pzfx) as it is too easy to get
mixed up and lose work.

10.3 File compatibility between Prism versions

Cross platform (win/mac) compatibility

The Windows and Mac versions of Prism use the same file format, and you
can go back and forth between Prism 8 Win and Mac without any special
conversion. 

Issues

· With older versions, there is one problem. If you pasted a WMF or EMF
image (from another program) onto a Prism graph or layout using Prism
Windows version 6 or earlier, that object will be replaced by a red object
when you open the file with Prism Mac. 

· If you use any of these nonstandard fonts (and perhaps others) with
Prism 8 Mac, the symbol will appear as a box when you open the file in
Prism 8 Windows: Cuneiform, Linear, Aegean, Miao, and Inscriptional.
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Upward compatibility

Prism 8  can open all PZF and PXFX files created by Prism versions 4-7,
and can even open .PZM files created by Prism versions 1 to 3. 

Downward compatibility

Overview

We have done extensive testing to make sure that Prism 7 can open
Prism 8 files. When Prism 7 lacks a Prism 8 feature, the result is sensible.
We have not extensively tested opening Prism 8 files in Prism 6 and
earlier. It will probably work ok for many files, but this is not something
we have tested.  

But note there are likely to be changes when you open a file with an
earlier version. Going back and forth between two versions is likely to be
annoying. 

The location of analysis results on analysis tables may change between
versions

When you open a Prism file on a version different than the version it was
created on, results also may appear on different rows of the results
tables. This means that results tables embedded on graphs may no longer
show the results you care about, and scripts may export the wrong
values. You may have to do a bit of clean up to make the files work as
intended.

Compatibility of Prism objects saved within other documents

On Windows (but not Mac), when you paste a Prism graph or layout
within Word or PowerPoint (or some other programs), you can paste just
a picture, paste a link, or embed a Prism object. If you paste a link or
embed an object , you can then double click on that image to edit within
Prism. This works only if the correct version of Prism (or the GraphPad
Prism Viewer) is installed or a newer one is installed on your computer.

Special characters may change to question marks

Prism 8 introduces use of Unicode to encode all characters. This is how
almost all programs work now. 

When you open a file created with Prism 8 in an earlier version of Prism
some characters will still appear fine (Greek..). But others will show as a
question mark in the earlier version. Three notes to help ensure that most
characters appear fine:

603
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· To properly open p8 file with Unicode symbols in Prism 7, make sure
you chose the appropriate locale for Prism 7. Other words, if user enters
Japanese and saves file in Prism 8, then to properly open this file in
Prism 7, user needs to make sure that Japanese locate is set in the
system.

· Make sure that you have updated Prism 7 to the last release, which
does a better job with character conversion than did earlier releases.
Use Help..Check for updates.

· In Prism 7 and older, symbols that don't have an ANSII equivalent will
show as "?" no matter which locale is set.

10.4 Merging and splitting projects

Merging

Prism offers three approaches to merging two Prism projects.

· To merge an entire Prism project into another: Drop the File menu and
choose Merge. Pick a file (which must not be open). That's it. All sheets
from that file will be appended to your current project. Prism places an
asterisk (*) in front of the name of each merged sheet.

· To merge just one graph and its related sheets into another Prism
project starting from the project with the graph: Copy a graph from one
Prism project. Go to a layout page in another project. Then paste. Prism
will ask if you want to paste an unlinked picture, paste a linked picture
(linked to file you pasted from), or merge the graph and its family into
the new file. 

· To merge just one graph and its related sheets into another Prism
project starting from the project you want to merge into: Go to a layout
page. Double click on a graph placeholder. The Place Graph on Layout
dialog lets you choose to merge the graph and data into the new file, to
maintain a link to the original Prism file so that changes in the original
will update in the current file, or to paste just a picture of the graph.
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Splitting

Prism offers two approaches to splitting apart a Prism project.

· To save one family of sheets into a new file:  Drop the File menu,
choose  Save Special, and then Save Family As. This will create a new
file from the current sheet along with all linked sheets. 

· To save a copy of the entire project with a new name: Drop the File
menu. In Windows, choose Save As. In Mac, choose Duplicate. 

Once you've saved a copy of the file, or part of it, you'll want to delete
unwanted sheets from the original project. The easiest way to delete
several sheets is to go to the Gallery for a section and click the checkbox
on several sheets. Then press Delete. When you delete a data table, you
have the option to delete all info, results, and graph sheets linked to the
selected data tables at the same time.

10.5 Emailing Prism files to colleagues

Click on the Send by Email button in the Send section of the Prism
toolbar. You can choose to send a Sheet, Family, or Project. Your email
program will open and create a new message with the Prism file attached.
The format of the file depends on what you choose:

· If you choose to send a data table or results sheet, it will be sent as a
text file. 

· If you send a graph or layout, Prism will send it as a .PDF file.

· If you choose to send a family or project, Prism creates a temporary
copy of the project, and attaches that to the email. Changes you make
after choosing the Send Mail command will not be included in the email,
even if you delay sending it. 
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These commands probably won't work if you use a web-based email
system or a nonstandard email program. If the command doesn't work, or
isn't available, you can still attach Prism files to email. Simply save the
file, and then attach it to an email from your email program. If you only
want to send a subset of your project, save the current sheet and all
related sheets using the Save Family As command. Choose Save Special
from the File section of the Prism toolbar.

You can send a Prism file even to someone who doesn't own Prism. The
recipient can view the file using a free Prism trial. After the trial expires in
30 days) it becomes a Viewer that doesn't expire. It lets anyone view and
print all contents of a Prism file, including analysis choices, but does not
allow any editing or exporting.

10.6 LabArchives

 Far more than an "ELN" (Electronic Laboratory Notebook), LabArchives
stores and catalogs all of your research for easy retrieval and publication. 

Free LabArchives account for Prism users

Registered users of Prism can obtain a free account on LabArchives.  To
set up this account, go to a graph in Prism, click the LabArchives button
to drop a menu, and choose to "LabArchives it". You will be prompted for
your email address, which is all you need to start an account. You do not
need to enter a credit card number!

http://www.graphpad.com/demos
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Prism integrates well with LabArchives:

· Click “LabArchive it” to upload files directly to LabArchives.

· When it uploads a file to LabArchives, Prism also sends LabArchives a
list of all words used in notes, titles, text boxes, etc. That mean you can
search within LabArchives to find the file you need.

· From the Welcome dialog of Prism, you can open a file directly from
LabArchives. There is no need to first go to labarchives.com to download
the file you want.

Logging on to an existing  LabArchives account

If you have a LabArchives username and password, Prism will prompt you
to enter it.

But what if you log in to your institutional server, and the logging into
LabArchives is done behind the scenes using an authorization system like
Shibboleth? In this case, you don't have a username and password
specific to LabArchives. But you can get one. After logging into the
LabArchives web browser interface, click on your name in the upper right-
hand corner of the screen and click “LA App authentication". The next
screen will show you a username (email) and password for LabArchives.
Use these when Prism asks you to log in to LabArchives. Prism will
remember this information, so you should only need to do this once. 

LabArchives usually uses a server maintained by LabArchives. If you want
to use a local server to host LabArchives files, you can do so. Details
here. 

10.7 Saving vs. exporting

Saving and exporting are different. When you Save your Prism file you
save it in Prism's file format. This type of file can only be opened with
Prism and it contains data, analyses and graphs.

Use Export to save a graph or layout in an image format that can be
imported to another application. If you export a graph  or layout, you
are simply creating a picture of it. You won't export the original data or
any analysis results. You won't be able to open the exported file or edit it,
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except as a picture. If you export a data table  as a text file, you are
just exporting the values.

10.8 Template, method and example files

Prism can save your work in three special kind of files designed to let you
save time by not repeating steps with future data. 

· A template is a Prism file that you recycle. Choose a template, add new
data, and all the analyses and graphs will be created automatically.
Templates  are an older feature, and we recommend you use example
files or method files instead. 

· Example files are files saved in a special location to later be cloned.
Choose to clone an example file  on the Welcome (File..New) dialog,
enter new data, and all the analyses and graphs will be remade. 

· Method files are files saved in a special location to later be applied to
new data you have entered. When you apply a method, you apply the
analyses and graphs in the method file to the data table you have
already entered. Do so in the Analyze dialog.

Save your work as a template, example or method from commands in the
File... Save special menu. To save an example, you must be looking at a
graph when you save the example. To save a method, you must be
looking at a data table. Templates can be saved from anywhere.

10.9 Automatic backups of Prism files

Automatic backup depends on platform.

 Automatic backup for Prism Windows

 Automatic back for Prism Mac

293
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11 Work efficiently. Repeat analyses and graphing

Once you've analyzed data and made some graphs

with Prism, you'll probably want to do similar

analyses and make similar graphs with new data.

Don't start again from scratch. Prism offers four

ways to recycle -- to quickly analyze and graph



GraphPad Prism 8 User Guide174

© 1995-2020 GraphPad Software, LLC

new data using the same steps and format that you

used earlier. The key point is that Prism links data

to results,  graphs and layouts. If you edit or

replace data, linked results, graphs and layouts are

updated automatically.
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· When you fix a mistake in data entry, the results and graphs are
automatically updated. 

11.1 Duplicate a family of sheets

A family  is defined to be a selected sheet and all linked sheets. 

To duplicate a family of sheets, do one of the following:

· Click the New button and choose Duplicate Family.

· Drop the Family menu and choose Duplicate Family.

· Right click (or Control-click if using a Mac) on any sheet in the
Navigator, and choose Duplicate Family

If you are starting from a data table, Prism will ask you to assign a name
to the new (duplicated) data table. If the table name is a subset of the
results and graph sheet names, these will be substituted. Suppose that
the data table is "October data", and is linked to "Nonlin fit of October
data" and "Graph of October data". If you start from the data table and
choose to duplicate family, you can enter "November data" as the name
of the new data table. Prism will then rename the linked sheets to "Nonlin
fit of November data" and "Graph of November data". It can only do this
because the exact name of the data table is part of the sheet names.

 If you are starting from another kind of sheet, Prism will ask you to enter
a prefix that will be prepended to the names of all the duplicated sheets.
In the example above, you could choose to preface all the newly created
sheets with "* ". These new sheets will be "* October data", "* Nonlin fit
of October data" and "* Graph of October data". Of course, you can
rename the sheet titles however you want. 

If you are not starting from a layout, Prism will ask whether you want to
include the layouts in the duplicated family.

Prism will duplicate the current sheet and  all linked sheets. Replace the
data on the new data table, and all analyses and graphs will update.

Note the distinction between duplicating a sheet, and duplicating a family
of sheets. When you duplicate a sheet, only that one sheet is duplicated.
If you duplicate a data table, it will not be linked to any graphs. If you

154
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duplicate a graph, the copy will link to the same data table as the
original. This is useful if you want to make two graphs of the same data.
But if you want to make two similar graphs of different data, you'll want
to duplicate the family (or clone the graph ).

11.2 Clone a graph

Cloning means to duplicate a graph along with data tables and results
included on that graph. Enter a new data set, and it will instantly be
graphed the same way. Clone a graph when starting a new project from
the Welcome (File..New) dialog. Or drop the New button and choose Data
Table (+ Graph). 

 

Use the tabs at the top of the window to choose graphs from an open
project, a recently-used project, or a Prism project that you have saved
as an example or has been saved as a shared example . At the bottom
of the dialog is a control where you can choose the size of the
thumbnails. 

Once you choose the graph to clone,  Prism will show a dialog where you
can choose which data and titles to delete. By default, Y values are
deleted, but X values and titles are kept.

176
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Q&A:

· Are analyses also cloned? It depends. Cloning duplicates regression
lines and curves,and results tables that are included on embedded
tables. Other analyses that are linked to the original data table, but are
not included on the graph, are not cloned. For example, say you have a
data table, analyzed with a t test, and graphed. If you clone the graph,
the t test analysis will only be included if you have pasted a portion of
the results onto that graph.

· To save the current graph as an example to clone in the future, drop the
File menu  and choose Save Special ...Save as Example. Start from a
completed graph. Don't erase the data before saving the example, as
you can ask Prism to remove the data when you clone the example.

· Can you clone layouts? No. But you can go to any layout, and duplicate
that sheet with its family . 

· How is cloning a graph different than duplicating a family of sheets?
When you start from a graph, and duplicate its family, the results are
identical to cloning that graph. To clone a graph, go to the Welcome
(File..New) dialog. To duplicate a family, go to the selected sheet.
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11.3 Use Wand to analyze and graph just like another table

If you've already entered data onto an empty data table, it is too late to
clone, too late to duplicate a family, and too late to open a template -- at
least without copy and pasting data. 

Prism provides a great tool to solve this problem: the Wand (Wizard to
ANalyze Data). Use it to analyze (and graph) the new table just like you
already analyzed (and graphed) an existing table. 

Follow these steps:

1. Start from the data table (with data) you wish to analyze (and graph).
Or select multiple data tables in the gallery.

2. Click the magic wand button on the toolbar, to bring up the Analyze
Data dialog.

3. Choose the existing data table (in the current project) you want to use
as an example. 

4. At the bottom of the dialog, optionally enter the prefix you wish to
appear in front of the new sheet names.

That's it. The new table (where you started from) will be graphed and
analyzed the same as the example table. 

Notes:

· The name Wand was new to Prism 6. This feature used to be called
Applying a Method.

· You can also choose to use the Wand to apply a stored method file. To
save a method file, go to the data table that has been analyzed and
graphed, drop the File menu  and select Save Special… Save Method.
Where is it saved?  To apply that saved method file, click the Analyze
button, and then choose Use Saved Method at the top left of the Analyze
Data dialog.
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· The same icon is used for both the Magic  and Wand features. Magic
(Make Graphs Consistent) changes the appearance of selected graphs
so they look like an example graph. You can only use Magic when you
start from a graph, or a set of graphs selected in the gallery. The Wand
analyzes and graphs a new table the way you have already analyzed
and graphed another table.  You can only use the Wand when you start
from a data table with data, or a set of selected tables.

11.4 Templates

What is a template?

A template is a Prism file that you recycle. Choose a template, add new
data, and all the analyses and graphs will be created automatically.
Templates are an older feature, and we recommend you clone a graph ,
or use the Wand , instead.

A Prism template is a regular Prism file, with three differences:

· A template has the extension .pzt. When Prism opens such a file, it will
"forget" the file name and open the file without a name. Then it will
prompt for a file name when you save. This prevents accidentally
overwriting the template.

· When you save a template, you can enter some brief instructions that
will appear when the template is opened. This can be useful when you
are creating a template for others to use.

· A list of templates will appear on the Open a File tab of the Welcome
(File..New) dialog.

Creating a template

Follow these steps to create a template:

1. Create a Prism project with only the sheets you want to see when a
template is opened. 

2. (Optional) Delete the portions of the data that will change with each
experiment (for example, delete the Y values but leave the X values
and the column titles). Don't delete entire columns, just the values in
those columns by selecting and then using the Delete key. 

348
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3. Go to the data table you want to see when the template is opened,
drop the File menu, choose Save Special, and finally choose Save
Template. You'll also find this command if you drop the Save menu
from the toolbar. This command will be gray (unavailable) unless you
are looking at a data table (not results or graph).

4. On the Save Template dialog, choose (or create) a category (folder), 
enter a name for the new template, and optionally enter a description
and/or instructions for using the template. If it will be used by others,
you can write a help file for it and install the files onto other
computers.

To use a template

You'll see a list of templates at the bottom of the Open a File tab of the
Welcome (File..New) dialog. When you open a template, any description
of instructions you entered will appear in a popup dialog.

Informal templates

The instructions above assume that you save the template from Prism,
and open it via a link on the Welcome (File..New) dialog. But you can
rename any Prism file in any folder to have a .pzt extension, and open it
from Windows Explorer or Mac Finder by double-clicking on it. The
difference is that when Prism opens a .pzt file, it instantly forgets the file
name so will prompt you for a file name when you first save it. That way
you won't accidentally overwrite the template. 

11.5 Template or method (wand)?

When you want to analyze and graphs a set of experiments the same
way, you can save your example as either a template or method. In
either case, start from the data table, drop the File menu, choose Save
Special..., and then choose Save Template or Save Method. 

The difference is in when you choose to use these files.
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· Open the template from the Welcome dialog, enter or import data, and
then look at (and fine-tune) the results and graphs.

· Methods are different. First create a data table and enter or import
data. Only then do you click the Analyze button to apply the method to
your data.  

Perhaps this distinction will help: A template is a noun - a place you start
from. A method is a verb - something you apply to data you have already
entered

. 

12 Organizing Prism projects
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A Prism project file (or PZF file) contains all the

pieces of a project. Each Prism project has basic

five sections: Data tables , Info sheets ,

Results , Graphs , and Layouts . Each section

can have up to 500 sheets. The term 'sheet' refers

201 188
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to an individual data table, info page, set of

results, graph or page layout.
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12.1 Renaming, sorting, and deleting sheets

Changing the order of sheets in a section

Simply drag-and-drop within the Navigator  or Gallery , or pull down
the Edit menu and choose Reorder

Renaming a sheet

Prism initially assigns each data table a generic name such as “Table 1.”
It is easier to manage large projects if you give the sheets more
descriptive names.

Click on the name of the sheet in the Navigator, and press F2 (or wait for
a second and then click again) to rename the sheet. Or right-click on the
sheet name and choose Rename sheet.

You can also rename using the bottom toolbar. Click on the sheet name in
the bar at the bottom of the Prism window and edit it. Don’t try to delete
the current sheet name from the drop down in the bottom toolbar. If you
delete the name, Prism replaces it with a default name. Instead, double-
click on the sheet name in the bottom toolbar to select it, and then begin
typing to replace it.

 Deleting sheets

Select a sheet in the Navigator  and click the Delete Sheet(s) button 
on the Sheet toolbar. You can select one or more sheets in the current
section to delete.

150 185

150



Organizing Prism projects 185

© 1995-2020 GraphPad Software, LLC

To delete several sheets,go to the Gallery  and select several sheets.
Then click the Delete Sheet(s) button or press the Delete key.

Because sheets are linked, remember that deleting one sheet may affect
others. When you delete a data table or results sheet, you also remove
those data and results from all graphs. The graphs themselves remain;
they just have fewer (or no) data plotted on them. Any results sheets
based on the deleted data become orphaned (you can still view and graph
orphaned results but can’t change the calculation parameters). When you
delete a graph sheet, you also delete that graph from all page layouts,
but you will not delete the page layout sheets themselves.

12.2 Working with multiple sheets at once

View all sheets in the gallery

Click a section title in the Navigator (Data tables, Info sheets, Results,
Graphs, or Layouts) to view thumbnails of all the sheets in that section.
We call this the Gallery.

Use the Zoom buttons on the bottom toolbar to make the Gallery
thumbnails larger or smaller.
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The gallery is useful for navigation and organization. Double-click on any
sheet to go to it. Drag and drop thumbnails in the Gallery to rearrange
sheets in a section.

Selecting multiple sheets

Check this option box below each sheet to select it. Alternatively, hold the
Control key while clicking on several sheets.

Working with several sheets at once

Many commands are available that work on all selected sheets at once.
Right click on the gallery to see a list of all available commands.

· Print  each selected sheet separately, or print a combined gallery
page.
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· Export .

· Send  to Microsoft Word or PowerPoint.

· Magic . Make graphs consistent.

· Apply a color scheme

· Change the background color or plotting area color

· Rename. Add a prefix or suffix to their existing names, or give all
selected sheets the same name (followed by 1,2,3...).
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12.3 Freezing a sheet to prevent changes

When you edit data, Prism automatically recalculates the analyses and
updates the graphs.

Freeze a results or graph sheet if you don't want it to update. For
example, you might want to freeze results and a graph before excluding
some outliers from the data. You can then repeat the analysis, and have
both copies of the results and graphs in the project. Note that Prism
doesn't let you freeze data tables, info sheets, or layouts.

Click the Freeze button in the Sheet section of the Prism toolbar to freeze
a results sheet or graph. The Prism bottom toolbar will indicate that the
sheet has been frozen and won't update with any changes to the data.
Click again to unfreeze.

         

12.4 Using Info sheets to organize your projects

Key concepts: Info sheets

· Use Info sheets to record experimental details and constants you want
to use in analyses.

· The left side of an info sheet is a table of structured information. The
right side is for unstructured notes

· Each project can have up to 500 info sheets. Each Info sheet can be
linked to a particular data table, but doesn't have to be. 

· The info constants can be used (hooked) in analyses. 

Create and edit an Info sheet
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To create an info sheet, click the New button on the toolbar, or drop the
Insert menu. Choose New Info. Select whether the new sheet should be
linked to a particular data table, or a global Info sheet for the project.

 How to use Info Sheets

To embed all or part of an Info table onto a graph or layout:

Select all or part of the Info table, and copy to the clipboard. Then go to a
graph or layout and paste. This will be a live link, updated if you edit the
info table. Double-click on the embedded table to adjust its properties.

To insert an Info constant into a graph title, legend, or text object:

While entering text, use the right-click menu or click on the Inset Info
Constant button in the Write section of the Prism toolbar. Prism will
maintain a link to the constant, updating the text when you edit the info
table.

To change the order of the rows on an Info sheet, or to delete a row:

Click on a row, then click the right mouse button. From the shortcut
menu, choose to move the selected row up or down, or choose to delete
that row. Or use the buttons on the Change toolbar.

To link a global Info sheet to a specific data table:
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Click this button in the Change toolbar to bring up a dialog to select which
data table the Info Sheet is linked to.

To change which info constants appear by default on new Info sheets:

Use the Info Sheet tab of the Preferences  dialog. You can also choose
whether or not Prism will automatically create a linked Info sheet to
accompany every new data table you create

To import info constants into an Info sheet at the same time you import data:

     See here for the details.   

To hook info constants into an analysis or graphing dialog.

You can "hook " Info sheet constants as constraints in nonlinear
regression or as constants when transforming.

You can also Hook to Info sheet constants to create custom ticks ,  set
axis limits , etc.

You'll know when it’s possible to insert ("hook") an info constant, because
you'll see the fishhook icon next to the number entry field.

  

When you see this button in a dialog, click on it to bring up a list of all
Info and Analysis constants that can be hooked.

To insert a text file into the notes portion of an Info sheet:

Drop the File menu and choose Import.

12.5 Annotating your work with floating notes

Floating notes will show on the sheet but not when a sheet is printed, or
exported or copied to another application, such as Word or PowerPoint.
Use different color notes for different things. For example, have one
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colleague review all yellow notes, and another one review all the blue
notes.

To add a floating note to a Prism sheet:

Click on the button on the Sheet toolbar.

To minimize a floating note:

 - Click the Minimize button on a Floating Note to collapse the note. Or just double-
click on the top border of the note.

To add a link to a web site:

 - Drop the Note menu using the button in the upper left corner of a note and use
the Create Link to add a hyperlink to a website or other document.

To change the color or delete a floating note:

Drop the Note menu using the button in the upper left corner of a note, and select
Note Color.

12.6 Color code selected cells in data or results tables

It is easy to color code selected cells in data or results tables. This would
be useful to highlight the key results, to mark surprising results you wish
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to review further, or to mark suspicious data entries that you wish to
double check. To do so:

1. Place the insertion point in the single cell you wish to color code. Or
drag to select a range of cells. 

2. Click the paint bucket icon in the Change area and choose a color. Or
drop the Change menu and choose "Cell Background Color".

 

Note the distinction between two related features. You can highlight
(color code) sheet names in the navigator, and you can also color code
the background of selected cells in data and results tables. 

12.7 Highlighting sheets in the Navigator tree

Highlight a sheet name to remind yourself to go back to it, or to flag
sheets you want a co-worker to view. You can choose among seven
colors.

Select a sheet in the Navigator, or several sheets in the Gallery , and
click on the Highlight button on the Sheet toolbar. Click on the highlight
button itself to use the same color as last time, or click the arrow to
choose a color.
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12.8 Grouping related sheets

Prism offers no way to create subfolders or to group sheets within a
section (except by color coding  them). But one of our customers came
up with a clever workaround. He creates extra data tables or graphs
(which can be ignored) and renames the sheet title to "-------". This has
the effect of dividing a long list of sheets into sections.

 

192
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12.9 Preferences

Overview

Use the Preferences dialog to set Prism's defaults for various settings.

Note that some preference settings are made elsewhere in Prism. The
import  (paste special) dialog, the export graph , and the diagnostics
tab of nonlinear regression, for example, all have check-boxes to make
the current settings default for the future.

Also note that on Macs, there are two settings in the General tab of the
System preferences  dialog that have a big effect on how Prism works. 

To open the Preferences dialog, drop the Edit menu (Windows) or Prism
menu (Mac) and choose Preferences.

Most of the settings are self explanatory. The rest of this page discusses
the settings that are not entirely self-explanatory.

View tab

· Reset zoom. If you zoom to make a graph or layout larger or smaller
and then view a different graph or layout, what happens? Keep the
same zoom, or reset to a default zoom? 

· Antialiasing. Prism uses antialiasing to improve the appearance of
graphs on screen. When curves or lines are drawn in black on a white
background, antialiasing fills in gray pixels in the corners to reduce the
jagged look. Prism Mac gives you no choice. Prism Windows offers an
option to turn of antialiasing, which improves the look on some old
computers. Note that antialiasing only affects the appearance of graphs
and layouts on screen those exported or copied in EMF+ format, but has
no effect on the appearance of printed graphs or those exported in
WMF, EMF(old), PDF, EPS, PNG or JPG formats.

· Default fonts.

280 585
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· Inches or cm?

· Autocomplete titles after you type the first few characters?

· Show alerts on graphs with missing error bars, points off scale, etc. ?
Untl Prism 7, these alerts tended to be long and a bit annoying. Prism 8
makes then much shorter, but you can turn them off altogether if you
want to.

File and Printer tab: Automatic backup

Choose to backup whenever you move to a different sheet and by timer
every K minutes (you specify K). For Windows, you can also ask Prism to
backup files when you close a file and choose not to save it (it will show
on Welcome dialog).

Read more about autobackup . 

File and Printer tab: File format

· Default to saving in PZF orPZFX format.

· If you use PZF format, do you want to use the compact style? All this
format does is leave out analysis results (and instead recomputes them
when you open the file).  It makes the file a bit smaller, but PZFX files
are way smaller. PZFX files never include analysis results which always
need to be recalculated when you open the file. 

File and Printer tab: Print options

· When Printing tables, choose whether to print grid lines and column
titles.

· For all printing, deciding whether you want a header with file name,
date and time. 
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File and Printer tab: Copy to clipboard options

· How to copy graphs and layouts to clipboard (Windows). Prism gives
you a choice of three formats: WMF, EMF (old) and EMF+. In theory,
EMF+ is the best because it is newest. But it all depends on which
application you are pasting into. You may need to experiment. 

· How to paste a graph from another project (Mac). Choose whether the
pasted image needs to be Windows compatible (which increases file
size, and on slow computers may noticeably delay pasting). 

· When copying a graph or layout, include the background color or not. If
you choose not to include the background color, the background will be
clear (transparent). How that looks depends on what you are pasting
onto. This option applies when copying a graph or layout to the
clipboard. If you use Send to Powerpoint instead, Prism always makes
the graph or layout transparent so the PowerPoint background shows
through. 

· When copying numbers, what to do with missing values. They can be
left blank, be pasted as numbers followed by an asterisk, or pasted as
regular numbers. 

· Use comma or period as the decimal separator.

· When copying numbers where Prism knows more decimal places than it
shows on screen, paste all the digits or just those shown on screen.

New Graphs tab

Set defaults for axes, error bars, symbols and lines, color schemes, and
graph and data table fonts. These defaults apply to newly created graphs,
but don't change existing graphs. 

http://www.graphpad.com/support/faqid/955/
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Analysis tab

Most analysis options are set on the various analysis tabs which have a
check box to make those settings the default for future analyses. Not all
anlayses, and not all tabs in the analysis dialogs offer this choice. 

There is only one choice in Preferences. Many analysis tabs give you a
choice for how to format P values. These choices offer a choice to show N
digits after the decimal, where you set N. The preference tab lets you
choose the default N and to choose when/if to use scientific notation.

Info sheets tab

Choose whether to create an Info table  (for entry of meta data and
notes) for each new data table, and what items to include by default. 

File locations

Set the default location for saving Prism files, for importing/exporting
data, importing/exporting graphs and layouts, scripts and templates.
Note that templates are saved to, and read from, folders within the folder
you specify but not in that folder itself.

Send to Office (Windows only)

Prism has buttons to send a graph or layout to Word or PowerPoint, and
you can set several options for how this is done.

Services tab 

Option to automatically check for updates and let you know if there is
one. Also an option to create an extended log file to troubleshoot unusual
problems.

12.10 Tips for navigating large projects

A Prism project file can have up to 500 data tables, info tables, analyses,
graphs and layouts. Lump lots of data into one file? Or split into many
files? The choice is yours. If you prefer to create large projects, use these
tools to navigate:
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Use the bottom toolbar

Browse the sheets sequentially.

Ping pong between any two sheets. Click once to go back to the previous sheet. Click
again to return.

Pick from a menu of sheets linked to the current sheet, or use the five tabs to jump
between sections.

Navigate within sheets in a family

At the bottom of the Navigator tree, you'll find links to all the sheets in
the current family . When you select a sheet in any section of the
Navigator, all the related sheets -- data tables, graphs, info sheets,
results, and layouts will be grouped and shown in the Family section.

Navigating in the family pane is especially useful when working with a
project with lots of sheets. It lets you move between related sheets
without scrolling the Navigator.

Working with chained analyses

Prism lets you chain analyses. For example, you can first transform data,
then normalize the transformed data, then fit a curve to the normalized
results, and finally run a normality test on the residuals from the curve
fit. The family pane at the bottom of the navigator always shows analyses
indented under the table being analzed.
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Use the Search tool

Use the search tool above the navigator to find pages (sheets) with
certain text. The results will appear in the Navigator. Prism searches for
the text you entered in titles, floating notes, sheet names, and more. It
only searches within the current file, and does not search within other
files that might include the search text.

         

Click the close X button in the search area to return to the usual
navigator.

Navigator tool tips

If you've got lots of sheets in a project, and you're not sure which one
you are looking for, hover your mouse over any sheet name in the Prism
Navigator  to display a thumbnail of the sheet.

Highlight or move selected sheets

If you identify certain sheets that you want to go back to frequently:
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· Highlight  the sheet name in a color you choose. Use the highlight
button in the toolbar, or right click on the sheet in the navigator and
highlight from there. 

· Move  them to the top of the list in the navigator. Just drag and drop. 

12.11 Tips to avoid the need for large projects

Delete sheets you don't need

As you work on a project, you might accumulate graphs and analyses
which you don't need. Keeping them in the project adds clutter and
makes it harder to find the sheets you want. Delete them . 

Save families of sheets

If a file is large, consider breaking it into smaller projects. You can save
any family of sheets as a new project. Find the command "Save Family
As" on the File  menu. 

Merge Prism files 

If you later want to merge two files, that is straightforward. Use the
Merge command on the File menu. 

Place a graph from one project on a layout of another

You can  place a graph from one project onto a layout of another project.
There are two ways to do this:

· Double click on a placeholder in the layout, and choose a graph from
another open project. 

· Copy the graph from one project, go to the layout of another project,
make sure no placeholders are selected, and paste. Prism will give you
three choices:to paste a picture, paste a hot link, or to paste merge, so
the entire family of the pasted graph is merged in. 
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13 Data tables

 

Unlike Excel or most other graphics programs,

Prism's data tables are formatted. In most cases,

the first column is for X. The rest of the columns



GraphPad Prism 8 User Guide202

© 1995-2020 GraphPad Software, LLC

are for Y values, and these can be divided into

subcolumns for entry of error bars.
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13.1 Distinguishing the eight kinds of data tables

Unlike the data tables of most programs, the data

tables in Prism have a format or structure. There

are eight different kinds of tables, and it is

essential that you pick the right one for your data

and experimental design.
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13.1.1 Key concept -- data tables

Choosing among the eight kinds of data tables is important

The format of a Prism data table determines what kinds of graphs you can
make and what kind of analyses you can perform. Choosing the right kind
of table for your data is really important. Take the time to get this right. 

Don't try to choose the right kind of table for your data by thinking about
the kind of graph you want to make. That approach will end up confusing
you because there isn't a one to one match between table and graph
types. For example,  you can make a bar graph from five kinds of
tables , and a graph showing points (a scatter graph) from three kinds
of tables . You need to choose a table based on the organization of the
data and the analyses you wish to perform. 

Prism projects can have many data tables

You are not limited to one data table per file. Store an entire project in
one file, creating as many data tables as you need.

Prism can compute error bars

Prism can plot error bars from raw data. You don’t have to enter SD or
SEM values, although you can.  

13.1.2 Prism's eight data table formats

The format of a Prism data table  determines what kinds of graphs you
can make and what kind of analyses you can perform. Choosing a data
table format lets Prism create a data table that fits your data and makes
it easy to create the kind of graph you want and perform the appropriate
analyses. You can always change  the format of a data table.

The eight kinds of data tables

XY tables  - An XY table is a graph where every point is defined by both
an X and a Y value. This kind of data are often fit with linear or nonlinear
regression.
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Column tables  - Use column tables if your groups are defined by one
scheme, perhaps control vs. treated, or placebo vs. low-dose vs. high-
dose. Each column defines one group.

Grouped tables  - The idea of two-way variables is best understood by
example. One grouping variable (male vs. female in the example below)
is defined by rows; the other grouping variable (control vs. treated) is
defined by columns.

Contingency tables  - Contingency tables are used to tabulate the actual
number of subjects (or observations) that fall into the categories defined
by the rows and columns of a table.
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Survival tables  - Survival tables are used to enter information for each
subject. Prism then computes percent survival at each time, and plots a
Kaplan-Meier survival plot (and also compares survival with the log-rank
and Gehan-Wilcoxon tests).

Parts of whole tables  - A Parts of whole table is used when it makes
sense to ask: What fraction of the total is each value? This table is often
used to make a pie chart. The example below shows the number of
students who received grades of A, B, C, etc. The sum of the five values
in the table (61) is the total number of students.
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Multiple variable tables . A multiple variable table is arranged the same
way most statistics programs organize data. Each row is a
"case" (experiment, animal, etc.). Each column is a different variable.
There are no subcolumns in multiple variable tables. 

Nested tables . A nested table is used when there are two levels of
nested or hierarchical replication. In this example, there are two
treatments given to three rats each and the outcome variable was
measured four times in each rat.
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13.1.3 XY tables

In an XY table, every point is defined by both an X and a Y value.

Analyses performed with XY data

· Nonlinear regression (curve fit)

· Linear regression

· Fit Spline/LOWESS

· Smooth, Differentiate or Integrate Curve

· Area Under Curve

· Deming (Model II) Linear regression

· Correlation matrix

· Correlation XY

· Interpolate a Standard Curve
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Example of an XY table

§ The first optional column is for row titles  to label individual
subjects or samples.

§ The next column ("X") is for X value. There is only one X column per
table. If you choose to enter X error values, then there will be two
subcolumns (one for X, one for the error value). 

§ Each remaining column ("A", "B", ...) defines a treatment group.

§ Subcolumns  are for replicates in a treatment group. Prism uses
these to calculate error bars.

§ Blank cells represent missing values.

§ Blue italics values are excluded  from graphs and analyses.

§ An XY data table can contain 256 data set columns and as many as
256 sub-columns.

§ XY tables can be configured to enter dates or times into the X
column, instead of numbers. Choose when you create table. 

Error bars

Prism will compute and graph error bars from replicate values placed in
side by side subcolumns as shown (triplicate values) in the table above.
Specify the number of subcolumns when you create a new XY table.
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You can also choose to create subcolumns formatted for entry of error
values computed elsewhere.

Prism can also plot horizontal X error bars . You must enter X error
values directly; Prism cannot compute them. You can only enter one
value for X errors, so X error bars are always symmetrical.

Entering multiple sets of data that don't share X values

Each data table has a single column for X and up to 104 sets of Y values.
What should you do if you have different X values for each set of Y
values? There are two ways to solve this problem.

The best approach is to stagger the data entry. You don't have to start
entering data in the first row. This example shows three data sets with
different X values.

An alternative approach is to enter each data set on a different table. The
disadvantage with this method is that you lose some analysis choices.
You must enter all the data sets on one table in order for Prism to

378
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compare linear regression lines, to compare best-fit values from nonlinear
regression, and to compare survival curves. Another minor disadvantage
is that Prism will automatically make a different graph for each table.
However, you can delete the unneeded graphs and include data from all
the data tables on a single graph.

Entering error values for X error bars

If you choose to enter X error values, the table will include a subcolumn
for that purpose. You can only enter one error value for each X. Prism
doesn't know if it is a SE or SD or something else. It just plots what you
enter. You cannot enter two error values to create asymmetric X error
bars. The X error values never enter into any calculations. 

What happens if you enter X values into the row title column of a Grouped
(or XY) table?

Possible point of confusion. A Grouped table has a column for entry of row
titles. Prism sees these as titles or labels, even if you enter numbers in
every row. The table below if a Grouped table with no X column. Note that
there is no heading "X" and that the labels (numbers) entered in that
column are left justified (X values would be right justified). Also note that
the values are equally spread across the X axis. Prism doesn't "know"
these labels are numbers, so doesn't use the value as a X coordinate. 
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13.1.4 Column tables (one grouping variable)

In a column data table, each column defines a group. These groups are
defined by one scheme, perhaps "control vs. treated." You can have more
than two groups in a one-way table, for example "placebo vs. low-dose vs.
high-dose.

Analyses performed with Column data

· Unpaired t test

· Paired t test

· Ratio-paired t test

· Mann-Whitney test

· Wilcoxon test

· Kolmogorov-Smirnov test

· Ordinary one-way ANOVA

· Brown-Forsythe and Welch ANOVA

· RM one-way ANOVA
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· Kruskal-Wallis test

· Friedman test

· One sample t and Wilcoxon test

· Descriptive Statistics

· Normality and Lognormality Tests

· Frequency Distribution

· ROC Curve

· Bland-Altman

· Identify Outliers

· Analyze a stack of P values

Example of a column table

•

· Each column defines a treatment group.

· Prism does not use a separate column to enter the grouping variable.
Instead the groups are defined by columns.
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· If data are not matched or paired, rows have no special meaning. Enter
data in any order you like.

· If data are from a before-after experiment with clear pairing or
matching, place each set of matched results on one row. Optionally, use
the row title to label it.

· Blue italics values are “excluded” (ignored by analyses and graphs). Use
Exclude Values.

Error bars

For one-way tables, Prism will calculate error values and create error
bars automatically. Enter all the values for a data set in a single column.

13.1.5 Grouped tables (two grouping variables)

The idea of grouped variables is best understood by example. One
grouping variable might be "male vs. female"; the other grouping variable
is "control vs. treated." Every data point you collect is categorized by
both grouping variables: "male vs. female," AND "control vs. treated." A
two-grouping variable table and graph is used to tabulate outcomes that
are measurements such as weight or blood pressure, often with error
bars.
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Analyses performed with Grouped data

· Two-way ANOVA (and mixed model)

· Three-way ANOVA (and mixed model)

· Row means with SD or SEM

· Multiple t tests - one per row

Example of a grouped table

Notes:

· Unlike other programs, Prism does not use separate columns to enter
grouping variables. Instead, groups are defined by rows and columns.

· The rows categorize the data by one grouping variable (men vs.
women).

· The columns (datasets) categorize the data by the other grouping
variable (control vs. treated).

· Blank cells represent missing values, which Prism handles properly. If
you are doing repeated-measures ANOVA, however, you can't have any
missing data values unless an entire subcolumn is empty.

· Blue italics values are “excluded” (ignored by analyses and graphs). Use
Edit… Exclude values.

· A grouped data table can contain 256 data set columns and as many as
256 sub-columns
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Error bars

Prism will compute and graph error bars from replicate values placed in
side by side subcolumns as shown (duplicate values) in the table above.
Specify the number of subcolumns when you create a new table.

You can also choose to create subcolumns formatted for entry of error
values computed elsewhere.

 

13.1.6 Contingency tables

What is a contingency table?

Contingency tables are used to tabulate the actual number of subjects
(or observations) that fall into the categories defined by the rows and
columns of a table.

The rows and columns can be defined in different ways, based on
experimental design.

· Prospective: You choose subjects based on exposure, from which you
define the rows. Each column represents a different outcome.

· Retrospective (case-control): Each column represents a different group
of subjects, identified based on presence or absence of disease. Each
row represents a different exposure they have had in the past.

· Experiment: Each row represents a different treatment group. Each
column represents a different outcome.

· Cross-sectional: You select a group of subjects, and then categorize
them by exposure (different rows) and disease (different columns).
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Analyses performed from a contingency table

· Chi-square and Fisher’s exact test (also computes odds ratios and
relative risk)

· Fraction of total

Example of a contingency table

The rows represent two different treatments. The two columns represent
two alternative outcomes. Each value is the actual number of subjects (in
this case; in other cases, the values may represent number of objects or
events). 

It is essential that you enter the actual number of subjects (objects,
events...) that you counted. Do not enter normalized values or
percentages. Since the values are counts, they cannot be negative and
must be integers. Prism won't let you enter a minus sign or decimal point
or create subcolumns. If you need to enter fractions or negative numbers,
or create a table with subcolumns, use a Grouped table  instead. 

13.1.7 Stacked vs. side-by-side replicates

Note that replicates are arranged differently on different kinds of data
tables.

· With XY and Grouped tables, replicates are entered into side-by-side
subcolumns.

· With Column tables, replicates are stacked into columns.

214
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· With Nested tables, replicates are stacked into subcolumns.

· When entering data on Contingency, Parts-of-whole, Survival and
Multiple Variable tables, you never enter replicate values so this
distinction is irrelevant. 

13.1.8 Survival tables

On a survival table, you enter information for each subject. Prism then
computes percent survival at each time, and plots a Kaplan-Meier
survival plot (and also compares survival with the log-rank and Gehan-
Wilcoxon tests).

Analyses performed with survival data

There is one survival analysis in Prism that gives you choices for any of
these analyses:

· Kaplan-Meier

· Log-rank test

· Wilcoxon-Gehan test
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Example of a survival table

Each row represents a distinct subject. (You can optionally use row titles
to identify the subjects.) Each column represents a treatment.

Notes:

· Enter elapsed time (usually in days) as X (Prism does not let you enter
dates).

· For each subject, enter a code for Y:

· Enter ‘1’ for a subject if the event (death) occurred at the time entered
into X.

· Enter ‘0’ if the data are censored. Data are censored when you simply
don’t know what happened to the subject after that time, or do know
but can’t use the information.
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· You'll find a more complete discussion of entering survival data and
interpreting the results in the statistics guide. 

Error bars

When Prism plots a survival curve, it can include SE or 95% CI error bars.
These are computed as part of the Kaplan-Meier method for creating the
survival curve. You can't enter error values directly -- they are computed
from all the data.

13.1.9 Parts of whole tables

A Parts of whole table is used when it makes sense to ask: What fraction
of the total is each value? This table is often used to make a pie chart.

Analyses performed on parts of whole data

· Fraction of total

· Chi-square goodness of fit (compare observed distribution with
theoretical distribution)

Example of a Parts of whole table

The example below shows the number of students who received grades of
A, B, C, etc. The sum of the five values in the table (61) is the total
number of students.
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You can enter data onto as many columns as you want. But note that only
the values entered into column A will be automatically graphed. Use
New...Graph to plot other columns.

13.1.10 Multiple variable tables

A multiple variable table is arranged the same way most statistics
programs organize data. Each row is a "case" (experiment, animal, etc.).
Each column is a different variable. There are no subcolumns in multiple
variable tables. 

Analyses performed on multiple variable data

· Correlation matrix

· Multiple linear regression

· Extract and rearrange portions of the data onto a new table

· Transform and select

· Identify outliers

· Descriptive statistics

Example of a multiple variable table

The example below shows the first few rows of data from a clinical trial
about diabetes. Each row represents one person studied. Each column is a
different variable measured. 
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Prism does not automatically graph these kinds of tables, because there
is too much data. 

Prism requires that you enter numbers only. If one column encodes sex,
you must enter codes (say 0 for female and 1 for male). You can't enter
"male" or "female" directly on a Prism table. 

.

13.1.11 Nested tables

Overview of nested tables

Prism 8 introduces a new kind of data table for nested data where values
stacked in each subcolumn are related, and lets you graph these
sensibly. In this example, there are two treatments given to three rats
each and the outcome variable was measured four times in each rat.

Analyses performed from nested tables

· Nested t test

· Nested one-way ANOVA

· Descriptive statistics (separate results for each subcolumn)

· Normality (and lognormality) tests (separate results for each
subcolumn)>

· Outlier tests (separate results for each subcolumn)

· One-sample t test (separate results for each subcolumn)
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Example of a nested table

Each nested table must have at least two subcolumns. It is not possible to
enter averaged data (mean, sd, n...). Error bars on graphs are computed
from a stack of values in the same subcolumn.

13.1.12 The difference between nested and grouped tables

Nested  and Grouped  tables look very similar. Both have subcolumns
and no X column. But they are used in very different ways. 

The key point is the arrangement of replicates:

· In a Grouped table, replicates are placed in side by side subcolumns.

· In a Nested table, replicates are stacked into subcolumns.

We suggest you use the tutorial data sets and pay attention to how the
data arrangement matches the experimental design. 
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13.2 Creating data tables

How to create data tables.

13.2.1 How to create a new data table

A Prism project  can contain many data tables.There are three ways to
create a new table

117
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New button

Click the new button from the Sheet section of the Prism toolbar (or drop
the Insert menu) and choose New Data Table and Graph. 

The New Data Table and Graph dialog looks a lot like the Welcome
(File..New) dialog (with fewer choices). Choose which of seven kinds of
data tables  you want, and whether to start with an empty table or use
sample data. If you choose to create an XY or Grouped table and are not
using sample data, you'll also need to decide about subcolumn format. 

From the navigator

New to Prism 8, click a link in the navigator to create a new sheet.
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Duplicate an existing table

To duplicate an existing table, to to that table, drop the Insert menu or
click the New button and choose Duplicate Current Sheet

13.2.2 Creating a table to create a bar graph

Prism offers eight distinct types of data tables. Five of these can be used
to create bar graphs, as detailed below. If you want to create a bar
graph, it is important to choose the kind of data table that matches your
data.

Column graphs

Enter data for each group into its own column, stacking replicates (if
any). Each column then becomes a bar, and you'll be able to control the
appearance of each bar individually.



Data tables 227

© 1995-2020 GraphPad Software, LLC

Note: If you want to create a graph like the one above, but you've already
calculated your mean and error values, start instead with a Grouped table
(see below) and use only the top row.

Grouped graphs

Each column represents a different kind of bar. Each row is a different
instance of that bar. Enter replicates (if any) in side-by-side subcolumns,
or format the subcolumns for entry of mean, n and SD or SEM. So if you
have two Y data set columns and four rows, you will have two kinds of
bars, and you can choose the color, fill, and border of each. You will have
four different bars of each type. You can choose whether you want the
bars interleaved, stacked, or separated.
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Contingency tables

A contingency table is like a grouped table but doesn't have subcolumns
for replicate values.
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Nested bar graphs

Each subcolumn becomes a bar, shown here with mean and SD.

XY Bar graphs

Both the kinds of bar graphs mentioned above place the bars on the
graph in order, with equal spacing. In some cases, you want to position
each bar along the X axis with the position determined by an X coordinate
you enter. To make this graph, choose the Spikes graph in the New Graph
dialog.
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Settings in the Format Graph dialog also let you make this graph.
Uncheck the option to "Show Symbols" and check the option to "Show
bars/spikes." 

13.2.3 Creating a table to create a scatter plot

Prism offers seven distinct types of data tables. Three of these can be
used to create scatter graphs.

XY scatter graphs

With an XY data  table, each X value can have several replicates for
every data set. When you make your graph, you can choose to show all
the replicates on your graph instead of error bars. Start with an XY table
if you want to show all your replicates for each X value.
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Here is the data table for the graph above.

To format an XY graph to show each data point as in the graph above,
click on the Format Graph button on the toolbar, select Global to choose
all data sets, and choose to Show each Replicate. To show mean and
error instead, choose Mean and Error from this drop-down menu instead.
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Column scatter graphs

If you want to compare groups and show every data point along with lines
for mean and error for each group, start with a column table. All the data
values for each group should be entered in a single column.

To make the graph above, start with a Column table  and enter all the
data points for each data set in a column. Prism will create error bars
from all the data points in each column.

If you instead want a graph that shows only the mean and error for each
data set, double click on any data point to open the Format Graph dialog
and choose "One symbol per column" and the type of error you want to
show.
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Grouped scatter graphs

If you want to create a scatter plot comparing groups by more than one variable, enter data on a
Grouped data table with side by side replicates.

Here are the data plotted as an interleaved graph:

You can also choose to superimpose the groups:
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13.2.4 Creating a table to combine bars and points

Prism offers three ways to create graphs that combine points and bars.

XY

Create an XY graph and then tell Prism to plot a data set (or several) as
spikes or bars. Detailed instructions to create the graph below. 

http://www.graphpad.com/support/faqid/1469/
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Grouped

Create a grouped bar graph, then tell Prism to plot one data set (or
several) as points. Detailed instructions for creating the graph below. 

Create two graphs and superimpose them on a layout

A third approach to getting bars and points on what appears to be one
graph is to create one XY graph and one column graph, and then tell
Prism to superimpose them on a page layout. Detailed instructions to
create the graph below. 

http://www.graphpad.com/support/faqid/1661/
http://www.graphpad.com/support/faqid/1646/
http://www.graphpad.com/support/faqid/1646/
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13.2.5 Inserting a series

Often you'll want your X column of an XY table to be a regular series of
values. Prism offers two ways to do this.

Using the Insert Series command

Follow these steps to insert an arithmetic or geometric series:

1. Place your insertion point in the first cell of the series. Alternatively
select the entire range that you want to contain the series. 

2. Drop the Insert menu and choose Create Series... Or click the
corresponding button in the Change portion of the toolbar.

   

3. Enter the number of values you intend the series to have. If you
preselected a range of values, Prism will default to the number of rows
in that range. Also enter the first value, and the rule to increment other
values. 
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Notes:

· You'll usually want to create a series in the X column of any XY table,
but you can insert a series in any column of any table. 

· If you select an entire column before bringing up this dialog, the dialog
will default to creating a series with 500,000 values. This can take a
while. Adjust the value a reasonable number. 

Turn the X column into a series

This option is a carryover from prior versions of Prism, and we suggest
you use the Insert Series command instead. 

To turn the X column into a series:

1. Create a new XY table.

2. Enter at least one Y value or column titles so the table is not
completely empty. 

3. Click the Table Format button at the upper left of the table, or drop
Change and choose Format Data Table.

4. Choose to generate X values, and enter the starting value and
increment.
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Notes:

· On older versions of Prism, you were able to define this series at the
time you created the table. With Prism 6, you can no longer do this. You
must first create the table, and then use Format Data Table to define
the series.

· When you define the X axis to be a series, Prism will delete any X value
you had entered into the X column without asking for confirmation.

· With this method, the entire X column becomes a nearly infinite series.
You cannot tell Prism where to stop the series.

· With this method, the series is always arithmetic -- each value is
computed by adding a constant increment to the prior one. Use the
Insert Series dialog to create a geometrical series — each value is
computed by multiplying a constant factor times the prior one.

13.2.6 Data table limits

You can have up to 500 data tables in your project. Each data table can
contain:
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· Any number of rows (limited by RAM and hard disk space). We've tested
hundreds of thousands of rows.

· Up to 256 data set columns. Prism 5 only allowed 104.

· Up to 256 subcolumns. Prism 5 only allowed 52.

If your table has more columns or subcolumns that Prism 5 can handle,
the table will simply not be included when you open the file in Prism 5. 
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13.3 Editing data tables

How to edit data tables.

13.3.1 Changing a data table format

The choice you make about how to format your data table is important. If
you don't choose the appropriate kind of data table, you won't be able to
make the kind of graph you want or perform the analyses you have in
mind.
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For XY tables Prism uses subcolumns replicate data. If your table needs
more subcolumns you can always change the number of subcolumns
(replicates) in a data table. Or, if you entered already-calculated error
values but your table is labeled wrong (say you actually entered SD, but
the table is formatted for SEM, you can make the switch.

To change the format of a data table, Click on the Table format area in
the upper left of a data table.

Alternatively, click on the Table Format button  on the Change toolbar.
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If you want to change the type of error bars displayed on your graph, you
don't need to change the data table. Instead, double-click on any data
point on your graph to open the Format Graph  dialog and use the drop-
down menu to change the error-bar format.
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13.3.2 Entering dates or elapsed times as X

Formatting the table to enter dates or times as X values

From the Welcome or New Table dialogs, you can choose to format the X
column for entry of dates or elapsed time instead of X values. 

If you forgot to format the table when you created it, use Change..Format
data table to format the X values for dates or times.
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Entering times or dates

If you choose elapsed time, enter time as hh:mm or hh:mm:ss. For
example, enter 1:12:30.2 to enter an elapsed time of 1 hour, 12 minutes,
30.2 seconds. 

If you chose to enter dates, you can enter dates in almost any format.
Prism will figure out what you meant and display the date on the table in
a standard format (that you cannot change). The only ambiguity is if you
enter a date like 1/2/2014 or 1-2-2014. Is that January 2 or February 1?
The convention depends on where in the world you live. Make your choice
on the bottom of the View tab of the Preference dialog. 

If you enter a year with two digits, Prism Windows follows the choices
made in the Date tab of the Additional Settings dialog, accessed from the
Format Tab of the Regional settings control panel. 
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When Prism shows a ? in the data table

If Prism doesn't understand the date or time you entered, it will show ? in
the data table. This is treated as a missing or blank value for graphing
and analyses. When you click on the cell to edit, Prism will show you
exactly what you entered for editing. 

Converting dates or times to values for analyses

When you analyze these data and make some kinds of graph, Prism
converts the dates or elapsed times to values. Choose the units and (for
dates) starting date on the Format Data Table dialog . Note that the
choice of months is not offered, because months have different lengths.
Years also have different lengths, so if you choose years, Prism does the
conversion based on 365.25 days per year.

Formatting dates and times on the graph

The Format Axes dialog will present several choices for numbering
format. 
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13.3.3 Column titles

Why use column titles?

Column titles are used to:

· Identify data sets on a data table.

· Identify data sets when choosing analyses and viewing results.

· Labeling the X axis of Column (and sometimes) grouped graphs. 

· Creating legends for XY and Grouped graphs.

How to edit column titles

Click on the column title and edit. You can  bold, italicize, and underline
text in titles and can insert superscripts, subscripts and Greek letters.

Enter two or three line row titles and column titles

You may enter two or more lines of text for each column title. 

To add an additional line of text to the title click the Line Break symbol or
press the key combination Shift-Enter to move to the next line.



Data tables 247

© 1995-2020 GraphPad Software, LLC

View and edit all the column titles at once

To view and edit multiple column titles at once, click on the Format Data
table button in the upper left corner of the data table and choose the tab
for column titles. If your table has many subcolumns, this is the best way
to edit column titles. Shortcut: Bring up this dialog by double-clicking in a
one of the column titles on the data table.

Autocomplete

Prism uses autocomplete to help you. It tries to guess what you are
typing, and let's you choose from a list of titles you've used before. If you
find this more annoying than helpful, turn it off in the View tab of the
Preferences dialog.

To see the full list of autocomplete entries, while your insertion point is in
a column title, hold Alt (Windows) or Option (Mac)and then press Page
Down. Next to each entry is a X icon that let's you delete that title from
the list. 

13.3.4 Subcolumn titles

XY and Grouped tables can be formatted to have side-by-side
subcolumns. These subcolumns can be created to hold preaveraged data,
perhaps entering mean, SD and n. In these cases, the subcolumns are



GraphPad Prism 8 User Guide248

© 1995-2020 GraphPad Software, LLC

labeled. In other cases, you create side by side subcolumns for entry of
replicate values. By default these are labeled "Y1", "Y2", etc. 

Prism lets you you change these labels. Use Change... Format data table
and go to the third tab. You'll see the subcolumn tab of the Format Data
Table dialog.

Shortcut: Double click on any subcolumn tiltle (A:Y1 or B:Y2..).

If you check the option on top of the dialog, the titles you enter will
appear on the data table. 

Notes:

· Choose between entering one title for every subcolumn for every data
set column (as above) or just a single set of subcolumn titles that apply
to all data sets. If you chose the latter choice with the example above,
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you'd enter only three subcolumn titles and these would be repeated for
each data set. 

· Controls are provided in the toolbar of the dialog to enter greek letters
and math symbols (etc.) and to enter super and subscripts.

· If the titles you enter are very long, you may wish to uncheck the top
option. This will leave the table labels as "Y1", "Y2", etc. 

13.3.5 Row titles

Why use row titles?

Row titles have four purposes:

· Label unknowns in standard curves -- the labels will propagate through
to the standard curve (interpolated values) results.

· Label individual points on an XY graph.

· Label groups in a grouped data table.

· Label subjects on a column table plotted as a before-and-after graph.

Show or hide the row title column 

If you don't see a column for row titles, click on the Table format area in
the upper left of a data table to open the Format table dialog. Choose to
"Show row titles."

To hide the row title column, click the X at the top of the Row title
column.
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Enter two or three line row titles and column titles

You may enter two or more lines of text for each row title. This is new to
Prism 6. You may also now bold, italicize and underline text in titles (you
could always use superscript, subscripts and Greek).

To add an additional line of text to the title click the Line Break symbol
or press the key combination Shift-Enter to move to the next line.

Autocomplete

Prism uses autocomplete to help you. It tries to guess what you are
typing, and let's you choose from a list of titles you've used before. If
you find this more annoying than helpful, turn it off in the View tab of
the Preferences dialog.

To see the full list of autocomplete entries, while your insertion point is
in a row title, hold Alt (Windows) or Option (Mac)and then press Page
Down. Next to each entry is a X icon that let's you delete that title from
the list. 

Showing row titles on a graph

Double click on any symbol to open the Format Graph dialog and choose
"Label each point with its row title". Double click on any row label to
change the font of all the labels. You can also delete individual labels or
drag them to a new location.
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13.3.6 Sorting data

Reordering XY data

If you choose connecting lines on an XY graph, Prism connects the points
in the order they appear on the data table. If the data are not sorted on
the data table, the connecting lines will jump back and forth across the
graph. If you want the connecting lines to go from left to right across the
graph, first sort the data table by X values. Click on the Sort Rows
button on the Change toolbar, and sort by X value.
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Reordering Grouped data

Distinguish two ways to reverse order on a Grouped graph.

Reverse the order of rows

Click on the Sort Rows button on the Change toolbar, and reverse the
order.

This example shows the effect of reversing the order of the rows in the
data table.

Reverse the plotting order of data set columns

Grouped tables are defined by two grouping variables. If you want to
reverse the order of how the columns are graphed, you don't need to
change the data table. Instead, go to the graph and click the Change
data set order button. One of the choices on its menu reverses the order
of data sets.
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This example shows the effect of reversing the plotting order of data
sets. Note that this example starts with the same graph as the prior
example.

 

13.3.7 Changing data table column widths

To adjust the width of a column, click anywhere on a column border and
drag. If you first select several columns, dragging the border of one
column will change the width of all selected columns. Prism determines
the width of subcolumns (replicates) automatically, and you cannot
change these widths individually. To make all larger or smaller, resize
the main column.

13.3.8 Specifying decimal places in a data table

Decimal format
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Prism automatically chooses the number of decimal points to display in a
data table automatically.

To change the number of decimal points displayed, Select the column or
columns you wish to change (click at the top of the column to highlight),
and click on the Change decimal format button of the Change toolbar. 

Notes:

· When you place the insertion point (click the mouse cursor) in a
particular cell in a data table, Prism expands that value to show all
digits. When you move to another cell, the value reverts back to the
selected numerical format.

· It is not possible to change decimal format of a contingency table or
the Y values in survival tables, since all values must be integers.

· You can only change numerical format for an entire column (or
several columns). It is not possible to change the numerical format
of individual cells.

Decimal separator

In some parts of the world, a period (point) is used as the decimal
separator. In other parts of the world, a comma is used.

When entering data into Prism, you can use either a period or a comma to
mark the decimal point.

When exporting data, Prism uses the separator you choose in the Export
dialog. When pasting data, Prism uses the separator set in Preferences .

When importing data , you can specify how a comma is interpreted (as
a decimal separator, as a thousands separator, or to separate columns of
data).

Changing the number of decimals shown vs. the number Prism stores

Using the Decimal Format dialog simply changes the number of digits that
Prism displays on the screen. It always stores as many as possible, and
will include all these if you export or copy the data. 

194

280



Data tables 255

© 1995-2020 GraphPad Software, LLC

If you want to truly round the values to a certain number of digits after
the decimal, you need to round the numbers to a specified number of
digits . 

13.3.9 Excluding or highlighting values

Excluding values from data tables

If a value is too high or too low to be believable, you can exclude it.
Excluded values are shown in blue italics on the data table, but are not
included in analyses and are not shown on graphs. From the point of
view of analyses and graphs, it is the same as if you had deleted the
value, but the number remains on the data table to document its value.

To exclude selected values, Click the Exclude button from the Change
toolbar.

The excluded values appear in blue italics, followed by an asterisk.

Choose on the File & Printer tab of the Preferences dialog how excluded
values should appear when copied to the clipboard. Your choices are to
copy a blank value (as if missing), a regular number (ignoring the fact
that the value is excluded) or a value followed by an asterisk (to match
what you see). Prism offers the same choices on the Export dialog to
control how excluded values are exported to .TXT or .CSV files. 

Instead of manually choosing points to exclude, you can ask Prism to
perform outlier elimination.

260
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Highlighting values

Select a cell or a range of cells. Then click the paint bucket icon in the
Change part of the toolbar, or drop Change and choose Cell Background
Color. You can choose from eight colors to mark values that you want to
double check, or to color code different aspects of an experiment.

    

Don't confuse highlighting cells in a data (or results) table from
highlighting sheet names in the navigator . 

13.3.10 Deleting or removing entire data sets

Deleting values only

To remove values from the data table, select then and then press the
Delete key. 

Removing entire data sets

To remove a data set from a Graph, click on the Add/Remove data sets
button from the Change toolbar. Alternatively, double click on a graph to
bring up Format Graph, and then go to the second tab. Select the data
set to remove.  
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To remove a data set from a Results sheet, click on the Analyze different
data sets button from the Change toolbar, and uncheck the data sets you
do not wish to include in the analysis.

13.3.11 Missing values

When entering data, simply leave a blank spot for any value that is
missing. Excluded values  are treated exactly the same as missing
values.  

Prism never ever treats an empty cell as if you had entered zero -- it
always knows that is a missing value. It will analyze the data if it can, and
leave analysis results blank when it cannot. Similarly, it never treats a
zero as a missing value.

The details of how Prism handles missing values differs for various
statistical tests. 

Unpaired t test; Mann-Whitney test; Ordinary one-way ANOVA; Kruskal
Wallis test

255
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These tests work fine with unequal sample size. Missing values are not
a problem.

Paired t or Wilcoxon matched pairs test; repeated measures one-way
ANOVA

Prism only analyzes rows where there are data for all conditions. If one
value is missing, that subject (row) is ignored.

  Ordinary two-way (not repeated measures) ANOVA -- Enter raw data

If some values are missing, two-way ANOVA calculations are
challenging. If any row/column combinations have no values at all,
Prism cannot compute ANOVA. If some row/column combinations have
fewer replicates than others (some replicates are missing),  Prism uses
the method detailed in SA Glantz and BK Slinker. This method converts
the ANOVA problem to a multiple regression problem and then displays
the results as ANOVA. Prism performs multiple regression three times
— each time presenting columns, rows, and interaction to the multiple
regression procedure in a different order. Although it calculates each
sum-of-squares three times, Prism only displays the sum-of-squares
for the factor entered last into the multiple regression equation. These
are called Type III sum-of-squares.

Ordinary two-way (not repeated measures) ANOVA -- Enter mean, SD
(or SEM) and N

If your data are balanced (same sample size for each condition),
entering data as mean, SD (or SEM) and N is not a problem -- you'll
get the same results as if you had entered raw data. However, this not
the case if your data are unbalanced, it is impossible to calculate
precise results from unbalanced data entered as mean, SD (or SEM),
and N. Instead, Prism uses a simpler method called analysis of
“unweighted means”. This method is detailed in LD Fisher and G
vanBelle (details below). If sample size is the same in all groups, and in
some other special cases, this simpler method gives exactly the same
results as obtained by analysis of the raw data. In other cases,
however, the results will only be approximately correct. If your data are
almost balanced (just one or a few missing values), the approximation
is a good one. When data are unbalanced, you should enter individual
replicates whenever possible.

http://www.amazon.com/Primer-Applied-Regression-Analysis-Variance/dp/0071360867%3FSubscriptionId%3D1EJNRTWJHMX1HXN1FX02%26tag%3Dgraphpadsoftware%26linkCode%3Dxm2%26camp%3D2025%26creative%3D165953%26creativeASIN%3D0071360867
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  Repeated measures ANOVA

Starting with Prism 8, Prism can run repeated measures ANOVA (one-,
two- or three-way) even with some missing data. It doesn't actually
run ANOVA but rather fiits a mixed model. But the results are
comparable. 

  Linear and nonlinear regression

Fitting lines and curves works fine with missing values. You can choose
whether Prism fits the individual replicates or fits the means. If you
choose to fit the means, each mean gets the same weight regardless of
how many values were used to compute it. If you fit the individual
replicates, then X values with more Y replicates get more weight than X
values with fewer replicates.

Survival curves

Comparison of survival curves does not require equal sample size. If
data are completely missing for any subject, simply don't enter data for
that subject. But before deciding to leave data out, read about
censoring which happens when you know the subject survived up until
a certain time, but don't know what happened after that (or you know,
but can't use the data because the experimental protocol wasn't
followed). Prism handles censored data fine. Don't omit those subjects,
enter the duration that they survived on the experimental protocol and
mark that duration as censored. 

13.3.12 Keyboard shortcuts

· The Tab key moves to the right. Shift-tab moves to the left.

· The Enter key moves to the right to the next subcolumn, if there is one;
otherwise it moves down a row and to the first subcolumn. Shift-Enter
does the opposite.
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· Shift and Enter does the opposite. It moves left to the prior subcolumn if
there is one; otherwise it moves up the the prior row.

· Control and Enter moves down to the next row (same as down arrow
key)

· The DEL key erases all selected values, but the data set will still be
linked to analyses and graphs. When you enter new data, Prism will
update the analyses and graphs. To delete a block of data completely,
select Delete from the Edit menu. Other data on the table will move to
fill the gap.

· Shift-space selects the entire row (Windows)

· Control-space selects the entire data set (Windows).

· Control-A selects the entire table (Windows).

· Shift-Control-Space selects the entire row (Mac).

· Shift-Option-Space selects the entire data set (Mac).

· Command-A selects the entire table (Mac).

13.3.13 Rounding

How many digits can Prism store?

Prior to Prism 7, Prism stored only seven digits (actually it is binary, so it
is 'about' seven decimal digits) so did not always store the exact value
you entered. For example, if you enter the value 99.2492427 into a data
table, Prism rounded it to 99.249250. 

Prism now stores numbers with double precision, so it can store about
fourteen significant figures.  If you enter the value 99.2492427 into a
data table, Prism stores it as 99.2492427

How to show fewer digits than you entered
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By default, Prism tries to show all the digits you entered, and increases
the number of digits after the decimal place to accommodate the extra
digits. But you can use the Decimal Format dialog  to show fewer digits.
And the results of analyses can be rounded as well. 

What you see on the Prism data table matters only when you look at that
table. Notes:

· Choosing to show fewer digits on the data table won't affect how Prism
analyzes or graphs your data. Analyses are always based on all the
digits you entered (up to the number Prism can store).

· When you save the Prism file (as .PZF or .PZFX), Prism saves all the
digits you entered (up to fourteen), so the values are not truncated
when you save.

· When you copy data from a Prism data table to the clipboard, Prism
copies the values you entered, not only the digits you see on the table.

· When you export a data table as a .TXT or .CSV file, Prism exports the
digits you entered, and not only those that appear on the table. 

 
Rounding

There are two issues that can make rounding seem erratic.

· When the next digit is a 5. Rounding values is straightforward unless
the next digit is 5. Should 2.5 be rounded up to 3 or rounded down to 2?
Both are equally accurate, and many strategies have been proposed to
deal with this issue. The Wikipedia article on rounding explains the
many possibilities. Prism rounds values that end with 5 somewhat
unpredictably. For example,  0.25 gets rounded up to 0.3, but 0.45 gets
rounded down to 0.4.  These are both correct, since rounding a 5 up or
down is an arbitrary decision. Prism Windows uses the C function
sprintf() to display real numbers. The function used by the Mac Xcode
compiler is similar but not quite identical. 

·  Decimal to binary to decimal. Computers store the number as binary
digits, so need to convert to and from decimal. For many values, this
requires rounding as well. For example, let's say you type in the number
0.055, and ask Prism to display the value to only two decimal places.
The next, third, digit is 5. One common rule to always round up when
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the next digit is 5, so you'd expect Prism to display 0.06. But the
computer can't store the value 0.055. Instead, all values are converted
to binary, and the binary value is close to 0.05499996 when converted
back to decimal. When rounding this value to two decimal places, the
next (third) digit is a 4. So Prism Windows rounds down in this case and
displays 0.05. Prism Mac rounds up, in this case, and displays 0.06. 

Rounding with Prism 8

The Format Decimal Format dialog rounds down what you see on the
table. But when you go to edit the data, all the digits you entered (or
imported or pasted) are still present. Starting with Prism 8, you can use a
transform round the data to a specified number of digits. This is a built-in
transform (bottom of the list) for both X and Y values. 

The results will appear on a results page. They will actually show one
more digit than you want and that last digit will always be zero. You can
use Format Decimal format to show one fewer decimal place. From the
results page, you can do further analyses or copy or export the rounded
values. 

Rounding with earlier versions of Prism

Click Analyze and choose Transform . Then choose User-defined Y
transform. Then click "Add..." to add a new function. Here is  a transform
that rounds numbers to only include two digits after the decimal:

Y = Floor(Y*10^2 + 0.5)/10^2

The transform multiplies the Y value by 10^2 or 100, adds 0.5, and then
rounds down to the lower integer (that is what the Floor function does).
Then divide by 100. 

Replace "2" in two places by "3" to round to three places, etc. 

The results will appear on a results page. They will actually show one
more digit than you want and that last digit will always be zero. You can
use Format Decimal format to show one fewer decimal place.

 

13.3.14 Data objects

Data objects are blocks of data imported or paste-linked from elsewhere.
You can't edit these data on that table either because the data are linked
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to an external text file or to another table in the same Prism project .
Data blocks appear with thick borders. 

The example above has a red border, because the data were copied and
then paste-linked from a red results table. If the values were pasted from
a green results table, the border would be green. Green results tables are
organized like data tables and (unlike red results tables) can be graphed
or further analyzed. If the data were paste linked from another data
table, the border is blue. If the data are linked to an external file, the
border is black. 

13.3.15 Transforming and normalizing?

It is common to want to transform data to perhaps change units or
convert to logarithms. On a spreadsheet you can transform right on the
same table. Not with Prism.  To transform you choose the Transform
analysis  which puts the results on a new Results table and leaves the
data alone. 

Similarly, choose a specialized analysis to Normalize , Transpose , or
Remove a baseline . 
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14 Importing and exporting data

Prism gives you several options to get data from

other applications. You can copy and paste, or

import.
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14.1 Linking and embedding data

When you copy and paste from an Excel file or text file into a Prism data
table, you have the option to paste only the values or to keep a live link
to the original file so that whenever the original file is changed and saved,
your Prism graphs and analyses will update. A third option is to embed
(keep a copy) of the original file inside your Prism file.

When you link, you keep a connection to the original file. When you
embed, you make a new copy.

Linking and embedding works differently with Prism for Windows and
Prism for Mac:

· With Prism for Windows you can link or embed to Excel and text files.

· With Prism for Mac, you can't embed files or link directly to Excel
spreadsheets. You can, however, link to text files.

14.1.1 Changing linked and embedded data

Blocks of Prism data linked to a text file or linked to an embedded spreadsheet
(Windows only) appear with a border around them. These are called data objects. You
cannot edit these values within Prism. When you click on any cell within a block, you
select the entire data object. The figure below shows a data object.
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To edit the data:

Double-click anywhere on a block of linked data to bring up the Import
and Paste Special  dialog. Then click Open File to Edit Data. This will
open your original Excel file. After editing and saving the spreadsheet,
return to Prism and press Update to close the dialog.

To unlink a data object:

Double-click anywhere within the object to bring up the Import and Paste
Special  dialog. Click the Unlink button on the bottom of that dialog. The
values will remain on Prism’s data table, but will no longer be linked to an
external file or to an embedded spreadsheet.

To move a data object to a different location on the same table:

Double-click anywhere on the data object to open the Import and Paste
Special Choices dialog. Go to the Placement tab. Find the spot where you
can change the top-left corner of the object. Enter a row number and
choose a column for the new location. 

To move a data object to a different data table:

It is not possible to move a data object to a different data table. You can
delete it from the table where it doesn't belong. Then go back to the
source data, and copy-paste special to the correct location. 

To update values in Prism after editing a linked file:

Double-click on the data object in Prism to bring up the Import and Paste
Special  dialog. Press the Update button on that dialog. This is only
necessary if you didn't check the option to automatically update on the
Source  tab.

To change the region of a spreadsheet file linked to Prism. (Windows only):

If you accidentally linked to the wrong part of a linked spreadsheet, the
simplest approach is to unlink the data object, then start over.

An alternative approach is to change the region linked within Prism. Click
on the linked data object, then pull down the Edit menu and choose Links.
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You will see a list of each linked data range on the current Prism table,
with the region you selected already highlighted. Press Change Source, to
bring up a second dialog.

At the bottom of that dialog, you'll see the current linked range in the
field labeled Item Name. With Excel, this range is formatted in an
unfamiliar way. R1C3:R100C4 goes from the first row of column 3 to the
100th row of column 4.

Note that you can also use this dialog to link to a different Excel file. 

To change the region of a spreadsheet embedded within Prism: (Windows
only.)

If you accidentally embedded the wrong part of a spreadsheet, you'll need
to copy and paste again. You can't simply delete the data object and start
again, because the object contains the embedded Excel table. If you don't
have the original spreadsheet file, you need to save it from Prism. To do
this, open the embedded spreadsheet from Prism, and then use Excel's
File..Save As command to save the spreadsheet as a file. Then you can
delete the data object, and start over.

To select a single cell within a Data Object to copy to the clipboard:

It is difficult to select a single cell within a data object. If you click on a
cell in a data object, you will select the entire object. To select one cell
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within an object, click on a cell near the object, but outside of it. Then use
the arrow keys to move the selection inside the object to the desired cell.

If a linked file has moved:

If the linked text or Excel file is in a folder different than the Prism file:
Prism stores the absolute location of the linked file. If the file no longer
exists at that location, Prism won't be able to find it, so will not be able to
update the data table. However, the imported values remain in the Prism
file. You won’t lose any data if the link is broken.

If the linked text or Exel file is in the same folder as the Prism file: It
matters whether the Prism file is stored in the .PZF or .PZFX format. If
.PZFX, the link is absolute. If the folder has a new name, or has been
moved to a new location, the link is lost. If the Prism file is in the .PZF
format, then Prism will maintain the link to the Excel or text file that is in
the same folder as the Prism file. It doesn't matter if the folder has been
renamed or has been moved to a new location. 

 

14.1.2 Paste linking data from Prism

You can copy data (or results), and paste link the data to the same or
different data table. You can either use the Paste...Link command on the
Edit menu (and the right-click shortcut menu), or choose to link in the
dialog that comes up when you choose Paste Special.

The pasted results are linked, which means if the original data are edited
or replaced, the linked values will update too.

Example 1

You use nonlinear regression to fit a dose response curve to six data sets.
The first three (A-C) are for one drug; the other three are for another (D-
F).  The logIC50 values are all on one row. You know tha the first three
are for one drug, and the next three for another. But Prism doesn't "know"
this. The results look like this:
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You want to put the logIC50 values into a new data table. The first three
should go into column A, and the next three into column B. Follow these
steps:

1.  Select the six values.

2.  Copy them to the clipboard.

3.  Use New...Data table and graph to make a new Column table.

4.  Put the insertion point into Column A and Row 1 of that new table.

5.  Choose Paste Special from the Edit (or right-click shortcut) menu.

6.  On the first (Source) tab of the Import and Paste Special dialog,
choose to insert and maintain link.

7.  On the fourth (Placement) tab of that dialog, choose to paste by
columns, stacking 3 values in each column. That way the six values
that you copied as one row, will paste into two columns.

8.  Click OK.

9.  Note that the values pasted into the data table are surrounded by a
red box. You cannot edit these values on the data table. If you double
click within that box, you'll return to the Import and Paste Special
dialog (where you can unlink the values, if you want to).
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10. Prove to yourself that the values are linked. Change the data being
analyzed, and notice that the summary values that you paste-linked
automatically update.

11. Create a graph of these values using New...Graph of existing data.

12. Compare the groups of values with a test.

13. Download the Prism file. 

 

Example 2

You have two sets of column data that you wish to plot both as a bar
graph showing the mean and SD, and also has a scatter graph showing
individual values.

One approach is to superimpose the bars and individual symbols. Prism 6
makes this simple, as it offers this as one of the choices for column
graphs. This can look good if you omit the error bar, but looks cluttered
when you include error bars. I used light colors for the symbols in the
graph below, which helped a bit.
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Another approach is to put the bars and symbols side by side. Follow
these steps.

1. Enter the two columns of data into columns B and C.

2. Select the values in Column B and copy to the clipboard.

3. Put the insertion point at the top of column A, and choose Paste...Link

from the Edit menu (or the right-click shortcut menu).

4. Select the values in Column C and copy to the clipboard.

5. Put the insertion point at the top of Column D, and choose Paste..Link

from the Edit menu.

6. Note that the pasted values in Columns A and D are surrounded by a

box and cannot be edited.

7. Edit a value in Column B or C. Note that Column A and D are instantly

updated when you move the insertion point. 

8. Polish the graph by double clicking on it, and choosing graphing options

for each data set.
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14.1.3 Unlinking data objects

When a block of data on a Prism data table is linked to another file (or to
embedded data), the data in Prism is included in a box. The box is black if
the linked data came from outside of Prism, red or green if the data were
paste linked from a Prism results table, and blue if the data were paste
linked from a Prism data table. 

You cannot edit these values in the data table because they are linked to
another source. 

To unlink the data block, and allow editing, right click anywhere within
the block of data, choose the Data Object command and then choose
Unlink.

14.2 Pasting data from Excel (Windows)

Select a range of Excel data and copy it to the clipboard. Switch to Prism,
move the insertion point to the cell of a data table that will become the
upper-left corner of the pasted data.

Pasting Excel data

Then click on the Paste  or Paste Special   button in the Prism
Clipboard toolbar.

If you use the Paste button or the keyboard shortcut (Ctrl+V), you will
only paste the values that have been copied to the clipboard. If you
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choose Paste Special , you have several options about how you want to
insert your data into Prism's data table. These options are only available
with Windows. If you use a Mac, skip to this page . 

· Paste Data -- Prism retains no link back to the Excel spreadsheet. The
values will be pasted and nothing else. The only advantage to using this
method is that it is conceptually simpler.

· Paste Embed -- You paste the selected data into the data table and also
paste a copy of the entire spreadsheet file into your Prism project, even
if it has several worksheets (tabs). This means you don’t need to worry
about keeping track of multiple files. You don't need to save the
spreadsheet file separately (except as a backup). You can open Excel
from within Prism, edit the data, and instantly update the analyses and
graphs in Prism. A potential disadvantage of embedding is that you will
end up with multiple copies of the same data. Another disadvantage is
that your Prism files will be larger.

· Paste Link -- Paste the values into the data table but also create a link
back to the Excel file. The link has two functions. It lets you trace (and
document) the source of the data so you stay organized. It also is a live
link. If you edit or replace the data within Excel, Prism will update the
analyses and graphs. The Paste Link command is available only if you
paste from an Excel workbook that has a name. If you are working with
a new Excel file, you must first save it (thus giving it a name) before
you can link its data into Prism. When in doubt, use Paste Link.

· Paste Data Transposed -- Converts data in Excel rows into columns in
Prism, and vice versa.

275
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· Paste Embed Transposed -- Converts data in Excel rows into columns in
Prism, and vice versa. You can choose to paste data only, and embeds a
copy of the Excel sheet in Prism.

· Paste Link Transposed -- Converts data in Excel rows into columns in
Prism, and vice versa. Retains a link to the original Excel sheet

· Paste Special -- Opens dialog to let you choose whether to embed or
link to the original file (Windows only), and also choose to filter and
rearrange the data as you paste it into Prism. The Paste Special dialog is
identical to the Import dialog .

Pasting an Excel table as a picture

You can copy a portion of an Excel spreadsheet and paste (or paste link)
it onto a Prism graph  or layout . This pastes a picture only, and Prism
cannot analyze or graph the values since the values are not in any Prism
data tables.

Importing Excel files

There are some limitations, and we don't recommend it, but you can
import  Excel files directly into Prism for Windows.
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14.3 Pasting data from Excel (Mac)

Pasting data from Excel

Select a range of Excel data and copy it to the clipboard. Switch to Prism
and move the insertion point to the cell of the data table that will become
the upper-left corner of the pasted data.

Then click on the Paste or Paste Special   button in the Clipboard
toolbar.

· Paste -- You will only paste the values that have been copied to the
clipboard.

· Paste Transpose -- Converts data in Excel rows into columns in Prism,
and vice versa.

· Paste Special -- You'll then see the Import and Paste Special  dialog,
where you can choose whether to filter and rearrange the data (such as
transposing).

Note that it is not possible to Paste Embed or Paste Link to Excel files on
the Macintosh. Those features only work on Windows.

Pasting an Excel table as a picture

You can copy a portion of an Excel spreadsheet and paste it onto a Prism
graph  or layout . This pastes a picture only, and Prism cannot analyze
or graph the values since the values are not in any Prism data tables.
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Importing Excel files

Prism Mac cannot import Excel files. Either copy and paste, or save from Excel in CSV

format and import that text file  into Prism.

14.4 Options when pasting data from Excel (win or mac)

What Excel puts on the clipboard

Excel Windows 2003 and later, and Excel Mac 2008 and later, copy data
to the clipboard in two formats: Plain text, and HTML.

By default, Prism (starting with 5.0c and 5.03)  pastes the HTML format.
This will allow much better pasting of Greek letters, superscripts and
subscripts, titles with punctuation, numbers with nonstandard thousands
or decimal separators, and more.

There is one change. If the Excel cell contains a mixture of numbers and
letters (or punctuation), prior versions tried to extract and paste just the
numbers. Prism Mac still works that way, but Prism Windows won't paste
anything into numerical parts of a Prism table if the corresponding Excel
cell mixes numbers and text. 

This new style of pasting only applies when pasting values. Paste-
embedding and paste-linking (Windows only) are not changed.

Changing back to the old style
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Pasting from the HTML rendition is the default. If it causes any problems,
use Edit..Paste Special and check the new option on the first tab:

    [ x]Paste older text-based clipboard format. Not recommended.

With this option selected, pasting will work just as it did with earlier
releases of Prism (before 5.03 and 5.0c). We don't anticipate any
situations where this will be helpful, but are providing this option just in
case. The option is available when you insert data only, and will be
unavailable if you choose to paste link or paste embed. 

Numbers, a Mac spreadsheet that is part of iWork, does not copy the
HTML so pasting from Numbers always uses the older style.

Two ways to paste from the HTML (older Excel versions only)

It gets even more complicated.

The HTML clipboard version from some versions of Excel contains each
number twice. One copy shows exactly what you see in Excel. The other
copy shows the value with more decimal places (ignoring formatting or
rounding within Excel). By default, Prism pastes the values as they are
shown in Excel. But the Paste Special dialog lets you use the other
version if you prefer:

 [x ]Paste as many digits as possible. If Excel rounds to 1.23, paste
1.23456

This option is not available if you copy from Excel Windows 2007 or later,
as the necessary information is not copied to the clipboard.

14.5 Importing data from text files

Importing a file vs. opening a file

From the Welcome dialog (or the File Open command), you can only open
Prism project files. 

To import data from a file, you must first create a new Prism project (or
open an existing one), go to a data table, position the insertion point, and
then choose the Import command or click the Import button.
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Prism will show you the Import and Paste Special  dialog, which will let
you choose whether to embed or link to the original file (Windows only),
and also will let you filter and rearrange the data as you bring it into
Prism.

Formats Prism can import

Prism can import text files delimited with tabs (.txt files) or commas (.csv
files).

When thinking about whether Prism can import your files, distinguish the
format of the file from the arrangement of the data. Prism arranges data
differently than do most programs that can export .csv or .txt files. 

To create a text file from an Excel spreadsheet:

Go to the worksheet (tab) you want to export, then pull down Excel's File
menu and choose Save as. Select either Text (tab delimited) or CSV
(comma delimited) format.

Importing csv files into Excel

If you configure Excel and Windows, you can double-click on a .csv file
and have it open directly in Excel. Convenient! But it doesn't work well
with some csv files (those with math symbols, Greek letters, international
characters). Better to use File Open in Excel, and then choose to open a
csv file from and select "65001: Unicode (UTF-8)"
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14.6 Importing text and Excel files directly

Importing Excel files

To import data into Prism (Windows only) directly from an Excel XLS file:

Start from a data table and move insertion point to the cell that will
become the upper-left corner of the imported data. Click on the Import
button on the Prism toolbar. Whenever possible, transfer data from Excel
using copy and paste.

Prism will show you the Import and Paste Special  dialog, which will let
you choose whether to embed or link to the original file, and also will let
you filter and rearrange the data as you bring it into Prism.

Limitations to importing Excel files directly

If your Excel workbook (spreadsheet file) has several worksheets (tabs),
Prism only reads one – the one that was selected when the file was
saved. Any other worksheets are invisible to Prism.

When importing data from an Excel file, Prism launches Excel invisibly,
and asks Excel to send the data to Prism. So Prism can only import an
Excel file if Excel is available on the same computer as Prism. Because
Excel has to be launched in the background, importing an Excel file can
take much longer than importing a text file.

Importing an Excel file requires an OLE (Object Linking and Embedding)
connection between Prism and Excel. This is a complicated process,
requiring the coordination of Excel, Prism, and various Windows
components. While it works fine on most computers, it simply doesn't
work on some computers. Because Macintosh computers don't support
OLE, importing Excel files directly isn't possible with Prism Mac.

You'll rarely want to import an entire Excel spreadsheet into Prism. While
you can restrict rows and columns to import on Prism's Import dialog, in
most cases it is easier to simply copy and paste the appropriate range.
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Importing text files

All spreadsheet and statistics programs can export blocks of data as a
text file, separating adjacent columns with commas, semicolons, or tabs.
Text files commonly have extensions such as .TXT, .DAT, .CSV (comma
separated value), or .PRN (printer). Some programs refer to these files as
ASCII files rather than text files.

To import data into Prism from a text (ASCII) file:

Start from a data table and move insertion point to the cell in the data
table that will become the upper-left corner of the imported data. Click on
the Import button on the Prism toolbar.

Prism will show you the Import and Paste Special  dialog, which will let
you choose whether to embed or link to the original file (Windows only),
and also will let you filter and rearrange the data as you bring it into
Prism.

Note that it is not sufficient that a file have an extension (file type) such
as txt or dat. The file has to be a plain text file. If a file is not a text file,
renaming it to have a different extension won’t help.

14.7 Importing and pasting choices

The Import and Paste Special Choices dialog comes up when you import
a file into a Prism data table, or use the Paste Special command. It has
five tabs:

Source  - The Source tab lets you choose between importing or pasting just the
values, linking to a file, or embedding a data object.

View  - The View tab lets you see the contents of the imported or pasted file,
divided into columns.

Filter  - The Filter tab let you choose which portions of the data file to import.

Placement  - The Placement tab lets you rearrange your data as you
import/paste it into Prism.
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Info & Notes  - The Info & Notes tab gives you tools to import
sections of a text file directly into a Prism Info sheet .

 

 

  

 

 

14.7.1 Source tab

Linking and embedding

Insert Data only

Prism retains no link back to the Excel spreadsheet or text file. The values
will be pasted and nothing else. The only advantage to using this method
is that it is conceptually simpler.

Insert and Maintain Link
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Paste or Import the values into the data table but also create a link back
to the original file. The link has two functions. It lets you trace (and
document) the source of the data so you stay organized. It also is a live
link. If you edit or replace the data in the original data file, Prism will
update the analyses and graphs. With Prism for Windows, you can link
directly to a text or Excel file. Prism for Mac will link only to text files.
With Prism Windows, the Link option is available only if you paste from an
Excel workbook that has a name. If you are working with a new Excel file,
you must first save it (thus giving it a name) before you can link its data
into Prism.

Embed as OLE object (Windows only)

Paste or Import the selected data into the data table and also paste a
copy of the entire original spreadsheet or text file into your Prism project,
even if it has several worksheets (tabs). This means you don’t need to
worry about keeping track of multiple files. You don't need to save the
spreadsheet file separately (except as a backup). You can open Excel
from within Prism, edit the data, and instantly update the analyses and
graphs in Prism. A potential disadvantage of embedding is that you will
end up with multiple copies of the same data. Another disadvantage is
that your Prism files will be larger.

Automatically update Prism when the data file is changed

If you check this option, whenever you look at a Prism data table, graph,
results sheet, or layout, Prism will update the sheet if the linked Excel file
has been changed.

Excel options

What Excel puts on the clipboard

Excel Windows 2003  and Excel Mac 2008, copy data to the clipboard in
two formats: Plain text, and HTML. Numbers, a Mac spreadsheet that is
part of iWork, only copies in plan text format.

When there is a choice, Prism (starting with 5.0c and 5.03) pastes the
HTML format by default. This allows much better pasting of Greek letters,
superscripts and subscripts, titles with punctuation, numbers with
nonstandard thousands or decimal separators, and more. You can specify
that the text format be used by checking the option:

  [x]Paste older text-based clipboard format. Not recommended.

Two ways to paste from the HTML
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It gets even more complicated. With Excel 2003, the HTML clipboard
version contains each number twice. One copy shows exactly what you
see in Excel. The other copy shows the value with more decimal places
(ignoring formatting or rounding within Excel). By default, Prism pastes
the values as they are shown in Excel. But the Paste Special dialog lets
you use the other version if you prefer:

   [x]Paste as many digits as possible. If Excel rounds to 1.23, paste 1.23456

This option is not available if you copy from Excel 2007 or Excel 2010, as
the necessary information is not copied to the clipboard. It is also not
available when importing from Excel.

Note a bug in Excel Mac 2008. In very rare cases, using that option will
result in the wrong values being pasted into Prism. 

How to interpret spaces and commas

The choices are self-explanatory, but important.

14.7.2 View tab

The View tab of the Import and Paste Special dialog lets you see the
contents of the imported or pasted file, divided into columns. This can be
especially helpful if you are importing from a comma- or tab-delimited
text file. A quick look can let you know if your columns are formatted
correctly.

http://www.graphpad.com/faq/viewfaq.cfm?faq=1607
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Once you've pasted linked data into a Prism data table, click Open File to
open and edit the data file. If it is an Excel file, you'll open Excel. If it is a
text file, you will open a text editor.

14.7.3 Filter tab

Choices on the Filter tab of the Import and Paste Special dialog let you
choose which portions of the data file to import.
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Unknown and excluded values

When entering data, you can leave any parts of the data table empty.
Prism automatically figures out what to do with missing values. When
Prism imports a text file, it handles missing values automatically. Some
other programs use a code, say 99, to denote missing values. If you
import data from such a program, enter that code value into the Filter
tab.

To denote an excluded value in a text file (or within Excel), put an
asterisk immediately after the value. Then check the option on the Filter
tab to exclude values followed by asterisks.

Pick which Rows you wish to import or skip

First, select the range of rows to import, by specifying a first and last
row. If the file you are importing includes <notes>, <info>, or <title>
information (see Paste Special Notes ), start counting rows at the first
row after this structured information. Row “1” is the first row with data,
not the first row in the file.

289
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Then, select rows you want to skip. The filters work by checking whether
a designated column meets a criterion you specify. You can apply any
combination of three kinds of filters:

· Skip all rows until a criterion is met

· Skip all rows after a criterion is met

· Skip every row that meets your criterion.

When defining the criterion, you can use any column in the original file.
You are not restricted to using columns you choose to import. Compare
by checking whether the value of each row in the column is less than or
equal to (<=), less than (<), equal to (=), greater than (>), greater than
or equal to (>=) or not equal (<>) to the value you enter. It is not
possible to define criteria that compare values in two columns, only to
compare the value in one column with a value you enter in the dialog.

Decimate

If your data file is huge, you can decimate the data as you import.
"Decimate" literally means to keep one of every ten rows of data, but you
can tell Prism to skip any number of rows between the rows it imports. It
imports a row, skips the number of rows you specify, and then reads
another row. This is useful with any large file as a way to make Prism files
smaller and accelerate analyses and graphing.

Columns

Choose a range of columns you wish to copy by specifying a first and last
column. Or choose to read a column, skip one or more columns, and then
read another column.

Unstack

Some statistics programs save data in an indexed format (sometimes
called a stacked format). Each row is for a case, and each column is for a
variable. Different groups or experimental conditions are not defined by
different columns (as Prism is organized), but rather by a grouping
variable. Prism can unstack indexed data. Specify which column contains
the data and which column contains the group identifier. The group
identifiers must be integers (not text), but do not have to start at 1 and
do not have to be sequential.
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Example: In this sample of an indexed data file, you may want to import
only the data in column 2 and use the values in column 3 to define the
two groups.

Row # Col. 1 Col. 2 Col. 3

1 12 123 5

2 14 142 6

3 13 152 5

4 12 116 6

5 11 125 6

6 15 134 5

Check the box to unstack data only from column 2 using column 3 to
identify the groups. Prism will automatically rearrange the data, so they
look this like:

Row # First Col. Second Col.

1 123 142

2 152 116

3 134 125

The column that identifies the groups must contain integers. The lowest
integer defines the group whose values will be placed in the column
containing the insertion point in Prism. If there are gaps in group
numbers, Prism will leave blank columns.

If you use Paste Special to paste data from the
clipboard, the column numbers in the Filter tab
are relative to the range of data you copied to
the clipboard. For example, if you copied cells
C13-F45 from Excel to the clipboard, then
column 1 in Prism’s Filter tab refers to the data
in Column C in Excel, the first column of the
copied range.
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14.7.4 Placement tab

The Placement tab of the Import and Paste Special dialog lets you
rearrange your data as you import/paste into Prism.

Names

The Placement tab lets you choose whether you want to rename the Prism data
table and/or the Prism column titles with the name of the imported file, or with text
imported from a specified row in that file.

Top-left position of inserted data within Prism

Specify the top-left corner of the data object in Prism. Normally, this will be the
position of the insertion point when you choose the Import or Paste Special
command, but you can change it.

Row and column arrangement

Prism can rearrange the data as it imports. If you choose Transpose, the first row
in the source will become the first column in Prism, the second row in the source
becomes the second column in Prism, and so on.

If the data source has one column (or row) and you want to organize the data
according to your experimental design, choose By rows or By columns.

Example: Your data source has thirty values in a single column, and you wish to
import into a Prism data table formatted for entry of triplicate Y values. The first
three values in the source data are the first three replicates. The next three values
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in the source are the next set of replicates, so they belong in row 2 of data set A.
After filling five rows, you want to start inserting data into data set B. Choose to
import by rows, placing three values on each row and starting a new column after
five rows.

If the data source has the values from 1 to 30 in order, Prism will organize the data
as shown below. When placing values side-by-side, Prism does not pay attention to
the difference between subcolumns and data sets. It just puts values in the next
cell to the right, and it doesn't care whether that cell is another replicate, a SD, or
the beginning of a new data set. In the example above, Prism placed three values
side-by-side because you entered 3 into the dialog. The data table was formatted
separately for triplicate values.

If you choose to arrange the data “By rows” or
“by columns”, Prism reads the values row-by-
row from your source file, but ignores all line
breaks. It treats the data as though it came
from one column or one row.

14.7.5 Info & Notes tab

Prism's Info Sheets are a place to store details about a project or
experiment. If you are importing data from a text file (or pasting), you
can import ranges of information from a text file directly into a linked Info
sheet  in your Prism file.188
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You can import this information at the same time you import your data.
Use the Info and Notes tab of the Import and Paste dialog to specify the
rows you want to import and which Info sheet you want them to flow into.

If you can control the format of your text file, you can include info
constants and notes in structured sections at the beginning of the text
file. Mark the sections in the text file with <> variable names as below.

· Mark any values that you want to import to Info Sheets for use as
constants as:

<Info>

· Mark sections you want to go into the freeform Notes areas of an Info
Sheet as:

<Notes>

· Mark a section to use as a title for your Info sheet as <Title>

Example:

<Info>
Experimenter, “Dave Jones”
”Lot number”,   564A
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”Specific radioactivity”,   345.6
</Info>
<Notes>
The experiment went smoothly, but we noticed a large bubble in the third replicate at 10 micro molar.
</Notes>
<Title>
Experiment of June 32, 2098
</Title>

Enter a tab after the <Info> variable name to separate it from its value.
If the variable name is two words, use quotation marks around the name.

The three blocks (info, notes, and title) can appear in any order,  but they
must appear at the beginning of the file. You can include one, two or all
three of the blocks,

If the info variable already exists, its value will be updated. If the variable
doesn’t exist, it will be appended to the Info table. 

Notes will be appended to the notes (right) portion of the Info sheet. It is
not possible to include Greek letters or super or subscripts when
importing.

The title you enter, if you include a <title> section, will replace the data
table sheet title.

When you use the View  tab to preview your data, the preview will not
include the structured information enclosed in notes, info, or title tags.
When you enter information on the Filter tab about which rows to include,
start counting with the first row following the structured information.

14.8 Troubleshooting: Negative numbers become positive; fractional
numbers become integers?

Situations where negative values become positive when pasted or
imported into a Prism table:

· In a contingency table. the rows denote treatment or exposure and the
columns denote alternative outcomes. Each value is the actual number
of subjects, objects or events. Thus all values must be positive integers
or zero. If the data you are importing has any negative values, the
minus signs are simply ignored, so the value will become positive. If you
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want to include negative numbers, you are not really creating a
contingency table. Drop the Change menu, choose Format Data Table,
and choose a different kind of table. You probably want a Grouped table.

· Excel can be configure to show negative values in red, without the
negative sign. When you copy and paste this to Prism, the color is lost
but the negative sign is not restored. 

· Some financial programs show negative numbers within parentheses.
Prism does not understand this syntax, and the numbers will not be
pasted as negative values.

· In a survival table, the Y values are a code. One value (usually 1)
indicates that the event (often death) occurred. The other value (usually
0) indicates that the data are censored after the specified X (time)
value. Negative values are impossible. 

Situations where fractional values can become integers when imported
or pasted into a Prism table:

· In a contingency table. the rows denote treatment or exposure and the
columns denote alternative outcomes. Each value is the actual number
of subjects, objects or events. Thus all values must be positive integers
or zero. If the data you are importing or pasting has a decimal point,
this will be ignored, so "1.23" will paste or import as "123".  If you want
to include numbers of fractions, you are not really creating a
contingency table. Drop the Change menu, choose Format Data Table,
and choose a different kind of table. You probably want a Grouped table.

· The Y columns of survival tables hold simple code values. Usually, 1
means death (or some other event happened) and 0 means the data
were censored. You can change the code, but Prism can only accept
integers into the Y columns of survival tables.

· Number format can depend on where you (or whoever made the text
file) lives. A comma sometimes denotes thousands, but sometimes is a
decimal separator. If you have trouble, use Edit..Paste Special (instead
of plain Paste). The first tab of Paste Special dialog  (which is identical
to the Import dialog) lets you define what commas mean. 
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14.9 Exporting from data tables

Copy and paste

The best way to take Prism data or results and place into Word or
PowerPoint is via copy and paste. If you do this, you'll find that Prism's
tables remain tables when they are pasted. In contrast, if you export then
import a text file, Word or PowerPoint won't format it as a table.

When pasting into Excel, or some other spreadsheet or statistical
program, note the options at the bottom of the File & Printer tab of the
Preferences dialog. Choose whether you want excluded values copied, and
whether you want the decimal separator to be a period or comma.

Exporting Prism data

From any data or results table, click on the Export button on the toolbar
and choose the format you want to use.
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Exporting format

You also can specify how to handle excluded values, how to format the
decimal separator, and whether or not to include column titles.

CSV

CSV stands for "comma-delimited values", but the name is a bit
misleading. In the Preferences dialog , you can choose to export values
using a period (point) or a comma as the decimal separator. If you choose
a period (the US standard), then adjacent columns are indeed separated
by commas. If you choose a comma, then adjacent columns or
subcolumns are separated by semicolons.

This is a very standard format useful for moving blocks of data into
spreadsheet or word processing programs like Excel and Word.

When Prism exports into CSV, it doesn't distinguish row titles, X columns,
Y columns, and subcolumns. All the values are simply exported. Special
characters (Greek, subscripts, etc.) are lost from column and row titles.

TXT

This format is very similar to CSV, except that adjacent columns are
separated with tabs. These are common formats and can be used to
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easily move blocks of data into spreadsheet or word processing programs
like Excel and Word.

This is a very standard format useful for moving blocks of data into
spreadsheet or word processing programs like Excel and Word.

When Prism exports into TXT, it doesn't distinguish row titles, X columns,
Y columns, and subcolumns. All the values are simply exported. Special
characters (Greek, subscripts, etc.) are lost from column and row titles

XML

When you export in XML format, the exported file includes all special
formatting, including Greek characters, subscript, superscript, subcolumn
formats, etc. When you later import an XML file, everything should just
work. There is no ambiguity about whether commas are for decimals,
thousands, or used to separate columns.

If your goal is to export a data table from Prism on one computer and
import it into Prism on another computer, you should choose XML format.

While Prism follows standard XML conventions, the way Prism denotes
unique features such as subcolumn, excluded values, floating notes, etc.
is unique, so files can't be directly imported into other programs without
some extra work.

An XML style sheet is appended to every XML file exported. That means
you can view the file in a web browser, and see your data tables as
tables. But don't be fooled by this. You are not viewing the XML file, you
are viewing a rendition of the file as specified in a style sheet that is
appended to every XML file Prism exports. To see what the file actually
looks like, use a text editor.

We provide the XML schema in the Prism program folder
(prism6xmlschema.xml). Using that (and by exporting sample files from
Prism) a programmer could enable other programs to export data in
Prism XML format.

In addition to exporting data tables as XML, Prism can save an entire
project in a new XML based file format (PZFX ).

More choices when exporting or copying data

How should excluded values be handled?
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The idea of excluding values is unique to Prism, so there is no standard
way to denote exclusion when exporting data. Prism 6 offers three
choices. Excluded values can appear:

· Just like all other values, ignoring the fact that they are excluded.

· Followed by an asterisk. 

· As missing values, blanks.

What should the decimal separator be?

You have three choices:

· A period or point (1.23).  

· A comma (1,23).  

· Let Prism decide, based on your Windows or Mac control panel.

These choices are set in the export dialog when you export to a file. When
you copy the data to paste somewhere, these choices are set in the File &
Printer tab of Preferences dialog.
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15 Analyzing data with Prism

This section explains how to analyze data with

Prism. For help with statistical principles, and with

particular analyses, go to the Statistics Guide.
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15.1 Analyzing data: The basics

 What 'analyze' means in Prism
How to analyze data with Prism
Statistical analyses and linear or nonlinear regression

15.1.1 What 'analyze' means in Prism

Prism uses the term analyze to include not only statistics and regression,
but also for data manipulations such as transforming, removing baselines,
and normalizing. In all cases, the results of each analysis appears on new
results pages and the data table does not change. For example, if you
transform data, the transformed values do not replace the data. Instead
they appear in a new results page. 

Data and analyses are linked. If you change the data, the analysis results
will update automatically as will any linked graphs. This works even if you
have chained several analyses . You can stop the automatic updating by
freezing  the results sheet. 

15.1.2 How to analyze data with Prism

Start from any data table or graph, and click the Analyze button. There is
no need to first select a range of data to analyze.  Prism completely
ignores any selection you made before clicking the Analyze button. 

Step 1. Analyze dialog

The analyze dialog appears. Make sure the drop down on the upper left is
set to 'Built-in analysis', and choose an analysis.The right half lets you
choose to only analyze selected data sets. It is not possible to choose a
subset of rows to analyze -- Prism always analyzes them all.
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Step 2. Analysis parameters dialog

Each analysis dialog has its own parameters dialog. Read about individual
analyses to learn about the choices.

If you are unsure about an analysis choice, click the Learn button in the
dialog to go to the appropriate help topic.

Step 3. View the results

Some results are presented on several analysis tabs . Choose an
analysis tab to view .

Step 4. Analysis checklist

Click the Analysis checklist button in the Interpret section of the Prism
toolbar to review a list of questions that will help you interpret the
results..

300
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15.1.3 Statistical analyses and linear or nonlinear regression

Prism comes with three on-line guides (help). The details of statistics and
regressions are explained in the other guides.

· View the Statistics Guide

· View the Curve Fitting (Regression) Guide

15.2 Working with results of analyses

Analysis tabs
Creating chains of analyses
Changing an analysis
Repeating an analysis
Graphing results
Frozen and orphaned analysis results
Excluding data points from an analysis
Embedding results on a graph
Hooking to analysis and info constants
Color coding key results

15.2.1 Analysis tabs

Viewing analysis tabs

Many analyses in Prism present results on more than one table. Prior to
Prism 8, these were called "views" or "subpages" of the results and they
were shown indented under the main results entry in the Navigator.
Starting with Prism 8, these tables are shown as analysis tabs. Here is a
nonlinear regression results (with optional outlier detection) shown in a
second tab. 
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Note that the appearance of results tabs were updated in Prism 8.2. An
example of the updated appearance can be seen below:

Notes:

· If the analysis has only one table of results, you won't see any analysis
tabs.

· Some analysis tabs have a red border. These are tables to look at. But
they can't be graphed or further analyzed because different rows have
different kinds of data.

· Some analysis tabs have a green border. These are tables that can be
graphed or analyzed further. Drop the New button and choose New
Graph of existing data or New Analysis.

· You can hide analysis tabs by clicking the "X" in the analysis tab. Read
on to learn about hidden tabs. 
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Hiding and unhiding analysis tabs

To the right of the analysis tabs is a downward pointing arrow. Click it to
see the full list of analysis tabs, including those that are hidden. The
analysis in the screenshot below has four analysis tabs. Two are visible
(checked) and two are invisible (unchecked).

Why are some results tabs hidden by default? 

Some analyses create results tables that are used to create graphs, and
there is really no point in viewing these tables. For example, nonlinear
regression can  creates a results tab showing the XY coordinates of the
curve and another showing the residuals,  Prism (starting with Prism 8)
hides these results tabs by default since you will probably only want to
look at the linked graph, and not the table of values. But you can choose
to show these tabs if you want to. 

Why would you choose to hide other tabs?

You can hide any results tabs you want to. If you are preparing a file for
others to view, you may want to hide some less important analysis tabs.
For example when interpolating standard curves, you may want to hide
the tabular results. Another example: If you do an ANOVA but only care
about the followup multiple comparisons tests, you may want to hide the
main results table with the ANOVA results. 

How to hide a tab

You can make any analysis tab invisible by clicking the "X" on the tab, or
unchecking that tab in the list of tabs. This can be useful when you are
preparing a file to show others. Maybe the whole point of regrssion was to
interpolate unknowns, so you only want the interpolated results to be
visible and want everything else to be invisible. Or maybe you did ANOVA
followed by multiple comparisons, but you want to hide the main ANOVA
results so as to put the focus on the multiple comparisons results. 

How to make a tab visible
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Any hidden analysis tab can be made visible again by checking the option
box in front of its name. 

Keyboard shortcuts

Windows: Hold Control and click Tab to move to the next analysis tab

Mac: Hold Command and press [ to move to the next analysis tab, ] to
move to the prior one.

 

15.2.2 Creating chains of analyses

Results tables that can be analyzed further have green grids (in contrast,
tables with red grids cannot be analyzed further). There is no limit to how
many analyses can be chained together in this way. When you edit or
update the data table, Prism will update the entire analysis chain
automatically.

In Family pane below the Navigator, analysis chains appear as a series of
indented sheet names. In this example, data are first transformed, then
normalized, and then fit with nonlinear regression.
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15.2.3 Changing an analysis

After reviewing the results of an analysis, you may want to change your
choices. Click on the Results button in the upper left corner of any
analysis results sheet to open the Analysis Parameters dialog.

Two buttons in the toolbar let you change an analysis:

 -- Change the analysis parameters (choices).
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 -- Change which data table and data sets are analyzed.

15.2.4 Repeating an analysis

If you have already entered data on a new data table, and want to
analyze it exactly like you have already analyzed an existing table, use
the Wand  (Wizard to ANalyze Data).

If you haven't yet entered the new data, consider duplicating the current
data table with its family . Then edit or replace the data on the new
table and the analyses will update. 

If you have placed parts of the analysis on the graph (regression lines or
curves, or copy and paste a results table), then you can clone that
graph . 

15.2.5 Graphing results

If the results table has a green grid (but not a red grid), you can make a
graph of the results. To do so, click the New button and choose Graph of
existing data.  Then choose the graph you want to make. 

15.2.6 Frozen and orphaned analysis results

Frozen results

When you edit or replace data, Prism automatically recomputes all linked
analyses. If you don't want a particular results sheet to automatically
update when the data are changed, click the freeze button in the Sheet
section of the toolbar. 

For example, you might want to freeze the results before excluding some
outliers from the data, then repeat the analysis and have both copies of
the results in the project. Click again to unfreeze. When a sheet is frozen,
you'll see the word "frozen" in the status bar at the bottom of the
window, as well as a floating note that explains.
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Note the distinction between deleting a data table and deleting all the
values. If you erase all values from a data set using the DEL key, Prism
still maintains the links between the data and the results. Since there are
no data, the results become blank. If you delete the entire data table, the
results remain and the sheet becomes orphaned.

 Orphaned results

 Prism hot links data to analysis results. If you change the data, Prism will
automatically recalculate the analyses and update the results. It will also
update any result tables that have been embedded  onto graphs, or any
result values that have been hooked  to dialogs.

If you delete a data table, any linked results become orphaned, and you'll
see the word 'orphaned' in the bar at the bottom of the Prism window.
When the data table is gone you can view and graph the orphaned
results, but you cannot change the analysis parameters.

15.2.7 Excluding data points from an analysis

Excluding data sets

If you want to only analyze selected data sets, you can do so. Don't
exclude  all the other points. And don't expect your selection of data
sets to matter when you click the Analyze dialog. Instead, you choose
which data sets to analyze on the right side of the Analyze dialog. You can
change your mind later via Change..Data analyzed.

Empty data sets

How does Prism deal with empty data sets (or data sets with all values
excluded) when analyzing data. If you selected to analyze all the data
sets (the default), then Prism leaves empty data sets in results if there
are empty data sets in the data table. That way the data set letter is
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always the same for data tables and results. In other words, the results
for data set E are always in results data set E. But if you selected to only
analyze selected data sets, Prism only analyzes selected data sets that
are not empty. If you choose to analyze data sets C, D and E, but data
set D is empty, then the results for data set C will appear in column A of
the results table, and the results for data set E will appear in column B in
the results table.

Excluding a range of rows

Prism is set up to work with sets of data set columns. There is no way to
select a range of rows to analyze. The workaround would be to duplicate
the table, and then remove unwanted rows from the copy.

15.2.8 Embedding results on a graph

You can copy any part of a results table and paste it onto a Prism graph
or layout. The link will be 'live' so will be updated if you edit the data or
change the analysis parameters.

Double-click on the embedded table to bring up a dialog that will let you
adjust its font, borders, etc.

When you copy a single cell of a table, you have two choices when
pasting:
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·

Paste as text -- First use Prism's Text tool to create a text box, then paste a
results sheet value into it. In this case, the value you copied will be pasted as text,
with no link back to the analysis.

·

Paste as link -- If you paste directly onto the graph or layout (not while entering
text), you will paste an embedded table (with one cell) that will automatically
update when the results are recomputed.

15.2.9 Hooking to analysis and info constants

What is hooking?

Prism lets you 'hook' the results of some analyses into the parameters
dialog of other analyses, and graphing dialogs. The value you hooked is
then used in that analysis, or graphing choice. The link is live, so will be
updated if the data are edited or (in some cases) if the analysis
parameters changed.

You can also hook constants entered on an Info sheet.

Which analysis results can be hooked?

Here is the list of all analysis results that can be hooked.

Analysis Values that can be hooked

Nonlinear
regression

·

Best-fit value of each parameter

·

Lower confidence limit of each parameter

·

Upper confidence limit of each parameter
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Survival
analysis

·

Median survival

Bland-Altman
·

Bias

·

Lower 95% confidence limit of bias

·

Upper 95% confidence limit of bias

Descrptive
statistics

·

Mean with lower and upper confidence limits

·

Geometric mean with lower and upper
confidence limits

·

25th and 75th percentile

·

Median

·

Lowest value

·

Highest value

·

QC control lines (Mean plus or minus 1, 2 or 3
SD)

·

SD

·

SEM

·

N

·

Sum

You cannot add to this list (but we can, so send us suggestions).

How to hook?

You'll see hook icons  on many dialogs next to fields requiring you to
enter a value. Click, and then choose an analysis constant (or info
constant) on the Hook dialog.
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Example 1. QC plot

The graph shows repeated quality control measurements. The descriptive
statistics analysis was run to compute the mean and SD (and more) of
the values. The lines at the mean and plus or minus two standard
deviations were drawn by hooking these values. This means that the grid
lines will move as more data are entered into the data table.

First double click on the Y axis to bring up the Format Axes dialog on the
Y axis tab. The bottom of the dialog lets you add additional ticks and grid
lines. To hook the grid line to an analysis constant requires drilling down
to the details dialog, so click the '...' button.
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You don't want to enter a Y coordinate on the Format Additional Ticks and
Grids dialog. Instead you want to hook an analysis constant. Click on the
hook button, and then choose the value you want to hook (first the mean,
later the two QC control lines). Back on the Format Additional Ticks and
Grids dialog, choose the kind of line (solid or dotted) and its color. You
can also choose to fill between the two QC lines
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Example 2. Confidence interval of EC50

This example shows grid lines at the EC50 along with its 95% confidence
interval. All three values were 'hooked' from the nonlinear regression
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using Additional ticks and grid lines , so will move if data are edited or
replaced.

15.2.10 Color coding key results

It is easy to color code selected cells a results tables. This would be useful
to highlight the key results, or to mark surprising results you wish to
review further. To do so:

1. Place the insertion point in the single cell you wish to color code. Or
drag to select a range of cells. 

2. Click the paint bucket icon in the Change area and choose a color. Or
drop the Change menu and choose "Cell Background Color".
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Note the distinction between the feature explained here with a related
feature that lets you highlight (color code) sheet names in the navigator. 

15.3 Transforming, normalizing, etc.
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Before graphing or analyzing your data, you may

first need to do some calculations to get your data

into proper form. While Prism is not as versatile

as Excel, Prism can do many data manipulations.
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15.3.1 Key concept -- Manipulating data

Before graphing or analyzing your data, you may first need to do some
calculations to get your data into proper form. While Prism is not as
versatile as Excel, Prism can do many data manipulations. From the data

table, click  on the toolbar, and choose transform  , normalize
, transpose , prune  or remove baseline .

Results will appear on a new results tab with a green grid. While you
cannot edit these results, you can create a new graph (use the New...
button) and do further analyses (click the Analyze button). 

What if Prism doesn't offer the tools you need to manipulate your data? In
that case, you should enter and manipulate your data in Excel, and then
copy and paste the results into Prism for further analysis and graphing.
Note that you can paste a link to the Excel file or you can paste embed
the entire Excel workbook within Prism. Learn more about linking and
embedding data from Excel .

 

 

320 327
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15.3.2 Transform data

When you transform data with Prism, the data table isn't changed.
Instead, Prism creates a new results table with the transformed values.

Standard functions

Choose a function

Choose from one of these functions for transforming Y values (analogous
functions are available for X):

Function Comments

Y= Y * K
Y = Y + K
Y = Y – K
Y = Y / K
Y = Y squared
Y = Y ^ K
Y = log(Y)
Y = -1*log(Y)
Y = ln(Y)
Y = 10 ^ Y
Y = exp(Y)
Y = 1/Y
Y = sqrt(Y)
Y = logit(y)
Y = probit(Y)
Y = rank(Y)
Y = zscore(Y)
Y = sin(Y)
Y = cos(Y)
Y = tan(Y)
Y = arcsin(Y)
Y = ABS(Y)
Y = Y + Random
Y = X / Y
Y = Y / X
Y = Y – X
Y = Y + X
Y = Y * X
Y = X – Y
Y = K - Y
Y = K/Y
Y = log2(Y)
Y = 2^Y
Y = Y rounded to K digits
after decimal

Enter K in the box provided.
“
“
“
Enter K in the box provided.

Log base 10 
Natural logarithm (base e)

Ten to the Yth power (inverse of log).

eY (inverse of ln)
 
Square root.
ln(Y/1-Y)
Y must be between 0.0 and 1.0. See notes below.
Column rank. Smallest Y value gets rank of 1.
Number of SDs from the column mean.
Y is in radians.
“
“
Result is in radians.
Absolute value.
Gaussian. Mean=0. SD=K (you enter).

Enter K in the box provided.
"
Logarithm base 2
2.0 to the power of Y
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Many of the functions include the variable “K”. Enter a value for K on the
dialog. When transforming Y values, you can enter one value of K for all
data sets or a separate value of K for each data set. To enter different K
values for each data set, choose a data set, enter K, choose another data
set, enter its K, and so on. Rather than entering the value of K, you can
hook an analysis or info constant .

Notes about the probit() function. Prism uses an older definition of probit
that adds 5 to all results, to avoid use of negative numbers. No, it doesn't
really make sense, but this was once a common standard. So
probit(0.025) = 3.04 (which is -1.96 + 5.00),  probit (.975) = 6.96 (1.96
+ 5.00), and probit(0.5) = 5.00 (0.00 + 5.00).

Interchanging X and Y

When you choose a standard function, you can choose to interchange X
and Y values and also choose transforms of X or Y or both.

Some notes on swapping X and Y values:

· Prism can interchange data on tables with more than one data set (more
than one Y column), even though the results sheet has only a single X
column. It does this by creating additional rows. The results will be
staggered down the page with only one data set in any particular row.

· If you entered replicate Y values (or mean with SD or SEM) Prism
interchanges X and Y by putting the mean Y value into the X column.
Information about the scatter of Y is ignored.

· If you selected X or Y transforms (in addition to interchanging), Prism
applies the transform to the data after interchanging X and Y. This
means that the X transform is applied to data that were originally in the
Y column, and the Y transform is applied to data originally in the X
column.

Transforming error values

If you entered replicate Y values, Prism can transform each replicate or
the mean of the replicates.

If you entered data as mean, SD (or SEM), and N, Prism tries to
transform the error bar as well as the mean. When a transform is
intrinsically asymmetrical (i. e. logarithms), it is mathematically
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impossible to transform a SD and end up with a SD. You have two
choices. You may either transform the mean only or erase the error bars.
Or you may convert the error bars to 95% confidence intervals, and then
transform both ends of the confidence interval. The resulting 95% CI will
be asymmetrical.

Transforms for pharmacology and biochemistry

Eadie-Hofstee, Hanes-Woolf, and Lineweaver-Burk transforms are used to
plot enzyme-kinetic results. Scatchard transforms are used to display
radioligand binding, and Hill plots are used to plot dose-response data.

Important:. Use these transforms only as a way to display data, not as a
first step in analyzing data. You'll get better results by using nonlinear
regression on the actual data.

Here is the mathematical definition of each transform:

Function X becomes Y becomes

Eadie-
Hofstee

Y/X No change

Hanes-Woolf No change X/Y

Hill No change if
you entered
your data as
log(conc.).
Log10(X) if you
entered your
data as
concentration.

log10(Y/(Ymax-Y))
(Prism prompts for
Ymax)

Lineweaver-
Burk

1/X 1/Y

Log-log Log10(X) Log10(Y)

Scatchard Y Y/X

 

Prism can also create Bland-Altman plots, which require a simple
transform of the data. However, this is not done via a transform, but
rather via a separate analysis. 

User-defined transforms
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When writing your transform, you may use any of these functions when
writing your equation. Mostly functions are pretty standard.  Beware of
the sqr() function, which has different meanings in different
environments. In Prism, sqr() squares the value, and the sqrt() function
takes the square root.

If you are transforming X values, you may use Y in the function. If the
data table contains several data sets (so has several Y values for a single
X value), Prism will stagger the results down the page, repeating X values
as needed. The results for column A will appear on top of the results
table. Below that Prism will place the results for column B. For these
rows, column A will be empty. 

Usually, the same function is applied to all data sets. But you can write a
transform to apply different transforms to different data sets. To do  this,
precede the lines that apply to only some data sets with column
designators. For example, put <B> in front of a line in your transform
that only applies to data set B. Put <~A> in front of a line that applies to
all data sets except data set A.

Prism allows you to introduce some branching logic through use of the IF
function. The syntax is:

IF (conditional expression, value if true, value if false)

You can precede a conditional expression with NOT, and can connect two
conditional expressions with AND or OR. Examples of conditional
expressions:

Y>100
Ymax=Constraint
(A<B or A<C)
NOT(A<B AND A<C)
FRACTION<>1.0
X<=A and X>=B 

Note: “<>” means not equal to, “<=” means less than or equal to, and
“>=” means greater than or equal to. Here is an example:

Y= IF (Y<Y0, Y, Y*Y)

If Y is less than Y0, then Y is unchanged. Otherwise Y is transformed to Y
squared.

Y = IF (Y<0, Y/0, Y)

This function  returns Y if Y is positive or zero, but otherwise leaves the
results blank. In other words, it removes all negative values. The way to
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leave a result blank is to do an impossible mathematical transform such
as dividing by zero.

15.3.3 Transforming concentrations

This analysis makes it easier to transform X values that are
concentrations.

Special handling of X=0

Why handle X=0 specially? Because it is common to transform X values to
their logarithms, which is required before fitting some models to your
data. Since the logarithm of zero is undefined, if you enter X=0 that value
will be empty (missing) after transformation. This analysis  lets you
substitute some other value (a tiny concentration) for zero before taking
the logarithm. For example if your data go from 10-9 to 10-3 molar and you
plan to take the logarithm, consider changing the 0 value to 10-11. 

Change units

Multiply or divide all X values by a constant you select to change units.

Transform to logarithms



Analyzing data with Prism 325

© 1995-2020 GraphPad Software, LLC

Choose whether you want to use natural logarithms or base10 common
logarithms. Unless you are a mathematician, you may only know about
common logarithms and "natural logarithms" will seem very unnatural. 

15.3.4 Remove baseline

Many kinds of data combine a measurement (signal) you care about with
a baseline or background (noise) you don't care about. You can analyze
these data using two approaches. One approach is to perform analysis on
the total signal. The other approach is to subtract or divide by a baseline
or nonspecific value and then analyze and graph the results.

To access this analysis, start from the data table, click Analyze, then
chose the analysis Remove Baseline and Column Math. If you can't find
what you want in the analysis, take a look at the Normalize analysis
which does similar calculations. 

Definition of baseline
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Depending on the experimental details, the baseline can be defined in (at
least) three ways. Think this through before choosing this analysis in
Prism. The baseline value for a particular value can be:

· A value, or the mean of several replicate values, in specified rows of the
same column as the total value. Choose to define the baseline as the
value in the first row, the last row, or the mean of a specified number of
values in the first and/or last rows. 

· A value (or mean of replicate values) in the baseline column of the same
row of the table as the value from which the baseline will be subtracted
(or divided) . So the baseline value for a value in row 13 of column B
would be the value in row 13 of column A, or the mean of replicate
values in row 13 of column A. Choose between a single column being
the baseline values for all other values, or of having every other column
be baseline vs. total. 

If you check the option to assume a linear baseline, Prism performs
linear regression using the X values as X and the background
(nonspecific) values as Y. It computes a  predicted Y value (from the
line) at each value of X. Finally, it subtracts (or divides) this predicted
baseline Y value. This method is appropriate when you know that the
nonspecific or background values must be linear with the X values (for
example nonspecific binding is often linear with ligand concentration),
and is particularly useful when you have not collected baseline or
nonspecific measurements at every value of X (Prism will fill in the
missing nonspecific values from linear regression). When Prism fits
linear regression, it does not assume that the line goes through the
origin and does not display the regression results.

· The mean of all the values in (say) column A. You need to approach the
calculation differently if you wish to define the mean (or median) of one
column to be the baseline to subtract from (or divide into) all the other
values,. You cannot accomplish this goal using Prism's Remove Baseline
analysis. Instead, do two analyses of your data table. First do a
Descriptive Statistics analysis to compute the column means. Then do a
Transform analysis, and choose the transform Y = Y-K (or Y = Y/K).
Hook  the value of K to the mean of the column you wish to use as the
baseline (usually the first column). 

Calculation

The choices are self-explanatory. You can ask Prism to subtract the
baseline, divide by the baseline, compute the fractional or percentage
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difference, etc.  Note that you can also use this analysis to add or
multiply two columns.

15.3.5 Normalize

Normalize the data to convert Y values from different data sets to a
common scale. If you can't get Normalize to do what you want, take a
look at the Remove Baseline analysis  which can do some kinds of
normalizing. 

One example of where normalizing can be useful: Investigators who
analyze dose-response curves commonly normalize the data so all curves
begin at 0% and plateau at 100%. If you then fit a sigmoidal dose-
response curve to the normalized data, be sure to set the top and bottom
plateaus to constant values. If you've defined the top and bottom of the
curves by normalizing, you shouldn't ask Prism to fit those parameters.

To normalize, click Analyze and choose Built-in analyses. Then select
Normalize from the list of data manipulations to bring up this dialog.

To normalize between 0 and 100%, you must define these baselines.
Define zero as the smallest value in each data set, the value in the first
row in each data set, or to a value you enter. Define one hundred as the
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largest value in each data set, the value in the last row in each data set, a
value you enter, or the sum of all values in the column. Prism can express
the results as fractions or percentages.

Notes:

· If you have entered replicate values, zero and one hundred percent are
defined by the mean of the replicates. It is not possible to normalize
each sub column separately.

· The X values are copied to the results table. They are not normalized.

· Each SD or SEM is normalized appropriately. Subtracting the baseline
does not affect the SD. Dividing by the range does affect the SD, so the
resulting SD values are the original values divided by the range (and
maybe converted to a percentage). 

· If you normalize to the smallest and largest value in the data set, you
can remove those values (which would become 0.000 and 1.000) from
the results.

· If your data are entered into subcolumns, you can normalize the means
or separately normalize each subcolumn.

15.3.6 Transpose rows and columns

Each row of Y values becomes one column (data set) in the results table.
The first row becomes the first data set, the second row becomes the
second data set, etc. You may not transpose a data table with more than
256 rows, because Prism cannot create a table with more than 256
columns.

The column and row titles in the results table are determined by your
choices in the dialog.
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Don't forget to check the option box if you want to create a new graph
from the transposed data.

An alternative way to transpose is to copy selected data, and then paste
transpose .

Don't confuse transposing a data table (making each row become a
column) with swapping X and Y columns (so X becomes Y, and Y becomes
X). If you want to swap (interchange) X and Y columns, this is possible
via a checkbox on the Transform  dialog.

15.3.7 Prune rows

This analysis takes a large table, and creates as output a smaller table,
which can be easier to work with. But note that your original data are still
part of the file, which means the project file gets larger not smaller. But it
can be useful to have a smaller data set for quicker analyses and
graphing.

272
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To prune, click Analyze and choose Built-in analyses. Then choose Prune
from the list of data manipulations to bring up this dialog.

 

Note that Prism can also decimate while importing data  – import a row,
skip K rows (you enter K), then import another row.
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15.3.8 Fraction of total

The fraction of total analysis divides each value by its column or row total,
or by the grand total.

This analysis is most often used for parts-of-whole data or for contingency
tables, but it can be used for column data and for XY or Grouped data
tables, so long as they have no subcolumns.

The calculation of confidence intervals only makes sense when each value
entered into the table is an integer that represents the actual number of
objects or events counted. In this situation, computing a confidence
interval based on the binomial distribution makes sense. Don't check the
option to compute confidence intervals if the data are measured values, or
percentages, or normalized. 

With the first three choices, the results are presented on a results table
with green grid lines, so those results can be plotted. With the last choice
(presenting fraction of all three totals), the results are on a table with red
grid lines so cannot be plotted. With this last option, the option to report
confidence intervals is not available.
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Prism can compute the confidence intervals of proportions using three
different algorithms. We recommend the Wilson/Brown method. Prior
versions of Prism used the Clopper-Pearson method.

15.3.9 Select and transform multiple variable tables

This analysis lets you make a new multiple variable table from an existing
one. You can select just a portion of the table, and can do transforms to
make new variables. You may then want to perform multiple regression
(or show the correlation matrix) on the newly created table. 

The dialog has three tabs.

Transform columns

On the top half, specify transforms of designated variables (columns), for
example logarithm or reciprocal or change units. The results will be
placed in new columns. 

The bottom half of the tab lets you specify equations to generate new
columns by combining two or more columns. 

Select rows

Select rows in three ways:

· A range of row numbers.

· Rows where a value in a particular column is greater than (or less than,
or equal to) a specified value.

· Rows where the value in one column is greater than (less than) the
value in another column. 

If you enter choices in more than one of these sections, only rows that fit
all the criteria you specied will appear in the new table. 

Select columns (variables)

·  Choose which variables (columns) you want to include in the new
table. 

http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_three_methods_for_computing_th.htm
http://www.graphpad.com/guides/prism/7/statistics/index.htm?stat_three_methods_for_computing_th.htm
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15.3.10 Extract and rearrange from multiple variable tables

This analysis takes as input a multiple variable table, and creates another
table of a different type (XY, Column, Grouped or Contingency) from a
subset of data. If you want to create another multiple variable table, this
is the wrong analysis to use. Use this one  instead. 

The dialog has two tabs:

Format of results table

On the first tab, decide which kind of table you want to create.

           

Data arrangement
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On the second tab, define which columns to use. 

· If you are creating an XY table, choose which column becomes the X
column, which contains the Y values, and which (integers only) defines
which data set the Y values go into. 

· If you are creating a Column table, choose which column has all the
values that will go into the new column, and which (integers only)
defines the data sets. 

· If you are creating a Grouped table, choose which column has all the
values that will go into the new column,  which (integers only) defines
which data  set each value goes into, and which defines which row each
value goes into.

· If you are creating a Contingency table, choose which column defines
the outcomes (columns) and which data set defines the exposure or
treatment (rows). None of the values in the input table go into the new
table. Rather the new table is a cross-tabulation table. Normally each
row in the input table will increment one particular cell (defined by row
and column) in the created table. Optionally, you can define another
column on the input table that defines how large an increment to make. 

Note: If your goal is to swap X and Y values on a XY table, this analysis
won't let you do it. Use the Transform  analysis instead. It has a choice
to swap X and Y.

320



Graphs 335

© 1995-2020 GraphPad Software, LLC

16 Graphs

For many, the whole point of Prism is to make and

polish graphs. Learn how.

16.1 Creating graphs

Automatically created graphs

New graph of existing data

336
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Duplicating a graph

Graphs created by analyses

Portfolio graphs

16.1.1 New graph of new data

When you create a new data table, Prism automatically creates a linked
graph.

You'll create your first data table from the Welcome (File..New) dialog,
and a graph will be automatically created. When you first go the the
graph, a dialog will pop up  where you can choose exactly the kind of
graph you want. 

To make additional data tables with linked graphs, click on the New
button in the Sheet section of the Prism toolbar and choose New Data
Table With Graph. Choose the kind of data table on the New Data Table
dialog.  

16.1.2 New graph of existing data

Before you create a new graph, consider duplicating  the graph. This is
super useful. 

To create a new graph of existing data:

338
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1. From the data table, click the New button and choose New Graph
of Existing Data.

  

2. Check that the correct table is chosen in the drop-down list. 

3. Check "Plot selected data sets only" if you don't want to plot all
the data on the graph. Then click Select and choose the data sets
to plot. You can only choose data set columns. You cannot choose
a range of rows. All rows are always plotted. 

4. If it is an XY table and you have fit a line or curve, check the
option if you want the curve or line to also appear (as well as the
data) on the new graph. 

5. Usually Prism creates one graph from the entire data set. If you
want one graph for each data set, check that option. If you choose
to create a new graph for each data set, you can specify the Y-
axis title here. 

6. Choose the kind of the graph you want. The drop down lets you
choose between XY, Column, Grouped, etc. graphs, but you'll
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almost always want the kind of graph that matches the data
table. 

7. Choose one of the thumbnails and make other choices to
customize the graph. 

To bring back this dialog, drop the Change menu and choose Graph Type,
or click the button shown below. 

    

16.1.3 Duplicating a graph

Duplicate a graph, and plot the same data

There are two reasons you might want to duplicate a graph:

· You want two graphs of the same data. Maybe one in color and one in
black and white. Or one plotting raw replicates and another with mean
and error bar. 

· You are experimenting with different ways to graph your data. You can
keep one graph while editing a copy, so exploring new ideas won't
delete a graph you sort of like. 

To duplicate a graph, go to it, click the New button, and choose Duplicate
Current Sheet. Prism will create a duplicate of the graph, and both copies
will plot the same data. Now you can change the properties of the new 
graph without affecting the original. In some cases, you may want to later
delete one of the copies . 

Duplicate a graph, and plot new data

Prism offers two ways to duplicate a graph with its data table (and
analyses). The two do basically the same thing, so it is a matter of
preference which you use. 
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· Duplicate family . Go to the graph you want to duplicate, click the New
button, and choose Duplicate Family. The duplicated graph will look
identical to the one you started with, but it will be graphing a duplicated
data table and perhaps duplicated analyses. Edit the data on that table,
and the new graph will update.

· Clone a graph . Click the New button and choose New Data Table (+
Graph). On the New Data Table and Graph dialog, choose the Clone tab,
and choose which graph to clone. Use tabs at the top to clone from a
current project, a recent project or a saved example file . 

When you clone a graph, you'll be asked if you want to delete the data (or
part of the data) on the new data table. When you duplicate a family,
you'll need to select and delete the data manually. 

16.1.4 Graphs created by analyses

Some analyses automatically create new graphs. For example, if you
choose to make a residual plot as part of linear  or nonlinear regression, a
new graph will be made. Another example: With most multiple
comparisons after ANOVA, you can choose to make a new graph showing
the confidence intervals of the differences between group means. 

16.1.5 Portfolio graphs

One tab on the Welcome (File..New) dialog that comes up when you start
a new Prism project is portfolio. Choose that tab and view dozens of
graphs made by Prism. Open any of these to explore how they were
made. You can also edit the data and graph to make your own graph
using the portfolio graph as, essentially, a template. 

175

176

172



GraphPad Prism 8 User Guide340

© 1995-2020 GraphPad Software, LLC



Graphs 341

© 1995-2020 GraphPad Software, LLC

16.2 Prism Graphs: the basics

A picture is worth a thousand words -- Prism

makes it easy to create the graphs you want.

Choose a type of graph, enter your data and Prism

automatically creates a graph. Because graphs

and data are linked, if your data changes your
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graph will automatically be updated. Once you've

made your graph, you can customize any part of

it. This section contains the key things you need

to know to get started with graphs.



Graphs 343

© 1995-2020 GraphPad Software, LLC

16.2.1 Eight ways to change a graph

Direct manipulation

Click on an axis to select it. Knobs appear on both ends. Move the mouse
over the right knob of the X-axis or the top knob of the Y-axis. Drag the
axis to make it longer or shorter. Or grab the middle of the axis and move
the entire graph around the page. 

Shortcut menus

Move the mouse over a symbol, title, axis, etc, and right click (control
click with Macs). The shortcut menu will give you many choices to format
the object.  

Change Graph Type dialog

You can bring back the Change Graph Type dialog  (the same one you
used to create the graph) any time. This is useful for making large
changes in how the graph looks. 

Format Graph dialog

Use the Format Graph dialog  to change symbols, bars, error bars, area
fills, legends, etc. Double click anywhere on the graph (except the axes)
to bring it up. Be sure to look at all the tabs.

Format Axes Dialog

Use the Format Axes dialog  to change the range, interval, scale,
numbering, etc. of the axes. Double-click on an axis to bring it up. Be
sure to look at all the tabs.

Select a range of points on a data table, and change how corresponding
points are graphed

Select a cell or a block of cells, right (control) click, and choose Format
Points. You'll be able to change the color, size, symbol, border, etc. of the
points or bars that correspond to the selected cells. 

Color schemes

Choose a color scheme  to change all colors at once. 
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Magic -- Make Graphs Consistent

The Prism Magic  tool makes one (or more) graph look like another. It is
a huge time saver.

16.2.2 Change Graph Type dialog

Click to open the Change Graph Type dialog. On the top of the dialog,
choose one of the thumbnails showing the various kinds of graphs, and
then inspect the preview at the bottom of the dialog to make sure it is the
graph you want.

This dialog is really designed to let you change graph type within a family.
For example, change from column chart with error bars to a scatter plot.
It also lets you change to a graph in a different family, but this rarely
makes sense. If you need to change to a different family of graphs, there
is a good chance you also need to change the format of the data table .

You can also change graph type within the Format Graph  dialog. Click
Global (upper right corner of dialog), then change all data sets, so the
changes you make apply  to all the data sets and not just one. 

Note that there are multiple ways to create bar graphs in Prism . Don't
think "make a bar graph". Instead think about how the data are
organized.

16.2.3 Changing which data are plotted

Key points about plotting data sets

Once you understand these key points, it will be easy to control which
data sets are graphed.

· A graph can include many data sets from many tables. By default, Prism
makes one graph per table. But you can plot the same data table on
multiple graphs, and a single graph can have data from multiple tables.
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· When you fit a curve by nonlinear regression (or a line by linear
regression) the best-fit line or curve is essentially a data set. Prism
automatically plots the line or curve on a graph, but you can remove the
curve from one graph, or plot it on other graphs. Treat the curves just
as you would treat any other data sets.

· When you transform or normalize data, the results appear on green
data tables. You can't edit these tables, but the data sets on green data
tables can be graphed like any other.

Data Sets on Graph tab of the Format Graph dialog

The second tab of the Format Graph dialog lets you add, remove and
replace data sets on the graph (and also change the front-to-back or left-
to right order of data sets).

Bring up the dialog by double clicking on the graph, or using a shortcut
button.
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Shortcuts for adding, replacing and removing data sets

You don't need to use the dialog to add or remove data sets. 

Add data to a graph by dragging a data or results table from the
Navigator  and dropping it onto the graph.

Remove or replace a data set by right clicking on any point or bar, and
choosing Remove Data Set or Replace Data Set.

16.2.4 The Format Graph dialog

Overview

Double click anywhere on a graph (except the axis) and the Format Graph
dialog will appear. Or click the Format Graph button. 

The choices on this dialog  depend on whether you are editing a XY ,
Column , Grouped , Contingency , Survival  or Parts-of-whole
graph. 

Click “Apply” to see the effect of changes

The Format Graph dialog gives you a huge number of options to change
the appearance of your graph.  Click “Apply” to see the effect of the
changes you made without closing the dialog. This saves you time over
clicking OK to see the changes, then bringing back the dialog to make
more changes. Once you click Apply, the changes are made even if you
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then cancel the dialog. To reverse those changes, use the Edit..Undo
command. 

16.2.5 The Format Axes dialog

Overview

Double click on an axis, or drop the Change menu and chose the X-axis or
Y-axis command, and the Format Graph dialog will appear. Or click the
Format Axis button.

The dialog has five tabs:

· Frame and Origin

· X axis

· Left Y axis

· Right Y axis

· Titles and fonts

Click “Apply” to see the effect of changes

The Format Axes dialog gives you a many options to change the
appearance of your graph.  Click “Apply” to see the effect of the changes
you made without closing the dialog. This saves you time over clicking OK
to see the changes, then bringing back the dialog to make more changes.
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16.2.6 Prism Magic - Make Graphs Consistent

The Prism Magic tool makes one (or more) graph look like another. It is a
huge time saver.

Start from a graph, or several graphs selected in the Prism Gallery .
Click on the Prism Magic tool in the Change section of the Prism toolbar.

Select the graph whose appearance you'd like to match. You can choose
from any graph in the current project or any open project, any graph
saved as an example , or any graph recently (two months) printed,
exported, copied to clipboard, or used as a Magic example (so long as it
had been saved, so the file has a name). 
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Click Next, and then select the properties of the example graph you would
like to apply to your current graph or graphs. 

 

Notes:

· If you check the option "Range and ticks of axis", what Prism does
depends on whether you have checked the option to use an automatic
range for the axes. If that is checked (on the example graph, then Prism
will check that option on the graphs you are changing. Depending on the
range of the axes, they may or may not end up with the same range. If
that option is not checked on the example graph, then all of the graphs
you are changing will be changed to have the range and interval of the
example graphs. 

· Note there is one choice near the top to change the fonts (including size
and color) of axis number, axis titles and graph title. There is also a
choice near the bottom (introduced with Prism 8) that changes the
wording of the axis and graph titles. 

· The choice to apply the formatting individually applied to selected points
or bars only makes sense when the example and target graphs have the
same number of points or bars. If that is not the case, the choice will be
gray.
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16.2.7 Rotating, flipping, reversing

The Rotate/Flip button in the Change section of the Prism toolbar drops a
menu with three choices. You can reverse the order of data sets on a
graph, flip the page settings between landscape or portrait orientation, or
rotate column graphs from vertical to horizontal

Reverse order of data sets

For XY and Survival graphs, this reverses the front to back order of data
sets. This only matters when data points overlap. You can fine tune that
order  in the Format Graph dialog.The two graphs in this example are
identical except that the plotting order was reversed.

 On Column, Grouped and Contingency graphs, this reverses the left-to-
right order. You can also fine-tune that order .

Flip between portrait and landscape orientation

You choice of portrait or landscape only matters when you print the graph
from the Graphs section. This choice does not change the aspect ratio
of the graph.

Rotate entire graphs

Rotate between vertical and horizontal presentation of Column, Grouped
and Contingency graphs.
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16.2.8 Formatting individual symbols and bars

Change the look of a single point or column

Right-mouse click on the point and choose Format this Point. You can
change the symbol shape, size, color and the format, color and direction
of the error bars.
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For example, on the graph below, each data point is formatted to show
different symbols and error bars directions for alternating data points.

Format a range of data from the data table

Select a block of data, right click, and choose Format Points.
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Revert individual formatting back to data set format

Open the Format Graph dialog by double clicking on the graph. Go to the
Graph Settings tab, and check the option to "Remove all individual
formatting."

16.2.9 Changing a graph's shape and size

Stretch an axis

Click on the axis to select it. Knobs appear on both ends. Move the mouse
over the right knob of the X-axis or the top knob of the Y-axis. Drag the
axis to make it longer or shorter.
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Enter the exact length of the axes

Double-click on the origin to bring up the Frame and Origin tab of the
Format Axes dialog. Select a custom shape, and enter both width and
height. Or select a standard (tall, square, or wide) shape, enter either
height or width, and Prism will automatically change the other value. On a
wide or tall graph, the long axis is 1.5 times the length of the short axis.

Set the default size and shape for new graphs

Pull down the Edit/Preferences menu and from the Graph tab choose Wide, Tall, or
Square. On a wide or tall graph, the long axis is 1.5 times the length of the short axis.
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Make a graph larger or smaller, including fonts

Click the Resize Graph button in the Change section of the Prism toolbar.
This button enlarges or shrinks both the graph and also the graph's
symbols and fonts. In contrast, resizing by stretching an axis doesn't
change symbol or font size.

If you click More Choices, a dialog lets you pick the exact size you want
and lets you resize the graph without changing font size. This can be
useful when the journal specifies both the exact graph size it wants and
the point size of fonts.
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Point of confusions 

Changing the size of a graph vs. changing the zoom

The Zoom buttons at the right end of the bottom toolbar let you zoom in
or out as you work on a graph. These controls only change the
magnification you see on screen, and do not change its size when printed
or exported.

Changing the length of the axes vs. changing the size of the graph

The first tab of the Format Axes dialog lets you choose exactly how long
the X and Y axes will be. The graph itself will be larger, depending on
what you choose for numbering and titles. The graph object will also be
larger if you place tables, text, drawings or images on the page. 

Click the Resize Graph button in the Change section of the Prism toolbar
to change the size of the entire graph object (including everything placed
on the graph page). You can tell Prism to make the graph have a specified
width. Or you can tell Prism how long you want the X axis to be.

You can also resize a graph when exporting . Specify the width of the
graph (with all the other objects on the page) in the export dialog. Prism
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won't change the graph in Prism, but will create the exported graph file to
match your choices. 

 

16.2.10 Legends

When are legends  created automatically?

When your graph includes more than one data set. If it plots only one
data set, no legend is created automatically. The legend is a symbol or
bar followed by the data set name. (Legends for heat maps are
different .)

When does the legend simply say "legend"?

When you have not entered a column title. Enter a column title on the
data table, and the graph legend will update.

How to edit the legend

You can edit the column titles of the data table, or you can edit the
legend directly on the graph. If you edit on the graph itself, you will
lose the linkage between the column title and the legend.

When is the column title hot-linked to the legend, so edits to the
column title appear on the graph?

The two are hot linked so long as you only edit the column titles. When
you edit the legend itself, the link is broken. Restore it by double-
clicking on the graph to bring up Format Graph dialog, go to the
appropriate data set, and then check the option "Revert legend to
column title".

 
How to delete a legend

Select it and press Delete. Or hold the Control key while selecting
several legends (or lasso them all) and press the Delete key to delete
them all. 

You can also delete legends by unchecking the "Show legend" option at
the bottom of the first tab of the Format Graph dialog.
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Moving legends
Select one or more legend, and drag it around. You can also use the
commands on the Arrange menu to align and equally space legends.

Reversing the order
A command on the Change menu, Reverse Legend Order flips the front-
to-back or left-to-right order of data sets on the graph. You can also
change the order of data sets by dragging them on the page one by
one. 

Master legends
Learn how to make one legend be a master legend  for several graphs
on a layout. 

XY: When does Prism give me a choice of plotting  a symbol, a line
or both?

When you have chosen to connect points with point-to-point connecting
lines. If you plot the points from one data set and also a fit curve from
another results data set, Prism won't give you the choice of having one
legend with both symbol and line.

Bar graphs: How to change from square to rectangular legends for
bar graphs. 

Double click on the graph to bring up Format Graph. Go to the third
tab, and you'll see this choice at the bottom.

16.2.11 Graphs with a right Y-axis

When you plot several kinds of data on one graph, it is often useful to plot
some data using a Y-axis on the left side of the graph and other data
using a Y-axis on the right side of the graph.  Note that you never can
have more than one X-axis.
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To create a second Y axis

Double-click on an axis to open the Frame and Origin tab of the Format
Axes dialog. Or click on the Format Axis tool in the Prism toolbar.

Select the tab for "Right Y axis" and choose how you want the axis to be
formatted.

All data sets are initially graphed using the left Y-axis. Depending on the
scale of the axis, the data points may or may not all be visible.

To plot data using the right Y-axis

Double-click on a data point or click on the Format Graph button on the
Prism toolbar. At the bottom of the Appearance tab, select “Right Y axis”.
Repeat for each data set to be plotted on the right Y-axis.

 If you assign a data set to the right Y-axis, and there is no Y axis. Prism
will automatically create the axis.
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To create a graph with ONLY a right Y axis

Turn off the left Y axis, and create a right Y axis to which you assign data
set.

To use different colors for the two Y axes
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It is possible to give the two Y axes different colors. Select one axis, drop
the Change menu, choose Selected Object(s), and set the color (and
thickness) on the Format Object dialog that appears.

To create a graph with three Y-axes

Prism does not allow three Y-axes. You can, however, create that effect
with a bit of a workaround. Create a graph with no data. Hide the X-axis
(one of the choices for axis frame). Delete all the titles, You are left with
just a Y-axis. You can make that whatever scale makes sense. Now make
a layout and put your real graph next to this bogus graph with only a Y
axis. With some fussing to get the sizes to match, and the data scaled
right, you can give the illusion you want. You'll need to tell Prism to plot
all the data sets on either the right or left axis, so may need to transform
your values to make this work well.

This FAQ explains in more detail. 

Limitations

Prism always draws the right Y axis, if there is one, the same length as
the left axis and starting and stopping at the same position on the page. 
If you want one of the axes to be shorter, the only way to get that effect
is to cover up part of one of the axes with a drawn rectangle that you
then make white (or whatever your page background color is).

16.2.12 Changing fonts  on graphs

You can change the font and point size of all the text that appears on
Prism graphs:

· Set the default for fonts used in new graphs on the New Graphs tab of
Preferences .

· The font of the graph title and axis titles can be changed by selecting
the title, then changing the font using the toolbar or Change..Selected
text. You can also change these fonts on the last tab of the Format Axes
dialog .

· The font of legends is changed by selecting and changing using the
toolbar or Change..selected text. 
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· To change the font of the axis numbering or labeling: Click once to
select the axis. Then use the toolbar or change selected text to change
the font of all the numbers or labels on that axis. You can also do this on
the last tab of the Format Axes dialog . 

16.2.13 Bar graphs

"Bar graph" describes how the data are plotted, but not how the data are
organized. Prism can make bar graphs  from XY, Column, Grouped ,
Parts-of-whole data and nested data. 

Notes:

· With XY data, you can combine bar graphs and XY on one graph .

· Until Prism 6, the border of a bar graph was placed half inside and half
outside the bar. With thick borders, this meant the top of the border of
the top part of the bar actually stuck up too high, so the bar graph did
an imperfect job of displaying the data. Starting with Prism 7, the
borders are placed entirely within the bars.

· Bar graphs are great for displaying proportions and counts. For
continuous data, there are lots of ways to plot data. Bar graphs (in my
opinion) are overused. Instead of making a bar graph, consider making
a scatter plot, a box-and-whisker plot or a violin plot. 

16.2.14 Colors

 .

16.2.14.1Color schemes

Color schemes change all of a graph's colors at once. They are very
useful, but underused. 

Prism 8.1 added new color schemes, including a "Colorblind Safe" color
scheme, with colors designed to be distinguishable even by individuals
with a variety of different color vision deficiencies. 

Go to the graph you want to change, or select several graphs in the
gallery . Then click on the Color Scheme button in the Change section of
the Prism toolbar. You can choose standard schemes right from the
menu, or click More Color Schemes to have more choices.
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In the color schemes dialog, you can choose a color scheme by name
using the drop down menu, or use the arrow buttons to browse the
schemes. 

 

You are not limited to the color schemes we provide. To create a new
color scheme, start from a graph with the colors you like. Click the Color
Scheme toolbar button and choose Define Color Scheme. The new color
scheme will default to the colors of the current graph, so this makes it
easy to transfer a color scheme from one computer to another: Apply the
color scheme to a graph on one computer, open the file on another, and
create a new scheme based on that graph. 
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After you click the "Define Color Scheme" button shown in the screenshot
above, you can also delete any user-defined color scheme you no longer
use. 

 

16.2.14.2Selecting colors (Mac)

To change colors individually, without dealing with color schemes:

· Change the color of a data set in the Format Graph dialog. Double-click
on the graph to open it.

· To change the color of just one data point,  right-click on that point or
bar and choose Format this data point

· Change the color of axes in the first tab of the Format Axes dialog.
Double click on an axis to open it.

When you choose any color in Prism mac, you use the standard MacOS
color picker.
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· The toolbar at the top lets you choose one of five different approaches
to choosing a color. The example above shows choosing from a a set of
crayons, but the other button or tabss  let you also use a color wheel,
color sliders (to enter RGB or CMYK), list of colors, or choosing from a
color palette.

· The  magnifying glass icon gives you a sixth way to choose colors, by
matching  a color elsewhere on your screen. Click on the icon, then click
on any color showing on your screen (ok if it is a different application). 

· The custom colors at the very bottom of the dialog offer a seventh way
to choose a color. Simply click on the desired color. See below for
adding colors to this palette.

· Once you choose a color in the color picker, you'll also see it in the
Prism dialog. You don't need to click OK or close the Color Picker dialog. 

· To add new colors to the custom color palette at the bottom of the
dialog, drag a color down from the large swatch on top of the dialog
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(white in the example) and drop onto one of the custom color boxes. To
choose a custom color, click on it.  

· To make a color semitransparent  (opaque), use the slider at the
bottom of the color picker. 

Troubleshooting the Mac color picker

16.2.14.3Selecting colors (Windows)

Using the color picker

Within Prism, there are color drop downs on many dialogs (Format Graph,
Format Axis...) and on some right-click shortcut menus. Choose a color
shown and you are done. Or click the bottom choice, More Colors. for
more choices.  This brings up the custom color dialog, which is part of
Windows and was not created by GraphPad. This offers three ways to
choose a color:

· Basic colors. 

· Custom colors. See below for how to define a color to be custom. 

· Use the large color picker on the upper right of the dialog. To use this,
you need to make two choices. First, choose a color in the large box.
Then use the vertical slider to choose the shade of the color, basically
how much black is added.  The slider often defaultsall the way down to
maximum blackness. In this position, all the colors look black! You'll
need to move that slider up. 

· Enter a color by entering three numbers representing HSL or RGB. With
Windows, it is not possible to choose a color by entering CMYK values.
But all colors can also be encoded as RGB.
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Custom colors

There is room at the bottom left of the dialog for 16 custom colors you
create. To define and save a custom color, follow these steps:

1. Make sure that "Use these custom colors in new projects" is checked.

2. Check on one of the 16 custom color boxes in the bottom left of the
dialog, an empty one if there is one empty.

3. Choose a color by clicking on the large box of colors at the upper right,
or by entering RGB (or HSL) values. (See the note below about the
intensity slider.)

4. Click the button Add to Custom Colors. The color will appear in one of
the 16 custom color boxes at the lower left, and wil stay there.

Notes:

· The checkbox "Use these custom colors in new projects" only applies to
custom colors you choose after you checked that option. It won't apply
to colors you chose before checking the option. 

· The colors you assign to the Custom Color slots at the bottom of the
dialog cannot be transparent. The transparency of all custom colors is
set to 0% (because this standard Windows dialog cannot store
transparency). 
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· If you want to create a custom color by entering RGB (or HSL) values,
you need to add a first step: click on a basic color. You'll see the RGB
values of that color. Change them to enter your RGB values. Finally click
"Add to Custom Colors". If you don't do that first step, you won't be
successful at creating a new custom color. 

Transparency

Optionally choose to make any color semitransparent  by sliding the
control between 0 and 100%. At 0%, the color is completely opaque. No
matter how light the color, objects that are underneath this object won't
show through. At 100%, it doesn't matter what color you picked, because
the color is invisible. In between, the color is semitransparent.

Note that semitransparent colors won't be transparent when exported
from Prism to a pdf format. 

16.2.14.4Semitransparent colors

Why use transparent colors?

The main reason is shown below. When points on a graph overlap, you
usually won't see some of them. If you choose a semitransparent color,
the overlapping points will get darker. 
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Semitransparent colors can also be useful when shading the area under a
curve (or between error bands) so you don't hide other objects on the
page.

Semitransparent color are not helpful with superimposed bar graphs.
Prism actually plots these as stacked bars (doing the subtraction to know
how big to make each slice). So you won't see the color of the bars
further back showing through the bars in front. Don't try to use
semitransparent colors with superimposed bars. 

Terminology

To be compatible with other programs, we use different terms for
Windows and Mac.

· Prism Windows uses the term transparency. At 0% transparency, the
color is completely opaque. No matter how light the color, objects that
are underneath this object won't show through. At 100% transparency,
the object is completely clear so it doesn't matter what color you
picked. With values in between, you'll see the color you chose, but
objects underneath will show through. 

· Prism Mac uses the Mac term opacity, which is the complement of
transparency. At 100% opacity, the color is completely opaque. No
matter how light the color, objects that are underneath this object won't
show through. At 0% opacity, the object is completely clear so it doesn't
matter what color you picked. With values in between, you'll see the
color you chose, but objects underneath will show through. 

A transparency of 75% equals an opacity of 25%. A transparency of 40%
equals an opacity of 60%.

Choosing semitransparent colors

Prism Windows lets you choose a few semitransparent colors in the color
drop down menu. 
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Or press "More colors & transparency" to bring up the full Choose Color
dialog where you can choose any color and apply any degree of
transparency. 

Prism Mac doesn't have the color drop down menu, so you choose opacity
at the bottom of the color picker. 

 A semitransparent color is not the same as a light color
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You can make any color with a light shade, with lots of white mixed in.
But a light color is not semitransparent. Light colors are opaque. To get a
color that looks light but is semitransparent, start with a darker color and
choose transparency. 

Semitransparent colors in exported images

When you export your graph or layout, the semitransparent/clear colors
may or may not look semitransparent/clear in the exported image. It
depends on what format you export in and on whether you use Prism
Windows or Mac. In the table below, "Yes" means that
semitransparent/clear colors will be encoded in the exported file, and
"No" means they will not be.

Format Windows Mac
Semitranspar
ent

Clear Semitranspare
nt

Clear

EMF Yes Yes
These formats are Windows

only.
EMF+ Yes* Yes
WMF Yes Yes
EPS No No No No
PDF No No Yes Yes
TIFF No Yes No Yes
PNG No Yes No Yes
JPG No No No No
BMP No No No No

* Prism 8 only; not Prism 7

16.3 Replicates and error bars

Entering replicates and error values
Key concept -- Replicates and error bars
Entering side-by-side replicates
Entering error values computed elsewhere
Error bars and confidence bands on Survival graphs
Horizontal error bars

Graphing replicates and error values
Graphing each replicate
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Box and whiskers graphs
Violin plots
Graphing error bars computed from replicates
Graphing error bars computed from entered error values
Graphing error envelopes
Confidence and prediction bands from regression

16.3.1 Entering replicates and error values

Prism lets you enter error values directly in a data

table and plot them on a graph, or it will calculate

them from raw data. You can choose what you

want error bars to show and how you want them

formatted.

Key concept -- Replicates and error bars

Stacked vs. side-by-side replicates

Error bars and confidence bands on Survival graphs

Confidence and prediction bands from regression

Graphing error bars calculated elsewhere

Graphing each replicate

Horizontal error bars

16.3.1.1 Key concept -- Replicates and error bars

When you collect scientific data, you often collect replicate data and plot
the individual replicates or an error bar showing the variability of the
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data. One of Prism's strengths is its ability to handle replicates and error
bars.

· You can enter replicates directly into a Prism data table.

· If you enter replicate values, Prism can plot either individual replicates
or error bars.

· You do not need to enter SD or SEM values in order to plot them. Prism
can plot error bars from raw data.

· You do not need to run a Row Means analysis to plot error bars. Prism
can plot error bars directly from raw data.

See also:

Graphing each replicate

Key concepts: SD

Key concepts: SEM

SD and SEM are not the same

When to plot the SD vs. SEM

16.3.1.2 Entering replicates

XY and Grouped graphs

When you create an XY or Grouped table, you can choose to include side-
by-side subcolumns. For example, this table was set up with three side-
by-side subcolumns:
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Prism can plot the raw data (each replicate) or can plot error bars it
computes. You don't need to run any analyses to compute the SD or SEM
(etc.). Prism does the calculations itself and plots the error bars. 

Column graphs

Replicates are entered into a stack in each column. There are no
subcolumns.

Nested graphs

Replicates are stacked into each subcolumn. 
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Note the big difference between nested and grouped tables. Replicates
are placed on side-by-side subcolumns on Grouped tables, but are
stacked in a subcolumn on a Nested table. 

16.3.1.3 Entering error values computed elsewhere

Choosing to enter precalculated error values

When creating (or reformatting) a Grouped or XY table, you can choose to
format the table for entry of preaveraged data.

Here is the list of choices:

If you enter mean and SD or SEM, why also enter n?

If you only want to make a graph showing mean and SD or SEM, you only
need to enter those values into the data table. It is ok to omit the "n"



GraphPad Prism 8 User Guide376

© 1995-2020 GraphPad Software, LLC

values, or to format the table for entry of Mean with SD or SEM, but
without n.

It is necessary to enter n in these situations:

· You want to be able to switch between graphing SD, SEM and CI error
bars. If you enter SD or SEM with n, Prism can switch between plotting
whatever form of error value you want to show. 

· You want to do statistical analysis. t tests, ANOVA and more require
knowing sample size. 

· You want accurate nonlinear regression. If you enter the data as mean
and SD or SEM, Prism will fit the means, and ignore the values you
enter as SD or SEM. If you also enter n, Prism can account for scatter
and sample size, and the curve fit will be the same as if you had entered
raw data.

What is the %CV?

The %CV is the coefficient of variation as a percentage, so is defined as
100*SD/Mean.  Since the SD and Mean are in the same units, the %CV is
a unitless percentage. This is only useful for ratio variables, where zero
means none of that value. Weight is a ratio variable, because a weight of
0.0 means no weight. Temperature in C or F is not a ratio variable,
because a temperature of 0.0 doesn't mean no heat.

The difference between entering +/- errors and upper/lower limit errors 

It is easy to confuse the +/- and upper/lower choices for entry of
preaveraged data. But the two are distinct.

· When you format the subcolumns for entry of +/- error values,  the
values you enter are interpreted as distances. These are added to (or
subtracted from) the value you enter as the mean to compute the end
point of the error bars. 

· When you format subcolumns for entry of upper/lower Limit error
values, the values you enter are interpreted as the end points of the
error bars. The error bars will end at the Y values you enter. 
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What if I want to enter the median and quartiles, or some other kind of
error bars?

If you choose to enter the mean, with sample size (n) and SD, SEM or %
CV, you really ought to enter those exact values. Otherwise, analyses
might be incorrect.

If you choose to format the data table with subcolumns for Mean and SD
or SEM or %CV without sample size, or for mean with +- error values or
upper and lower limits, no analyses will be possible. Or rather Prism will
only analyze/fit the means and ignore the error values. If you choose to
format the table so the subcolumns are labeled mean, upper limit, and
lower limit, you are welcome to enter into those subcolumns the median
plus the 25th and 75th percentiles, or whatever values you want. Prism
will plot the error values you enter, and it is up to you to keep track of
how these values were actually calculated, and to label your graphs
accordingly.

16.3.1.4 Error bars and confidence bands on Survival graphs

Survival tables offer no choices for data entry

When you create a survival table, you have no choices for data entry. You
don't enter error values. Instead, Prism computes the SE or 95% CI of
survival when it creates the survival curves from raw survival data. Learn
more about entering survival data .

If you want to enter survival fractions with SE values computed
elsewhere, create an XY graph. In this case, Prism will not be able to
compare survival curves.

Survival graphs can include error bars computed as standard errors or as
confidence interval. To change: Double-click anywhere on the graph to
bring up the Format Graph dialog and then go to the third "Graph
Settings" tab. 

If you plot the 95% confidence interval as confidence bands, you can fill
or color the area between the bands.

218
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16.3.1.5 Horizontal error bars

There are three approaches to having horizontal error bars in Prism. 

XY graphs with X error values

In the Welcome (File..New) dialog, or using Format Data Table, you can
ask Prism to create a subcolumn for X error bars. 

Prism will then plot each point with horizontal X error bars sticking in
each direction a distance defined by the X error value you entered. It is
not possible to tell Prism to only plot the error value in one direction.

Prism will only plot the horizontal error bars if you turn on plotting of the
Y error bars too. Even if you have entered to replicates or error values for
Y values, you need to tell Prism to plot the Y error bars in order for it to
plot the X error bars. To do this, choose "Mean and error" in the
appearance drop down in Format Graph, and "Mean and SEM" in the Plot
dropdown.

Rotate Column or Grouped graphs so the Y axis is horizontal

A choice on the third tab of Format Graph, lets you flip any Column or
Grouped graph  so the Y axis is horizontal. If you plot symbols or bars
with error bars, those error bars will now be horizontal, but that
horizontal axis is now the Y axis. 

Depth charts

When you place an XY graph on a layout, you can choose to have it
rotated 90 degrees to create a depth chart . Error bars that are vertical
on the graph will now be horizontal on the layout.

350
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16.3.2 Graphing replicates and error values

Graphing each replicate
Box and whiskers graphs
Violin plots
Graphing error bars computed from replicates
Graphing error bars computed from entered error values
Graphing error envelopes
Confidence and prediction bands from regression

16.3.2.1 Scatter plot of each replicate

The advantage of showing every replicate instead of error bars

When making a XY graph, Column graph or Grouped graph, you don’t
have to plot error bars. Instead you can graph each data point (replicate).
This is often the best way to display variation, as it shows your data
exactly. Don't plot mean or median with error bars too quickly. Stop to
think about whether a graph of the actual data would be more
informative.With modest amounts of data, it is almost always better to
show the data.

XY graphs

Choose Individual Replicates when you pick the error format for your
graph.
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Column graphs

Choose to make a scatter plot.

Grouped graphs

Choose the Plot individual values tab. Then choose any of the graph
types.   
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Three ways to plot Column or Grouped scatter plots

Prism 8.2 introduces a choice for how to plot scatter graphs. These
choices are in the Graph Settings tab of of the Format Graph dialog. You
can choose the default Prism uses when creating graphs in the New
Graphs tab of the Preferences dialog.

· Standard: With this method, the width of the distribution of data points
is proportional to the number of individual points at that Y value. This
will create a visualization with your data points arranged similar to the
appearance of a violin plot. Sort of like a histogram. This is the best
choice if you're wanting to visualize the distribution of your data

· Classic: This method prioritizes minimizing the amount of overlap of
individual data points over representing the shape of the distribution. In
regions of less data, it will try to spread these points out so you can see
individual points better. Additionally, this method may create "smiles" in
the scatterplot (similar to the appearance of scatterplots in prior
versions of Prism). This is a good option if you want to maintain a
consistent look with graphs created using older versions of the software
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· Expanded: This method also prioritizes minimizing the amount of
overlap of individual points over representing the shape of the
distribution. Data points in regions with less data will be spread out, but
without generating "smiles" in the data

With a small number of points, the three methods look almost the same.
With more points, the differences between the methods becomes more
apparent. 

16.3.2.2 Box and whiskers graphs

Before creating a box-whiskers plot, consider a violin plot  instead.
Violin plots are simply better!

Creating a box and whiskers plot

Prism lets you create box-and-whisker plots from stacks of values entered
into a Column table, or side-by-side replicates entered into an XY or
Grouped table. 

386
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The box

The box always extends from the 25th to 75th percentiles. These limits
are sometimes called the hinges of the plot. Surprisingly, there are
multiple ways to compute these percentile values. Prism uses a standard
method, but a different method than Excel uses. 

The line in the middle of the box is plotted at the median. You can not
choose a different value, but Prism also lets you put a "+" at the mean. 

The location of the whiskers

Prism offers six ways to create whiskers in box-and-whiskers plots: 

§ Min to max. The whiskers go down to the smallest value and up to
the largest. 

§ Tukey. See details below. 

§ 10 to 90 percentiles. The whiskers are drawn down to the 10th
percentile and up to the 90th. Points below and above the whiskers
are drawn as individual points.

§ 5 and 95 percentiles

§ 2.5 and 97.5 percentiles

§ 1 and 99 percentiles

§ Min to max, show all points. This method plots whiskers down to the
minimum and up to the maximum value, but also plots each
individual value as a point superimposed on the graph.

Other options

§ Choose the border color and thickness, and fill the box with color. 

§ Plot the mean as a "+". 
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§ Choose a fill pattern for the box, and choose the design (pattern)
and color. 

More about box and whisker plots

How the Tukey method plots  whiskers and outliers

1. Calculate the inter-quartile distance (the difference between the 25th
and 75th percentiles). Call this the IQR.

2. Add the 75th percentile plus 1.5 times IQR.  If this value is greater
than (or equal to) the largest value in the data set, draw the upper
whisker to the largest value. Otherwise stop the upper whisker at the
the largest value less than the sum of the 75th percentile plus 1.5IQR,
and plot any values that are greater than this as individual points.

3. Calculate the 25th percentile minus 1.5IQR.  If this value is less than
the smallest value in the data set, draw the lower whisker to the
smallest value. Otherwise stop the lower whisker at the lowest value
greater than the 25th percentile minues 1.5IQR, and plot any values
that are greater than this as individual points.

Notes on Tukey boxplots

§ Why 1.5IQR? There is no statistical rationale; it is simply how Tukey
decided to do it, and he invented the idea of box-and-whisker plots.

§ When the Tukey method is used to create the whiskers, the ends of
the whiskers are sometimes called the inner fences. 

§ The values that are plotted individually are sometimes called
outliers, but "outlier" is defined differently by Grubbs test or some
other outlier test. The chance of finding one or more "outlier" by
Tukey's rule in data sampled from a Gaussian distribution depends
on sample size. 

§ If you only enter three values per group (n=3), Prism will plot the
median and range. It will not plot the percentiles and will ignore your
choice for how to plot the whiskers.

§ With Tukey's method, the whiskers always end at a value matching
one of the values in the sample. So the two whiskers are often not
the same length.
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§ The terms boxplot and box-and-whiskers plot are often used
interchangeably, although originally the boxplot was used to describe
a plot with Tukey whiskers (fences) and the box-and-whisker plot
was used to describe a plot where the whiskers extend down to the
minimum value and up to the maximum value.

Five number summary

The term five-number summary is used to describe a list of five values: the
minimum, the 25th percentile, the median, the 75th percentile, and the
maximum. These are the same values plotted in a box-and-whiskers plot when
the whiskers extend to the minimum and maximum.

The term outlier

The term outlier has many definitions. The individual points that are plotted
beyond the whiskers of a box-and-whiskers plot are sometimes called outliers,
but this definition does not match the definition used by the Grubbs' or other
outlier tests. 

How to create a box-and-whiskers graph by entering the minimum,
maximum, median and 25th and 75th percentiles rather than entering the
raw data 

Usually, Prism creates a box-and-whiskers graph from raw data. You
enter a stack of values, and Prism computes the range and percentiles to
make the box-and-whiskers graph. 

You need to be just a tiny bit sneaky if you want to enter the minimum,
25th percentile, median, 75th percentile, and maximum values directly.
Prism won't know that you entered those values, but will make the graph
as if you entered raw data. If you just enter those five values, Prism will
correctly compute the minimum, maximum, and median, but  the 25th
and 75th percentile values Prism computes will be incorrect. 

Here is a trick: Enter the median value three times, rather than once, and
also enter the minimum, maximum, and 25th and 7th percentile values.
For each group, enter seven values on separate rows of one column (the
order doesn't matter. )

§ Minimum

§ 25th percentile

§ Median
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§ Median

§ Median

§ 75th percentile

§ Maximum

 You can't "tell" Prism that these values are not the raw data, so it
"thinks" they are raw data and so computes the minimum, maximum,
median and quartiles from those seven values, and plots those computed
values, which exactly match the values you entered.  If you use this
workaround to create a box and whisker plot from summary data, the
choice to plot the mean as a + won't work. It will compute the mean from
the values you entered, and that mean is unlikely to equal the actual
mean of the data. 

16.3.2.3 Violin plots

What is a violin plot?

When you enter replicate values in side-by-side replicates in an XY or
Grouped table, or stacked in a Column table, Prism can graph the data as
a box-and-whisker plot or a violin plot. Violin plots show the frequency
distribution of the data. The example below shows the actual data on the
left, with too many points to really see them all, and a violin plot on the
right. It gives the sense of the distribution, something neither bar graphs
nor box-and-whisker plots do well for this example. 

How smooth?

You decide (in the Format Graph dialog) how smooth you want the
distribution to be. You have three choices shown below: Light (left),
medium (middle), heavy (right). Light smoothing shows more details of
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the distribution; heavy smoothing gives a better idea of the overall
distribution. 

Showing individual points and violin plot

Prism lets you superimpose individual data points on the violin plot. This
is not really helpful for displaying data. Why show both the data and a
crude distribution? But it is very useful when exploring which level of
smoothing to use.  It is hard to assess the degree of smoothness of the
violin plot if you can't see the data at the same time.

If you use small points the same color as the violin plot, the highest and
lowest points won't be visible as they will be superimposed on the top and
bottom caps of the violin plot itself. If you want to see these points, make
them larger or a different color. 
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Notes

· Violin plots are new in Prism 8. They are a great way to show data. Use
them!

· Surprisingly, the method (kernal density) that creates the frequency
distribution curves usually results in a distribution that extends above
the largest value and extends below the smallest value. As violin plots
are meant to show the empirical distribution of the data, Prism (like
most programs) does not extend the distribution above the highest data
value or below the smallest. That is why violin plots usually seem cut-off
(flat) at the top and bottom.

· In addition to showing the distribution, Prism plots lines at the median
and quartiles. Separately specify the pattern (dotted, dashed..), color
and thickness for the median line and for the two quartile lines.

· You can choose to fill within the violin plot, as the example shows. 

· Violin plots show the median and quartiles, as box-and-whisker plots
do. But violin plots do a much better job of showing the distribution of
the values. Consider always using violin plots instead of box-and-
whisker plots.

16.3.2.4 Graphing error bars computed from replicates

Reality check

It is very common to publish data with error bars, and Prism does this
well. But first think if this is really the best way to display your data.
Consider plotting each replicate  or plotting a violin plot  instead.
These kind of graphs show much more detail. 

What Prism can do

When you entered replicate data, Prism can plot on XY and Grouped
graphs:

· Mean only

379 386
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· Mean with error bars computed as SD, SEM, 95% CI, or range.

· Geometric mean only

· Geometric mean with error bars computed as 95% CI, or geometric SD
factor

· Median only

· Median with error bars computed as 95% CI, interquartile range, or
range

Choose on the New Graph (or Change Graph Type) dialog:

You can also change on the Format Graph dialog. This will change one
data set at a time, unless you choose to make Global changes using the
control in the upper right of the dialog. 
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16.3.2.5 Graphing error bars computed from entered error values

If you entered error values into the data table (for example SD or SEM),
Prism will plot the error value you entered. If you entered %CV, Prism will
plot the SD. 

If you created a table with a subcolumn for sample size n, then Prism
gives you more flexibility. It can plot SD, SEM or %CI from data entered
as either Mean, SD & n, as Mean, SEM & n, or Mean, %CV & n.

16.3.2.6 Why do error bars on bar graphs sometimes appear asymmetrical?

One reason for asymmetrical error bars is because they actually are
asymmetrical. If you enter separate up and down error values, they may
not be the same. If you plot median with quartiles, the error bars are
likely to be asymmetrical.

But if you plot mean and SD (or SEM), how can the error bars appear
asymmetrical. The figure below demonstrates.

The error bars on the bar on the right seem asymmetrical. But look
closer. The outer border denotes the mean, and the entire bar’s thickness
is inside the bar (for Prism 7 and later). Thus, the error bar is
symmetrical around the outer edge of the bar. But because part of the
down-pointing error bar is covered by the bar’s thick inner border, the
error bars appear asymmetrical. The workaround, of course, is to make
the bar borders thinner. 
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16.3.2.7 Graphing error envelopes

In some cases you may prefer to plot the error values as error envelopes,
as shown on the right below, rather than error bars (left). 

To plot error envelopes on an XY graph, on the first tab of Format Graph
make two settings:

1. Drop the error bar style drop down and choose one of the two
horizontal line choices (solid or dotted). 

2. Check the option to show area fill, choose a color, and choose to put
the fill within the error bands.
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16.3.2.8 Confidence and prediction bands from regression

When you fit a line with linear regression, or a curve with nonlinear
regression, you can choose to plot confidence or prediction bands.
Confidence bands tell you how precisely you have determined the line or
curve. Prediction bands tell you about the scatter of the data.

Learn more about choosing and graphing prediction and confidence bands
from linear regression and nonlinear regression.

Prediction and scatter bands are computed using complicated calculations
that are part of the regression procedures. You don't enter these values
directly. All you do is check an option when choosing analysis options.

16.4 The Format Graph Dialog
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Prism lets you customize every feature of a graph.

Change the shape, color, and size of graph

symbols; change the fill pattern and color of graph

columns; change the order that data sets are

plotted.
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16.4.1 Overview of Format Graph

 .

16.4.1.1 How to bring up the Format Graph dialog

Two ways:

· Double-click on the main part of the graph (not an axis).

· Click this button. 

16.4.1.2 Different Format Graph dialogs for different kinds of graphs

Each kind of graph has a different Format Graph dialog. 

XY graphs

Column graphs

Grouped and Contingency graphs

Heat maps

Survival graphs

Parts of whole graphs

Nested graph

16.4.1.3 Changing one, some or all data sets

Parts of whole and heat maps are distinct, but for XY, Survival, Column,
Grouped and Contingency table graphs, the first tab of the Format Graph
dialog controls the appearance of symbols, bars, lines, etc. 

Change the appearance of one, several, or all data sets.

· One data set. Choose a data set from the drop  down on the top of the
dialog, then change the settings for that data set.
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· All data sets. Drop the Global menu at the top right of the dialog,
choose to change all data sets, and then make the changes. Any
changes you make after choosing the change all data sets will apply to
all the data sets. Changes you made before making that choice only
apply to the data set selected then. Shortcut: Hold the Control key
down while you make changes. Any changes made while holding Control
down will apply to all data sets on the graph. When you are in global
mode (change all data sets), the cursor changes to include a globe:

· Several data sets. Drop the Global menu at the top right of the dialog.
Choose some data sets, and then change the settings for those data
sets. For example, you could select data sets A, C, E, and G and change
all of those data sets to use a dotted line. Then choose B, D, F and H,
and make those lines solid. Any changes you make after choosing a set
of data sets to change will apply to those data sets. 



GraphPad Prism 8 User Guide396

© 1995-2020 GraphPad Software, LLC

16.4.1.4 Style

The Style selections at the top of the Format Graph dialog is where you
make the most important choice about your graph. Graph points or bars?
Error bars? If so, showing what error value (SD, SEM, Range, ...)? 

The choices available here depend on what kind of graph you have chosen
(XY, Column, Grouped, etc.) and how you entered your data. 

16.4.1.5 Symbol shape and border

You can plot symbols on Column, Grouped, Contingency, and XY graphs. 

Notes:

· You will only have choices of border color and thickness when you
choose an open symbol (as shown above). 

· The standard set of symbols will probably have what you want:

          

· If you click "More", you can choose any character from any font to use
instead of a symbol. 

16.4.1.6 Bar borders and fills

You can plot bars on Column, Grouped, Contingency, and XY graphs. 
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Formatting bars works a bit different than it did in prior Prism versions. 
By default, the bars are solidly filled with a color you choose, and have a
border whose thickness and color you choose. 

If you want a fill pattern, check the option box, then choose the design
(the fill pattern) and color. 

16.4.1.7 Distinguishing the X axis from the bar baseline

If you make a Column or Grouped bar graph with some bars having
positive values and others having negative values, Prism will by default
make a graph like this:

Distinguish the X axis from the bar baseline. 

· The X axis in the graph above is at the bottom of the graph. Set the
location of the X axis (and move it to Y=0) if you want in the first tab of
the Format Axis dialog. Bring up this dialog by double clicking on any
axis.
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· The bar baseline is set in the third tab of the Format Graph dialog. In
the graph above, the setting is at its default value of "automatic" which
means Prism draws the baseline at Y=0. Bring up this dialog by double
clicking on the main part of the graph.

The default graph, as above, is usually what you'll want. But if you want
something different, knowing how the X axis and the bar baselines are set
will let you make the kind of graph you want. 
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16.4.1.8 Graphing error bars

You'll be able to choose error bars for XY, Column and Grouped graphs.
Choose the color of the error bars, the direction (up, down or both), the
style (capped or not) and thickness. 

Notes on error bars:

· Prism can plot several kinds of error bars: SD, SEM, interquartile range,
etc. Choose this at the top of the Format Graph dialog in the style
section. If you entered error values directly, then you can plot those
values only. 

· In XY graphs, you can plot the error bars as error envelopes or bands
and fill the area between the two bands. 

· Survival graphs  deal with error bars differently.

· Learn more about error bars . 

16.4.2 XY graphs

Format graph: XY

Prism lets you customize every feature of a graph. Change the shape, color, and size
of graph symbols; change the fill pattern and color of graph columns; change the
order that data sets are plotted.

Double-click on any symbol (or the background of the graph) to bring up the Format
Graph dialog.

See also

Appearance of XY graphs

Front-to-back order of data sets

Use row titles to label data points

Nudging XY data sets

Additional XY settings
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16.4.2.1 Format Graph -- XY

Format Graph dialog - XY graphs

Use this dialog to change the look of all the symbols in a data set. If you
want to change the look of a single data point , use the right-click
menu. You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.
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To change the settings for one data set:

Select a data set from the list, and choose the symbols, lines, and error
bars for that data set. Then select another data set and choose settings
for that data set. Click OK to redraw the graph with all the changes. Note
that a fitted curve is treated as a separate data set.

To change all data sets on the graph for example to make all symbols larger:

Click the Global button at the top right of the Format Axis dialog. Then
choose to change all data sets, or a subset  of data sets. Changes you
make after that will then apply to all selected data sets.
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There is a shortcut for changing all -- Hold down the control key. (Note
the 'globe' cursor since you are making global changes.)

Style

Choose how to plot error bars. Select SD, SEM, 95% CI, or range. If you
created a data table with no Y subcolumns, you won't have any choices
here. But, if you entered data into subcolumns, the choices here
determine how the replicates or error bars will appear. The Appearance
drop-down on the left determines the basic look, with further choices in
the Plot drop-down to the right (the choices will depend on what you
select in Appearance).

 

Since it rarely makes sense to choose different error bar (or replicate)
choices for different data sets, you will probably want to click Global and
then All before changing error bar format.

If you have four or more subcolumns for replicates, Prism will also give
you the opportunity (at the bottom of the appearance drop down menu)
to plot  box-and-whiskers at each X value.
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Show symbols

Choose symbol type, size, and color. If you pick an open symbol, also
select a border thickness. Check the Clear option if you want point-to-
point lines and overlapping points to show through the open symbol. Use
the Shape drop-down menu to select one of Prism's symbols. Use the
More option on this drop-down to use any character from any font on your
computer as a symbol.

Show bars/spikes/drop lines

Use this setting if you want to drop vertical bars from your data points.
The bar will start at the X-axis or whatever Y value you choose and go up
(or down) to the Y position of the point. This is useful when you want to
create a bar graph where each bar’s position is determined by its X value.
It is also useful when you want to combine points and bars on one graph
as shown below. If you pick the narrowest width for the bars, the bars will
actually be spikes suitable for graphing mass spectra.
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Show error bars

Choose the format and color of error bars. Choose dotted or solid lines to
show an error envelope as in the graph on the right below. Use the Show
Area Fill button to add fill between the limits of the error envelope. 

Connecting line/curve

Choose the line's color, style (straight vs. staircase), thickness, and
pattern (solid, dotted, dashed, etc.). This section includes choices to have
your connecting start either at the first data point or the graph origin,
whether to leave gaps in the connecting line next to the symbols, and
whether to plot lines connecting each replicate for repeated measures in
corresponding data sets as in the graph on the bottom row below.

If you choose arrows as connecting lines, it looks best to not also show symbols.
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Don't confuse the connecting line – which always goes from point to point – with a
best-fit curve or line created by regression. If you have fit a curve through the data,
Prism sees the curve as a separate data set. Select the data set for the values, and
choose symbols but no connecting line. Then choose the data set for the curve, and
choose a connecting line (curve) with no symbols.

Area fill

Fill below (or above) the point-to-point line that connects your points with a fill. Specify

fill color and pattern, and background color. You may need to adjust the front-to-
back order  of the data sets to get the effect you want.

Plot on which Y axis

Specify which axis to use for each data set. If you choose to plot on the right Y-axis,
Prism will create that axis if it doesn’t already exist.

Legend

Select Show legend to create a legend for this data set. Select Label each point with its
row title to link the legend to the column title entered on the data table. Uncheck this
box if you don’t want the legend to change when you edit the column title. You can
also edit the labels in the legend. Double-click on the legend text and type whatever
you like. Use the checkbox Revert Legend to Column Titles in the Legend to change the
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labels back to match the column titles. (This checkbox is only available if you have
edited a legend.)

Label each point with its row title

Check this box to include row titles  on graph near each data point. You can
move each label by selecting it and dragging. Even if you move a label,
however, it remembers its position relative to the data point -- so when
you change your data, or the size and shape of your graph, the labels will
adjust accordingly. Click on any label on the graph and use the Text
section of the Prism toolbar to change the size, font, and color of all the
labels.

         

16.4.2.2 Front-to-back order of data sets

When data points overlap (or are superimposed) on an XY graph, the
plotting order determines which will show on top.

The two graphs in this example are identical except that the plotting
order was reversed. Note the green symbols are behind the clear ones in
the graph on the left, and in front on the graph on the right.
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To change the front-to-back order of the data sets on a graph:

Click the Rotate/Flip button in the Change section of the Prism toolbar to
reverse the front-to-back order of data sets on a graph.

To fine tune the front-to-back order, go to the Data Sets on Graph tab of
the Format Graph dialog.
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Changing the order of the data sets on this dialog changes the font-to-
back order of the data sets on the graph. It does not change the order
of the legends . 

 Front to back order within a data set

Within a data set, the front-to-back order of plotting is determined by the
order of rows in the data table. The first row is furthest back and the data
entered in the last (bottom) row is plotting in front. If you need to control
which point is on top, change the order of the rows.

See also:

Nudging data sets on a graph.

 

16.4.2.3 Use row titles to label data points

Enter row titles  in a special column on the XY data table.

Click on the Format graph button on the Prism toolbar or double-click on
any data point to open the Format Graph dialog. Check the "Label each
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point with its row title" box to include row titles  on graph near each
data point.

You can move each label by selecting it and dragging. Even if you move a
label, however, Prism remembers its position relative to the data point --
so when you change your data, or the size and shape of your graph, the
labels will adjust accordingly.

Click on any label on the graph and use the Text section of the Prism
toolbar to change the size, font, and color of all the labels. You cannot
adjust the font individually. All the row labels always share the same font,
size and color.

16.4.2.4 Nudging XY data sets

Nudge overlapping data sets to make a graph easier to understand.

Double-click on any data point to open the Format Graph dialog. Use the
bottom of the Data sets on Graph tab to nudge a data set.

Nudging adds a specified value to each X and Y coordinate before
graphing. Use this feature cautiously, as it means that the position of the
symbol on the graph will not match the actual X and Y values of the data
point.

The values you enter are the actual increments of X and Y. Each data set
is incremented as much as you specify. The nudging is not cumulative

Nudging can be helpful to differentiate datasets that otherwise overlap a
lot. For example, the data in the following graph overlap so much it is
impossible to tell which tracing is which.
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The graph below is an alternative way to plot the same data. The second
data set is nudged by 25 units in the Y direction (and not at all in the X
direction).

The third data set is nudged 50 units in the Y direction (with zero in the X
direction).

Now you can see the individual tracings.

All three tracings still have about the same baseline Y coordinates. But
nudging the data in the Y direction separated them. Because the Y values
were nudged, it would be misleading to plot the data on a full Y axis as in
the graph above. So instead, the Y axis is hidden (Frame and Origin  tab
of the Format Axes dialog) and replaced with a scale bar.

Waterfall graphs

Nudging can also help you create a waterfall graph. All the data sets in
the following graph cover the same range of wavelengths, and all have a
baseline of zero optical density. Each data set was nudged in both X and Y
directions, each data set nudged a bit more than the previous data set.
This creates a pseudo 3D look that is sometimes called a “waterfall” (but
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note that "waterfall" can also refer to a column graph where the columns
are sorted by height; Prism cannot automatically make such a graph but
you can sort the order of columns in the middle tab of Format Graph
dialog).

16.4.2.5 Skip over some points to speed graphing

Plotting XY graphs with tens or hundreds of thousands of points can be
slow. If you are impatient, Prism lets you specify that a graph only show
one out of every K points (you specify K), to speed up screen redrawing.
Choose at the bottom of the second tab of the Format Graph dialog.
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16.4.2.6 Additional XY settings

The Graph Settings tab of the Format Graph dialog

Gaps at missing points.

Leave a gap when you have missing data points, or connect the existing
data points on each side.

Reset any individual formatting of points or bars

If you have changed the format of individual data points (by right clicking
on them ) , check an option here to reset everything back to the format
set in the dialog. 
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Line of identity

The line of identity is a line where every value of X exactly equals Y. If the
X and Y ranges are the same, it is a 45 degree line. It is created
automatically by some analyses, and you can check this option to add to
any XY graph. If you want this line to show when the file is opened with
Prism 7 or earlier, there are other ways to create it.

 

16.4.2.7 Adding a line of identity

The regression guide explains how to fit a line or curve to your data. But
sometimes you just want to add a line of identity --  a line where every
point has equal X and Y coordinates. Prism 8 makes this easy. Double-
click on the graph to bring up Format Graph, go to the third tab, and
check the option to draw a line of identity (sometimes called the line of
equality).
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Earlier versions of Prism offered three ways to draw a line of identity. Use
one of these methods if you want the line to show when you open the file
with an earlier version of Prism. 

· Enter a data set on your data table with only two points defining the two
ends of the line you want to draw. In both cases X and Y will have the
same value. You can put these points on the same data table as your
data. Just put the Y values into a new Y column. Place the X values
below the X for your main data set, and make sure the Y values are in
the same row (many rows above that will be blank). When you look at
the graph, that new data set will first show as only two data points.
Double click on one to bring up the Format Graph dialog. Uncheck the
option to show symbols, and check the option to show a connecting
line. 

· Use the analysis to plot a function. From the graph, click Analyze, and at
the bottom of the analyze dialog go to the Generate a Curve folder and
choose the Plot a function analysis. Choose a straight line (from the
Lines folder of equations), enter the first and last X values you want to
plot the line between, and then go to the third tab of that dialog and
enter values for the Y intercept (probably 0.0) and slope (probably
1.0). 

· Use the line drawing tool to draw the line manually. 

The first method is probably the most straightforward. The second
method is great in that it can be extended to other functions besides
straight lines. We don't recommend the third method, but it is a quick
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and easy way to produce the line for someone who doesn't want to think
about math.

16.4.2.8 Point to point lines

Check on option in the Format Graph dialog to connect the XY points with
point to point lines. 

Notes:

· You can choose to have the line begin at the origin by checking an
option. Otherwise, the line starts with the first point.

· The lines are drawn point to point in the order the data are in the data
table, which may not be in the order of the X values. But note that there
is a Sort-by-X-Value command on the Edit menu you see when looking
at an XY data table. 

· The graphs below show four ways to draw these lines. The bottom
choice is one you probably want to avoid. That graph uses open symbols
with clear (transparent) fill so the point-to-point lines will be visible
going through (or under) the points. You want to use white (or whatever
the background color is) fill color which covers up the point-to-point
lines. 
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16.4.2.9 Spaghetti plot

Spaghetti graphs plot longitudinal data, showing individual tracings for
each subject (or other experimental unit). 

1. Enter data into an XY data table, formatted with subcolumns for
replicates.

2. At the top of the Format Graph dialog, choose to plot each replicate.

3. Uncheck "Show symbols"

4. Lower on that dialog for connecting lines, choose to connect "Each
replicate, Spaghetti plot".
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16.4.2.10Box and whiskers plot

If you have five or more replicate values in side by side subcolumns, you
can plot XY data as box-and-whisker plots. Because this is not a choice on
the Change Graph Type dialog, you have to first make a different kind of
XY graph (scatter, mean and error...) and then change to box and
whiskers. To do that,

1.  Double-click on the main part of the graph to bring up Format Graph
dialog

2. Use the Global setting at the upper right to change all data sets at
once.
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3. Drop the Appearance control and choose Box-and-whiskers.

4. Use the Plot control to fine tune. 

5. Adjust the size and color of the boxes, and the width and color of the
border.

16.4.3 Column graphs

Format graph: Column
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Prism lets you change every feature of a graph. Change the shape, color, and size of
graph symbols; change the fill pattern and color of graph columns; change the order
that data sets are plotted.

Double-click on any symbol or bar (or the background of the graph) to bring up the
Format Graph dialog.

See also:

Appearance of Column graphs

Data set spacing on Column graphs

Plotting order of Column graphs

Additional Column graph settings

Graphing each replicate

Violin plots

 

 

 

 

 

 

 

 

 

 

 

16.4.3.1 Format Graph --Column

Format Graph dialog - Column graphs

Use this dialog to change the look of all the columns in a data set. If you
want to change the look of a single column , use the right-click menu.
You can also change all the symbols in selected data sets .
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Double-click on any graph symbol or bar to open the Format Graph
dialog.

To change the settings for one data set:

Select a data set from the list, and choose the bar format and fill, lines,
and error bars for that data set. Then select another data set and choose
settings for that data set. Click OK to redraw the graph with all the
changes. Note that a fitted curve is treated as a separate data set.

To change all or some data sets on the graph (for example to make all
symbols larger):
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Drop the list of data set names and choose --Change ALL data sets--. Or
click the Global button just to the right. Changes you make after that will
then apply to all data sets, or to data sets you select from the Global
button.

Style

Choose how you want to display your data for each data set. Choose from
a simple bar (with or without error bars), a scatter plot, an aligned dot
plot, box and whiskers, before and after plot, or floating bars. Also choose
how to plot error bars. Select SD, SEM, 95% CI, or range.

Note that your choice applies to only one data set column unless you used
the global button to choose all or a subset of columns.

It can also be useful to use different styles for each bar of a graph, as
below:

Or connect data sets A and B as before-and-after and data sets C and D,
but not B and C.
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To do this, choose Before-and-after as the style for data sets A and C,
and Aligned dot plot as the style for data sets B and D.

There are seven ways to plot box-and-whisker graphs. Traditional
Tukey whiskers go 1.5 times the interquartile distance or to the highest
or lowest point, whichever is shorter. Other choices show specified
percentiles, which seems more logical. Any data beyond these whiskers
are shown as points. Or you can choose to superimpose each individual
point on the box and whisker plot. You need to have at least four values
in order to create a box-and-whiskers graph.

Because whiskers can be done in various ways, it is essential to mention
in a graph's figure legend which way they were made.

You can also plot "Symbol (one symbol per column)" and specify mean or
median. This kind of graph looks better if you add a grid line from the first
tab of the Format Axis dialog and flip it to be horizontal.

Bars and boxes
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Set the format of bars and the box part of box-whisker plots. If you check
the option to use a fill pattern, you can then choose the type of fill pattern
you want and what color to use.

Symbols

Choice here apply to symbols used for column scatter and before-after
graphs, as well as the symbols shown (if any) on box-and-whisker plots. 

If you check the option to plot a symbols on a bar graph, every value will
be plotted. If you check the option to plot symbols on a box-and-whiskers
plot, the number of symbols is chosen in the drop-down in the Whiskers
section at the top of the dialog (see above). You can choose to plot all
points (last choice in the list) or only to plot "outliers" defined in various
ways.

Error bars

Choose the format and color of error bars. Learn more about error bars
.

Lines

Choose the color and thickness of lines for means on scatter plots and the
connecting lines on before and after plot.

Plot on which Y axis

Specify which axis to use for each data set. This is useful if you want to
show different type of data on the same graph. If you choose to plot on
the right Y-axis, Prism will create that axis if it doesn’t already exist.
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Legend

Select Show legend to create a legend for this data set. You can edit the
labels in the legend. Double-click on the legend text and type whatever
you like. Use the Revert Legend to Column Titles checkbox in the Legend
section of the Format Graph dialog to change the labels back to match the
column titles. (This checkbox is only available if you have edited a
legend.)

Label each point with its row title

On before and after plots and scatter plots, you can choose to have X
labels show on the graph to identify individual data points. Check this box
to include X titles on graph near each data point. Select each label on the
graph and drag it to move it where you want.

16.4.3.2 Data set spacing on Column graphs

Set the standard spacing between columns

To change the standard spacing between individual bars (or array of
column scatter points), go to the Graph Settings tab. If you enter a larger
value, the gaps between bars will be wider so the bars will be narrower.
You can also set the gap before the first and after the last column.
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The values you enter here are widths as percentages of column width 

Changing the spacing between selected columns

To change the space between two adjacent bars, go to the Data Sets on
Graph tab. Select a data set and enter (at the bottom of the dialog) the
percentage of normal spacing you want between that data set and the
prior one. If you enter 200, that bar will be twice as far from its left
neighbor as the others. If you enter 50, it will be half as far. If you enter
0, this bar will touch the neighbor on the left.
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Note one possible source of confusion. 

When you enter a value here as the space between a selected data set
and the prior one, you enter the percentage of the gap set in the Graph
Settings tab. If you enter 200%, you are setting the gap between the
selected data set and the prior one to be twice as large as the usual
gap.  

When you enter a value on the graph settings tab as space between
columns, enter the percentage of the width of the bar (or plotting area for
the set of scatter symbols). A value of 50%, means the gaps between
bars are half as wide as the width of the bars. 
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Adding a line between adjacent columns

To add a line between two adjacent bars, go to the Data Sets on Graph
tab. Select a data set and enter (at the bottom of the dialog) the
specifications of the line you desire.
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Empty columns

An alternative way to leave a gap is to create an additional data set
column on the data table, enter only a single number (usually 0), and
include it on the graph. If the baseline of the graph is 0.0, and that value
is 0.0, then Prism will draw a zero height bar, which is essentially a gap.

16.4.3.3 Plotting order of Column graphs

The two graphs in this example are identical except that the plotting order
was reversed.

To reverse the plotting order of the data sets on a graph, click the Rotate/Flip button in the Change section of the Prism toolbar.

To fine tune the left-to-right order, go to the Data Sets on Graph tab of
the Format Graph dialog.
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Changing the order of the data sets on this dialog changes the left-to-
right order of the data sets on the graph. It does not change the order
of the legends . 

16.4.3.4 Additional Column graph settings

Graph Settings tab of Format Graph dialog

Use the Graph Settings tab of the Format Graph dialog to change the
direction of bars on a graph from vertical to horizontal, to set the baseline
for graph columns, and to adjust the space between columns. Double-
click on any bar to open the dialog.
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Rotate columns from vertical to horizontal

You also can use the Rotate button.

Baseline

Fill in this box to change the baseline for bars on a graph. The default is
for the bars to begin at the X axis.
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Check the box for "Hide Baseline" if you want your bars to float as in the
example below.

Dimensions

Prism automatically adjusts the width of columns based on the size of the
graph, the number of data sets, and the gap between bars which you set
here. To make the columns wider, make the spacing smaller.
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Discontinuous axis

When you have a gap in a Y axis, choose whether or not you also want a
gap in any columns that span the gap.

Reset any individual bar formatting

If you have changed the format of individual bars (by right clicking on
them ) , check an option here to reset everything back to the format set
in the dialog. 

Shape of legend key

If you are plotting bars and chose to have a legend key, then choose here
if the box showing the bar color and fill should be square or rectangular. 

 

16.4.3.5 Annotations on Column graphs

Place the mean/median or sample size within each bar or above. On the
Annotations tab of the Format Graph dialog, note there are three tabs
within, to specify labeling (if any) above the bars, within the bars on top,
or within the bars at the bottom. (Note this feature offers more choices,
so a different look, starting with Prism 8.2.)
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.

When writing within each bar, choose one color for all values, or choose 
"auto" so the color is either black or white depending on background.
With Prism Windows, the auto choice is in the Format Graph dialog as
shown above. With Prism Mac, the auto choice is in the color picker as
shown below. 
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16.4.3.6 Forest plots

This graph below is a Forest plot, also known as an odds ratio plot or a
meta-analysis plot. It graphs odds ratios (with 95% confidence intervals)
from several studies.

There are a few tricks to making this graph:

1. Enter the data into a Column table. Keep the default choice to enter the
"replicates" into columns. (In this case, they are not replicates, but
Prism thinks they are).

2.  Enter the results for each study into a separate data set column. Enter
in each column the Odds ratio itself, as well as the high and low
confidence limits (computed elsewhere).  The order of those three
values doesn't matter. Label the studies by entering column titles. You
may use Greek symbols, super and subscript, etc.

2. Go to the graph.

3. When you first go to look at the graph, Prism will prompt for the kind of
graph you want. Choose "Column Mean with error bars". 
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4. Note that Prism's doesn't (can't) know that each column contains a
computed odds ratio along with the low and high confidence limits. It
just sees three values. So choose to plot the median and range. The
median and range of the three values you entered are the odds ratio
and its confidence limits computed elsewhere. If you choose to plot a
confidence interval instead, Prism will compute a confidence interval
from the three values you enter and the results will be nonsense.

5. The default graph is vertical. To make the graph horizontal (as below),
double click on the graph to bring up Format Graph, and go to the third
tab.

6. Double-click on the X axis to bring up Format Axis. Choose to make the
axis scale logarithmic with log spaced minor ticks, and to create a grid
line at X=1.0.
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16.4.3.7 Color coding column scatter graphs

When you make a column scatter graph with Prism, all symbols in each
column have the same shape and color. This page explains how to make
some points have a different color. 

Choose selected points in the table

1. Select a range of data, perhaps one row or one subcolumn.

2. Right click, choose Format Points, and then Symbol color

Notes:
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· If you have more than one graph from the same data, Prism will ask
whether you wish to change one or all graphs.

· There is no way to create a new legend using this method to explain
what the colors mean.

Change selected points on the graph

1. Make a column scatter graph as usual.

2. Right click on a point, choose Format This Point, and choose a different
color.

3. Repeat for each point you want to change.

Make a Grouped graph instead (to get a legend)

1. Create a Grouped data table, and choose a Grouped Column Scatter
graph.

2. Enter data on a Grouped data table, rather than a Column table. Put
the values you want to have different colors into different data set
columns. Put the values you want to appear in different columns of the
graph into different rows. 

Example:
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16.4.4 Grouped graphs

Format graph: Grouped and contingency

Prism lets you change every feature of a graph. Change the shape, color, and size of
graph symbols; change the fill pattern and color of graph columns; change the order
that data sets are plotted.

Double-click on any symbol or bar (or the background of the graph) to bring up the
Format Graph dialog.

See also:

Appearance of Grouped and Contingency graphs

Data set grouping and spacing on Grouped graphs

Plotting order of Grouped graphs

Additional Grouped graph settings
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16.4.4.1 Appearance of Grouped graphs

Format Graph dialog - Grouped graphs

Use this dialog to change the look of all the columns in a data set. If you
want to change the look of a single column , use the right-click menu.
You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.
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Global settings

To change the settings for one data set:

Select a data set from the list, and choose the symbols, lines, and error
bars for that data set. Then select another data set and choose settings
for that data set. Click OK to redraw the graph with all the changes. Note
that a fitted curve is treated as a separate data set.

To change all data sets on the graph (for example to make all symbols
larger):

Click the Global button and choose, Change all data sets. Changes you
make after that will then apply to all data sets.
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Bars and boxes

With two-grouping variable graphs, replicates are placed in side-by-side
columns on the data table. One grouping variable is the main column
heading, the other is the row title.

Choose how to display a data set on the graph. Choose between a scatter
dot plot, an aligned dot plot, a before-and-after plot, a column or bar, a
box-and whiskers plot, or a floating bar showing the minimum and
maximum.

Choose how to plot error bars. Select SD, SEM, 95% CI, or range. Your
style choice will determine which options below you can use. Since it
rarely makes sense to choose different error bar (or replicate) choices for
different data sets, you will probably want to click "All" before changing
error bar format.

 Symbols

If you choose to plot data as a scatter dot plot or a before-and-after
graph, select the symbol type, size, and color. If you pick an open
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symbol, also select a border thickness. Check the Clear option if you want
point-to-point lines and overlapping points to show through the open
symbol.

Click More to use any character from any font as a symbol.

If you choose to plot your data sets as bars, columns, box-and-whiskers,
or floating min/max boxes, choose the color, outline and fill of the bars
and boxes.

Use the Data Sets on Graph tab  to adjust the spacing between bars,
and whether you want the bars stacked, interleave, grouped, or
superimposed.

Prism labels bars with the row titles from the data table. You may not edit
the bar titles directly, but if you edit the row titles, the graph will update.
Use the Format Axes  dialog, not the Format Graph dialog, to turn off
the labels or to change to vertical or angled labels.

If your data table has only one row, Prism will place the column titles,
rather than row titles, under each bar.

Error bars

Choose the format and color of error bars. Learn more about error bars
.

Lines

Choose the format of lines connecting data points for a before-and-after
plot. Consider using arrows.
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Plot on which Y axis

Specify which axis to use for each data set. If you choose to plot on the
right Y-axis, Prism will create that axis if it doesn’t already exist.

Legend

Select Show legend to create a legend for this data set. Prism
automatically uses the column titles in your data table as legend labels.
You can also edit the labels in the legend. Double-click on the legend text
and type whatever you like. Use the "Revert Legend to Column Titles"
checkbox in the Legend section of the Format Graph dialog to change the
labels back to match the column titles. (This checkbox is only available if
you have edited a legend.)

16.4.4.2 Grouped graphs with XY data

If you entered XY data, with values in the X column, you can make a
Grouped graph. But note:

The whole point of a grouped graph, is that the X axis is spaced by row
number. The X value does not determine the position of the points on the
graph. This can be useful in some situations, but very misleading in
others. As shown below, the X values may not even be plotted in order of
their value. On a grouped graph, position is determined by row number
only.
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The graph above has the X axis labeled with the X values. On the Format
Axes dialog, you can choose to use Row titles (if you entered any), row
numbers or column titles instead.
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16.4.4.3 Data set grouping and spacing on Grouped graphs

How do you change the grouping and spacing of bars on Grouped
graphs?

Click on the Format graph button on the Prism toolbar or double-click on
any data point to open the Format Graph dialog.

Set the standard spacing between data sets 

To change the standard spacing between individual bars and groups of
bars, go to the Graph Settings tab.

Use these settings to set adjust the spacing between columns on a graph,
between groups of columns, and before the first column and after the last
one. If you make the spacing smaller, the columns will become wider.
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Choose how much if any space to leave for the bar where no value was
entered (the cell is blank).  In the example below, no data was entered
for black dogs. You can choose to leave no space, normal 100% space, or
something in between.

Note a possible point of confusion. The percentages set in this tab of the
dialog specify spacing as percent of the "normal" width. The normal width
is set in the by the number of data sets, number of rows and width of the
graph. 

Set how you want the bars to be grouped

You can change the overall grouping scheme of a graph or make hybrid
graphs types using the order tab of the Format Graph dialog. For each
data set, choose whether it should be interleaved with, stacked on top of,
placed apart from the (starting a new group of bars, hence the name
“grouped”) or superimposed on the preceding data set.
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Add lines between groups

 Check the box to Separate a data set from another with a line.
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Stacked and superimposed bars

Note the difference between Stacked and Superimposed below. When the
bars are superimposed, each extends from the X axis to the value. When
bars are stacked, each bar starts at the top of the one below.

Notes:

· Semitransparent color are not helpful with superimposed bar graphs.
Prism actually plots these as stacked bars (doing the subtraction to
know how big to make each slice). So you won't see the color of the
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bars further back showing through the bars in front. Don't try to use
semitransparent colors with superimposed bars. 

· Use the second tab of Format Graph to change the order of data sets,
which controls which data set is on top. 

· With stacked bars, each row in the data table becomes one stack of
bars. If you want to leave a gap between stacks (to create a natural
grouping of sets of stacked bars), leave a blank row in your data table. 

· It sometimes is helpful to combine both stacked and interleaved bars on
the same graph as below. This is done by checking the option to stack
the "dogs" data set on top of hippos, and to make the "cats" data set
grouped.

 

16.4.4.4 Plotting order of Grouped graphs

Data set order

The two graphs in this example are identical except that the plotting
order was reversed.

Click the Rotate/Flip button in the Change section of the Prism toolbar to
reverse the order of data sets on a graph.
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To fine tune the left-to-right order, go to the Data Sets on Graph tab of
the Format Graph dialog.

The two graphs in this example are identical except that the plotting order
was reversed.

To reverse the plotting order of the data sets on a graph, click the Rotate/Flip button in the Change section of the Prism toolbar.
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To fine tune the left-to-right order, go to the Data Sets on Graph tab of
the Format Graph dialog.

Changing the order of the data sets on this dialog changes the font-to-
back (if you plot symbols) or left-to-right (if you plot bars) order of the
data sets on the graph. It does not change the order of the legends
. 

Order of bars within a data set

The previous section explained how to adjust the order of the data sets.
The order of the individual columns within a particular data set is
determined by the order they are entered in the data table.
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To reverse the row order on a data table, go to the data table. From the
Change menu, click the Sort button, and choose "Reverse row order".

See another example of changing plotting order for Grouped graphs.

16.4.4.5 Additional Grouped graph settings

Graph Settings tab of Format Graph dialog

Use the Graph Settings tab of the Format Graph dialog to change the
direction of bars on a graph from vertical to horizontal, to set the baseline
for graph columns, and to adjust the space between columns. Double-
click on any bar to open the dialog.
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Direction

Rotate columns from vertical to horizontal

You also can use the Rotate button.

Baseline

Fill in this box to change the baseline for bars on a graph. The default is
for the bars to begin at the X axis. Check the box for "Hide Baseline" if
you want your bars to float as in the example below.
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Spacing

This is explained in a separate help page . 

Discontinuous axis

When you have a gap in a Y axis, choose whether or not you also want a
gap in any columns that span the gap. Not leaving a gap may make your
graph misleading.

Shape of the legend key

For bar graphs, choose between square or rectangular (wider) boxes
before the legend text.

16.4.4.6 Annotations on Grouped graphs

Place the mean/median or sample size within each bar or above. On the
Annotations tab of the Format Graph dialog, note there are three tabs
within, to specify labeling (if any) above the bars, within the bars on top,

446
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or within the bars at the bottom. (Note this feature offers more choices,
so a different look, starting with Prism 8.2.)

.

When writing within each bar, choose one color for all values, or choose 
"auto" so the color is either black or white depending on background.
With Prism Windows, the auto choice is in the Format Graph dialog as
shown above. With Prism Mac, the auto choice is in the color picker as
shown below. 
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16.4.4.7 Row or column titles under bars?

You can change how the bars are labeled. Double-click on the axis to
bring up Format Axis, then choose to use Row numbers, Row titles, or
Column titles. If you choose Column titles, you'll want to use the text tool
to add text to the graph to explain the grouping.
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16.4.4.8 Plotting the grand mean or grand median

To plot the grand mean or grand median, plot grouped data (with
individual replicates) on a Grouped graph, choose "Plot individual values"
and then choose to plot a superimposed scatter plot. The last two choices
on the Plot drop down menu will be to plot the Grand mean or Grand
median. It is not possible to plot the grand mean or median with error
bars, and it isn't totally clear even how those error bars would be
defined. 
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The data for the graph above were entered on a Grouped table with five
subcolumns. The three kinds of symbols represent data from three data
set columns. The two columns in the graph (serum starved and normal
culture) come from two different rows in the data table. 

16.4.4.9 Three way graphs

A three way graphs is a Grouped graph set up to show data entered into
Prism for analysis by three-way ANOVA. The entered data look like this.
Note the two line column titles. These are essential both to properly label
the data, but also to properly label the graph.

From the Change Graph Type dialog, choose the Three-way tab and one
of the thumbnails.

The graph looks like this. 
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Note that the first line of the column titles in the data table become labels
for the two halves of the graph, and the second line of the column title
becomes the graph legend. The row titles become labels under the bars. 

16.4.5 Contingency graphs

Format graph: Grouped and contingency

Prism lets you change every feature of a graph. Change the shape, color, and size of
graph symbols; change the fill pattern and color of graph columns; change the order
that data sets are plotted.

Double-click on any symbol or bar (or the background of the graph) to bring up the
Format Graph dialog.

See also:

Appearance of Grouped and Contingency graphs

Data set grouping and spacing on Grouped graphs

Plotting order of Grouped graphs

Additional Grouped graph settings
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16.4.5.1 Appearance of Contingency graphs

Format Graph dialog - Grouped graphs

Use this dialog to change the look of all the columns in a data set. If you
want to change the look of a single column , use the right-click menu.
You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.
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Global settings

To change the settings for one data set:

Select a data set from the list, and choose the symbols, lines, and error
bars for that data set. Then select another data set and choose settings
for that data set. Click OK to redraw the graph with all the changes. Note
that a fitted curve is treated as a separate data set.

To change all data sets on the graph (for example to make all symbols
larger):
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Click the Global button and choose, Change all data sets. Changes you
make after that will then apply to all data sets.

Bars and boxes

Plot bars (usually), symbols, or both (but why?)

Use the Data Sets on Graph tab  to adjust the spacing between bars,
and whether you want the bars stacked, interleave, grouped, or
superimposed.

Prism labels bars with the row titles from the data table. You may not edit
the bar titles directly, but if you edit the row titles, the graph will update.
Use the Format Axes  dialog, not the Format Graph dialog, to turn off
the labels or to change to vertical or angled labels.

Plot on which Y axis

Specify which axis to use for each data set. If you choose to plot on the
right Y-axis, Prism will create that axis if it doesn’t already exist.

Legend

Select Show legend to create a legend for this data set. Prism
automatically uses the column titles in your data table as legend labels.
You can also edit the labels in the legend. Double-click on the legend text
and type whatever you like. Use the "Revert Legend to Column Titles"
checkbox in the Legend section of the Format Graph dialog to change the
labels back to match the column titles. (This checkbox is only available if
you have edited a legend.)
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16.4.5.2 Data set grouping and spacing on Contingency graphs

How do you change the grouping and spacing of bars on Grouped
graphs?

Click on the Format graph button on the Prism toolbar or double-click on
any data point to open the Format Graph dialog.

Set the standard spacing between data sets 

To change the standard spacing between individual bars and groups of
bars, go to the Graph Settings tab.

Use these settings to set adjust the spacing between columns on a graph,
between groups of columns, and before the first column and after the last
one. If you make the spacing smaller, the columns will become wider.
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Choose how much if any space to leave for the bar where no value was
entered (the cell is blank).  In the example below, no data was entered
for black dogs. You can choose to leave no space, normal 100% space, or
something in between.

Note a possible point of confusion. The percentages set in this tab of the
dialog specify spacing as percent of the "normal" width. The normal width
is set in the by the number of data sets, number of rows and width of the
graph. 

Set how you want the bars to be grouped

You can change the overall grouping scheme of a graph or make hybrid
graphs types using the order tab of the Format Graph dialog. For each
data set, choose whether it should be interleaved with, stacked on top of,
placed apart from the (starting a new group of bars, hence the name
“grouped”) or superimposed on the preceding data set.
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Add lines between groups

 Check the box to Separate a data set from another with a line.
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Stacked and superimposed bars

Note the difference between Stacked and Superimposed below. When the
bars are superimposed, each extends from the X axis to the value. When
bars are stacked, each bar starts at the top of the one below.

Notes:

· If bars are superimposed, it can help to use semitransparent colors.
That way you can see the smaller bar that is hidden behind a taller one. 



GraphPad Prism 8 User Guide470

© 1995-2020 GraphPad Software, LLC

· Use the second tab of Format Graph to change the order of data sets,
which controls which data set is on top. 

· With stacked bars, each row in the data table becomes one stack of
bars. If you want to leave a gap between stacks (to create a natural
grouping of sets of stacked bars), leave a blank row in your data table. 

· It sometimes is helpful to combine both stacked and interleaved bars on
the same graph as below. This is done by checking the option to stack
the "dogs" data set on top of hippos, and to make the "cats" data set
grouped.

 

16.4.5.3 Plotting order of Contingency graphs

Data set order

The two graphs in this example are identical except that the plotting
order was reversed.

Click the Rotate/Flip button in the Change section of the Prism toolbar to
reverse the order of data sets on a graph.
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To fine tune the left-to-right order, go to the Data Sets on Graph tab of
the Format Graph dialog.

The two graphs in this example are identical except that the plotting order
was reversed.

To reverse the plotting order of the data sets on a graph, click the Rotate/Flip button in the Change section of the Prism toolbar.
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Changing the order of the data sets on this dialog changes the font-to-
back (if you plot symbols) or left-to-right (if you plot bars) order of the
data sets on the graph. It does not change the order of the legends
. 

Order of bars within a data set

The previous section explained how to adjust the order of the data sets.
The order of the individual columns within a particular data set is
determined by the order they are entered in the data table.

To reverse the row order on a data table, go to the data table. From the
Change menu, click the Sort button, and choose "Reverse row order".
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See another example of changing plotting order for Grouped graphs.

16.4.5.4 Additional Grouped graph settings

Graph Settings tab of Format Graph dialog

Use the Graph Settings tab of the Format Graph dialog to change the
direction of bars on a graph from vertical to horizontal, to set the baseline
for bars (but they really should start at zero), and to adjust the space
between columns. Double-click on any bar to open the dialog.
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Spacing

This is explained in a separate help page . 

Discontinuous axis

When you have a gap in a Y axis, choose whether or not you also want a
gap in any columns that span the gap. Not leaving a gap may make your
graph misleading.

Shape of the legend key

For bar graphs, choose between square or rectangular (wider) boxes
before the legend text.

16.4.5.5 Row or column titles under bars?

You can change how the bars are labeled. Double-click on the axis to
bring up Format Axis, then choose to use Row numbers, Row titles, or
Column titles. 

16.4.6 Heat maps

 .

16.4.6.1 Creating a heat map

Heat maps are a standard way to plot grouped data. The basic idea of a
heat map is that the graph is divided into rectangles or squares, each
representing one cell on the data table, one row and one data set. The
rectangle or square is color coded according to the value of that cell in the
table. Prism offers lots of options to make Heat maps useful. 

466
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Enter data on a Grouped table. Most often you'll want to format this with
no subcolumns. In this case, each number you enter maps to one
rectangle on the heat map. Unless you choose to reverse or transpose
axes, the arrangement of the colors on the heat map will correspond to
the numbers in the table. If your table as three rows and four columns,
the heat map will also have three rows and four columns. 

If you enter replicate values in side by side subcolumns, you can later
choose if you want the heat map to be based on the mean, median or
geometric mean of the replicates. You can even choose to make a heat
map of variation, and use the SD, %CV or SEM as the basis of the
heatmap. 

When you go to the automatic graph (or choose New..Graph of existing
data), the New Graph dialog opens. Choose the Heat Map tab and make
basic choices about the kind of heat map you wish to make.

Once you see the graph, double click on it to bring up the Format Graph
dialog with many more choices. 

Color mapping 476
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Graph settings

Titles and labels

Gaps

Legends

16.4.6.2 Color mapping

Mapping replicates

 If you entered replicate values (side by side), you can later choose if you
want the heat map to be based on the mean, median or geometric mean.
You can even choose to make a heat map of variation, and base the heat
map on the SD, %CV or SEM of replicate values. 

Color map and range

There are four choices of color maps:

· Single gradient. Choose the range of values to convert to colors and the
range of colors. 

478
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· Grayscale. You can choose whether black or white is for the lower value,
and what the range of values is. 

· Rainbow. You choose the range of data values. Prism chooses the range
of colors by fixing the saturation and brightness to 100% and varying
the hue from 0° to 300°. Using the Rainbow color map, the largest
values are shown in red. If you select the Reverse Rainbow color map,
the smallest values are encoded red. 

· Double gradient. You choose the baseline value (almost always 0.0) and
color (usually white or black). Then separately enter the maximum
value (almost always positive) and color, and also enter the minimum
value (almost always negative) and color. 

· Categorical. Enter a value or range of values, and what color you want it
to show as. Repeat as needed. Ranges cannot overlap. You can't have
one range "1-2" and another "2-3" because that would leave it
ambiguous how to encode 2.0000. Instead do something like this -- one
rage for "1.0-1.99" and another for "2.0-2.99". 

Off the map

Choose a color to use if the value is too large or too small to be part of
the map you defined, or if the value is blank or excluded. Of course, these
choices are irrelevant if no values are off scale, blank or excluded. To
make blank and excluded values more apparent,  check an option to place
a black X through those cells. Since the X is always black, use a light
color to encode these cells. 
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16.4.6.3 Graph settings

Borders and background

Choose the page background color and the color and thickness of the
borders around each cell (box) and around the entire heat map. 

Size and shape

You can set the size of the entire heat map, in which case the size and
shape of each cell will be determined by that size and how many rows and
columns there are. Or set the size and shape of each cell, and the overall
size is determined from that. 

Order

Optionally reverse the order of columns and/or rows. Or transpose rows
and columns. 
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16.4.6.4 Labels

Choose whether to write the numerical value (or the mean, median, etc)
of each cell in that cell, and how to label the two axes. 

If you place the value in each cell, choose one color for all values or
choose "auto" so the colors are either black or white depending on the cell
color. With Prism Windows, the auto choice is in the Format Graph dialog
as shown above. With Prism Mac, the auto choice is in the color picker as
shown below. 



GraphPad Prism 8 User Guide480

© 1995-2020 GraphPad Software, LLC

16.4.6.5 TItles

Choose whether to show an overall title, or titles on the two axes, and
choose their fonts.
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16.4.6.6 Gaps

There are two reasons to use gaps. 

· You can put gaps next to and under all the cells just because you think
the heat map is more attractive that way. The gaps server as borders. 

· Use gaps to group sets of rows and columns to give some structure to
the heatmap. Maybe the left half is for one cell line, and the right half
for another. Put a gap in between to distinguish them. 
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16.4.6.7 Legend for heat maps

The legend is the key that maps colors to value. 

Choose if the legend will be horizontal or vertical and whether it has a
border, then choose the interval for labeling it, and the location and
formatting of each label.

16.4.7 Survival graphs

Format graph: Survival

Prism lets you change every feature of a graph. Change the shape, color, and size of
graph symbols; change the fill pattern and color of graph columns; change the order
that data sets are plotted.

Double-click on any symbol or bar (or the background of the graph) to bring up the
Format Graph dialog.

See also:
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Appearance of Survival graphs

Changing the plotting order of data sets

Nudging survival data sets

Error bars and confidence bands on Survival graphs

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

16.4.7.1 Appearance of Survival graphs

Format Graph dialog - survival plots

Use this dialog to change the look of all the points in a data set. If you
want to change the look of a single data point , use the right-click
menu. You can also change all the symbols in selected data sets .

Double-click on any graph symbol or bar to open the Format Graph
dialog.
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To change the settings for one data set:

Select a data set from the list, and choose the symbols, lines, and error
bars for that data set. Then select another data set and choose settings
for that data set. Click OK to redraw the graph with all the changes. Note
that a fitted curve is treated as a separate data set.

To change all data sets on the graph (for example to make all symbols
larger):

Drop the list of data set names and choose --Change ALL data sets--. Or
click the ALL button just to the right. Changes you make after that will
then apply to all data sets.

Show Symbols

Choose symbol type, size, and color. If you pick an open symbol, also
select a border thickness. Check the Clear option if you want point-to-
point lines and overlapping points to show through the open symbol. Use
Shape the drop-down menu to select one of Prism's symbols. Use the
More option on this drop-down to use any character from any font on your
computer as a symbol.
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In survival plots, you can choose to show symbols only for censored data
points, or for all data points. Make this selection on the Graph Settings
tab of the Format graph dialog.

Error bars

Choose how you want error bars to be formatted. Error bars can go above
or below a data point or in both directions. Learn more about error bars
on survival graphs .

Depending on the choices you made when you created a survival plot, the
option for error bars may or may not be available. You can change this
setting in the Graph Settings tab of the Format Graph dialog.
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Connecting lines

Choose the format of lines connecting data points for a survival plot.
Consider using arrows.

Show Area fill

Choose to show area fills below or above the plot lines. Click the All
button to turn on this feature for all the data sets on a graph.

Plot on which Y axis

Specify which axis to use for each data set. If you choose to plot on the
right Y-axis, Prism will create that axis if it doesn’t already exist.

Legend

See the page on Legends for XY graphs.  

16.4.7.2 Changing the plotting order of data sets

Change the order to determine plot lines are in front. Plotting area
matters the most when you use area fills. The graphs below are the
same, but with the plotting order reversed. Note that on the graph on the
left the area fill from the one data set hides the other.
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To change the plotting order of the data sets on a graph:

Click the Rotate/Flip button in the Change section of the Prism toolbar to
reverse the front-to-back order of data sets on a graph.

To fine tune the front-to-back order, go to the Data Sets on Graph
tab of the Format Graph dialog.
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16.4.7.3 Nudging survival data sets

Nudging can be helpful to differentiate datasets that otherwise overlap a
lot. The "Treatment B" data set in the graph on the right has been nudged
up a bit to separate it from the "Treatment A" data set.
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16.4.8 Parts of whole graphs

 .

16.4.8.1 Changing the look of parts of whole graphs

Format Graph dialog - Parts of whole plots

Use this dialog to change the look of a Parts of whole graph If you want to
only change the look of a single segment, it is simpler to use the right-
click menu on the graph. You can also change all the symbols in selected
data sets .

Double-click on any graph section to open the Format Graph dialog.
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To change the general appearance of the graph:

 Click on the thumbnail image in the Graph type section of the dialog. You
can change from a pie chart to a donut, slice or dot plot. Prism will
preview how your graph will look after the change.

To change the settings for one data set:

Select a data set from the Colors and legend list, and choose the color or
fill pattern of the graph segment, and what information you want the
legend to show.

To change all data sets on the graph:

Click the Global button to select all data sets on the graph. Or, select the
data sets from the drop-down menu that you want to change.

If your graph only has one data set (one slice):

The graph is generated from values entered into a single column in the
data table. If you enter data into a row, you'll only get one value on the
graph.
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Color and Legends

You can set the color of each graph segment. Use the roll-down to choose
if you want a particular segment of a pie or donut graph exploded from
the main graph and how far away you want it to be. Or choose to hide a
segment.

Choose the information you want the legend to show and how you want it
formatted.

If one of the rows of data is zero, then Prism will not create a legend for
it. If you want a legend, even though the value is zero, enter some tiny
nonzero value like 0.000001. The slice will be invisible on the graph, but
Prism will create a legend for it. 

Borders

Choose the color and thickness of the segment borders. You can have
different settings for the inner and outer borders. These setting are for all
the segments of the graph.
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Titles

Click to show or hide the graph title, or to show or hide the total of all
values, The graph shows each category as the fraction of the total, so it
can be very useful to show the total  near the graph. With donut graphs,
it is common to put the total in the center of the graph as shown below.
Optionally add a prefix or suffix, for example: 1,000 Applicants, or Total:
1,000. 

Order

Reverse the order of the data sets to change the orientation of the graph.
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Size

Use the Size portion of the dialog to change the size of the whole of a
donut graph.

16.4.8.2 Changing which data set is plotted

A parts-of-whole graph can only plot one data set. To plot a different data
set, double click on the graph to bring up the Format Graph dialog, go to
the second tab, and choose the table and data set to plot. 

Note that the values that comprise a parts-of-whole graph are always
entered into one data set column. If your values are in a row, you'll need
to select them, copy to the clipboard, go to an empty row and paste.

16.4.9 Nested graphs

Enter topic text here.

16.4.9.1 Appearance tab: Nested graphs

For the most part, the choices are the same as for Grouped graphs . 

For each data set, decide if the subcolumns should be shown as
scatterplotm aligned scatter plot, before-after (used rarely for nested
data), symbol at mean, bar, box-whisker or violin plots. Use the "global"
setting to change all data sets at once. 
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At the bottom of the dialog, choose which Y axis the data set is plotted on
and whether to show a legend or not. 

16.4.9.2 Data sets on graph tab: Nested data

For the most part, the choices are the same as for Grouped graphs . 

At the top of the tab, choose which data sets are included on the graph. 

At the bottom of the tab, choose how the data sets are related to each
other. Usually you will want interleaved or separated. Superimposed rarely
is helpful. If you separate the data sets, optionally choose to place a line
and/or gap to separate one data set from the next. 

16.5 Format Axes dialog

Scientists often individualize the axis range, numbering and ticks.

Axis range

Axis numbering

Major and minor ticks

Graphs with two Y-axes

Hide an axis and show scale bars

Put a gap in an axis

Additional ticks and grids

 Axis titles
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16.5.1 Overview of the Format Axes dialog

How to bring up the Format Axes dialog?

Two ways:

· Double-click on an axis.

· Click this button. 

Uses of the Format Axes dialog

The first tab lets you makes changes to the frame and origin , and to
choose a color for the page background and the plotting area. 

The middle tabs let you format the X axis, the left Y axis and the right Y
axis . 

The last tab lets you turn axis (or graph) titles  on or off, and choose
their font and distance from the graph. 

How to change the color or thickness of one axis

In rare cases, you may want to change the color or thickness of one axis
and not the other(s). Or you may want to make one axis white (or
whatever your page background color is) to make it essentially invisible.
To do this, select the axis, drop the Change menu and choose Selected
Object. Then change the color or thickness in the Format Object dialog. 
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16.5.2 Axis range, numbering & titles

 Axis range
Axis numbering or titles
Major and minor ticks
Hide an axis and show scale bars
Discontinuous axes
Additional ticks and grids
Axis titles

16.5.2.1 Axis range

Double-click on an axis to open the Format Axes dialog. Or click on the
Format Axis tool in the Prism toolbar.

Prism chooses the range of each axis automatically. To override this,
uncheck the "Automatically determine the range and interval" box and
enter the minimum and maximum value you want plotted on the axis. You
can also hook  a range limit to an info constant.
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You can only set the range on numerical axes, not the categorical axis
of Column and Grouped graphs.

 

 

 

 

 

16.5.2.2 Axis numbering or titles

Double-click on an axis to open the Frame and Origin tab of the Format
Axes dialog. Or click on the Format Axis tool in the Prism toolbar.

What values or labels show on the X axis?

XY graphs

Normally, of course, the X axis of an XY graph plots the X values you
enter into the  X column. The X axis, in this case, is numerical. If the X
values are not evenly spaced, then the points won't be equally spaced. 

If you enter row titles for each row, then you can choose to label the X
axis with row titles rather than X values. Choose in the Number format
drop down in the Regularly spaced ticks part of the Format Axes dialog. 
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When you choose to label the X axis with row titles, the spacing of the
points may change. Essentially, Prism uses the row number as the X
value, so the points will be equally spaced along the X axis, even if the X
values are not evenly spaced. By default, each row label will appear. If
you have many rows, this will be cluttered. You can ask Prism to plot,
say, every fifth row label by changing the major tick interval to 5, starting
at 0. Keep in mind that Prism uses the row number (first row is 1) rather
than the values entered into the X column, to position the data and
determine which labels to show. Prism also uses this coordinate system
(row numbers) when positioning additional ticks and grid lines. If you ask
for a grid line at X=5, Prism will draw it to correspond with the point in
the fifth row, whatever its X value.

If you entered elapsed times or dates instead of X values, Prism presents
a different set of choices for Number format. 

Grouped and contingency table graphs

With Grouped graphs (and graphs of contingency tables), you can have a
choice of labeling the X axis with row titles, column titles, or row number.
You may or may not see all three choices, depending on how you
configured your graph.
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Other types of graphs

Survival graphs always use survival time as the X values. Column graphs
always label the X axis with column titles. Parts-of-whole graphs don't
have axes.

Appearance of axis numbers or labels

To change the font, size, and color of the numbering for one axis:

Go to the Titles and Fonts tab of the Format Axes dialog. Click the Font button in
the Numbering or labeling section. Or select an axis by clicking on it, and use the
Font settings in the toolbar.

To change the default font used for new graphs:

Set on the New Graphs tab of the Preferences dialog .

To move the numbers above/below the X-axis or to the right/left of the Y-
axis:

Select the position of the axis numbering in the Axis Titles section on the Titles and
Fonts tab of the Format Axes dialog. Or select the axis numbering by clicking once;
then drag the numbering with the mouse or nudge it by clicking the arrow keys:

To put a prefix in front of all axis numbers, or a suffix after:

Enter the prefix (i. e. “$”) or suffix (i. e. “%”) in the Format Axes dialog.

To rotate the numbering 90 degrees:

Set the number orientation In the All Ticks section in the Format Axes dialog.

To label axes with row titles instead of X values:

If you entered both X values and row titles on an XY data table, you can choose to
label the axes with Row Titles instead of Decimal numbers via the Format setting in
the Regularly spaced ticks section of the Format Axis dialog. If you do this, Prism
will ignore the X values entirely, and use the row number (top row is 1) as the X
values when plotting values.

194
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16.5.2.3 Major and minor ticks

Prism lets you show both major and minor ticks on an axis. By default,
Prism automatically sets the minimum and maximum range for an axis as
well as the major tick interval.

To change the major or tick interval:

Double click on an axis to open the Format Axes dialog. Uncheck the Auto
box in the Range section and set the major tick interval in the Regularly
Spaced Ticks section.

To show minor ticks:

Double-click on an axis to open the Format Axes dialog. Select an interval
for minor ticks in the Regularly Spaced Ticks section. Choose the interval
for minor ticks between major ticks and whether you want regular or log
spacing . Select the number of intervals you want between major ticks,
not the number of ticks. (For example, choosing four intervals creates
three minor ticks.)

To hide ticks:

Double-click on an axis to open the Format Axes dialog. In the All Ticks
section, choose None for Direction in the All Ticks section.

To change the direction and length of ticks:

Double-click on an axis to open the Format Axes dialog. Set the direction
and length of ticks in the All Ticks section.

To place additional custom ticks or grid lines on a graph:

See: Additional ticks and grid lines .
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16.5.2.4 Hide an axis and show scale bars

Hiding the X or Y axis. Or both. 

Prism lets you hide either the X- or the Y-axis and show scale bars
instead.

To hide and axis and show a scale bar instead:

 

Double-click on an axis to open the Frame and Origin tab of the Format
Axes dialog. Or click on the Format Axis tool in the Prism toolbar.

Choose to hide one or both axes in the Frame & Origin section. You can
also choose to Show Scale Bars.
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Scale bars

To show or hide the scale bar:

If you choose to hide either axis, a new option will appear in the Frames and axes
section of the Format Axes dialog: Show Scale Bar. Check this option to see scale
bars; uncheck to hide scale bars.The length of the scale bar equals one axis
interval, set in the Regularly Spaced Ticks section of the Format Axes dialog.

To delete a scale bar:

Click on a scale bar to select it, and then press DEL to delete it.

To change the color or thickness of a scale bar:

Double-click the scale bar to bring up the Format Object dialog. Choose color and
thickness in this dialog.

To remove the caps on the end of the scale bar:

By default the scale bars are capped. These are actually "arrowhead" styles. To
change, double-click the scale bar to bring up the Format Object dialog. Then
change the arrowhead settings.

To move a scale bar:

Drag with the mouse. Or click to select, and then nudge by clicking the arrow keys.

To label a scale bar:
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Scale bars don't include any numbering. To create a label for a scale bar, click the
text tool ("T" button), click near the scale bar, and type.

To change the length of the scale bar:

You can’t change the length of a scale bar by stretching it. Instead, bring up the
Format Axes dialog and change the tick interval in the Regularly Spaced Ticks
section.

16.5.2.5 Discontinuous axes

Creating a gap in an axis

When plotting scientific data, you will often want to create a
discontinuous axis - and axis with one or two gaps. Double-click on the
axis to open the Format Axes dialog. In the Gaps and Directions section,
you can choose either a two-segment (one gap) or three-segment (two
gaps) axis.

Set the range of each segment and its length as a percent of the total
length of the axis. 
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Finally,  choose the spacing and properties of minor and major ticks
separately for each axis segment.

Limitations:

· You cannot make one segment have a logarithmic or probability scale
without making all the segments have such a scale. 

· Axes with multiple segments can only be in the standard direction (no
reverse axes with segments). 

· You can only create discontinuities in the X axis of XY and Survival
graphs, not Column and Grouped graphs. 

Adjusting the position of the gap on the graph and the width of the gap

To move the gap along the axis, or make the graph wider or narrower,
click on an axis segment to select it and then:

· Drag the knob just to the left of (or below) the gap to change the
position of the gap along the axis (make one segment larger, and
another smaller). 

· Drag the knob to the right of (or above) the gap to widen or narrow the
gap itself.

Examples

Example 1

· Left segment range: 0 to 15

· Left segment length: 67% of the total

525
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· Right segment range: 15 to 50

· Right segment length: 33% of the total.

Because of the change in scale, the linear regression line appears to have
two slopes. In fact the mathematical slope is identical everywhere, and
the line was created by a single analysis of all the data. The slope just
appears steeper in the right half of the graph because the time scale is
more compressed.

Example 2

· Left segment range:  -9.5 to -8.5

· Left segment length: 12% of the total

· Right segment range: -8.5 to -2.5

· Right segment length: 88% of the total

To place "0" on the left segment, create an additional tick label at X=-9
and enter the text "0". 

Example 3

· Left segment range:  0 to 24

· Left segment length: 50% of the total



Graphs 507

© 1995-2020 GraphPad Software, LLC

· Right segment range: 48 to 72

· Right segment length: 50% of the total

The line was drawn by linear regression, which automatically skips over
the axis gap.

 

16.5.2.6 Additional ticks and grids

Prism let's you add up to 30 additional ticks or grid lines at defined
positions along the axis. A discontinuous axis has two or three segments,
and the limit of 30 additional ticks or grid lines applies to each segment
separately. 

To create additional ticks or grid lines:

Double-click on an axis to open the Format Axes dialog. In the Additional
Ticks and Grid Lines section, set the coordinate on the axis where the tick
or line should appear. Check the box to show either a tick or a grid line. If
the coordinate is at a location where there already is a regular number or
label, the label you enter in the Additional ticks section is shown and the
regular label will be hidden. 
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To format an additional tick:

 Click on the Details button of the Additional Ticks and Grid Lines
section of the Format Axes dialog. This appears as a gear on Prism
Window, and as "..." on Prism Windows. This lets you format how the tick
or grid line will look and add text to the label.
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Choose whether you want each tick in line with or across from the regular
ticks.

You also can Hook  the text of the label to an analysis or Info Sheet
constant .

To add a fill between additional ticks or grid lines

Check the option to fill between two ticks, and choose the fill color and
pattern.
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To create adjoining fills

Prism can only fill the space between an Additional Grid line and one of its
neighbors. To create fills on both sides of a grid line, place two additional
grid lines at the same position and fill backward from one and forward
from the other.

To remove or change an additional tick:

Double-click on the axis to bring up the Format Axes dialog. Locate the
tick you want to change in the Additional Ticks and Grid Lines section.

Click the Details button to open the Format Additional Ticks and
Grid lines section and click on the Delete Tick button.
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To create an additional tick or grid line by hooking an info or analysis
constant:

The coordinate, or text, of an additional tick can be hooked to an analysis
constant  or info constant . Click on the Details button in the
Additional Ticks and Grid lines section and then on the Hook icon in the
Format Additional Ticks and Grids section and select the constant you
wish to link to.

308 188
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In this example, the dashed line for Kd and BMax were hooked to the Kd
and BMax values in fit by nonlinear regression. If the raw data are
subsequently changed, both the results information and this grid lines will
update.

16.5.2.7 Axis titles

By default, Prism puts generic titles on top of the graph and on the X-
and Y-axes.

To edit a title:

Click in the title to select it. If you are editing a Y-axis title, it will be
temporarily displayed horizontally for editing. Edit (or replace) the text.
To enter more than one line, press Enter between lines. When you are
done, click in the background of the graph. While editing the title, you can
use controls in the text toolbar.

To delete a title:
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Drag over the title to select it. If you are editing a Y-axis vertical title, it
will be temporarily displayed horizontally for editing. Then press the DEL
key.

To bring back a deleted title:

Double-click an axis to open the Format Axes dialog. Check "Show title" in
the Titles and Fonts tab of Format Axes dialog.

To change the font of a title:

Select the title, or a portion of it, and use Font tools on the toolbar. Or
double-click on the axis to open the Format Axes dialog, go to the
Titles&Fonts tab,  and click the Font button.

To make a title a bit smaller or bigger.

Select the title, Then press the  or  buttons on the toolbar to change
the point size.

To justify a title:

Usually a title is centered over the graph or axis. To justify the title with
the right or left edge of the axis, select the title and click on the text
justify button on the Text toolbar.

To move a title:

Move the mouse near the title until the cursor turns into a two-headed

arrow . Then hold down the primary mouse button and drag the title
into position. Alternatively, go to the Titles and Fonts tab of the the
Format Axes dialog, where you can position the title by entering the
desired distance between the axis and the title. 

A graph title is always centered over the graph, and an axis title is always
centered on the axis. If you want noncentered titles, delete the title and
then create a separate text object which can be positioned anywhere.

To hide a title, or rotate a title:
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Double-click an axis to open the Format Axes dialog. Uncheck options to
hide any of the titles.  For both Y axes you have the choice to make the
title vertical or horizontal.

To change the default font and size used for new graphs:

Pull down the Edit menu (the Prism menu in Mac OS X), and choose
Preferences, then go to the New Graphs tab.

Why you want to put titles on axes!

 

From XKCD. 

https://xkcd.com/833/
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16.5.3 Labeling axes with dates and times

 .

16.5.3.1 Elapsed time

This page explains how to make graphs when you entered X values as
elapsed time . Another page  explains how Prism 6 and earlier dealt
with dates and times. 

The Format Axis dialog offers two new choices when you entered elapsed
times instead of X values. '

Elapsed time scale

At the top of the dialog, choose to use a Elapsed Time scale. 

If you choose an Elapsed time scale, you can choose to display just hours,
hours:minutes, hours:minutes:seconds or
hours:minutes:seconds.milliseconds. To avoid overlap, you'll probably
want the dates to be displayed vertically or at an angle (not horizontal).

243 520



Graphs 517

© 1995-2020 GraphPad Software, LLC

Linear scale for X values entered as elapsed time

If you choose a linear (numerical) scale, Prism tells you what the units
will be. These units are set on the data table.  

To change those units, go back to the data table, drop the Change menu,
choose Format Data Table ,  and then select the units you want to use.240
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What values are used when you fit a curve or line to the data?

When you analyze an XY table with X values entered as elapsed times,
Prism converts the elapsed times to numbers. To change the units
(seconds, minutes,...), go back to the data table, drop the change menu,
and choose Format Data Table.

Note that the choice of months is not offered, because months have
different lengths. Years also have different lengths, so if you choose
years, Prism does the conversion based on 365.25 days per year. 

16.5.3.2 Dates

This page explains how to make graphs when you entered dates as X
values . Another page  explains how Prism 6 and earlier dealt with
dates. 

The Format Axis dialog offers two new choices when you entered dates
instead of X values. 

243 520
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Date scale

At the top of the dialog, choose to use a Date scale. 

If you choose a Dates scale, you can choose many ways to display the
dates. To avoid overlap, you'll probably want the dates to be displayed
vertically or at an angle (not horizontal).

When you choose a Dates axis scale, Prism is smart about how far to
space the dates. Jan 3 is much closer to Jan 1 than is Feb 3...

Linear scale for X values entered as dates

If you choose a linear (numerical) scale for X values entered as dates,
Prism tells you what the units will be.
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 To change those units, go back to the data table, drop the Change menu
and choose Format Data Table. 

What values are used when you fit a curve or line to the data?

When you analyze XY data where X values are entered as dates, Prism
converts the dates to numbers using a starting date and a date unit
(days, weeks, etc.). To change this, go back to the data table, drop the
change menu, and choose Format Data Table.

16.5.3.3 Dates (Compatible with Prism 6)

Prism 6 and earlier did not understand the concept of dates or times, so
you could not enter times or dates as X values. But you plot dates i a



Graphs 521

© 1995-2020 GraphPad Software, LLC

manner compatible with Prism 6 by entering  dates or times as row
titles. 

Note that Prism does not try to interpret the meaning of row titles. Those
labels will always appear equally spaced on the graph, even if the dates
are not equally spaced chronologically. You'll need to use a different
approach to plot a series of dates that are not equally spaced to be
compatible with Prism 6. Enter the data onto an XY table. Enter the dates
as row titles. Into the X column, enter the number of days since some
starting point. 

To make this graph, you'll need to make some changes on the Format
Axis dialog. Leave the Number Format set to Decimal. Don't choose Row
Titles, or you'll end up with an equally spaced graph. Use the Additional
Ticks section to specify each label and its location (X coordinate). Check
the option to plot only these additional ticks (instead of regular ticks). 
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16.5.4 Logarithmic axes

If your data span a wide range of values, it can be easier to visualize the results
when you make one of the axes logarithmic. Distinguish between transforming
your data to logarithms (which creates a new results table) from choosing a
logarithmic axis (which only stretches the axis, without altering your data).

  

What is a logarithmic axis?

How to: Create a log axis

Logarithmic axes cannot contain zero or negative numbers

Regression fits the data, not the graph

When to use a logarithmic axis

Advice: Bar graphs with log axes rarely make sense

523

525

527

528

529

531



Graphs 523

© 1995-2020 GraphPad Software, LLC

Graphing logarithms - different than using a log axis

A review of logarithms

 

 

 

 

 

 

16.5.4.1 What is a logarithmic axis?

A logarithmic axis changes the scale of an axis

The two graphs below show the same two data sets, plotted on different
axes.

 

The graph on the left has a linear (ordinary) axis. The difference between
every pair of ticks is consistent (2000 in this example).
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The graph on the right has a logarithmic axis. The difference between
every pair of ticks is not consistent. From the bottom tick (0.1) to the
next tick is a difference of 0.9. From the top tick (100,000) down to the
next highest tick (10,000) is a difference of 90,000). What is consistent is
the ratio. Each axis tick represents a value ten fold higher than the
previous tick.

The red dots plot a data set with equally spaced values. Each dot
represents a value with a Y value 500 higher than the dot below. The dots
are equally spaced on the graph on the left, but far from equally spaced
on the graph on the right. To prevent overlap, the points are jittered to
the right and left so they don't overlap. The horizontal position of the red
dots has no other meaning.

The blue dots represent a data set where each value represents a Y value
1.5 times higher than the one below. On the graph on the left, the lower
values are almost superimposed, making it very hard to see the
distribution of values (even with horizontal jittering). On the graph on the
right with a logarithmic axis, the points appear equally spaced.

Why “logarithmic”?

In the example above, the ticks at 1, 10, 100, 1000 are equally spaced on
the graph. The logarithms of 1, 10, 100 and 1000 are 0, 1, 2, 3, which are
equally spaced values. Since values that are equally spaced on the graph
have logarithms that are equally spaced numerically, this kind of axis is
called a “logarithmic axis”.

Interpolating between log ticks

What value is halfway between the tick for 10 and the one for 100 on a
logarithmic axis? Your first guess might be the average of those two
values, 55. But that is wrong. Values are not equally spaced on a
logarithmic axis. The logarithm of 10 is 1.0, and the logarithm of 100 is
2.0, so the logarithm of the midpoint is 1.5. What value has a logarithm
of 1.5? The answer is 101.5, which is 31.62. So the value half way
between 10 and 100 on a logarithmic axis is 31.62. Similarly, the value
halfway between 100 and 1000 on a logarithmic axis is 316.2.

Lingo
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The term semilog is used to refer to a graph where one axis is logarithmic
and the other isn’t. When both axes are logarithmic, the graph is called a
log-log plot.

Advantages of a logarithmic axis

One advantage, as shown above, is that a lognormal distribution is easier
to see on a logarithmic axis. Another reason to prefer a logarithmic axis is
when the values span a large (many orders of magnitude) range of values
and otherwise wouldn't really fit on a linear graph. At least not without a
lot of creativity (from xkcd)!

16.5.4.2 How to: Create a log axis

 This page shows how to stretch the axis to a logarithmic scale (which
doesn't alter your data). Distinguish this from transforming your data to
logarithms, which you can plot .

To create a log axis:

Double-click on the axis to open the Format Axes dialog. In the Scale
section, set the axis to Log10 or Log 2 or Ln (natural logarithm).

533
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This graph shows log10 spaced minor ticks. The minor ticks between the
major ticks at 10 and 100 show the position of 20, 30, 40, 50, 60, 70, 80
and 90. Since the minor ticks are not equally spaced on the graph, we
call these log spaced minor ticks. Note that there are eight ticks, so nine
intervals (many people mistakenly think there ought to be ten).

To set the numbering for a log10 axis:

Double-click on the axis to open the Format Axes dialog and set the
number format in the Numbering or Labeling section. Prism offers four
numbering format choices for log10 axes.

Antilog: 10, 100, 1000, 10000, etc.

Scientific: 1x101, 1x102, 1x103, 1x104,etc.

Power of 10: 101, 102, 103, 104,etc.

Log: 1, 2, 3, 4, etc.

To set the numbering for a ln axis:

Double-click on the axis to open the Format Axes dialog and set the
number format in the Numbering or Labeling section. Prism offers three
numbering format choices for log10 axes.

Scientific: 1x101, 1x102, 1x103, 1x104,etc.

Power of e: e1, e2, e3, e4,etc.

Ln: 1, 2, 3, 4, etc.

To set the minor tick intervals for a log axis:

Double-click on the axis to open the Format Axes dialog and set the
number format in the Numbering or Labeling section. Choose Equal or
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Log spacing, and the number of intervals you want between major ticks,
not the number of ticks.

 

16.5.4.3 Logarithmic axes cannot contain zero or negative numbers

The logarithms of negative numbers and zero are simply not defined

Let’s start with the fundamental definition of a logarithm. If 10L = Z, then
L is the logarithm (base 10) of Z. If L is a negative value, then Z is a
positive fraction less than 1.0. If L is zero, then Z equals 1.0. If L is
greater than 0, then Z is greater than 1.0. Note that there no value of L
will result in a value of Z that is zero or negative. Logarithms are simply
not defined for zero or negative numbers.

Bottom line: A logarithmic axis can only plot positive values. There simply
is no way to put negative values or zero on a logarithmic axis.
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A trick to plot zero on a logarithmic axis in Prism

If you really want to include zero on a logarithmic axis, you’ll need to be
clever. Don’t enter 0, instead enter as a small number. For example, if
the smallest value in your data is 0.01, enter the zero value as 0.001.
Then use the Format Axis dialog to create a discontinuous axis, and use
the Additional ticks feature of Prism to label that spot on the axis as 0.0.

16.5.4.4 Regression fits the data, not the graph

Choosing a log scale changes the way the graph looks, but does not
change the data values. Linear or nonlinear regression fit an equation to
your data. Your choice of axis scaling does not affect any calculations.

The three graphs shown below represent the same data by linear
regression.

The graph below has linear X and Y axes, so the linear regression line
appears straight.

The graph below has a logarithmic X axis. The curve you see is the
results of linear regression. It is the best fit to the equation Y=intercept
+ slope*X. The X values used by the linear regression are the X values
you entered. Graphing this linear regression line on a log axis results in
a curve.
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The graph below has a logarithmic Y axis. Again, the best-fit linear
regression line appears curved when plotted on a logarithmic axis.

16.5.4.5 When to use a logarithmic axis

A logarithmic X axis is useful when the X values are logarithmically
spaced

The X axis usually plots the independent variable – the variable you
control. If you chose X values that are constant ratios, rather than
constant differences, the graph will be easier to view on a logarithmic
axis.

The two graphs below show the same data. X is dose, and Y is response.
The doses were chosen so each dose is twice the previous dose. When
plotted with a linear axis (left) many of the values are superimposed and
it is hard to see what’s going on. With a logarithmic axis (right), the
values are equally spaced horizontally, making the graph easier to
understand.
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A logarithmic axis is useful for plotting ratios

Ratios are intrinsically asymmetrical. A ratio of 1.0 means no change. All
decreases are expressed as ratios between 0.0 and 1.0, while all
increases are expressed as ratios greater than 1.0 (with no upper limit).

On a log scale, in contrast, ratios are symmetrical. A ratio of 1.0 (no
change) is halfway between a ratio of 0.5 (half the risk) and a ratio of 2.0
(twice the risk). Thus, plotting ratios on a log scale (as shown below)
makes them easier to interpret. The graph below plots odds ratios from
three case control retrospective studies, but any ratio can benefit from
being plotted on a log axis.
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The graph above was created with the outcome (the odds ratio) plotted
horizontally. Since these values are something that was determined (not
something set by the experimenter), the horizontal axis is the Y axis even
though it is horizontal.

A logarithmic axis linearizes compound interest and exponential growth

The graphs below plot exponential growth, which is equivalent to
compound interest. At time = 0.0, the Y value equals 100. For each
increment of 1.0 on the X axis, the value plotted on the Y axis equals 1.1
times the prior value. This is the pattern of cell growth (with plenty of
space and nutrients), and is also the pattern by which an investment (or
debt) grows over time with a constant interest rate.

The graph on the right is identical to the one on the left, except that the Y
axis has a logarithmic scale. On this scale, exponential growth appears as
a straight line. Exponential growth has a constant doubling time. For this
example, the Y value (cell count, value of investment) doubles for every
time increment of 7.2657.

Exponential decay is also linearized on a logarithmic axis, but only when
the decay eventually decays to zero.

16.5.4.6 Advice: Bar graphs with log axes rarely make sense

Prism can create bar graphs with a logarithmic Y axis, but think twice
before deciding to make this kind of graph. The point of a bar graph is to
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let people compare heights or areas of the bars. In most cases, you
should try to avoid using a log axis when creating a bar graph.

The treated bar in the graph below (with a linear axis) is four times as
tall (and has four times the area) as the control bar. This tells you that
the treatment increased the response fourfold. This is very
straightforward since the Y axis is linear.

Beware of bar graphs with a logarithmic axis. Since zero can’t be shown
on a log axis, you need to decide where to begin the axis. A log scale
has no logical starting place, so the choice is arbitrary. The graphs below
show the same data as the graph above, but with the Y axis beginning at
0.001, 10 or 100.
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The relative height of the bars appears to be almost the same in the
graph on the right and very different on the graph on the left. The
relative heights (or areas) of the bars on a log scale is not informative. 

If the goal is to create propaganda, a bar graph using a logarithmic axis
is a great tool, as it lets you either exaggerate differences between
groups or minimize them. All you have to do is carefully choose the
range of your axis to give the impression you want to project.  If your
goal is to honestly show the data, don’t create bar graphs using a
logarithmic axis 

The only case that I know of where it makes sense to plot bars on a
logarithmic axis is when the Y axis is plotting the fold change in
something. Then the baseline of 1.0 is logical (no change), as is a
logarithmic scale.

16.5.4.7 Graphing logarithms - different than using a log axis

Transforming data to logs

If you need log data for your analysis, you can either enter logs directly
or transform your data. For example, you should fit a sigmoidal dose-
response equation to data expressed with X as logarithm of dose. If you
enter concentrations, you'll need to convert them to logarithms before
using nonlinear regression.

To transform your data to logs:

Click the Analyze button, choose built-in analyses, and then select
Transforms from the list of data manipulations. Choose X = log(X).

Also check the box at the bottom of the dialog to Create a New Graph of
the results. Prism will create a results table of the transformed data, and
a new graph. To perform nonlinear regression on the transformed data,
click Analyze from either the results table or the new graph.
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Plot data already entered as logarithms

If you enter data as logarithms, or graph the results of a log transform,
you should graph the data with a linear axis. Don't choose a log scale!
Your data are already logarithms. If your data represent logarithms, you
can format the axis numbering to make this clear.

The figure below compares the appearance of decimal (the default),
powers of ten, and antilog formatting.
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In the graph below, the X values represent the logarithm of
concentration. The logs were entered directly into the X column of the
data table. The graph of these data has a linear (not log) X axis. The axis
was formatted with a numbering format of powers of 10, and with nine
minor tick intervals with log spacing (see dialog settings below the
graph).

In the graph below, An alternative way to indicate that the data are
logarithms is to choose the antilog numbering format (this choice is only
available when the interval is 1, the minimum is –9 or greater, and the
maximum is 9 or less).
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16.5.4.8 A review of logarithms

Common (base ten) logarithms

The best way to understand logarithms is through an example. If you take
10 to the third power (10 x 10 x 10) the result is 1000. The logarithm is
the inverse of that power function. The logarithm (base 10) of 1000 is the
power of 10 that gives the answer 1000. So the logarithm of 1000 is 3. If
you multiply 10 by itself 3 times, you get 1000.

You can take 10 to a negative power. For example, taking 10 to the -3
power is the same as taking the reciprocal of 103. So 10-3 equals 1/103, or
0.001. The logarithm of 0.001 is the power of 10 that equals 0.001, which
is -3.

You can take 10 to a fractional power. Ten to the 1/2 power equals the
square root of 10, which is 3.163. So the logarithm of 3.163 is 0.5.

Ten to the zero power equals 1, so the logarithm of 1.0 is 0.0.

You can take the logarithm of any positive number. The logarithm of
values between zero and one are negative; the logarithms of values
greater than one are positive. The logarithms of zero and all negative
numbers are undefined; there is no power of 10 that gives a negative
number or zero.

Logarithms to other bases

The logarithms shown in the previous section are called base 10
logarithms, because the computations take 10 to some power. These are
also called common logarithms.
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You can compute logarithms for any power. Mathematicians prefer natural
logarithms, using base e (2.7183…).  Despite that name, use of
logarithms with base e does not seem natural to most scientists who tend
to be far more comfortable with base 10 logarithms.

Biologists sometimes use base 2 logarithms, often without realizing it.
The base 2 logarithm is the number of doublings it takes to reach a value.
So the log base 2 of 16 is 4 because if you start with 1 and double it four
times (2, 4, 8, and 16) the result is 16. Immunologists often serially
dilute antibodies by factors of 2, so often graph data on a log2 scale. Cell
biologists use base 2 logarithms to convert cell counts to number of
doublings.

Logarithms using different bases are proportional to each other. So
converting from natural logs to common logs is sort of like changing
units. Divide a natural logarithm by 2.303 to compute the common log of
the same value. Multiply a common log by 2.303 to obtain the
corresponding natural log.

Mathematical properties of logarithms

Logarithms convert multiplication into addition and division into
subtraction, and exponentiation into multiplication:

log(A.B) = log(A) + log(B)

log(A/B) = log(A) - log(B)

log(An) = n.log(A)

Antilogarithms

The antilogarithm (also called an antilog) is the inverse of the logarithm
transform. Since the logarithm (base 10) of 1000 equals 3, the
antilogarithm of 3 is 1000. To compute the antilogarithm of a base 10
logarithm, take ten to that power.

To compute the antilogarithm of a natural logarithm, take e to that
power. The natural logarithm of 1000 is 6.980. So the antilogarithm of
6.908 is e6.908, which is 1000. Spreadsheets and computer languages use
the notation exp(6.908).

Terms that sound similar to logarithm:  logit and logistic
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The term logistic sounds like it is related to logarithms. In fact, the term
logistic has three distinct meanings, which don't all involve logarithms.  

The logit function, used in logistic regression, is the natural logarithm of a
probability (P, with a value between 0.0 and 1.0) divided by 1-P:   

Logit(P) = ln[P/(1-P)]

The lognormal distribution is a distribution of values whose logarithms
follow a Gaussian distribution. The lognormal distribution itself is
asymmetrical with a heavy tail to the right. It is easy to be mislead by the
asymmetry, and  mistakenly eliminate values in the tail of the distribution
as outliers. 

The notation “log(x)” can be ambiguous

Within Prism transforms and equations, the log() function computes the
common (base 10) logarithm.

With some computer languages (for example, Javascript) log(x) denotes
a natural logarithm, not a common logarithm. Excel is especially
confusing. In an Excel worksheet function, log(X) is the common
logarithm, but in an Excel VBA macro, log(X) is the natural log.

The notation “ln(X)” is the natural logarithm in Prism.

Don't mix up logarithms with scientific notation

Consider the value 0.000000001. It can be written as 10-9. Since
computer programs can't deal with subscripts, this is entered into most
computer programs (including GraphPad Prism and Excel) as 1e-9. The 'e'
here means "times ten to the power of". Don't mix up that scientific
notation with a logarithm. The logarithm of 0.000000001 is -9.

16.5.5 Frame and origin

The frame determines the basic look of a graph, and its position on the page.

http://www.graphpad.com/faq/viewfaq.cfm?faq=1465
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Positioning a graph on the page

Customizing a graph's frame and axes appearance

Showing grid lines

Setting the graph origin

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

16.5.5.1 Positioning a graph on the page

If you plan to copy and paste the graph to another program, or place the
graph on a Prism layout, you won't really care where it is on the page.
But if you plan to print that page, you might care to position a graph
precisely. 

To see the position of a graph on the page:  Drop the View menu,
choose Zoom, and choose To Fit Page. This lets you see the entire page
at once, so you can see the position of the graph relative to the entire
page. 
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To center the graph on the page: Click on the Center on page button
in the Arrange section of the Prism toolbar.

To drag a graph on the page: Grab either axis and drag the graph.

To  specify an exact position on the page: Click on the Format Axis
tool in the Prism toolbar and enter the exact distance of the graph from
the top and left edge of the page in the Frame and Origin tab of the
Format Axes dialog.
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16.5.5.2 Customizing a graph's frame and axes appearance

Double-click on the graph origin to open the Frame and Origin tab of the
Format Axes dialog.
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Use this dialog to set the origin of your graph and to format the color and
shape of the axes or surrounding frame.

Notes:

· To change the gap of an offset axis, click and drag the end of the axis.
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· To draw a box around a graph , including titles and numbering, use
the drawing tool. Or wait until you assign a graph to a layout, and
choose the border on the second tab of that dialog . 

· To change the color or thickness of one axis. In rare cases, you may
want to change the color or thickness of one axis and not the other(s).
Or you may want to make one axis white (or whatever your page
background color is) to make it essentially invisible. To do this, select
the axis, drop the Change menu and choose Selected Object. Then
change the color or thickness in the Format Object dialog. 

16.5.5.3 Showing grid lines

Regular  grid lines

Double-click on the graph origin to open the Frame and Origin tab of the
Format Axes dialog. Or click on the Format Axis tool in the Prism toolbar.

568
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Note that grid lines from the Y axis always come from the left Y axis.
Even if you turned off that axis, its major tick interval controls the grid
lines. It is not possible to create automatic grid lines from the right Y
axis. But you can  place additional ticks or lines  one at a time to give
the same effect.

Special grid lines

Double-click an axis and use the Format Axis tab to place additional ticks
or lines  (formerly called Custom Ticks) on your graph. You can create
as many grid lines anywhere on an axis.

507

507
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Using a grid to align objects

Right-click anywhere on the Prism toolbar and choose Show Grids, or
drop the View menu and choose Show Grids. This grids will not show in
printouts or exported images.

16.5.5.4 Setting the graph origin

The position where the X and Y axes intersect is called the "origin." To
change the position of a graph's origin, double-click on the origin of a
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graph to open the Frame and Origin tab of the Format Axes dialog). Or
click on the Format Axis tool in the Prism toolbar.

16.5.5.5 Graphs: Frame and axes

The choices on the Format Axis dialog are self-explanatory. Don't
overlook the Additional Ticks and Grid lines section  which lets you place
any numbers or labels anywhere on any axis. And don't overlook the
Frame and Origin  tab.

Here is a list of shortcuts to change the axis directly, without using the
Format Axes dialog:

507

541
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· To change the shape and size of a graph by stretching: Click once on an
axis to select it. Then drag on either end to stretch.

· To make a graph proportionately larger or smaller: Click Resize Graph
button on the Change section of the Prism toolbar.

· To change the thickness or color of one axis: Click once to select that
axis. Then click Change and choose Selected Object(s). If you change
the X axis, the top part of the axis frame will also change accordingly. If
you change the left Y axis, the right part of the axis frame will also
change accordingly (unless you created a right Y axis).

· To move the graph and axis titles closer to, or further from, the graph:
Position the mouse near the title until the cursor becomes a two-headed
arrow. Then drag.

· To move the axis numbering (or labeling) closer to, or further from, the
axis: Move the mouse over the numbering until the cursor becomes a
two-headed arrow. Then drag. Or click once on the numbering to select.
Then nudge one pixel at a time by clicking the arrow keys.

· Double-click on the origin of a graph to bring up the Frame and Origin
tab of this dialog.

· To format the size, font, color, etc. of the numbering of an axis, click to
select the axis and then use the controls in the Text toolbar.
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17 Page layouts

Page layouts let you combine several graphs on a

single page, along with data or results tables, text,

drawings, and imported images. Graphs can be

from one or several Prism projects.
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17.1 Creating a layout

Create a new layout

Click the New button on the toolbar, drop the Insert menu and choose
New Layout, or choose New Layout in the navigator panel on the left. 
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1.  Choose whether you want portrait or landscape orientation for the
overall page, and choose its background color. 

2.  Choose the number of placeholders you want on the page, and their
arrangement.

3.  Decide either to start with a layout page with placeholders only, or to
automatically place graphs onto the layout. In the latter case, you
specify the first graph and Prism places the other graphs automatically
working in the order the graphs appear in the Graphs section of the
navigator.

Change the arrangement of graphs on a layout, or add more placeholders

When you first create a layout page, Prism asks you to choose an
arrangement of placeholders. But you are not stuck with this
arrangement. You can always go back to the Format Layout dialog by
clicking its toolbar button, or dropping Change and choosing Arrangement
of graphs. You can then either choose a new layout arrangement or
choose to add one more placeholder to the layout. 

17.2 Placing a graph from the same project on a layout

Place a graph on a layout using a placeholder

The simplest way to add a graph to a layout is to double-click on a graph
placeholder, and then choose a graph in the Place Graph in Layout dialog
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Note that you can choose a graph from any project. It is especially easy
to choose a graph from another open project. If you choose to Pick a
graph from another project that is not open, after you choose that project
file, Prism will open it. 

Other ways to add graphs to the layout

· Drag a graph from the Navigator  and drop onto a blank spot on the
layout page. Don't drop too close to an existing graph or you might end
up replacing that graph rather than adding a new one. 

· Go to the Graphs section of this project or any other, and copy a graph
to the clipboard. Then go to the layout, and paste.  

· From the layout, drop the Insert menu and choose Prism Graph. Then
choose the graph you want to add to the layout. 

What if you assigned the wrong graph?

If you assign the wrong graph to the layout, it is easy to replace. Just
double-click on the wrong graph (in the layout) and choose its
replacement. Or drag the name of the replacement graph from the
Navigator and drop on top of the graph you want to replace. 

17.3 Placing a graph from another project on a layout

You can place a graph from a different project file from within the Place
Graph in Layout dialog. Or you can copy the graph in one project and
paste into another.

If you choose or paste a graph from another project, Prism offers three
choices.

150
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Link to file

The graph in the layout will be linked to the graph in the other file. The
advantage of linking (which some will consider to be a disadvantage) is
that the data and graph only exist in one place.

The link is by file name and location. Prism can maintain the link only if
the name and location of the linked file doesn't change If you rename the
file, move it to a different folder, or work on the file with the layout on
another computer, you will break the link. 

To edit a linked graph, you'll need to go to the original project. 

To force an update to the graph in the layout, save the file that includes
the graph and data. Then when you go to the graph with the layout, the
graph will update. If you use Prism Mac, it is enough to move to a
different sheet in the project with the data and graph. But this works only
if you have set the preferences in the File & Printer tab to save a backup
whenever you switch to a new sheet. In this case, you don't need to save
the file for the layout to update. 

Merge in graph and data

Merge a copy of the graph, along with its data tables and analyses, into
the project you are working on now. 

The advantage of this approach is that everything will be in one project.
This means the file is self-contained. Even if you move it to a different
computer, everything will work.

The disadvantage (which some consider to be an advantage) is that the
data will now exist in two files. 
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Unlinked picture

As the name suggests, this is just a picture that is not linked to any data
or any editable graph. 

17.4 Adding another graph to the layout

When you first create a layout page, Prism asks you to choose an
arrangement of placeholders. But you are not stuck with this
arrangement. You can always go back to the Format Layout dialog by
clicking its toolbar button, or dropping Change and choosing Arrangement
of graphs. 

If you assign the wrong graph to the layout, it is easy to replace. Just
double-click on that graph (in the layout) and choose its replacement. Or
drag the name of the replacement graph from the Navigator and drop on
to the graph you want to replace. 

It is easy to add a new graph to the layout. First resize and move graphs
to make space for a new one. Then do any of the following (the first two
choices are the simplest). 

· Drag a graph from the Navigator  and drop onto a blank spot on the
layout page. Don't drop too close to an existing graph or you might end
up replacing that graph rather than adding a new one. 

· Go to the Graphs section of this project or any other, and copy a graph
to the clipboard. Then go to the layout, and paste.  

· From the layout, drop the Insert menu and choose Prism Graph. Then
choose the graph you want to add to the layout. 

· From the layout, bring up the Format Layout dialog (by clicking its
toolbar button, or dropping Change and choosing Arrangement of
graphs) and choosing to add another graph to the layout. 

17.5 Making a graph an unlinked picture

By default, Prism the graph on the layout automatically updates when the
graph itself updates. 

150
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You can choose to place the graph on the layout as an unlinked picture
with no link to the original data. You might prefer this option if you are
sure the graph is 100% done, and you don’t want to allow any possibility
of it being changed. It can also be useful if you want to keep "snapshots"
of a graph as a project continues and additional data are collected and
graphed. 

The choice to make a graph an unlinked picture is on the lower left corner
of the Assign Graph to Layout dialog.

17.6 The size of graphs on layouts

What is the scaling factor?

The scaling factor is defined as the ratio of the size of the graph on the
layout compared to its size on the graph. 

If the graph and layout are zoomed  differently, it will be hard to
understand the scaling factor. Set the zoom to be the same for  the graph
and layout (using controls in the lower right of the Prism Window). 

Changing the scaling factor of one graph

The easiest way to change the scaling factor is to select a graph on a
layout page, grab a corner knob and drag. 

If you want to set the scaling factor to a particular value, double click on
the graph (on the layout) to bring up the Place Graph on Layout dialog.
Go to the second (Size and Location) tab, and set the Scaling Factor.

159
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Note that this tab also lets you specify a border to go around the graph.

Equalize the scaling factor of several graphs

1. Select the graphs to equalize (not necessary if you want to equalize all
graphs on the layout).

2. Choose Equalize Scaling Factor from the Arrange menu, or press the

button in the Change section of the toolbar.  

3. Choose to reduce the scaling factor of graphs that are larger than the
others, or to increase the scaling factor of those that are too small. If
graphs were originally made the same size, with same size fonts, this
command will get things the same again on layout. If graphs started off
with different sizes, however, this command won't be very helpful.
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Increase or decrease the scaling factor of all graphs

1. Choose Resize Layout from the Change menu, or click the Resize

button. 

2. You'll see a menu with choices: Smaller, Larger, To Fill Page, or More
Choices (which brings up the dialog shown below). 

Cropping  

The first tab of the Assign Graph graph dialog lets you crop a graph to get
rid of white space or portions of the graph you don't want to see on the
layout. If you enter a negative value for any of the cropping values, you'll
make the graph placeholder larger, adding white space in that direction.



GraphPad Prism 8 User Guide558

© 1995-2020 GraphPad Software, LLC

17.7 Creating a depth chart

A depth chart is an XY plot rotated so the independent X variable is
shown on the vertical axis, and the dependent Y variable is shown on the
horizontal axis. This makes sense when the X variable is depth. Follow
these steps:

1. Enter data on an XY table. Enter the depth values into the X column.

2. Prism will create an XY graph with X on the horizontal axis. 

3. Use the Format Axis dialog to change the direction of the numbering on
both axes. Set the X axis numbering to: Below, vertical. Set the Y axis
numbering to: Left vertical.

4. Delete the automatic X axis title (because it cannot be rotated).

5. Create an independent text object with the depth title. Select it, and
rotate 180 degrees by clicking the rotate button in the lower right of
the Text area in the toolbar several times.Your graph will now look like
this:
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6. Assign that graph to a layout. 

7. Double click on the graph to bring up the "Place graph on layout"
dialog. Go to the second (Size and Location) tab, and choose to rotate
90 degrees clockwise.

 

The result, on the layout, is a depth chart, with the X variable on the
vertical axis and the Y variable (and its error bars) plotted on the
horizontal axis. 
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17.8 Master legends (one legend for several graphs)

If you place several graphs on a layout, you can create a master legend
that applies to all the graphs as shown below.

A master legend is one legend on a layout that is for several graphs. To
create a master legend, create an extra graph (not on the layout) with
the legend you want. Then select and copy that legend and paste to the
layout. Then add other graphs without legends to the layout.

It took four graphs to make the figure above. The first three graphs show
data, and the fourth (not shown) was used only to create the master
legend. Follow these steps:
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1. Duplicate one of the graphs to create another graph that won't be
shown in the layout, but will be used to create a legend. To create a
legend on this graph, double-click on a symbol to bring up the Format
Graph dialog. Click the ‘Global’ button, select ‘Change all data sets’ in
drop-down. You can also select ‘Change ALL data sets’ from ‘Data set’
drop-down.

2. Create a layout and assign the graphs (three in this example).

3. Select and copy the legends from the extra graph and paste onto the
layout (Paste Drawing). That is a simple copy and paste operation and
does not use a placeholder.

Notes:

· The master legend is linked to the graph from which it was copied. If
you change the symbols in that graph, Prism will update the master
legend.

· Master legends on a layout have exactly the same size as the legend on
the graph from which you copied the legends. When you place graphs
on layouts, you can shrink or expand it to fill a placeholder. You can't do
this with master legends. The only way to change the size of the symbol
in the master legend is to change the font size and symbol size on the
graph used to create the master legend. This is done in the graphs
section, not the page layout section.

· You can edit the text of the legend,  change the size of the text in the
master legend, and make it bold or italics. These changes will be lost if
you make any changes to the graph from to which the master legend is
linked. 

· After copying a legend, you can only paste it into a layout. It is not
possible to paste a legend onto another graph.

· It doesn't work well to copy a legend from a graph in one project and
paste onto a layout of another. Set things up so the copy and paste is all
within one file. 
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17.9 Duplicating a layout

If you have a page layout whose arrangement you like, duplicate it (just
the sheet). Then double-click on each graph to bring up a dialog where
you can choose a different graph for that slot.

Prism offers a direct way to clone a graph from the Welcome (File..New)
dialog, but does not allow cloning of layouts. However, you can
accomplish the same goal by going to a layout, dropping the New button,
and choosing to Duplicate Family. This will duplicate not only the layout,
but all graphs on the layout and all results and data sheets linked to those
graphs. Edit all the data tables, and you are done. The analyses and
graphs will automatically update.
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18 Adding text, drawings, results and pictures to graphs or
layouts

This section explains how to add text, drawings and

pictures to a graph or layout.
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18.1 Adding text

Adding text to a Prism graph or layout

To enter new text anywhere on a graph or layout:

Click one of the text 'T' tool buttons (the one on the right makes a text
box with a border).

Click on the graph or layout at the spot where you want to enter text and
type. If you want to enter several lines, press Enter between lines. When
you are finished, click to select another tool or somewhere else on the
page.

To enter a paragraph with automatic word wrapping:

Enter the first line or two using one of the text tool buttons and then click
anywhere else on the page to create the text object. Go back and click on
your text. You'll see knobs on the corners. Drag the knobs to make the
text object the correct width. Don't worry about the height, as it will grow
automatically as you enter text. Now, double-click inside the text object
to bring back the insertion point and type your text. Don't push Enter at
the end of each line, as Prism will automatically wrap the text as you
type.

To add Greek letters, European characters, math symbols or Wingdings:

First be sure you have a text insertion point. Then press the Greek button
and choose a character from the menus provided.

Tech details: Within Prism, Greek characters are encoded by switching
to the Symbol font, and this is also true when you export a graph that
encodes fonts (pdf, eps, wmf, emf). However, if you copy text to the
clipboard, the Greek is encoded as Unicode characters, so there is no
need to switch to Greek font. 

To add a constant from an Info table:

You can add a constant from an Info sheet  in a text box. Use the Insert
Info Constant button on the Write section of the Prism toolbar. Once
you've added an Info constant to your graph or layout, double click to

188
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open the text box and add a label. If you edit the Info constant, the linked
text-box on your graph will be updated.

To enter en or em dashses:

An en-dash is wider than a hyphen or minus sign. An em-dash is even
wider. Learn how to enter these in Prism. 

Changing text

To change font and size of text:

Standard toolbar buttons let you make text bold, italicized, underlined,
subscripted, or superscripted, and let you change font, color, and size.

Select a block of text or an entire text object and use the right-click
menu. Or pull down the Change menu and choose Selected Text to bring
up the font dialog.

GraphPad does not provide any fonts with Prism, but lets you choose any
TrueType font already installed in your system. If you want a font that is
not in the list, you'll need to find or buy the TrueType font and then install
it into Windows or Mac OS X. 

To rotate text:

You can rotate text objects to any angle you want. Click on one of the
text-rotation buttons in the Text section of the Prism toolbar. The buttons
will rotate your text in 15 degree increments.

http://www.graphpad.com/support/faqid/1328/


GraphPad Prism 8 User Guide566

© 1995-2020 GraphPad Software, LLC

Or double-click on the object boundary to bring up the Format Text
dialog. Then set a standard rotation (horizontal, vertical up, vertical
down) or choose angled and enter the rotation angle in degrees.

To change the alignment of a text block:

Click on the Justify button on the Font toolbar. From the drop-down
menu, you can choose, right-justified, left-justified, or centered.
Whichever you choose will be the default the next time you enter text.

To add or change a border or background:

Right click on a text block, and you'll see choices to change the border
thickness and color, and the background. Or double-click on the border of
the text object to bring up the Format Text dialog. Then click the Border
and Fill button to bring up a dialog where you can change border and
background.

To move text:

Move a text object by dragging. You can also stretch the object to change
its shape. This will change how text wraps, but will not change the point
size of the lettering.

You can only move axis and graph titles closer to, or further from, the
graph. They always remain centered. To move a title closer to or further
from the graph, point the mouse near the title until the cursor changes to
a two-headed arrow. Then drag the title.

You can also move axis numbering (or labeling for bar or category
graphs) closer to, or further from, the axis. Click on the numbering to
select. Then use the arrow keys to nudge its position. Or set the distance
between numbers and axis within the Format Axis  dialog.

To prevent text from snapping into alignment:

When you drag a text object around the page, it will automatically snap
into alignment with other text objects, with the center of bars (etc.) on
graphs, or with the center of a graph. You can keep dragging, so are not
trapped by the snapping. If the snapping gets in the way of moving the
text object where you want it, hold down the ALT key while dragging and
there will be no snapping.

498
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18.2 Using Word to add text (Windows only)

You can use Microsoft Word® to add text to a Prism graph or layout.
Word gives you more formatting options than are possible with Prism text
tools. You can create bulleted lists, add tables -- anything you can do
with Word. It's a bit more cumbersome, however, because you must open
Word in a separate window to edit your text, rather than editing it directly
on your Prism sheet. This is most often helpful when you have large text
boxes that require a lot of formatting.

To add text to a graph or layout using Word, click the Word button in the
Write section of the Prism toolbar. This will open Word so you can create
your text box. To finish, click on Update in Word File menu, or simply
close Word.

To edit a Word text box in Prism, double click on the text in Prism. This
will open Word. To finish, click on Update in Word File menu, or simply
close Word. 
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18.3 Drawing lines, arrows, and shapes

Drawing lines, arrows, and other shapes on a graph

1. Click on the drawing tool in the Drawing toolbar. If you want to draw
several objects, hold Shift while selecting the drawing tool. Then you'll
be able to use it repeatedly without selecting it again. Click any other
Toolbar button to unselect the drawing tool. The tool you used most
recently will show as the default drawing button on the main Prism
toolbar.

2. Position the mouse pointer (now a pencil) at one end of the line or
arrow (or one corner of the box or oval). 

3. Hold down the primary mouse button and drag to the other end (or to
the diagonally opposite corner). Hold the control key if you want to
draw a perfect circle or square.

4. If you chose a line (or bracket) with text, click in the insertion point
over the line to enter centered text.

5. If you chose a line with text either choose a standard or recently-used
text string from the dropdown that appears automatically, or enter
something else.
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Changing the appearance of a drawing object (line, arrow, square, etc.)

Select any object and double-click on it to bring up the Format Object
dialog. Choose the thickness, color, and style of lines or borders; the fill
color and shading of shapes; and arrowhead direction, size, and style.

For a line, for example, you can choose to have no arrowheads, or
arrowheads on one or both ends. You can also choose to caps on the ends
of a line instead or arrows.

You also can right-click on any drawing object to change individual
properties like color and line thickness.

Changing the default line color or thickness

Draw a line, then double click to bring up the dialog above. Change the
thickness, color and style to what you want the default to be for future
lines and arrows. Check the option "Set as default" and OK from the
dialog. Now those settings will be used when you draw new lines or
arrows.
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18.4 Including pictures and other objects

Pasting or importing images

You can paste or import picture onto a Prism graph or layout. 

OLE

Windows only: When you paste an object created by a program that is an
OLE server, Prism will embed the object. This means that Prism contains
a separate copy of the object, so you can double click to edit in the
original program. This is great, for example, with equations.  In some
cases, you may prefer to paste link to the original file. To do that, copy
the object and then choose Paste Special from the Edit menu. Then
choose Paste Link. To learn more about the pros and cons of linking and
embedding, see Object linking and embedding . You can also use the
Insert Object command to create a new OLE object. 

Formats Prism can paste or import

Prism Windows can import:

Windows Enhanced Metafile (*.emf)
Windows Metafile (*.wmf)
TIFF (*.tif;*.tiff; bot extensions are used for exactly the same file
type)
JPEG (*.jpg;*.jp2;*.j2k;*.jpx)
Portable Network Graphics (*.png;*.mng)
Windows Bitmap (*.bmp)
Graphics Interchange Format (*.gif)
PC PaintBrush (*.pcx)
TruvisionTarga Format (*.tga)
Microsoft Paint Format (*.msp)
PhotoShop 3.0 Format (*.psd)
Windows Icon and Cursor Formats (*.ico)
Portable document format (*.pdf)

Prism Mac can import:

TIFF (*.tif;*.tiff)
Windows Bitmap (*.bmp)
JPEG (*.jpg;*.jp2;*.j2k;*.jpx)
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Macintosh Pict (*.pct;*.pict)
Portable Network Graphics (*.png)
Portable document format (*.pdf)

If your image uses a 16 bit color model (millions of colors), Prism
(Windows and Mac) stores the image as such and does not simplify it. 

Editing the picture in Prism

To resize: Grab a corner and drag larger or smaller. 

To add a border or crop: Click once to select the image or object in Prism.
Then drop the Change menu and choose Selected Object. You can also
double-click on the object. 

Problems with windows/mac compatibility

We try to keep Windows and Mac completely compatible. Since version 7,
Prism Windows keeps a copy of each image in a Windows  format (EMF,
WMF) also in pdf for Prism Mac to use. Prism files created with older
versions of Prism Windows may lose pasted/imported images when
opened on Prism Mac. 

18.5 Tips for moving or rotating objects

Selecting objects on the page

When you work in the Graphs  section of your project, the graph itself
as well as text, legends, drawings, and imported images are all referred
to as “objects”. When you are working in the Layout section  of your
project, each graph with all of its objects is grouped into a single object.
Images imported onto a page layout are also objects. Images imported
onto a graph are objects in the graph section, but are part of the graph
object in the page layout section.

To select one object:

Point to the object and click the left mouse button. To select a rectangle or oval,
click on its edge. Prism displays knobs on the selected object.

To select several objects:

Hold down the Shift key while selecting the objects one at a time. Or… drag an
imaginary rectangle around all the objects. You've selected all objects entirely
contained within the rectangle.

392
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Moving objects

To move an object with the mouse:

Point to an edge. Press the left mouse button and drag.

To move an object vertically or horizontally only:

With Prism Windows:

Hold the Shift key while dragging to allow only vertical movement. (Remember
this because the Shift key is marked with a vertical arrow.)

Hold the Ctrl key while dragging to allow only horizontal movement. 

With Prism Mac:

Hold the Shift key. Prism will let you drag vertically or horizontally, but not at
an angle.

To prevent automatic snapping:

Hold the ALT key down while dragging an object to prevent Prism from trying to
automatically snap it into place.

To nudge an object a tiny distance:

Select one or more objects. Press the up, down, right or left arrow keys. Each
press of an arrow key moves the object(s) one pixel.

To nudge an object in larger steps:

 Hold down the Control key (Windows) or Command key (Mac) and each click of an
arrow key will move the objects in larger steps.

To group two or more objects so they move together:

Select Group from the Arrange menu or toolbar.

The set of objects now acts as a single object. If you want to work with the
individual objects again, drop the Arrange menu and choose Ungroup.

To rotate an object:

Grab the rotation knob and move your mouse.
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18.6 Aligning objects on a graph

Automatic snapping

Prism will automatically try to snap objects to be in alignment with graph
axes and other objects. For instance, you can drag a text box over a bar
or group of bars and Prism will try to snap the text box to align with the
centerline of the bar. Prism will also change the justification of the text to
"centered." If you don't like this, you can change the justification back
using the text justification button in the Text toolbar. 

To overcome this automatic snapping, hold down the ALT (Windows) or
Command (Mac) key while dragging the object.

 
Using the Align or Group button in the Arrange section of the Prism
toolbar

For graphs, use the drop-down menu under the Arrange button
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For layouts, each task has its own button in the Arrange toolbar.

To align objects:

 - Select Align Objects from the Arrange menu or toolbar. Choose horizontal
and vertical orientation, or to align by the X or Y axes.

To position an object by entering distances:

Select Position Object from the Arrange menu or toolbar. Enter the distance
between the upper left corner and the top and left edge of the page.

To lock an object so you can’t accidentally move it:

 - Select Lock Object from the Arrange menu or toolbar. When you select a
locked object, the knobs will be gray rather than black, and you will not be able to
move the object or change its size. To unlock the object, select it, then select Lock
Object from the Arrange menu again.

To bring an object on top of overlapping objects.

 - Select it, drop the Arrange menu or toolbar and choose Bring to Front. Or use
the toolbar button.

To send an object behind overlapping objects.

 - Select the object. Drop the Arrange menu or toolbar and choose Send to
Back. Or use the toolbar button.
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To space objects equally:

 - Select three or more objects. Choose Distribute Objects from the Arrange
menu or toolbar.

To duplicate one or more objects.

Select the object(s). Drop the Arrange menu or toolbar and choose Duplicate
Object.

To center everything on a page.

 - Click the Center button.

Zoom settings

To precisely align objects, zoom to a larger magnification. Select a zoom level in the
View menu or click the zoom buttons. Zooming changes the magnification on the
screen, but does not change the size of the graph or layout when printed. Hold Ctrl
and press M to zoom larger or J to zoom smaller.

Rulers

Choose Rulers from the View menu. The rulers appear on top and to the left of the
graph and page layout screens. Show the rulers to align objects precisely. Hide the
rulers to leave more space for the graph.

Alignment guides

Alignment guides are temporary lines you can drop from the ruler to check on the
position and alignment of objects. Click the mouse in either ruler to drop a single
guide (down from the top ruler, or over from the left ruler). Click the corner where
the two rulers intersect to drop both alignment guides at once. The guides will
remain visible only as long as you hold down the mouse button.
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Grids

Choose Grids from the View menu. Prism will show a grid that extends from the
minor ticks on the rulers, spaced every 0.1 inches, or 1 millimeter. This grid is
provided to help you align objects. It will not print. Select Grids from the View
menu again to turn it off. Note the distinction between showing this grid, and
choosing a frame with a grid (from the Format Axes dialog) to include a grid on a
graph.

18.7 Adding analysis results to a graph

You can put analysis results on the graph easily. 

1. Select a cell or a range of cells on a results table (or data table).

2. Copy to the clipboard.

3. Go to a graph and layout and paste. 

4. Double click to reformat.
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18.8 Adding Pairwise Comparisons

Prism 8.4 introduced the ability to automatically add lines or brackets
with P values or associated asterisks to a graph of data after performing
an appropriate analysis on that data. To access this feature, simply click
on the toolbar button located in the Draw section of the toolbar (or select
the menu item "Pairwise Comparisons" from the Insert menu).

Which analyses have comparisons that Prism can plot automatically?

T tests

Comparisons from all variants (paired/unpaired, parametric/non-
parametric) can be added automatically.

One sample t test and Wilcoxon test
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These are only available when there are no subcolumns in the data, or (if
there are subcolumns) the default option "Average the replicates in each
row" is selected.

One-way ANOVA

All options for multiple comparisons following all variants
(paired/unpaired, parametric/non-parametric) can be added
automatically.

Two-way ANOVA

Multiple comparisons that compare individual cell means (but not
comparisons of entire rows/columns) can be added automatically.
Appropriate multiple comparisons for two-way ANOVA include:

· Compare each cell mean with the other cell mean in that column (only
available for two-way ANOVA with exactly two rows)

· Compare each cell mean with the other cell mean in that row (only
available for two-way ANOVA with exactly two columns)

· Within each row, compare columns (simple effects within rows)

· Within each column, compare rows (simple effects within columns)

· Compare cell means regardless of rows and columns

Format Pairwise Comparisons dialog

After performing an appropriate analysis (or re-calculating an appropriate
analysis from an older version of Prism), clicking the toolbar the first time
will automatically add lines and asterisks for all comparisons included in
the analysis for that data set. Most of the time, that's all you'll need to
do!

However, if you'd like to customize the appearance of the comparison
lines/brackets, clicking on the toolbar button a second time (or double
clicking on one of the comparison lines) will bring up the Format Pairwise
Comparisons dialog.
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On the first tab (Appearance) of this dialog, you can choose to display
numeric P values or asterisks, you can specify a cutoff threshold for which
P values to display on the graph, or you can customize the appearance of
all of the displayed comparison lines.

The second tab (Comparisons on Graph) of this dialog allows you to select
specific comparisons to display or hide on the graph. By default, all
comparisons defined by the analysis are displayed on the graph.
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Formatting individual comparison lines

To change the settings of a single comparison line, simply right-click on
the line you would like to customize. From the menu that appears, you
can choose to change:

· Text font, color, size, and appearance

· Line color, thickness, and style

· Title position (for vertical graphs, this controls if the text is above or
below the line. For horizontal graphs, this controls if the text is to the
left or right of the line.)

· For horizontal graphs, you can also choose for the text direction to be
either "up" or "down"

Note that all of these items can also be applied to multiple comparison
lines simultaneously. Simply click and drag to select multiple lines, or
click multiple lines while holding the shift key on your keyboard before
applying the custom settings.

Selecting the test to display

Prism will only automatically display comparisons from a single analysis.
If you've performed more than one of the tests listed above on the
graphed data set (it's unlikely that this would be required or - in some
cases - even appropriate), you'll need to identify which test includes the
comparisons you'd like to display. If you decide later that you want to
display comparisons from a different test performed on the same data,
you can choose which analysis results to display from the dropdown menu
on the Comparisons on Graph tab of the Format Pairwise Comparisons
dialog.
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Removing Pairwise Comparison lines from your graph

If you decide you no longer want the comparison lines on your graph,
there are a number of ways that they can be removed. To remove a
single comparison line, you can select the line to be removed by clicking
it, then simply pressing the "delete" key on your keyboard. Alternatively,
you can open the Format Pairwise Comparisons dialog, switch to the
Comparisons on Graph tab, and deselect the desired comparison(s) in the
list there.
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To remove ALL comparison lines from the graph, click on the dropdown
portion of the Pairwise Comparisons toolbar button and select "Remove
Pairwise Comparisons". Alternatively, you can open the Change main
menu, select "Pairwise Comparisons", and then select "Remove Pairwise
Comparisons". Note: this will not simply hide the comparison lines.
This removes them from the graph and erases any custom
appearance settings that had been applied to them.

Data from multiple data tables on a single graph

This feature works only when there is data from a single data table
displayed on the graph. Comparisons will not be shown on a graph if it
contains data from more than one data table
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19 Exporting images from Prism

There are several ways to get your graphs and

layouts into other applications. You can export

them to PowerPoint or Word using one-click

export . You can export them in a variety of600
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image formats, or you can copy and paste your

graphs and layouts as bitmaps.
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19.1 How to export one or more graphs or layouts

Are you sure you want to export?

If your goal is to send graphs to a colleague who doesn't own Prism,
consider sending a Prism file. He or she can then open the file using Prism
itself, or the free Prism trial (which expires in 30 days but then becomes a
free Prism viewer that never expires).   

If your goal is to place graphs into a Word document or PowerPoint
presentation, you can copy-and-paste or use the one-click send buttons
rather than exporting. There are some settings in the File & Printer tab of
the Edit/Preferences dialog that will affect the result and whether or not
you will paste your graph as a Prism object or a picture.

How to export

1. Start from one graph or a layout, or from several graphs or layouts
selected on the Gallery . 

2. Click the Export button on the Prism toolbar to bring up the Export
Graph dialog. Alternatively, drop the File menu and choose Export. You
can also use the Send-to-PowerPoint or Send-to-Word buttons. Or the
Print button.

3. Choose the export format , and also choose the location and name of
the exported file. 
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19.2 Exporting options

Export one graph or layout, or several or many?

To export several graphs at once, start from the graph gallery, select two
or more graphs, and then choose to export. With most formats, each
graph or layout will be exported to its own file. With PDF format, you can
choose to export each to its own file or all to one file. 

File format

This is the most important choice. If you don't want to think about it, we
suggest using PDF if you can, and use TIFF as a second choice.

 Read about the pros and cons of the alternative formats .  

Clear (transparent) background?

Within Prism, there is no distinction between having a clear page
background  and a white background. When you paste or export a Prism
graph into another program, however, the two are distinct if the exported
graph is combined with other objects that are behind (in a front-to-back
sense) it. If the background is clear, you'll see other objects that are
behind it. If the background is white, you won't.  

The TIF, PNG, PDF, WMF (Windows only) and EMF (Windows only)
formats allow you to choose a transparent (clear) background. With Prism
Mac, but not Prism Windows, you can choose a clear background with EPS
export. If you choose to export as a TIF file with a clear background from
Prism Windows, it will be RGB 32 bits (with no choice of color model). The
.JPG, and BMP formats simply have no concept of a clear background, so
those file formats simply don't allow for the possibility of clear
backgrounds.   

Resolution 

The resolution is entered in dots per inch (dpi).  For perspective, most
computer screens have a resolution of about 100 dpi, and most
professional printing presses (used by journals) use a resolution of 1200
dpi. Laser printers range from 300 to 1200 dpi. 

The PDF, EPS, WMF (Windows only) and EMF (Windows only)  formats
encode vectors and fonts, so have essentially infinite resolution. If you
export in one of these formats, you will not be asked to enter a
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resolution. The other formats offer choices of 100, 300, 600, and 1200
dpi.

If you double the dpi, note that you quadruple the number of pixels in the
image, and thus quadruple the file size. 

Color model

If you choose the PDF, EPS or TIF format, you'll need to choose between
RGB and CMYK color models . We recommend that you choose RGB
when possible, as there will be fewer surprises. RGB colors will closely
match what you see on the Prism screen (which internally uses RGB).
Select CMYK only when submitting images to a journal that insists on
CMYK. 

With some formats, you can also choose between being able to save
thousands (8 bit) or millions (24 bit) of distinct colors. When you choose
thousands of color, some colors may get changed a bit when saved. When
you save RGB, thousands of colors are stored in an indexed format, but
millions of colors are not. Some journals may specify whether they want
colors expressed in 8 or 24 bits, and whether they prefer indexed or
nonindexed colors. 

When exporting in jpg, tiff, pdf or eps formats, instead of exporting in
color, you can choose grayscale where colors are converted to various
shades of gray. With tiff, you can also choose monochrome (black and
white with no grays).

Size

In most cases, you'll want to export without changing the size of the
graph or layout. But you can specify the width of the exported graph.
Don't enter the desired width of the graph's plotting area, but rather the
desired width of the entire graph object, including any legends or
drawings or objects. 

The size you specify is the final size (width) of the exported object. If you
choose "actual" size, then the size of the graphs in the exported file are
the same as in Prism. What is the size of an exported image? It can
depend on the program used to view it, so it helps to think about number
of pixels instead (for the bitmap format). If you choose 300 dots per inch,
and a graph is 4 inches wide and you choose actual size, then it will be
1200 dots wide in the exported file. 
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Note that "actual size" doesn't refer to the size of the page the graph or
layout is on. Prism ignores the size of the page when it exports. It exports
the portion of the page that contains graphs or objects with a small
margin.

Embed fonts (EPS on Windows only)

When you export to EPS format using Prism Windows, choose whether to
convert the fonts to outlines. Learn the pros and cons of the two
approaches .

Prism Mac does not offer the choice of converting text to outlines. 

Defaults

Check an option at the bottom of the dialog to lock in your settings of
format and options to use as the default for future exports. To change the
default exporting location, use the File Locations tab of the Preferences
dialog. 

19.3 The differences between export formats

Setting the default export format and the default for copying to clipboard

Set the default for how Prism copies graphs and layouts to the clipboard
in the File & Printer tab of the Preferences dialog. Choose the export
format in the Export dialog, and check an option at the bottom of that
dialog to set the default for future exports. 

PDF

Prism's PDF files encode vectors and fonts (not bitmaps), so the resulting
file can be stretched to any size with no loss of quality. Export in PDF
format when you can.  Unfortunately, few Windows programs import pdf
images, and few journals accept them. In contrast, PDF is the preferred
format for transferring images between Mac programs.

Notes:

· If your graphs are in color, you will need to choose between RBG and
CMYK color model. . 
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· You don't have to have Adobe Acrobat to export PDF files. Prism creates
PDF files on its own. 

· When exporting several graphs or layouts, you can choose to export all
of them to one PDF file. Or you can  ask Prism to create a separate PDF
file for each sheet. 

· Prism Mac and Windows can encode transparent colors in PDF export.  

TIFF or TIF

(Prism uses the extension TIF but it is identical to TIFF used by some
other programs. The two are exactly the same, and you can rename from
one to the other.)

This is a bitmap format, which means that your graph or layout is turned
into a collection of dots.  TIFF files tend to be trouble-free when
submitted to journals. You need to choose resolution, color model, and
size.

The resolution is expressed as dots per inch (dpi). Computer screens
display images at about 100 dpi. Computer printers generally print at
300-600 dpi, and publications are generally printed at 1200 dpi. Journals
typically ask for a file at 1200 dots per inch (dpi), the highest resolution
that Prism offers.

Choose between two ways to express colors: RGB (designed for computer
monitors or projectors) or CMYK (designed for printing). If you are
submitting to a journal, follow their instructions. If in doubt, choose RGB.
Prism Windows also lets you choose Monochrome files, which are pure
black and white with no grays. If you choose RGB, Prism Windows lets
you choose between 256 colors (smaller files) or millions of colors (larger
file, but more accurate color rendition). Prism Mac always uses millions of
colors.

Typically, graphs and layouts in Prism projects are much larger than
publication size. If you ask for a graph at 1200 dpi at the actual size in
Prism, you will end up with either a huge file or an out-of-memory error
message. Avoid this problem by specifying the publication size. Let’s say
your graph is 6 inches wide, but you will publish it with a width of 2
inches. By checking the option to reduce the graph to a width of 2 inches,
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you will create a file one-ninth as large (one-third the width times one-
third the height).

With TIF format, and no other, Prism lets you choose to compress the file.
The advantage of compressing, of course, is that the file is smaller. The
disadvantage is that compressed TIF files might be less compatible with
other programs. 

With Prism Windows, choose between two compression methods. PackBits
compression create the smallest file size, but  LZW (Lempel-Ziv-Welch)
compression might be more compatible. 

Prism Mac does not offer you a choice of compression methods, it uses
LZW compression 

TIFF files exported by Prism (Windows or Mac) encode transparent
colors. 

EMF+, EMF or WMF (Windows only)

Windows Metafile (.WMF) and Enhanced metafile (.EMF) files contain
vector and font instructions for how to draw the graph. This means you
can resize the image (in another program) with no loss of quality. These
formats are only used by Windows program, not Mac programs (and
Prism Mac cannot export in these formats).

WMF is an ancient format; EMF is old, and EMF+ is the newest. So
generally EMF+ is the best format. But not always. You may need to
experiment to see which format works best for your needs, but these
notes may help:

· Don't use WMF when exporting or pasting bar graphs with fill  patterns
to PowerPoint. If you use WMF, the patterns on such a graphs do not
scale and appear of higher density.  

· If you paste an EMF image into PowerPoint, the colors may change when
you save then reopen the file. Not with WMF or EMF+.

· Choose EMF  instead of "EMF+" to workaround the problem with
somewhat corrupted graph when pasting EMF+ to older versions of
Adobe Illustrator (CS5) or Corel draw. The problem is how Adobe
Illustrator opens "EMF+" format that is generated by GDI+ in Prism.  
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· Choose EMF instead of "EMF+" to when a graph is sent to PowerPoint
and then exported to PDF. WIth EMF+, the fonts can change. 

· Some very old programs do not support EMF. For these choose WMF.

· EMF and EMF+ files exported by Prism encode the transparent (clear)
"color", but WMF files cannot encode transparency. 

· EMF+ but neither EMF(old) or WMF can encode semitransparent (semi-
clear) colors.

· EMF+ is a newer format than EMF but both kinds of files use the same
.EMF extension.

 
EPS

Like PDF, EPS files contain vectors and fonts. The resulting file isn't just
an EPS wrapper around a bitmap file. Prism Windows gives you the choice
of converting text to outlines. If you do that, the image will always look
right (no font files required), but you wont be able to edit text in other
programs. If you include text as text, it can be edited elsewhere but font
files are required. Prism Mac always converts text to outlines. 

In theory, the EPS format is the best (tied with PDF). It encodes
everything as vectors and fonts, so can be expanded or shrunk without
any loss of resolution. In fact, submitting EPS files to journals is often
problematic. Fonts and EPS files.

The EPS format is unable to encode transparency. If you choose any
transparent colors in Prism, they will look solid in the exported file.

JPEG

The .JPG format is designed for photographs with gradients of similar
colors. It is not a particularly good format for exporting for line art and
graphs. Prism offers this choice because some journals insist on it, but we
recommend that you use the .TIF format when possible. The only
advantage of .JPG is that the files are smaller.

Most programs that export to the .JPG format give you a choice of
compression. If you compress more, the files will be smaller but the
resulting image won’t be as sharp. Prism gives you no choice. It only
exports to the .JPG format with the least possible compression, making
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larger files but sharper images. Any compression would reduce the clarity
of your graphs noticeably.

The JPEG format is unable to encode transparency. If you choose any
transparent colors in Prism, they will look solid in the exported file

PNG 

The .PNG format is great for posting graphs on web sites. PNG files use
screen resolution, which is fine for displaying on screen but is too little
resolution for submission to printed journals. There are no options of color
depth.

Prism Windows can encode transparent colors in PNG export. Prism Mac
cannot, and any transparent colors in your graphs become solid in the
exported PNG file.

BMP

This is an older format that offers no advantages over other formats.

 

19.4 Exporting for publishing in journals

When you submit figures to journals for publication, you have to decide
which format to use. Each journal has their own rules, and these
sometimes change. But here are some general notes on preparing Prism
graphs for publication.

Exporting as a TIFF file

Exporting as TIFF, our customers tell us, usually works well. Notes:

· In most cases, you will want the page background in Prism to be white,
and to check the option in the Export dialog to include that color in the
file.Transparent backgrounds can sometimes cause problems.

· If your journal asks for a tiff file without an "alpha channel", choose
"White" for the Background color in Prism's Export dialog, not
transparent or clear. 

· For resolution, try to follow your journal guidelines. It would seem to
make sense to choose the highest resolution (1200 dpi) but some
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journals prefer 300 dpi. Definitely avoid the 100 dpi resolution, which is
way too low for publication. Some of our customers say they always
give the journal more resolution than requested, and this seems to work
well for them.

· Choose the color model  requested by your journal. Different journal
have different requirements.It seems that RGB is now more popular
than CMYK, so choose RGB if you don't know what your journal wants. If
your graph is entirely black on white, choose the monochrome or gray
scale color model. 

· For size, choose to make the exported file the exact width the journal
wants. More.  

· For compression, choose the LZW method, as it is standard and should
not pose any problems to the journal production process.

Exporting as an EPS file

EPS files (encapsulated postscript) files encode the graphs as vectors and
fonts, so have infinite resolution (except for any embedded pictures).
They are more compact and sharper than TIFF or other bitmap files. Even
if the journal you are submitting to doesn't list EPS as an acceptable
format, ask them, since their printed guidelines may be out of date.  

The problem of fonts in EPS files

Prism Windows (but not Mac) offers an option to convert fonts to
outlines  when exporting to an EPS file.

The default is to save the text as characters, with references to the font.
If you have used only standard fonts, this format lets the journal
producers edit the text, or change the font and size. The only drawback is
that if the file is opened on a computer that does not have the exact fonts
you used, another font will be used and the look of the graph (or layout)
will change. If you use standard fonts, we recommend this approach. 

If you check the option  to convert all text to outlines or glyphs, the look
of your graph or layout will be preserved on any computer, even one that
does not have the fonts you used. The disadvantage is that the text no
longer is encoded as text, so the people processing your files at the
journal will not be able to edit the text, change the point size or switch to
a different font. We only recommend this approach if you use any unusual
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fonts in your figure, and are not sure if the journal computers will contain
those fonts.

Prism Mac always converts fonts to outlines. 

Adobe products offer a third way to deal with fonts that combines the
best of the two approaches above, but Adobe has not provided the hooks
our programmers would need to implement this approach. If you have
access to Adobe Illustrator, here is an approach that is likely to work well.
Export the graphs from Prism Windows without converting the text to
outlines. Or try copy and paste.  Then export from Illustrator in EPS
format. We do not use Illustrator, so can't give you any detailed
information.

Beware of the term embedded font. If your journal asks for that, clarify
what they mean. Previous versions of Prism and some other programs 
used the term "embed" to describe converting fonts to outlines. Adobe,
and some journals, use the term "embed" to the describe the third
approach above, an approach that Prism does not offer.

Choosing a color model

If your graph is entirely black on white, choose the monochrome or
grayscale color model.

If your graph includes color, choose the color model  requested by your
journal. Different journal have different requirements. It seems that RGB
is now more popular than CMYK, so choose RGB if your journal has not
specified. 

Previewing EPS files

Once you've exported an EPS file from Prism, you'll probably want to see
it to make sure it is correct. With Macs, this is no problem. Just double-
click on the file and it will be opened in Preview, a program that is part of
the OSX system. What actually happens is that Preview converts from
EPS to PDF, and displays the pdf image. 

Windows, however, has no built-in program that can view EPS files.
Adobe Illustrator seems to be the standard that many journals use, so
import the EPS files into Illustrator if you can. If you don't have access to
Illustrator, you'll have to find another program. Try double-clicking on the
file to see if you already have a program that can open EPS files. Also try
the free program GhostScript, which works OK. Another option is to
export from Prism as a pdf file, and view that. This works because eps

595

http://pages.cs.wisc.edu/~ghost/


Exporting images from Prism 595

© 1995-2020 GraphPad Software, LLC

and pdf files contain mostly the same information, with a different
"wrapper". 

19.5 RGB vs. CMYK color models

The Export dialog requires you to choose between RGB and CMYK color
models when you choose to export a graph (or layout) in the PDF, EPS,
JPG (Mac only) or TIF format. 

RGB (Red, Green, Blue) is based on projecting. Red light plus Green light
plus Blue light all projected together create white.  Black is encoded as
the absence of any color. Colors encoded as RGB are sometimes called
spot colors. 

CMYK (Cyan, Magenta, Yellow, blacK) is based on ink.  Superimpose Cyan
ink plus Magenta ink plus Yellow ink, and you get black. White is encoded
by the absence of any color.  Colors encoded as CMYK are sometimes
called process colors. 

Even though it uses one more number to encode a color, the CMYK
scheme actually encodes a smaller "color space" than does RGB. That
means that the appearance of some colors will change when converted
from RGB to CMYK. Most noticeably, bright colors in RGB (left side of
figure below) will look duller and darker in CMYK as shown in the right
side of the figure below. 
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We recommend that you choose RGB when possible, as there will be
fewer surprises. The colors will closely match what you see on the Prism
screen (which internally uses RGB). Many scientific journals now request
RGB. 

Select CMYK only when submitting images to a journal that insists on
CMYK. 

Learn more about the differences between RGB and CMYK  here and here.
 

19.6 Fonts and EPS files

Prism Windows (but not Mac) offers two choices about how to handle
fonts when exporting to EPS format.

The default choice is to choice saves the text into the EPS file as
characters, with references to the fonts you used. If you have used only
standard fonts, this format lets others edit the text, and change the font
and size. The only drawback is that if the file is opened on a computer
that does not have the exact fonts you used, another font will be used
and the appearance can change drastically.

Prism Windows also offers an option to convert all text to outlines, so that
each letter is described as a set of graphic objects without reference to
any font file. Prism Mac always exports EPS in this format. The advantage
of this approach is that the look of your graph or layout will be preserved
on any computer, even one that does not have the fonts you used. The
disadvantage is that the text no longer is encoded as text. That means it
is impossible to opens the .eps file and edit the text, change the point
size or switch to a different font.

Adobe products offer a third way to deal with fonts that combines the
best of the two approaches above. The font definitions themselves are
included in the file, so the text remains as text, but will render perfectly
on any computer. As far as we can tell, this choice only works within
Adobe products and Adobe has not provided the hooks our programmers
would need to implement this approach. 

http://www.printernational.org/rgb-versus-cmyk.php
http://www.articlesbase.com/printing-articles/difference-between-rgb-amp-cmyk-1916310.html
http://www.sketchpad.net/basics7.htm
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Beware of the phrase embedding fonts, as it is not used consistently.
Adobe uses it to describe the third approach listed above (including font
definitions in the file). Prism 5 and earlier (and some other programs) use
the phrase "embedding fonts" to mean the second choice above
(converting fonts to outlines or glyphs). 

19.7 The size of exported graphs and layouts

How to change the size of a graph in Prism

When exporting a graph to submit to a journal, you will often want to set
the exact width of the graph, and any other objects (text, legends,
drawing, pictures, results tables) on the graph page. There are two ways
to change the size of the graph in Prism:

· Set the width of the exported graph on the Export dialog.

· On the graph page. Drop the Change menu and choose Resize Graph. 

A third possibility is to change the length of the X and Y axes in the
Format Axis dialog. But just sets the axis length. The full graph will be
larger when you consider titles, numbering,  legends, drawing etc.).

We recommend the second approach above (change the size of the graph
in Prism), as you can then check that nothing is too small. One guideline
(from Cadmus, who handles production for many journals) is to make no
font be smaller than 6pt, and no line be thinner than 1/2 point.  

What happens when you resize exported images?

EPS, PDF, WMF, EMF files

The EPS, PDF, WMF and EMF formats are all based on vectors and fonts.
These formats essentially store the instructions to draw the graph. You
can stretch them to any size, and they should still look great. The only
exception is if you pasted a picture onto your graph. Then that picture will
remain a bit map in your EPS (etc.) file, and may not look great if its size
is changed. 

Even though it shouldn't matter, it is not a good idea to create an
oversize graph, and expect the journal to reduce the graph size (and thus
increase its resolution for TIFF files). Journals prefer that you export the
graph at the size it will be published. 

TIF, PNG, BMP, JPG files
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TIF, PNG, BMP and JPG files encode bitmaps. If you stretch or shrink
these images in another program, that program has to figure out how to
create extra pixels or remove existing ones. Often the image becomes a
bit blurry. It is much much better to resize in Prism (in the Graphs
section) and then export the bitmap image file at exactly the size you
want it to end up at.

If you want to know the size of an image, beware of viewing it after
importing  into another program. The size you will see in the other
program depends on how that program deals with the mismatch of dots-
per-inch (dpi) between the file and on screen, and also on what view
zoom setting you have in that program.

It is easy to find out how large an image is in pixels, and its dpi:

· Mac. Double-click to open in Preview and then drop the Tools menu and
choose Show Inspector. 

· Windows: Double-click to open in Photo Viewer, then drop the File menu
and choose Properties. (This works for Windows 7; other versions are
similar.)

 

19.8 Clear (transparent) background

What is a clear background?

Within Prism, there is no distinction between having a clear background
and a white background. Both look identical on screen.

When you paste or export a Prism graph into another program, a clear
background will let colors and objects show through, so Clear is not the
same as White. 

The problem is that not all export formats support the concept of
transparency, and Prism doesn't support all formats. The JPG, and BMP
formats simply have no concept of a clear background, so those file
formats simply don't allow for the possibility of clear backgrounds.
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Note that Prism lets you set two separate colors for the background of a
graph. What Prism calls the background is the color of the 'page'. The
plotting area color is the background color within the plotting area defined
by the axes. Both can be set by right clicking (control-click for mac) on
the graph, or by dropping the color wheel icon. Layouts, of course, only
have the page background property.

Which export formats allow you to choose a clear background?

With Prism Windows, you can choose a clear background when you export
in PDF, EMF, EMF+, WMF, TIFF or PNG formats. Prism Windows cannot
export EPS images with clear backgrounds (but Prism Mac can). 

With Prism Mac, you can choose a clear background when you export to
PDF, PNG, TIFF, and EPS format.

This choice is in the Exporting options part of the Export Graph dialog,
where you can choose to include a background color or export with a clear
background.

Copying graphs and layouts to the clipboard

Choose on the File & Printer tab of Preferences whether you want Prism to
copy graphs and layouts to the clipboard with the background color you
specified in Prism or with a clear background.

Sending to PowerPoint

Rather than copy and paste, we urge you to use the Send-to-PowerPoint
command (a button at the right end of the toolbar, or a command in the
File menu. The choice you make for sending background color (vs.
transparent) to the clipboard (see prior section) also applies when
sending a graph or layout to PowerPoint.

When you copy a graph or layout from Prism Mac, two versions are placed
onto the clipboard. The PDF version supports transparent background and
plotting area. Whether the background is clear or not depends on an
option you set in Prism's Preference dialog (bottom of File & Printer tab). 
The bitmap version does not support a clear background. If you copy and
paste, which version pastes depends on your version of PowerPoint and
on whether you use Paste Special. Avoid the uncertainty by using the
Send-to-PowerPoint command. 
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19.9 Exporting graphs with semitransparent colors

When you export your graph or layout, the semitransparent/clear
colors  may or may not look semitransparent/clear in the exported
image. It depends on what format you export in and on whether you use
Prism Windows or Mac. In the table below, "Yes" means that
semitransparent/clear colors will be encoded in the exported file, and
"No" means they will not be.

Format Windows Mac

Semitran
sparent?

Clear? Semitran
sparent?

Clear?

EMF Yes Yes
These formats are

Windows only.
EMF+ Yes* Yes

WMF Yes Yes

EPS No No No No

PDF No No Yes Yes

TIFF Yes Yes Yes Yes

PNG Yes Yes Yes Yes

JPG No No No No

BMP No No No No

* Yes for Prism 8; no for Prism 7

19.10 One-click to Microsoft PowerPoint or Word

Send to PowerPoint or Keynote

The Send-to-PowerPoint command copies the current graph or layout,
creates a new slide in PowerPoint, and pastes.

When you send to PowerPoint, it matters what the background color is in
Prism. If the background is CLEAR in Prism, then Prism leaves the
background alone in PowerPoint. If the background is any color in Prism,
including white, then Prism changes the PowerPoint background to match.
If your PowerPoint slide master has a background gradient or image that
you want to keep, make your backgrounds in Prism clear, not white.

Send to Word (Windows only)

368
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The Send-to-Word command copies the current graph or layout  (or a set
of graphs or layouts selected on the gallery ), and pastes it into Word.
Position your insertion point in Word before using this button.

This button is available on Prism Windows, but not Prism Mac.

Setting preferences for Send-to-Word or Send-to-PowerPoint (Windows only)

Open the Send to MS Office tab of the Prism Preferences  dialog.

185

194
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The most important choice (Windows only) is whether to embed, link, or
send a picture . Embedding is the most versatile, but makes your Word
or PowerPoint files larger.

When sending to Word, choose whether to display full colors, black and
white, or gray scale. The latter two options simply set a setting within
Word to display and print the graph in black and white or gray. If you
embed or link, and double-click to edit in Prism, you'll see the graph in its
original colors.

Problems sending to Word or PowerPoint? EMF(old) vs. EMF+ vs. WMF

603
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Windows supports three similar formats for describing images using
vectors and fonts. The WMF (Windows Metafile) format is older. The
EMF+ (Enhanced metafile) format is newer, and in theory a bit better.
Prism can also use an older version of EMF. In fact, one format works
better for some programs and the other format for others. It seems
impossible to predict.

Choose which format to place on the clipboard (and to use when sending
graphs to PowerPoint) at the bottom of the File & Printer tab of the
preferences dialog. If you're having problems with pasted graphs looking
funny, try another format.

19.11 Embedding or linking Prism graphs in other programs

This page applies only to Prism Windows. Object Linking and Embedding
is not possible on the Mac. We wish it were.

The difference between pasting an object, a link or a picture

There are three ways to copy a Prism graph or layout and paste it into
many Windows programs, including Word or PowerPoint.

Paste a graph or layout as a Prism object:

Prism will paste a picture of the graph, plus a copy of all the data,
analyses and graphical settings needed to create that graph (or layout).

Double-click the object in the other program to edit it within Prism, where
you can edit data, change analysis settings, and format the graph. When
you exit Prism, the revised graph will appear in Word.

The advantage of embedding is that the Word or PowerPoint file is
complete, containing the Prism data and settings. One disadvantage is
that this makes the Word file larger. Another disadvantage (for some) is
that it means your data can be stored in multiple places. If you realize the
data was entered incorrectly, you will need to edit all the copies. Others
see this as an advantage -- a way to backup your data.
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A Prism object only includes the data tables and results that are linked to
the graph (or layout) that you pasted. Other parts of the Prism project
are not included.

This is Windows only, and is not possible with Prism Mac.

Consider creating a drawing canvas in Word

In Word (but not PowerPoint) you can go to Insert, Shapes and select
"New Drawing Canvas". That "canvas" is an area where you can combine
images. Paste in a Prism graph, add text, import images, insert shapes
and equations.... If you insert those items individually right on the page,
they get entangled with flowing text. Putting them into a canvas keeps
them together and away from the flowing text, and lets you control their
arrangement with one another. Learn more. 

Paste a graph or layout as a picture

A picture may be worth a thousand words, but it doesn't let you edit data,
change analysis choices or reformat the graph. When you double-click on
a pasted picture, you cannot edit it within Prism. Instead, you'll open up a
generic graphic or photo editor.

An advantage of this approach (for some) is that people you send the file
to won't be able see your data or edit your graphs. Because there is no
need to store the data and settings, this approach doesn't take up so
much disk space.

Paste a graph or layout as a link

Prism can paste a picture along with a link to the Prism file. When you
double-click, Prism will be launched and open the linked Prism project.
You can then edit the data, analysis settings, or graph in Prism. When
you exit, the revised graph will be updated in Word or PowerPoint.

One advantage of this method (over pasting an object) is that your Word
or PowerPoint files will be smaller. Another advantage (for some) is that it
keeps your data in one place for easy editing. The disadvantage is that
the link really is just a link to a file with a particular name in a particular
place. If the linked file has been deleted, renamed or moved, you won’t
be able to edit it. If you move the Word or PowerPoint to another
computer, you won't be able to open the linked file unless it too is moved.

This is Windows only, and is not possible with Prism Mac.

Insert object

https://www.graphpad.com/support/faqid/1630/
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If you insert a Prism object into Word or PowerPoint, you'll embed an
entire Prism project. In contrast when you paste a graph as an object,
you only embed the data and results linked to that graph.

Choose the Insert Object command from the other program's Insert menu
(or in Office 2007, the right side of the Insert tab). Choose to create
object from a file, and choose your Prism file.

The advantage of this method is that it includes the entire Prism project.
This might be useful if you send a document to a colleague and want to
include all supporting details.

This is Windows only, and is not possible with Prism Mac.

How to choose to paste an object, a link or a picture

One-click buttons to send to PowerPoint or Word

Choices in the Send to MS Office tab of Prism's preference dialog
determine whether Prism's one-click Send buttons  send an object, a
link, or a picture.

Copy and paste

When you copy a graph (or layout), Prism put all the necessary
information on the clipboard so the pasting program can choose if it
wants to paste a picture, an object, or a linked picture. Microsoft Word
and Excel and older versions of PowerPoint paste an embedded object.
PowerPoint 2007 and 2010 are different. By default, they paste a picture.
To override this, drop the clipboard menu,  choose Paste Special, and
then choose to paste a Prism object. 

Copy and Paste Special

Instead of pasting (and letting the program choose), use the Paste
Special command, so you can choose which format is pasted. With most
programs, Paste Special is a choice on the Edit menu. With Office 2007
and 2010, it is a choice on the Paste menu which is on  the left side of the
Home tab of the ribbon.

The Paste Special dialog lets you choose to paste an object ("GraphPad
Prism 8 Project Object"), or a Picture ('Enhanced metafile"). You can also
paste a bitmap, which might be useful if you want this Word or
PowerPoint document to look nice on a Mac.

600
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If you check this option to paste a link, the scrolling list gives you no
choices. This option will not be available if you copy a graph from an
unnamed Prism project, because linking requires that the Prism file has a
name.

EMF+, EMF(old) or WMF?

Windows supports three similar formats for describing images using
vectors and fonts. The WMF (Windows Metafile) format is older. The
EMF+ (Enhanced metafile) format is newer, and in theory a bit better.
Prism can also use an older version of EMF. In fact, one format works
better for some programs and the other format for others. It seems
impossible to predict.

Choose which format to place on the clipboard (and to use when sending
graphs to PowerPoint) at the bottom of the File & Printer tab of the
preferences dialog. If you're having problems with pasted graphs looking
funny, try another format.

Editing a Prism object embedded in PowerPoint or Word

To edit a Prism object embedded in PowerPoint or Word, simply double
click on it. 

If you have multiple versions of Prism installed on your computer,
Windows will choose which version to launch (the one used to create that
object). But you can override that decision: Right click on the Prism
object in PowerPoint, choose the Prism Object command, and then choose
Convert from the submenu, and choose the Prism version you want to
open that object.

Opening Prism objects with different Prism versions

What happens when you double click on a Prism object embedded in
Word or PowerPoint (or elsewhere)? If the Prism version that created that
object is present on your computer, that version of Prism will open it. If
that version is not present, a newer version of Prism will open the file. But
if the object was created with Prism 7, but the computer only has Prism
6, the object will not open. Instead you'll see a message that explains.

After editing in Prism, updating the object in Word or PowerPoint

After editing an object in Prism, you'll want to push those changes to the
program that holds the object, usually Word or PowerPoint. There are
three ways to do this:
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· Close Prism completely. To do this, click the "X" at the upper right of
the Prism window. Or drop the File menu and choose Exit.

· Close the Prism "file" containing the object, but don't close Prism
entirely. To this click the smaller "X" button at the upper right of the
Prism window, just below the one that closes Prism entirely. Or drop the
File menu and choose "Close and Return to ...".

· Close the Prism "file" containing the object, but don't update PowerPoint
or Word. Ignore your changes, and leave Word or PowerPoint as they
are. To do this, drop File and choose "Close But Don't Update..."

· Update the object in PowerPoint or Word while still leaving it open in
Prism. To do this, click the Save button in Prism, or use the Control-S
keyboard shortcut.

20 Printing

This section explains how to print graphs and

layouts, and how to change your printing options.

20.1 Two toolbar buttons for printing

The Print section of Prism’s toolbar has two buttons for printing.

 -Print the current sheet, or multiple sheets selected in the Gallery ,
using your default Print settings.

 -Bring up the Print dialog to choose a printer and which pages to print.

185
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20.2 Printing data and results tables

Choose font size

Change the font size to control the size of the print on the page, and thus
the number of pages needed to print a table. To do so, click the Zoom
buttons. Or use the keyboard shortcuts: Use Smaller Font (Ctrl-J), Use
Larger Font (Ctrl-M)

 

Note these buttons work differently in data and results tables than they
do in graphs and layouts. When you are working with a table, the zoom
buttons change the actual size of the font used, which will then change
the size of the printed table.  When working with a graph or layout, these
buttons simply zoom what you see on screen, but do not change the
actual size of the graph or layout when printed.

Portrait vs. landscape

Save paper, with some tables, by changing the Landscape/Portrait
orientation when printing data tables, results, and info sheets. Go to File…
Printer Setup for Windows (File… Page Setup for Mac). A single setting
applies to all data tables, results sheets, and info pages in the entire
project.

While you can change graphs and layouts from portrait to landscape
orientation, you cannot o so on data or results tables.

Change column widths

Reduce column widths by positioning the cursor between column
headings, and dragging to squeeze more onto each printed page.

Printing preferences

These options on the File & Printer tab of the Preferences dialog affect
printing of tables.

· Print grid lines on tables -- Check this box to include the horizontal and
vertical lines on data and results tables. Omit it for a cleaner look.
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· Print row and column labels -- When printing data tables, print the row
numbers on the left of every page and the column letters on top of
every page.

· Print the sheet name as header -- Print the sheet name, file name, and
date on each page as a header. You'll probably want this header on
pages placed in your notebook, but not on graphs submitted for
publication.

20.3 Printing graphs and layouts

Page orientation

Each graph or layout can be set to be portrait or landscape. Since the
page orientation setting in the portrait/landscape setting of the printer
setup dialog only allows one setting per file, Prism ignores this setting for
graphs and layouts.

Flipping the orientation of a graph

Click the rotate button in the Change toolbar and choose Flip. 

Flipping the page orientation does not change the aspect ratio of the
graph. You won't see the change on screen unless you zoom  down to
see the entire page.

Flipping the orientation of a layout

Use the Flip button in the Change section of the Prism toolbar to change
the orientation of a layout.

159
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Printing preferences

Two options shown on the File & Printer tab of the Preferences dialog
affect printing of graphs and layouts.

· Print the sheet name as header -- Print the sheet name, file name, and
date on each page as a header. You'll probably want this header on
pages placed in your notebook, but not on graphs submitted for
publication.

· Print no grays and no colors -- Convert all colors to black. Don’t print
colors as shades of gray.

Printing posters

Prism can print on very large pages (up to 1.5 by 2 meters) so can create
a poster directly. 

Choose the paper size by dropping the File menu and choosing Printer
setup (Windows) or Page Setup (Mac). The details vary with each printer
driver.

Since you can only set the page size once for the entire project, we
suggest that you create your graphs in one project (or several projects)
using a standard page size. Then make your poster in a separate project
created just for that purpose. Set a large page size and then go to the
layout section and create a layout sheet. Arrange the placeholders, and
assign graphs from your other projects.

 

20.4 Printing the gallery

Open a Gallery  page by clicking on the section title in the Navigator
(Data tables, Results, Graphs, etc.). You'll see thumbnails of all the
sheets in an array.

Distinguish two ways to print from the gallery. 
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Print selected sheets: Select the sheets you want to print. Then
select the Print command or click on one of the Print buttons on the
Prism toolbar.

Print the gallery page itself:  Click on the Print button in the Prism
toolbar and click the Gallery option in the Print dialog. Printing the
gallery might be useful to create a table of contents for a lab notebook,
or to see an overview of your work. 

20.5 Custom page size

Windows

Windows lets you define custom page sizes. 

You must first define the custom size in the Printer control panel. This is
explained in this video (not created by GraphPad).

Once you create a custom page size in the Windows control panel, you
can choose it in Prism's print dialog. 

Mac

From Prism, drop the File menu and choose Page Setup. Then drop down
the list of page sizes. At the bottom, find "Manage custom sizes".

https://www.youtube.com/watch?v=fETyUz5Io8o
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21 Scripts

Use a Prism script to automate the analysis of a

large number of files. Prism's scripting language

lets you open and close Prism files, import data,

and export or print results and graphs.
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21.1 Overview of Prism scripts

Because Prism links data to graphs and analyses, a great deal of
automation is built in. Simply edit or replace data or info constants, and
everything will be updated. Although this built-in automation suffices for
day-to-day lab work, it can be tedious when repeated over and over.

You can use a Prism script to automate the analysis of a large number of
files, or simulate many data sets for Monte Carlo analyses. Prism's
scripting language lets you open and close Prism files, import data, and
export or print results and graphs. You can run Prism scripts from within
Prism, or launch Prism from another program.

Note that Prism scripts do not tell Prism how to analyze or graph your
data. That is built-in to the Prism project (or template). Use a script to
import data into an existing project and to specify which results and
graphs you want to export or print.

Scripts are small computer programs. Creating a script is slightly more
difficult than using Prism. Experience with other scripting or macro
languages is helpful, but is certainly not necessary. If you want to launch
a Prism script from Excel, you will also need to learn a bit about Excel's
macro language, Visual Basic for Applications.

To learn about scripts, first look over the examples we present in the next
section. These examples show you the kinds of things that Prism scripts
can do and give you a feel for how easy it is. Then read on to learn the
details of Prism syntax. The final sections of this chapter explain how you
can launch a Prism script from another program.

Can a Prism script control how Prism analyzes and graphs data?

No. A Prism script can open a Prism project file (or template), import
data, and export results and graphs. But the details of how data are
analyzed and graphed are stored in the Prism file. Note that when you
change data, Prism updates the results and the graphs. This includes
updating analysis constants and paste-linked data. For this reason, Prism
scripts tend to be very short and easy to write.

Does Prism have an API that can be called from other programs?

No. But other programs can launch a Prism script. Read the details about
how this works with the Windows  and Mac  versions of Prism.

Can other programs create Prism files?

652 650
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Yes .

21.2 Alternatives to scripting

Prism can save its project files in two formats. The PZFX format
includes all the data and info tables in plain text XML that other programs
can view, edit or replace.

While other programs can't really create Prism files, they can start with a
Prism file you have created, and replace the data. When a user then
opens this file, the results and graphs will be updated.

To get an idea about how this approach works, follow these steps:

1. Create a Prism file, with data, analyses and graphs as you want them.

2. Save from Prism in the PZFX format.

3. Then open the file with a text editor (notepad). The analysis and
graphing stuff is all encrypted in a way you can't access. But the data
and info are in plain text, structured, XML.

4. Edit the data (and perhaps the info constants), and resave.

5. Double click on the file to open in Prism. You'll see that graphs and
analyses are updated to analyze and graph the new data.

Using this approach, you can effectively (from the user's point of view)
save a Prism  file from your application (or instrument). No scripts. No
need to use your software and Prism on the same computer at the same
time. No need to even use the same platform (Win vs. Mac) for Prism and
your program. All you have to do is replace the data portion of a .PZFX
file, and resave it.

21.3 Example scripts

The easiest way to learn Prism's scripting language is to follow some examples.

The examples are all for Prism Windows. The only difference on a
Macintosh is that you use a colon instead of a backslash to specify disk
names, folder names, and files. For example, the first line of the first
example would read:

614
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SetPath “Hard Drive:Prism 4:Data:June21”

 

Script example 1. Repeatedly import data

Script example 2. Monte Carlo analysis

Script example 3. Import several files onto one table

Script example 4. Open a template and import data

Script example 5. Import data and info constants from the script
file

Script example 6. Import data into several tables

21.3.1 Script example 1. Repeatedly import data

This script analyzes a folder full of dose-response data stored as text
files, perhaps from an instrument. It creates a single file that tabulates
the logEC50 values along with the standard error and the R square of the
fit.

Script command Comments

SetPath “c:\data\june21\” This sets the disk and directory
to be used for the rest of the file.

OpenOutput results.txt Create a file called results.txt to
contain the output.

Table Text Start a tab delimited text table in
that file.

Open dr.pzfx Open the Prism file dr.pzfx

  ForEach dr*.txt Loop for all files that begin with
dr, have the extension .txt, and
are located in the disk and
directory defined by the SetPath
command.

  Goto D Go to the data section, to the
data table last visited.
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  ClearTable Erase all data from the table.

  Import Import the file defined by the
ForEach statement into the first
empty columns.

  WTable “File name”  %F Write the file name into the 
output file.

  Wtable “logEC50”, 5, 1 Write to the output table the
value on the fifth row, first Y
column (A), and label that
column of the table “logEC50”.

  WTable “SE of logEC50”, 11,
1

Write the SE of the logEC50
(from the 11th row of results)
into the next column.

  Wtable “R2”, 21, 1 Write the R2 value into the next
column.

Next Loop back to the ForEach
statement and read the next file.
Exit loop if no more files.

Beep Signal completion.

 

21.3.2 Script example 2. Monte Carlo analysis

This is an example of Monte Carlo analysis. We'll simulate 500 data sets
with random variation and fit a dose-response curve to each. This script
creates a table containing the logEC50 and HillSlope from all 500 fits.
Before running this script, you must create a file that has the first data
table formatted for a one-grouping variable data set (no X, No Y
subcolumns). The first results sheet must be one that simulates data with
error. The second results sheet must be a nonlinear regression that fits a
dose-response curve to the data.

Script command Comments
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Table Prism 1 Clear Designate the first data table in your
file to contain the results of this script.
Delete all the contents of that table now
(clear). Note this script requires that
the first data table be formatted for one
grouping variable data, with no X
column.

ForEach 500 Loop 500 times.

  GoTo R 1 Go to the first results sheet, which is a
simulation.

  Regenerate Regenerate the simulation with new
random numbers.

  GoTo R 2 Go to the second results sheet. Since
this sheet contains nonlinear regression
results, Prism will automatically refit
the data for each loop.

  Wtable “logEC50”,
5,1

Write the value from the first Y column
in row 5 to the first column of the
output table, and label that column
“logEC50”.

  Wtable “Hill Slope”,
6,1

Write the value from the first Y column
in row 6 to the next (second) column of
the output table, and label that column
“Hill Slope”.

Next Loop back to the ForEach statement.

 

When the script is done, table 1 will have two columns and 500 rows.
Each row will have the logEC50 and Hill Slope from one of the simulated
experiments.

21.3.3 Script example 3. Import several files onto one table

This example uses the script to import several files onto one data table.
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Script command Comments

SetPath “c:
\Data\Oct2011\”

Define the disk and directory to be used
by the rest of the commands.

Open rapid.pzt Open the Prism template rapid.pzt that
was created to contain a formatted data
table.

GoTo D Go to the data section.

ForEach
Avge_*.dat

Loop through all files that start with
Avge_ and have the extension DAT.

    Import Import into the first empty column.

Next Go to the next file, which will be imported
into the next column of the same table.

21.3.4 Script example 4. Open a template and import data

This example uses a script to launch Prism.

Script command Comments

SetPath “c:\data\oct2011\” Define the disk and
directory to be used by
the rest of the
commands.

Open rapid.pzt Open the Prism
template file rapid.pzt

GoTo D Go to the data table.

    Import today.txt Imports the file
today.txt.

GoTo G Go to the graph
section.

Save today.pzfx Save the file with the
specified name
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While Example 4 would not be useful when run from Prism, it would be
useful as a way to launch Prism.

For 32 nbit (x86) Windows: Create a shortcut icon with a target
something like this:

"C:\Program Files\GraphPad\Prism 8\prism.exe” @”C:\Users\(current user)\Documents\”doit.pzc. 

For 64 bit Windows: Create a shortcut icon with a target something like
this:

 “C:\Program Files (x86)\GraphPad\Prism 8\prism.exe” @”C:\Users\(current user)\Documents\”doit.pzc. 

Double-click that icon to launch Prism and run the script doit.pzc.

For Mac: You cannot create an icon that launches Prism running a certain
script. All you need to do with Prism Mac is double-click on the script icon
and that will launch Prism and run the script. 

The script shown above instructs Prism to open a template (today.pzt)
and import today's data (today.txt, presumably changing daily) into the
file, and go to the graph. Once you have set this up (a few minutes) and
also have a mechanism so the data file is updated daily (outside the
scope of Prism), you simply double-click the saved file to see a new graph
of today’s data.

21.3.5 Script example 5. Import data and info constants from the script file

Script command Comments

GoTo D , 1 Go to the first data table.

InsertData 1,0 Insert data from the script file, starting
at row 1, column 0 (the X column).

<DATA>
1.000           564.1452
2.000           389.7727
3.000           138.9337

Data block within script file.
Adjacent values are separated by tabs.
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4.000           115.3119
</DATA>

GoTo I, 2 Go to second info sheet.

SetInfo "Experiment", 2,
0

Set the name of the second info
constant.

SetInfo "345", 2, 1 Set the value of the second info
constant.

SetInfo "Experimenter",
3, 0

Set the name of the third info constant.

SetInfo "Dan Brown",3,
1

Set the value of the third info constant.

SetInfo "[Potassium]",
4, 0

Set the name of the fourth info
constant.

SetInfo "3.45 mM", 4, 1 Set the value of the fourth info
constant.

 

It would not make sense to create this script by hand, but it would be
very useful if created by another program. 

21.3.6 Script example 6. Import data into several tables

Before running this script, create a Prism file with 9 data tables each
linked to a graph, and all the graphs placed on one layout.  

Script command Comments

GoTo D Go to the data section.

ForEach 9 Loop nine times.
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GoTo %N Go to the Nth data table, where N is the
loop number.

Import Data%
N.txt

Import the data file. Data2.txt goes into
the second table, Data3.txt goes into the
third table, and so on.

Next Loop.

GoTo L 1 Go to the first layout, which was setup to
show all nine graphs.

Print Print the layout.

21.3.7 Script example 7. Changing the X-axis title of all graphs

Script command Comments

GoTo G Go to the graphs section.

ForEachSheet Loop over all sheets in this
section.

   SetAxisTitle X, "Time (minutes)"
Change the X axis tite.

Next

21.4 Script details

General commands

Adding comments to a script

Loops and simulations

Creating new sheets
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Changing data tables

Changing graphs

Setting the default drive and folder

Opening and saving Prism Files

Importing data

Changing info constants

Including data and info constants in the script file

Exporting a graph or layout

Exporting data, results or info tables

Copy and paste

Writing to Prism, text, HTML, XML or SQL tables

Writing to text files

Send to Microsoft Office

Special purpose commands

21.4.1 Script syntax

Punctuation in scripts

· Each script command begins with the command name. Most commands
then have one or several arguments. 

· Separate the command name from the arguments with a space.

· Separate the arguments from each other with spaces or commas. 

· Use upper and lower case letters interchangeably.

· Add extra spaces to improve readability.

How optional and required parameters are shown in the Help
pages

· Required arguments are shown in square brackets [like this].
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· Optional arguments are shown in angled brackets <like this>. 

· Lower case arguments describe a value you will enter. 

· Uppercase arguments are the  exact word you need to type if you want
that option.

21.4.2 Navigating a project

Commands

GoTo <section: D, I, R, G, or L >, <sheet#>, V<tab#>

GoTo +        

Explanation

The GoTo command is used in almost every script, to navigate to a
different sheet in the project as these examples show:

Example: Description:

GoTo G Go to the graphs section, to
the most recently viewed
graph.

GoTo 3 Go to the third sheet of the
current section.

GoTo G, 3 Go to the third graph.

GoTo V2 Go to the second analysis tab
of the current results.

GoTo R, 3,
V2

Go to the second analysis tab
of the third results sheet.

GoTo + Go to the next sheet in the
current section.

GoTo - Go to the previous sheet in the
current section.

Notes:
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· Prism numbers the sheets so the first sheet is #1. This seems normal to
everyone except computer programmers, who expect the first one to be
#0. 

· Don't forget to include a space (or comma) between the results and the
view. The command "GoTo R4V2" goes to the default (current tab) of
results sheet 4, and the view (analysis tab) part of the command is
ignored. 

21.4.3 How rows and columns are numbered

Many commands let you specify a particular row or column number. 

Column numbering

· The Row Title column, if there is one, is number -1. 

· The X Column, if there is one, is number 0. 

· Column A, is column 1.

· Column B, is column 2, etc. 

Row numbering

· The Column Title row, if there is one, can be referred to either as row 0
or -1 (to be consistent with column titles).

· The other rows follow the row number shown on the table. So the first
data row is #1. This seems obvious to most, but people familiar with
other computer languages may expect the first row to be #0.

· It is not possible to access subcolumn titles via script. 

21.4.4 Adding comments to a script

Add comments to your script following these examples:
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Commands

//single comment line

/*

  Several lines

  of comments.

*/

21.4.5 Loops and simulations

Commands

ForEach [# of loops]

ForEach [filespec, i. e. ”C:\data\DR*.txt”]        

ForEachSheet

Next

Regenerate

Explanation

The heart of many scripts is a loop. You can loop a certain number of
times (for simulations), over all matching files (repeated importing), or
over all sheets in a section (to print or export…). End the loop with a Next
statement. You cannot nest loops.

Starting and ending the loop

There are three ways to start a loop:

· Loop a specified number of times (example ):  ForEach 100. 

· Loop over a set of files (example ):  ForEach *.CSV

· Loop over all sheets in the current section:  ForEachSheet

616
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For all three kinds of loops, the Next statement ends the loop.

Regenerate random numbers

One common use of a Prism script is to do Monte Carlo analyses. First
create a Prism file that uses the analysis ‘Simulate data with random
scatter” to generate data, and links those simulated data to another
analysis (say a nonlinear regression). Inside each loop, use the GoTo
command to go to the analysis page that generates the data, and use the
Regenerate command to create new ‘data’ (with different random
scatter). Then go to the results, write out selected results, and use the
Next command to loop again. See script example 2  at the beginning of
this chapter.

21.4.6 Using variables when outputting text

The Prism scripting language lets you use these four variables in any
command that exports text. They are mostly useful inside of loops . 

· %F. The name of the file. This is useful in ForEach loops that import a
set of files. %F is the file name before the period. 

· %X. The file extension (without the preceding period).

· %S. The name of the current sheet. This is useful when looping over all
sheets in a file.  You may also use this variable outside of a loop.

· %N. The loop number. This is useful in simulations, which loop a set
number of times.

· %%. This outputs the percent symbol, %.  
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These variables can be preceded and/or followed by other text. They can
only be used within a script loop. Note there are additional variables
you can use when writing text. 

21.4.7 Creating new sheets

Commands

DuplicateDataTable  <CLEAR>

DuplicateFamily  [prepend_text] <CLEAR>

CreateLayout [#rows] [#columns] <orientation>
<#StartingGraphIndex> <#Graphs> 

Explanation

DuplicateDataTable

For the most part, script commands navigate among sheets you have
already created by hand. You can’t create new data tables, new analyses
or new graphs in a script except by duplicating existing ones. When you
duplicate a data table, all you get is a new data table. You can import
data into it, but not analyze or graph within the script. 

DuplicateFamily

Duplicates a sheet as well as all linked sheets. Import new data to replace
the existing data, and all analyses and graphs will update.

All new sheets include the prepended text in front of the sheet name.
Enter %F as the prepend text, to use the name of the most recently
imported file.

CreateLayout

Create a new layout with an array of placeholders with the specified
number of rows and columns on a page of the specified orientation
"portrait" or "landscape" (portrait is the default).  Assign graphs starting
with the specified one. Specify by rank order in the navigator, with "1" as
the first graph. If you specify GraphsCount, Prism will assign that many
graphs only. If you omit this parameter, Prism will stop when it has
reached either the last placeholder on your layout or the last graph in the
project
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21.4.8 Changing data tables

Commands

SetYReplicates  [#]

ClearTable <row>,<col>,<subcol>

DeleteAllDataSets <CLEAR>

Explanation

Using a script, you have limited ability to change a data table.

The SetYReplicates command changes the number of Y replicates
(subcolumns), but script commands can not make other changes to the
data table or number (decimal) format.

The DeleteAllDataSets command deletes all data and all links to
analyses and graphs.

The ClearTable command erases all data to the left and below of the
designated cell (including the cell itself) but maintains links to analyses
and graphs.

21.4.9 Changing graphs

Commands

ApplyColorScheme ["scheme name"]

SetAxisTitle [which axis: X, Y, or Y2] ["new title"]
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SetGraphTitle [“new title”]

SetAxisLimits [which axis: X, Y, or Y2] <segment #>
[Top/Bottom/Interval]  [value]

Explanation

You must create graphs manually (or by duplicating). You can’t change
most graph properties via scripts, but you can apply a color scheme,
change the limits of an axis, and change the graph or axis titles.

When entering the graph or axis title, you can only enter plain text, and
Prism does not provide tools to enter Greek letters, math symbols,
superscripts or subscripts. But note that Windows lets you enter some
special characters by holding Alt and typing its four digit code. For
example, alt-0181 enters the Greek letter mu.

To use the % symbol in an axis or graph title, enter it twice. The
command "SetAxisTitle Y %% Complete" changes the Y axis title to "%
Complete". This is because the % symbol is used to indicate a variable. 

Each use of the SetAxisLimits command lets you change the range
(minimum and maximum  values) or interval of an axis. Each use of the
command only lets you change one of those values. If you want to change
the Y axis (left Y) so it ranges from 100 to 200 with an interval of 10, you
need to use this command three times (in any order): 

SetAxisLimits Y top 200
SetAxisLimits Y bottom 100
SetAxisLimits Y interval 10

If the Y axis was split into two segments, you need to specify which
segment to change. The first (left or bottom) segment is '0', and the
second segment is '1'. If you wanted to change the bottom  segment, use
these commands. Note that it is not enough to specify the segment
number; you also need to include the word 'segment'.

SetAxisLimits Y segment 0 top 200
SetAxisLimits Y segment 0 bottom 100
SetAxisLimits Y segment 0 interval 10

After you change a graph using a script, linked layouts won't update
unless you write script commands to go to that layout. Here is a script
that flips through all the layouts, so ensures they are all up to date.

Goto L
ForEachSheet
Next

http://www.geoff-hart.com/resources/accents-windows.pdf
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21.4.10 Setting the default drive and folder

Commands

SetPath [“drive and folder path”]

Explanation

All the commands that read and write files use the path set in the
SetPath command unless you specify a different drive or folder in the
other commands. For Windows, use these examples:

SetPath “C:\Users\(current user)
\Documents\007\goldfinger\oddjob”

SetPath “(local drive):\DataFiles\August2005\”

SetPath “\\LabServer\DDrive\PrismFiles"

The last example opens a file on another computer named “LabServer”.
In this case you don’t use the “C:” notation for hard drives, but rather
refer to the name of the drive (“DDrive” in this example.)

On the Mac, use a format like this:

SetPath “Hard Drive:Prism 4:Data:June21”.

If you prefer to specify the path within each individual command, you can
still use the same formats as shown above.

21.4.11 Opening and saving Prism Files

Commands

Open [“filename”]

Close

Save <”filename”>
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Explanation

Scripts can either be saved as part of a Prism file, or in a separate script
(.pzc) file. When the script is running from a separate file, the Open and
Close commands let you switch between Prism files. The script commands
work on the last opened file. You may open several files at once. To go
back to a file you already opened, simply reissue the open command
again.

If you don’t include a disk and directory, Prism will look in the directory
(folder) specified by the SetPath command. Include the file extension
(.PZF, .PZFX, .PZT or .PZM). If no SetPath script command was used
Prism, Prism uses the temporary folder.

Unlike the Import command, the Open command by itself will not
automatically open the next file file in a ForEach loop. To do so, use this
syntax: Open %F.PZFX.  That opens the next file in the loop (%F) with
the extension .PZFX (which you may want to change to .PZF).

The Close command does not save the file, so issue the Save command
first if you want to keep the changes. Include a file name with the Save
command to create a new file. Omit the file name to save changes using
the same name.

The Save command saves to either .PZF or .PZFX format, depending on
the file name you enter.

21.4.12 Importing data from a text file

Commands

Import <”filename”>, <row>, <col>, <subcol>

ImportLink <”filename”>, <row>, <col>, <subcol>
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Explanation

The Import command imports data from a text file into a data table. The
ImportLink command replaces data in a data object file using existing
choices for filtering and rearranging

If you omit the filename and are in a ForEach file loop, Prism will use the
current loop’s file. If you include a file name, don’t precede it with a path,
Prism will use the path defined in the SetPath statement if there is one.

If you want to import starting at a particular row or column, specify them.
Row 0 is the title row, and row 1 is the first row with data. Column 0 is
the X column, and column 1 is the first Y column. Column -1 contains the
row titles. It is not possible to import subcolumn titles. 

The advantage of the ImportLink command is that it lets you specify
which parts of the file to import and how to rearrange the data. Before
creating the script, manually import a data file and choose the option to
maintain a link between Prism and the data (text) file. At this time,
choose options on the Filter and Placement tabs of the Import dialog to
select rows and columns to import and rearrangements (such as
transpose). These properties are stored with a data object. See Data
objects in Prism . The ImportLink command then replaces new data,
using the same properties.

If there is only one data object on the table, don’t specify row, column, or
subcolumn. Prism simply uses the only data object on the table.. If there
is more than one data object you need to specify the row, column, and
subcolumn of the upper-left corner of the data object you wish to import
into.

Note that the ImportLink command updates a Prism data object linked to
a text file. If you Paste Link data from Excel, you cannot update the link
using this command. You'd need to write VBA code in Excel to change the
data in Excel.
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21.4.13 Importing data from the script file

Commands

InsertData <row>, <col>, <subcol>

InsertDataLink <row>, <col>, <subcol>

Explanation

If you create the script file from within another program, you can include
data and info constants within the same file as the script commands.

The InsertData command imports data included within the script file, into
the current data table, starting at the specified position. The data are
included right in the script file enclosed between the tags <Data> and
</Data>. The rest of the script continues right after the </Data> tag.

InsertData

<Data>

1, 2, 4

5, 7, 9

</Data>

The InsertDataLink command imports data included within the script file,
into a data object whose upper left position is at the indicated position.
This works similarly to the ImportLink  command.

If you want to import starting at a particular row or column, specify them.
Row 0 is the title row, and row 1 is the first row with data. Column 0 is
the X column, and column 1 is the first Y column. Column -1 designates
the row titles.
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21.4.14 Copy and paste

Commands

Copy

Copy [#rows] [#columns] [first row] [first col] <first subcol>

Paste  [first row] [first col] <first subcol>

Paste  

Explanation

From a data, info, or results table, copy selected values to the clipboard.

If you use the Copy command with nothing else, Prism copies the entire
sheet to the clipboard.

You can also specify which range to copy. Note that #columns includes
subcolumns. So if you want to paste triplicate values into two adjacent
columns, you need to enter #columns as 6 (or 7 if you also paste an X
column).

If you use the Paste command with no arguments, Prism will paste the
entire table starting at the current position of the insertion point. 

Copy and paste use the Windows or Mac system clipboard, so will
overwrite any other information copied to the clipboard.

Example

 Copy 1, 9, 5, 10 

This selects and copies one row (row 5) and nine columns or subcolumns
(starting at column/subcolumn 10). 
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21.4.15 Changing info constants

Commands

SetInfo [”value”] [rownumber] <position: 0 (name) or 1 (value)
or 2 (notes)>

SetValueToInfo [infotable #] [inforow#] [datarow] [datacol]
<datasubcol>

Explanation

The SetInfo and SetValueToInfo commands inserts (or changes) a
value into an Info sheet.

With the SetInfo command, set position to 0 to change the name of the
constant, 1 to change its value (the default choice), or 2 to append to the
notes (in which case the row number is ignored).

Examples:

SetInfo 5.3, 3 

Setinfo "Notebook 25, page 34", 5

Setinfo "Experimenter", 3, 0

Setinfo "Dennis", 3, 1

Setinfo "Notebook 2007H, page 304", 1, 2

The first example sets the third constant equal to 5.3. The second
example sets the fifth constant to “Notebook 25, page 34”. The third
example names (or renames) the third constant to “Experimenter”. The
fourth example assigns the value “Dennis” to that constant. The fifth
example adds some text to the notes portion of the info page.

With the SetValueToInfo command, the value comes from a data, results
or info table. You must first navigate to that table using the Goto script
command. Then specify the row and column (and perhaps subcolumn) of
the cell with the value you want to use, and which row of which info table
you want to ‘paste’ that value into. Example:

SetValueToInfo 2, 4, 14, 0
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From the table that a prior Goto script command has taken it to, find the
X value (column 0) in row 14. Put a copy of that value in the fourth row of
the second info table. 

21.4.16 Exporting a graph or layout

Commands

ExportWMF [filename] <CLEAR> (Windows only)

ExportEMF [filename] <CLEAR> (Windows only)

ExportTIF [filename] <resolution> <mode> <compress or LZW>
<CLEAR>

ExportBMP [filename] <mode><resolution>

ExportPNG [filename] <resolution><CLEAR>

ExportJPG [filename] <mode> <resolution>

ExportEPS [filename] <mode> <CLEAR> <nofonts>

ExportPDF [filename]   <mode> <CLEAR>

ExportAllPDF [filename]   <mode> <CLEAR>

Explanation

For the formats that let you set resolution (dots per inch), enter 100,
300, 600 or 1200. You cannot enter other values. The default is 300 dpi.

For EPS or PDF export, set the mode to “RGB” (256 colors, default),
“CMYK” or “Grayscale” 

For TIFF export, set the mode to “RGBlow” (256 colors, 8 bits),
“RGBhi” (millions of colors, 24 bits), “CMYK” (default), “GRAY” or “MONO”.
Note that “MONO” means black and white only, with no grays. CMYK and
RGB are two ways of denoting colors.

For TIF export, include the "compress" option to save the file using
"PackBits" compression, which will make the file smaller but perhaps less
compatible. Or use the "LZW" option (Windows only) to compress using
the Lempel-Ziv-Welch algorithm, which doesn't compress quite as well as
PackBits, but may be more compatible with some programs. 
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For EPS export, choose nofonts to not include fonts. This makes the EPS
file smaller and more compatible, but requires that the same fonts be
present on the computer used to import the file. 

If your page has a colored background, you will see that background in
the exported file, unless you include the parameter "CLEAR" to export the
graph or layout with no background color (only allowed for some
formats).

For all export commands, Prism will use the SetPath location if you don't
specify disk and directory.

ExportPDF exports the current graph or layout. 

ExportAllPdf exports all the graphs (or all the layouts) into one multipage
file. 

If you use “%F” to export a file with the same name as
the imported data table, remember to append an
extension. For example “ExportWMF %F.WMF “.

21.4.17 Exporting data, results or info tables

Commands

ExportTable [filename] <ALL>

Explanation

If used from a data or results table, this command exports the entire
table. The format will depend on the extension you give the file name.
Choose from tab-delimited text (.txt), comma-delimited text ( .csv), or
Prism XML ( .xml).

If used from an info table, and the filename is a .txt file, this command
exports only the notes (and not the info constants). If the file name is an
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.xml file, then this command exports both info constants and notes. If you
want to export only info constants, use the WSheet command  instead.

If you choose the XML format, and include the ALL option, all data and
info tables will be exported.

You can also export the values in a data table or results sheet to a table
created by a script.

21.4.18 Writing to Prism, text, HTML, XML or SQL tables

Commands

Table Prism [datatable number] <CLEAR>

Table Text <&> <delimiter>   

Table CSV <’delimiter’>  

Table HTML <border #> <width #>

Table XML [filename]

Table SQL [datasource] <table > <login> <password> <CLEAR>

WTable [column title] [row] [col] <subcol>

WTable [column title] [text or %F or %N]

NextRow

EndTable

OpenOutput [“filename”] ,<CLEAR>, <”delimiter”>      

  
Explanation

These commands make it easy to export Prism results into structured
tables. The first step is to define your table. Choose to place the results
into a data table within Prism, to a text file (delimited with tabs), to a
CSV (text file delimited with commas), to a HTML (web) table, to an XML
table, or directly to a ODBC connected database. If you choose to write
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to a text, CSV or HTML file, create the file using the OpenOutput
command before creating the table. This lets you combine other
information (as explained in the next section) as well as the table. XML
output must be in its own table, so enter its file name as part of the
Table XML command.

Use the WTable command to write a value into the table. The first
argument will become the column title in the new table (or the variable
name when exporting to a database). The next three arguments define
the cell on the current results (or data) table that will be written to the
new table. Or enter text to just space columns apart, or %N to put in the
loop number or %F to put in the current file name.

Note that the Wtable command has a name that can be misleading. It
writes a single value (or text string) to a table. The command does not
write an entire table. If you want to write an entire results (or data)
table, use the WSheet command . 

In almost all cases, you’ll create a table as part of a loop. The Next
statement that ends the loop also starts the next row on the table. When
the loop is complete, so is the table. In rare circumstances, you might
not want the end of a row to correspond with the Next statement of a
loop. In this case, end a row with the NextRow statement, and close the
table before the loop ends with the EndTable statement.

21.4.19 Writing to text files

Commands

OpenOutput [“filename”] ,<CLEAR>, <”delimiter”>        

WText <"text"> <;&>

WDate <;&>

WTitle  

WCell [row], [col], <subcol> <;&>

WRow [row], <col>, <subcol> <;&>

WCol [row], <col>, <subcol><;&>

639



GraphPad Prism 8 User Guide640

© 1995-2020 GraphPad Software, LLC

WSheet <row, col, subcol><;&>        

WBlock [row(s)]  [column(s)] <row label> <;>

WTCol [row, col] <, subcolumn><;&>

WTRow [row] <,col, subcol> <;&>

WTSheet <row, col, subcol><;&>

WTBlock [row(s)]  [columns to include] <row label> <;>

WVersion

CloseOutput

Explanation

Prism offers two methods for writing results from a script. The previous
section explains how to write tables. A more general method, writing to a
text file, is explained here. Generally, you’ll find it easier to write to
tables (previous section) but may find uses for  the extra flexibility of
writing to text files.

The first step is to use the OpenOutput command to open (or create) a
file to contain the text the script will output. If you don't precede the file
with disk and directory, Prism will use the path defined in SetPath. If
there is no SetPath command, then Prism assumes that you want to use
the directory that contains the script. If you include a delimiter, say “,” it
will appear between entries. Otherwise the output file will be delimited
with tabs.

If the output file already exists, Prism appends to that file unless you
have included CLEAR.

Results will be tab delimited unless you include an alternative delimiter in
the OpenOutput statement.

Examples: 

OpenOutput C:\gp25\output.txt, Clear

OpenOutput C:\data\july97, “,”

You can write (export) data and results to the text file using any of the
commands that begin with W (or by creating a text or CSV table as
described in the next section).

If you end any of the W commands with a semicolon, the next W
command will add text to the same line, following a tab. If you end with
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an ampersand (&), the next W command will add text to the same line,
without a tab. If you omit the semicolon or ampersand, Prism inserts the
codes for carriage return and line feed so the next W command will write
to the next line in the file.

The most useful W command is WCell which writes out the contents of
one cell in a data or results table. You need to specify the row and
column of the cell to write. Row 0 refers to the row of column titles, and
row 1 is the first row of data. Column 0 refers to the X column, and
column 1 is the first Y column (column A).

You can also write out entire rows or columns, or the entire sheet, at
once. The commands that begin with WT transpose the data (so each
row becomes a column) before writing to the text file.        

WVersion writes the version of Prism you are using, to fully document
your results. 

Note that the WTable command is distinct  from the set of commands
described here, despite the fact that it begins with the letter W. 

Read more about WBlock and WTBlock . 

Variables

Use the following variables when writing text:

· %D   Date and time this file was last saved, e.g. "Tuesday, September
16, 2014 4:08:10 PM"

· %P   File name of the Prism project

· %S   Sheet name

· %V   Prism version
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21.4.20 The WBlock and WTBlock commands

These commands were introduced in GraphPad Prism 6.04 and 6.0e. The
idea is to specify a block (range) of cells to write to a text file already
specified in an OpenOutput command.

 WBlock script command

Syntax:   WBlock [row(s)]  [column(s)] <row label> <;>

Rows 

The parameter for rows can designate a single row, a row down to a blank
row, a range of rows , or a list of rows which can be in any order.  You
must have used the OpenOutput script command first to specify where
the results will be written.

What you
enter

How Prism interprets it

7
Only row 7. Of course, row 7 is the row labeled with a 7 in
front of it, so row 0 is the column titles.

“7” Only row 7

“7-“ Start at row 7 and keep going until you hit a blank row

“7-12”
Start at row 7 and end at row 12. Note that the second
number is the ending row, not the number of rows.

“7, 11, 9,
8”

Specified rows in that order.

 
Columns

The parameter for columns can designate a single column, a column
across until an empty column, a range of columns, or a list of columns
which can be in any order.  You must have used the OpenOutput script
command first to specify where the results will be written.

What you
enter

How Prism interprets it

3
Only column 3. The column of row titles (if it exists) is column
0. Column 1 is column A, but for some results there are no A,
B, C column labels.

“3-3”
Only column 3. The column with titles is 0, so in the example
above, this is the “significant” column

“3” Only column 3. 
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“3-“
Start at column 3 and keep going right until a column is empty
(or the end of the table).

“3, 4” Columns 3 and 4

“3-6” Columns 3, 4, 5 and 6. 

“3, 8, 4”
Columns 3, then 8 then 4. Note that the order in the results
will not match the order in the Prism table.  Also note that I
included spaces after the commas which are ignored.

“3,8,4” “

 
Row label

The parameter row label would must be quoted text. That text will appear
as the first item in every row output. If the WBlock command ends with a
semicolon, then there is no delimeter (no tab, no space, no comma) after
that text. If there is no semicolon, then the row label text is separated
from the next column just like all the columns are separated (tab unless
an alternative is specified in OpenOutput command).  If there is no row
label (as it is an optional parameter), then a semicolon at the end of the
command is ignored and has no impact. 

 

WTBlock script command

The WTBlock command has the same syntax as WBlock. Note that the
label is applied to each row as output (which is each column in the Prism
table)

    WTBlock [row(s)]  [columns to include] <row label> <;>

Examples

Here are results of one way ANOVA followed by Dunnett's test from Prism
6.04 (the results show two new columns that were not in prior releases):
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The results are shown here as tables. In fact, they will be tab-delimited
text (or comma delimeted, if that is set in the OpenOutput command).

Example 1

WBlock "7-", "6,4", "PSummary"
WBlock "7-", "6,3", "Significant?"

The results will be as shown below. Here it is a table. In fact it will be tab
delimited text. (The delimeter is set in the OpenOutput script command,
and defaults to tabs).

Psummary B ****
Psummary C ns
Psummary D *
Psummary E ns
Significant? B Yes
Significant? C No
Significant? D Yes
Significant? E No
 
Example 2

WBlock "7-", "6,4", "PSummary";
WBlock "7-", "6,3", "Significant?";

The results will be as shown below. Note the semicolon after the labels,
so in both cases the label and the columnID column run together.         
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PsummaryB ****
PsummaryC ns
PsummaryD *
PsummaryE ns
Significant?B Yes
Significant?C No
Significant?D Yes
Significant?E No

Example 3

WBlock "7-", "7,4", "PSummary"
WBlock "7-", "7,3", "Significant?"  

Here there is no semicolon, so the labels have their own column.

Psummary Treated
***
*

Psummary
Treated+Anta
gonist

ns

Psummary
Treated+Agon
ist

*

Psummary Solvent Blank ns
Significant? Treated Yes

Significant?
Treated+Anta
gonist

No

Significant?
Treated+Agon
ist

Yes

Significant? Solvent Blank No

Example 4

WTBlock "7-", “7,3,4”
 

Treated
Treated+Antagonis
t

Treated+Agonist Solvent Blanks

Yes No Yes No

*** Ns * ns

 
Example 5

WTBlock, “7-“, 3, “Significant?”
 

Yes No Yes No
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Significant?
 
Prism file
 

21.4.21 Send to Microsoft Office

Commands

SendToWord

SendToPP

Explanation

These commands send the current graph or layout to Word or
PowerPoint.

21.4.22 Special purpose commands

Commands

SetProjectName [“new name”]

SetScriptDialogTitle [“dialog title”]

RecalcAll

Beep

Createlog

SetSheetTitle [new_name] <K>

CloseScriptDialog

Print

Exit

http://cdn.graphpad.com/faq/1893/file/1893.pzf
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Explanation

Use the SetProjectName command to change the name of the project
file (the name it will have when next saved) and the
SetScriptDialogTitle command to change the wording of the dialog that
shows while the script is running (only useful if you are creating scripts
to be used by others).

If you are opening a file created by a prior version of Prism, and saved in
the large format (which includes analysis results) the RecalcAll
command will tell Prism to recalculate all the results.

If you script takes a long time to complete, you might want to use the
Beep command to alert you when the script is complete.

If you run a script from the script dialog, every step is logged in the
second tab of the dialog. In this case, the CreateLog command is
ignored, as the log is always created. If you run a script from a file, the
CreateLog command starts logging every step into a file with the same
name as the script file, but the extension .log.

SetSheetTitle renames the sheet. If you specify K, the first K characters
of the sheet name are retained, and the rest is renamed.

The Print command prints just the current sheet.

The Exit command closes all open files, without saving and without
prompting to save, and exits Prism. It works on Windows only.
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21.5 Running a Prism script

There are several ways to run a Prism script. While

testing and developing a Prism script, run it from

Prism. Once you perfect it, you may want to run it

from the command line or from another program as

explained in this section.



Scripts 649

© 1995-2020 GraphPad Software, LLC

21.5.1 Creating and running a script from Prism

Creating and running a Prism script within Prism

While testing and developing a Prism script, run it from Prism. Once you
perfect it, you may want to run it from the command line or from another
program as explained later.

Creating a script

To create a script within Prism:

1
.

Click the Prism button (or drop file menu) and choose Run Script

2
.

Choose to make a new script

3
.

Choose to start with a blank screen, or to start with a copy of an existing script.

4
.

Enter or edit the script on the left side of the GraphPad Prism Script dialog. Use
the right side to review script syntax.

5
.

Repeatedly click ‘1 step’ to step through the script. You can watch the result in
Prism, as well as observe the script log.

6
.

Click “12 steps’ if you are feeling lucky.
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7
.

Click ‘Run” when you are convinced the script will run without error. The Script
dialog will minimize, as will Prism, while the script runs.

Editing a script
1
.

Click the Prism button (or drop file menu) and choose Run Script

2
.

Choose one of the scripts listed in the menu. Or choose Open Script file to open a
script in an external file.

3
.

Follow steps 4 through 7 above.

21.5.2 Run a script  using Automator, MacScript, or AppleScript

Run a script using Automator

If you use OSX 10.4 (“Tiger”) or later, Prism installs an Automator Action
that lets you launch a Prism script. The inputs to this Action is either a file
containing a Prism script, or the text of the script itself. The output is
either the word “Done” or an error message.

Run a script from Microsoft Office using MacScript

MacScript commands let you launch Prism from Word or Excel. These
examples assume you are running Visual Basic for Applications (VBA)
from within Excel.

Launch Prism with this MacScript command.

MacScript “tell application “”HD:Prism4:Prism””” + Chr(13) +
_

“activate” + Chr(13) + _

“open file “”Macintosh HD:Prism4:Scripts:dr2””” + Chr(13) +
_

“end tell”

The MacScript command has to specify both the full location of Prism and
the script that Prism will launch. The MacScript command is a Visual Basic
statement that you will need to write in an Excel macro, perhaps one that
runs when the user clicks a button.
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As soon as Visual Basic has launched Prism, it will continue to the next
statement in the Visual Basic program or macro. It will NOT wait for Prism
to complete before continuing. If you don't take the extra steps described
below, your Visual Basic program will try to read a file containing Prism’s
results before Prism has finished creating that file. To avoid this, make
your Visual Basic program pause until Prism creates a file.

When you write the Prism script, include lines at the end of the script to
create a file that will tell Visual Basic you are done. The example below
creates done.txt.

OpenOutput "done.txt"

WText "done"

CloseOutput

Your Visual Basic code should first delete the file done.txt (if it exists from
a previous run) and then launch Prism. Immediately following, include
these lines that make your program loop until done.txt is created.

Do Until Dir$(“HD:prism 5:done.txt") > "" 

Application.Wait Now + TimeValue("00:00:1")

Loop

The first line in the example above checks whether the file done.txt
exists. Change the path and file name as needed. If the file exists (Prism
is done), Visual Basic continues beyond the loop with any code that
follows. If the file doesn't exist yet, Visual Basic waits 1 second, and then
loops back to test again whether the file exists.

MacScript “tell application “”HD:Prism4:Prism””” + Chr(13) +
_

“quit” + Chr(13) + _

“end tell”

 
Run a script from AppleScript

Here is a sample AppleScript that launches Prism and tells it to run the
script named DR2 located in the P4scripts folder on a disk named HD.

tell application "HD:Applications:Prism4 Folder:Prism"
   activate
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   open file “HD:P4scripts:DR2.pzc”
end tell

Note that are two ways to specify the path. The example above uses a
HFS path. Here is the same example using a POSIX path.

 tell application "HD:Applications:Prism4 Folder:Prism"

   activate

   open POSIX file “/P4scripts/DR2.pzc”
end tell

With the Posix style, you use slashes (not colons) and must have the
opening slash.

 

21.5.3 Launching a Prism script from outside Prism (Windows)

One way to launch a script is from within Prism (drop the File menu and
choose Run Script). You can also launch a Prism script from outside
Prism. When you launch Prism this way, if the script closes all open Prism
files, then Prism will shut down when the script ends. Otherwise Prism will
remain open.

Launching a Prism script from a desktop icon

To create an icon that launches a Prism script, point your mouse to an
empty spot on the desktop, click the right mouse button and select New…
Shortcut. Enter a command line that starts Prism and points to the Prism
script file to launch. Include the @ symbol in front of the path to the
script name. If either path includes spaces, include the entire path in
quotes as shown below:

“C:\PRISM5\PRISM.EXE” @”C:\PROGRAM FILES\PRISM 6\SCRIPTS\DOIT.PZC”
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Shelling to Prism from another program

To "shell" simply means to launch one program from another. Here is an
example of a shell command in an Excel VBA macro.

Shell ("C:\prism 5\prism.exe @C:\prism 6\dr2.pzc")

The shell command has to specify both the full location of prism.exe and
the script that Prism will launch. Include the @ symbol in front of the
script name.

Two important notes:

· Prism will run invisibly. Even when it is done, Prism will not show on
screen.

· As soon as Visual Basic has launched Prism, it will continue to the next
statement in the Visual Basic program or macro. It will NOT wait for
Prism to complete before continuing. If you don't take the extra steps
described below, your Visual Basic program will try to read a file
containing Prism’s results before Prism has finished creating that file. To
avoid this, make your Visual Basic program pause until Prism creates a
file, as explained below.

When you write the Prism script, include lines at the end of the script to
create a file that will tell Visual Basic you are done. The example below
creates done.txt.

OpenOutput  "done.txt"
WText "done"
CloseOutput

Your Visual Basic code should first delete the file done.txt (if it exists from
a previous run) and then launch Prism. Immediately following, include
these lines that make your program loop until done.txt is created.

Do Until Dir$(“C:\prism 6\done.txt") > ""  
Application.Wait Now + TimeValue("00:00:1")
Loop

The first line in the example above checks whether the file done.txt
exists. Change the path and file name as needed. If the file exists (Prism
is done), Visual Basic continues beyond the loop with any code that
follows. If the file doesn't exist yet, Visual Basic waits 1 second, and then
loops back to test again whether the file exists.



GraphPad Prism 8 User Guide654

© 1995-2020 GraphPad Software, LLC

Launching Prism from another program using OLE automation

An alternative to the Shell command is to launch Prism using OLE (or
Active X) automation. Here is an example.

Set Prism = CreateObject("Prism.command")
Prism.SetPath (”C:\data\july99”)
Prism.visible
Prism.runcommand (“c:\prism5\doseresp.pzc")
Prism.quit
Set Prism = Nothing

The first line creates a Prism command object. You may give the object
variable any name you like (on the left side of the = sign), but it is
convenient to name it Prism. You don’t have to tell the program the
location of prism.exe. Windows takes care of this automatically via the
registry.

The second line, which is optional, tells Prism which folder to use. This
replaces the need for a SetPath statement within the Prism script. When
running a script, Prism looks for data files and templates in this directory
(folder) first. Place the name of the folder in quotation marks or use a
text variable. 

The third line tells Prism to show its progress dialog. Once you have
tested your code, remove this line so Prism will run invisibly (show no
dialogs).

The fourth line launches the Prism script. You must include the full path of
the script file; the directory used in the SetPath message (above) is not
used automatically.

The final two lines cause Prism to exit, and free the memory used by the
Prism object.

Shell command vs. VBA automation

There are two advantages to using OLE automation, rather than the Shell
statement. First, with OLE automation Visual Basic and Prism run
sequentially, with no possibility of Visual Basic trying to obtain results
that haven't been created yet. Second, with OLE automation, your Visual
Basic program can direct Prism to import data from a particular folder
(Prism.SetPath command) without changing the Prism script.

Launching a script from an intranet web page (Windows)

You can launch Prism from a link on an intranet web site.
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First, create a batch file on your web server that calls (using the Call
command) the program and individual configuration files.

For example, create a file called StartPrism.bat containing a single line
something like this

Call “N:\Program Files\PRISM5\PRISM.EXE” -OC:\WINDOWS\prism5.cnf

Or this:
Call F:\Prism\Prism.exe @"F:\PRISM\PRISMSCRIPTS\DOIT.PZC"

Of course, you'll need to adjust this example depending on where you
have installed Prism. The drive letters are aliases for the server drive. In
the first example, the first part opens Prism and the second part tells
Prism where to find the configuration file. In the second example, the
second part launches a Prism script.

Next edit your web page to include a hyperlink to the batch file. For
example, HTML link the text "Prism" to the file StartPrism.bat

21.5.4 Using Prism scripts with Excel

Exporting data from Excel to Prism

Although Prism can open Excel files, this is slow. Instead, write a Visual
Basic macro to export selected values as a text file. The macro below,
run from Excel, exports the upper left corner of worksheet 1 (12 rows, 6
columns) to a comma-separated value (CSV) file, which Prism can
import.

Open  "C:\data\july97\dr2.csv" For Output As #1
For I = 1 To 12
For J= 1 to 6
   Print #1, Worksheets(1).Cells(I,J).Value; ",";
Next
Write #1,
Next
Close #1

Follow this with code to launch Prism, run the Prism script, and perhaps
import results from Prism back to Excel.
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Creating a PZC (Prism script) file from Excel

While creating a system to run Prism from Excel, you need to edit both
the Excel VBA statements and the Prism PZC script. One way to simplify
your work is to write Visual Basic code that exports the PZC file from
Excel. Then you only have to edit one file. For example, you could use
the following VBA code:

Open  "C:\Prism4\auto.pzc" For Output As #1

Print #1, “Shortlog”

Print #1, “SetPath C:\gp\prism25\”

Print #1, “Open generate.pzm”

Print #1, “openOutput fit.txt”

Print #1, “   ForEach 500”

Print #1, “    GoTo R 1”

Print #1, “    Regenerate”

Print #1, “    GoTo R 2”

Print #1, “    WCell 5,1”

Print #1, “ Next”

Close #1

Shell ("C:\program files\prism5\prism.exe  @C:
\prism5\auto.pzc")

The first line starts a new file called auto.pzc and designates it as file
number 1. The next 10 lines, export Prism script commands you have
written into that file. The next line closes the script file, which is
launched by the final line shown above. Further lines would import the
results exported by Prism.

Putting all the commands into one file doesn't help conceptually. You still
have to distinguish the VBA code within Excel from the script commands
of Prism. The advantage is that you can do all the editing within one file,
rather than two. The disadvantage is that writing the script is a bit
harder, as you have to place each line in quotations and precede it with
"Print #1,".
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Putting Prism graphs into Excel

In addition to importing the results of Prism analyses, you may want to
import a Prism graph into Excel. Exporting the graph is no problem, as a
Prism script can export a graph or layout as a WMF picture. The problem
is importing it into Excel, as there is no way to write Visual Basic
commands to import a picture. You can do it indirectly. Create a picture
object manually in Excel (display the control toolbar, click on the image
button, then drag to create the object). Then write Basic code to change
the contents of that picture object. For example,

Sheet2.DRGraph.Picture = LoadPicture(Path$ + "dr2.wmf")

21.5.5 How long can a script be?

The maximum size of a script is not limited by number of lines, but rather
by number of characters. The limit is 64,000 characters. If you hit this
limit, consider removing comments and blank lines. Also consider
removing any parts of the script that are not needed. For example, most
script commands have default parameters and if these are correct, you
don't need to hard code parameters. 
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22 Standardizing Prism use in a lab

If many people in your lab use GraphPad Prism,

you may want to standardize some preferences or

provide all with a set of templates or equations or

color schemes. This section explains how to do so.
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22.1 Locking the preference file

What is included within the preferences file?

Prism offers many choices on its Preference dialog. It allows you to set
defaults for color schemes, fonts, symbols sizes, graph units, and more.
Beyond that, the Prism Preferences file remembers which files you have
recently opened or closed, user-defined equations you have created, color
schemes you have created, autocomplete text, and more. All that is
saved in a preference file that customizes Prism for you. 

Where is the preference file located?

Windows XP:

[system disk]:\Documents and Settings\[user] \Application data\GraphPad Software\Prism\8.0\Prism8.cfg

Vista and Windows 7-10:

[system disk]:\Users\[user]\AppData\Roaming\GraphPad Software\Prism\8.0\Prism8.cfg

Mac:

 ~[local user]\Library\Preferences\ com.GraphPad.Prism.plist

With older versions of OSX, you can locate the file using Finder and drag
it to the trash. Since Lion, the file is invisible. To delete it, launch the
Terminal application, and enter this command:

             rm ~/Library/Preferences/com.GraphPad.Prism.plist

How to prevent saving changes to the preferences file: Windows

When Prism is used in a teaching lab, you want Prism to startup the same
way each time. When a student uses Prism, you don't want preferences
set by other students to be used, as that would make it seem that Prism
acts unpredictably. 

The first step is to create and write-protect the preference file. 

1. Delete the Prism preference file, Prism8.cfg from:

   [system disk]:\Users\[user]\AppData\Roaming\GraphPad
Software\Prism\8.0  
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2. Launch Prism so it creates a default preference file.

3. Set any preferences as you want them to appear for each user.

4. Create any color schemes you want everyone to have access to, as well
as user-defined equations you want everyone to access.

5. Quit Prism. Now the preference file is saved.

6. You might wish to write-protect the preference file to make sure it isn't
changed in the future.

The second step is to add /C to the Prism command line , to tell Prism
not to resave the preference file when it exits.

Individual users will still be able to make changes to the Preference file,
and these will be used during that session. But those changes won't get
saved and so won't be seen by the next user.   

How to prevent saving changes to the preferences file: Mac

When Prism is used in a teaching lab, you want Prism to startup the same
way each time. When a student uses Prism, you don't want preferences
set by other students to be used, as that would make it seem that Prism
acts unpredictably. 

The method explained above for Windows doesn't work, because there
are no command line switches in OSX. Instead, create and write-protect
the preference file. 

1. Delete the Prism preference file, com.GraphPad.Prism.plist, from:

        ~[local user]:Library:Preferences   

2. Launch Prism so it creates a default preference file.

3. Set any preferences as you want them to appear for each user. Also
create any color schemes or user defined equations you want everyone
to access.

4. Quit Prism.

668
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5. Write protect the preference file:

Open the folder that contains the preference file 

    : ~[local user]:Library:Preferences

Beware that Macs have multiple Library folders. Pick the one within the
local user that each student will log in as, not the overall Library folder. 

Right-click on the file "com.GraphPad.Prism.plist", and choose Get Info.
Check "Locked".  

Repeat for the file that contains the list of autocomplete text entries: 
com.GraphPad.Prism.autocomplete.plist

22.2 Individual preference files

Prism stores the list of user-defined equations, choices from the
Preferences  dialogs, the list of recently used files, and more in a
configuration file.

Prism Windows stores preferences in the file Prism8.cfg. Prism Mac stores
preferences in a file named “Prism6 Preferences”. The location of these
files depends on which version of Windows or the Mac OS you use, so
search for them.

If several people use the same Windows computer, each may wish to
maintain their own preferences and equations. To do this, create a
different shortcut icon for each user. In the target portion of the
properties dialog for the shortcut, enter the full path name of the Prism
program followed by “-O” (letter O, not zero) and then the full name of
the configuration file you want to use. If the file doesn't exist, Prism will
create it. For example:

C:\Program Files\PRISM8\PRISM.EXE -OC:\JERRYS\JSPRISM.CNF

If you are running a network license, you may place the Prism6.cfg file
into the program folder on the shared (server) drive. When Prism is first
used on a new computer, it will use the settings in this shared
configuration file. Changes will be saved on the individual user’s hard
drive. This means that all users can begin with the same settings, but
then customize them..

194
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22.3 Shared templates, methods, and examples

You can ensure that everyone using Prism sees the same templates ,
methods  and examples . Create them on one computer, and then
move the files to the other computers you manage. To do that, you need
to know where the files are stored.

Templates

Templates  are complete Prism files that you'll see listed on the Open
File tab of the Welcome (File..New) dialog. You can tell Prism where to
save templates in the File Locations tab of the Preferences dialog. The
default locations are listed below. 

Prism saves templates in:

[[system disk]:\ProgramData\GraphPad Software\Prism\8.0\Templates\[templates category folder]

Prism Mac saves these files in:

Users/[User]/Library/Application Support/GraphPad/Prism/8/Templates/[templates category folder]

 Methods

A method file  contains a data table and linked analyses and graphs.
When you apply a method, using the Wand (Wizard to Analyze Data),
those analyses and graphs are attached to a new data table.

 Prism saves methods in:

[system disk]:\ProgramData\GraphPad Software\Prism\8.0\Methods\[methods category folder]

Prism Mac saves these files in:

/Library/Application Support/GraphPad/prism/8/Methods/[methods category folder]

Examples

An example file is a Prism graph with linked data and analyses. You
clone  an example from the Clone A Graph tab of the Welcome dialog. 

Saved examples

Prism Windows XP saves examples in:

[system disk]:\Documents and Settings\[User]\Application Data\GraphPad Software\Prism\8.0\Examples\[examples category folder] 
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On Vista or Windows 7, Prism saves examples in:

[system disk]:\Users\[User]\AppData\Roaming\GraphPad Software\Prism\8.0\Examples\[examples category folder]

Prism Mac saves these files in:

/Users/[User]/Library/Application Support/GraphPad/prism/8/Examples/[examples category folder]

Shared examples

The Welcome (File..New) dialog cloning tab offers a separate tab for
shared examples. These are intended to be examples created in a lab to
be shared with everyone in a lab. The only way to show graphs on this
tab is to manually move filed from the saved example folder to the shared
example folder. 

On Windows XP, Prism looks for shared examples in:

[system_disk]:\Documents and Settings\All Users\Application Data\GraphPad Software\Prism\8.0\Examples\

On Windows Vista or Windows 7, Prism looks for shared examples in:

[system_disk]:\Users\All Users\GraphPad Software\Prism\8.0\Examples\

Prism Mac looks for shared examples in:

Library/Application Support/GraphPad/prism/8/Examples

Prism Mac also looks for shared examples within the application bundle: 

[Prism.app]/Contents/SharedSupport/Examples

Providing online Help for methods and templates

When you save the template or method, enter a brief description. If you
want to provide more extensive help to your users, also create a web
(.htm) file that explains use of the template or method. Give it the same
name as the template or method, but with the extension .htm, and place
it in the same folder. For example, if your template is doseresponse.pzt,
create a help file named doseresponse.htm. When someone uses the
template or method, Prism will pop up the dialog with the brief
instructions. This dialog also has a button “Help for this template”. When
your uses click this button, Prism will launch a web browser to display the
.htm file you created.
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22.4 Adding your own built-in equations

Prism makes it easy to add your own equations, and these will appear in
the "User defined equations" group of equations. But if you want to share
a set of user-defined equations with others in your lab, you can create a
new group of equations that will appear underneath the ones we provide. 

How to create new Equation files:

1. Start a new Prism project. Go to preferences, file and printer tab, and
make sure that you are saving in .pzf format and that the "Save
compact" option is not checked.

2. For each equation, either fit a data set with nonlinear regression or
simulate a theoretical curve (plot a function). Reorder the results pages
to the order you want the equations displayed in the equation list.

3. If a user picks your equation and clicks 'Details' they will see a small
preview of the graph that is linked to the equation. Make sure this
graph is easy to comprehend at small sizes.

4. When entering each equation, also consider entering a description and
tip. The tip appears on the Fit tab of nonlinear regression. The
description appears on the Details page.

5. When saving your equation, use a name something like this: "[Smith
Lab] Flow cytometry equations", so it is very clear to anyone using
Prism that these equations did not come from GraphPad (we won't be
able to answer questions about them).

6. Note that each file you create will become a "folder" of equations in
Prism. You'll want each file, therefore, to include several equations. 

How to make those equations appear with the list of built-in
equations:

· Windows: Move (or save) the files to the Equations folder within the
Prism program folder.

· Mac: Find the Prism.app file. Right (or control) click and choose Show
Package Contents. You'll see the "folders" within the package. Drill down
to Contents: SharedSupport:Equations. Move your equation files there.
Note that by changing the prism.app file (bundle) you have changed its
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digital signatures. So you'll need to configure Gatekeeper to let Prism
run anyway.

· Both platforms:  Please do not delete any equation files that came with
Prism. They are "built in" so should always be available (to prevent
confusion later).

If Prism is running, quit (exit) it, then restart it. You'll now see your list of
equations in the Fit tab of nonlinear regression.

Editing those equations is a bit tricky. Quit Prism, and move the file out of
the Equations folder. Now restart Prism, open the file and edit it. When
done, save your changes and quit Prism. Finally, move the file back to the
Equations folder, and restart Prism.

Don't worry about .pze files

For every "built-in" equation file, Prism creates a .pze file. These files
contain, essentially, compiled equations and so let Prism load the
equations more quickly. With Windows, you'll find these deep in the
Application Data folder. With Mac, they are deep in the Application
Support folder and also in the Cache folder in the Equations folder in the
Prism bundle. 

You don't need to manage these files, and shouldn't try to. Prism will
automatically create  and update the needed file when necessary.

22.5 Using a local LabArchives server

LabArchives usually uses a server maintained by LabArchives.

If you want to use a local server to host LabArchives files, you can do so.
Details here. 

http://graphpad.com/support/faq/how-to-configure-prism-to-communicate-with-a-local-labarchives-server/
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23 Support and license

Prism makes it easy to get the support you need.

This section tells you about the Prism license

agreement and how to contact our support

department.
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23.1 Installing Prism

Installing for one person

Installing Prism is standard and easy. 

On Windows, simply run our .MSI installation program by double-clicking
on the file. The single installer will install either the 32- or 64-bit version
of Prism depending on which version of Windows you use.

On a Mac, drag the Prism application file to your Applications folder.

Installing for many people

We offer some shortcuts to help IT people installing Prism for many. Read
the details in this document: 

Installing GraphPad Prism 8 for Many - A guide for IT staff

23.2 System Requirements

Prism 8 for Windows

· Runs under either the 32- or 64-bit versions of Windows Vista, 7, 8 or
10. The installer will detect your version of Windows and install the 32-
or 64-bit version of Prism accordingly.

· Requires a display resolution of at least  800 x 540 pixels. So the lowest
standard display resolution for Prism is 800 x 600.

· Requires about 100 MB (megabytes) of space on the hard drive.

· Must connect to the internet to verify the license when it is first
activated and also at at least once every 30 days (or every 20 launches,
whichever comes sooner).

http://cdn.graphpad.com/docs/prism/How-to-Install-Prism-A-Guide-for-IT-people.pdf
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Prism 8 for Mac

· Runs under macOS X 10.9 (Mavericks) or later. If you use macOS 10.8,
Prism will launch and seems to run OK, but we haven’t tested Prism
thoroughly under this version of macOS and can’t provide much
support. If you use 10.8, we urge you to update MacOS.

· The most recent versions of Prism 8 have been updated to be
compatible with macOS X 10.15 (Catalina). If using macOS X 10.15, be
sure to update Prism to the most recent version.

· Requires a display with a resolution of at least 1024 x 768 pixels.

· Requires about  130 MB (megabytes) of space on the hard drive.

· Must connect to the internet to verify the license when it is first
activated and also at at least once every 30 days (or every 20 launches,
whichever comes sooner).

23.3 Fire wall settings

Prism tries to connect to the internet with every launch, and must
succeed at least every 30 days or 20 launches (whichever comes first) to
conform the validity of the license. Once it hits those limits, it displays:

"You are currently offline. Prism must connect to the internet at least
once every 30 days to validate your license. Please connect to the
internet and launch Prism again."

If you are getting this message even though you computer is connected
to the internet, perhaps you have a firewall that prevents Prism from
communicating with the internet. Prism uses port 443, which is the same
port that web browsers use when browsing securely (https:), but it is
possible that your IT people configured your firewall so that web browsers
(and email programs...) but not Prism can use that port. If that is the
case, they will need to change the firewall settings. 

23.4 Command line switches (Windows only)

When Prism starts up, you can give it some special instructions in the
command line. In order to add command line instructions, edit the
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Prism.exe start icon. Right click on the Prism desktop icon and In
Properties change the target to add the command after the last quote
mark. Leave a space between the quote mark and the slash, so the target
looks like this:

"C:\Program Files\GraphPad\Prism8\prism.exe" /U

You can use hyphens or slashes (-U and /U) interchangeaby. 

All of the options shown below also work if you use the Shell command to
launch Prism from another program using Visual Basic for Applications
(VBA).

These options only work on Windows. There is no similar mechanism for
sending startup commands to Mac applications.

Run prism script - @[some_prism_script_file_path]

To create an icon that launches a specific Prism script, point your mouse
to an empty spot on the desktop, click the right mouse button and select
New… Shortcut. Enter a command line that starts Prism and points to the
Prism script file to launch. Include the @ symbol in front of the path to
the script name. If either path includes spaces, include the entire path in
quotes as shown below:

"C:\Program Files\GraphPad\Prism5\prism.exe" @"c:\program files\GraphPad\Prism8\scripts\doit.PZC"

Turrning off check for update - /U

When Prism (Windows) first starts, it tries to check for updates via the
web. If it can't connect, it normally just keeps going. But in very rare
cases, it tries to check for updates and then can't get past this step so
never gets to the Welcome dialog. This is quite rare, but easy to work
around. One way to get Prism to stop check for updates is to use the /U
switch when starting Prism.

Edit the Prism start icon so that the target looks something like this (with
quotes around the path, but not around the /U, and a space beteween the
quotation mark and the slash):

"C:\Program Files\GraphPad\Prism8\prism.exe" /U

Create log  - /L
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If Prism will not start at all, it can help to create a start log. This will show
us which steps Prism completes successfully and which steps fail. To
create a log, edit the Prism start icon to add the /L switch so the target
looks looks something like this (with quotes around the path, but not
around the /L, and a space between the quotation mark and the slash):

"C:\Program Files\GraphPad\Prism8\prism.exe" /L

Regenerate PZE files (prism equations cache) - /E

The "built-in" equations are actually installed as a set of Prism files. You
can even add your own "built-in" equations. The first time Prism runs, it
compiles these equations to a form (.PZE files) that it can access and
compute very quickly. It should never be necessary, but you can force
Prism to compile all the equations again. To do so, edit the Prism start
icon to add the /E switch so the target looks something like this (with
quotes around the path, but not around the /E, and a space between the
quotation mark and the slash):

"C:\Program Files\GraphPad\Prism8\prism.exe" /E

Print file - /P [file_path]

You can create an icon that will open a Prism file and print all pages. Edit
the Prism start icon to add the /P switch so the target looks like this.
Please note space between /P and [file_path]. Prism prints silently,
without Prism appearing in the taskbar.

"C:\Program Files\GraphPad\Prism8\prism.exe" /P c:\test.pzf

Use custom option file  - /O [prism_cfg_file_path]

Prism stores many settings in a preference file (also called an options
file). This file contains all the settings in the Preferences dialog, a list of
recently used files, user-defined equations, color schemes and more. You
can use a startup option to force Prism to access the preferences file from
a different location. This might be useful if you use Prism for several very
distinct uses, and want a separate set of preferences for each. It would
also be useful if different people use Prism, and each wants unique
preferences, but they all want to log in to Windows as the same User. To
tell Prism to use a unique preference file, edit the Prism start icon to add
the /O switch so the target looks like this. Please note the space
between /O and [file_path].
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"C:\Program Files\GraphPad\Prism8\prism.exe"  /O c:\gsconfig.cfg

Don't save preferences - /C  

Prism stores many settings in a preference file (also called an options
file). This file contains all the settings in the Preferences dialog, a list of
recently used files, user-defined equations, color schemes and more. You
can use a startup option to tell Prism to not save any changes to the
preferences file. This is useful in a teaching lab, or a shared computer, so
Prism will always start with the same preferences.

"C:\Program Files\GraphPad\Prism8\prism.exe" /C

 

23.5 Technical support

Check for program updates

Like all software companies, GraphPad occasionally issues minor updates
to Prism. The full version number is not on the CD. Instead, drop the Help
menu and choose ‘Check for updates’. 

Check for answers on graphpad.com

If you can’t find the answers in these help screens, please visit our
support web site. We update the Quick Answers database almost every
week, and the answer to your question is very likely to be there.

Personal support

Drop the Help menu and choose Personal support command. Prism will
instruct your email program to create a new email, automatically
including your version and serial number, and attaching (if you choose)
the file you are working on.

If the Personal support command does not work on your computer (or you
use a Mac) email us at support@graphpad.com . 

Please send:

· The version of Prism you are running and if you are using Prism for
Windows or for Mac. To find the version number, drop the Help menu
(Windows) or Prism menu (Mac OS X) and choose About Prism.
Windows versions have two digits after the decimal point (i. e. 8.01).

http://www.graphpad.com/support
mailto:support@graphpad.com
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Mac versions have a single digit after the decimal followed by a letter (i.
e. 8.0b). Send us the actual version number (which you can see on the
Welcome dialog when you start Prism. Don't say something ambiguous
like "Prism 8" or "the latest version". 

· In most cases, a problem is best demonstrated by attaching a particular
project (.pzf) file to your email. Please make the project small and
focused. If you are having a problem with one graph, send us a project
with one graph, not 100. 

· If you saw an error message, send us a screen shot or the exact
wording you saw. 

· Send screen shots when that would help us understand the problem.

· Don't send raw data in the text of the email and expect us to paste this
into Prism, reproduce what we think you might have done, and then
comment on what we see which may or may not be what you see.
Similarly don't send data in Excel files. 

We provide support for Prism, not statistical consulting

Your Prism license does not include free statistical consulting. Since the
boundary between technical support and statistical consulting is often
unclear, we often will try to answer simple questions about data analysis.
But don't push your luck! While we are often willing to look over a
completed analysis to offer our thoughts, we won't analyze your data for
you.

No phone support

We've discovered that we can provide much better support by offering it
via email only. We know that some companies use "email only" as a way
to brush off customers and avoid providing support. We are not like that.
We really do provide individual, helpful answers to your email questions,
often within an hour or two.

GraphPad doesn't offer telephone support for several reasons.

· Our customers live all around the world, but we're only here during
business hours on the West coast.
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· When we return your phone call, you might be at lunch, away from your
desk, or gone for the day. If we leave a message, it might start a round
of telephone tag that could last for days.

· We often consult with contract programmers in a different country
before answering questions.

· It is difficult to describe graphing and analysis problems on the
telephone. When you email us a question, you can attach your Prism
files, exported images, or screenshots of error messages. This helps us
figure out the problem and provide helpful solutions. 

· In many cases, our answers contain screen shots or links to pages on
our web site. Trying to relay a URL via telephone doesn't work very well.

· We keep a record of problems and solutions. When you receive a email
from us, you can always refer back to it -- even weeks or months later.
And we can keep a record of the questions you asked and whether or
not we solved your problems. We use these records to help others with
similar questions, and to help design new versions of our software.

· We often answer emails while traveling or from home. This lets us
answer much more promptly than we could by phone.

23.6 How to cite GraphPad Prism

Citing Prism

When citing analyses performed by the program, include the name of the
analysis, and Prism version number (including the second number after
the decimal point). Use this example as a guide:

“One-way ANOVA followed by Dunnett’s multiple comparisons test was
performed using GraphPad Prism version 8.0.0 for Windows, GraphPad
Software, San Diego, California USA, www.graphpad.com”.

To find the full version number, pull down the Help menu (Windows) or
the Prism menu (Mac OS X). Then choose About Prism.
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It is more important to explain which analysis choices you made than
which program you used. For example, it doesn’t really help to say you fit
a curve with Prism if you don’t say which equation you selected, how you
chose to weight data points, whether you fixed any parameters to
constant values, etc.

Citing a page in the user's guide or an FAQ

 Include the name of the page, the date you accessed it and the URL. Use
this example as a guide:

"What you can conclude when two error bars overlap (or don't)?"
GraphPad Software, Inc.  Accessed 5 November 2008.  
http://www.graphpad.com/faq/viewfaq.cfm?faq=1362

 Citing the QuickCalc free web calculator

Include the name of the calculator and the date you used it. Here is an
example:

Confidence intervals of proportions were calculated using the GraphPad
QuickCalcs Web site:
http://www.graphpad.com/quickcalcs/ConfInterval1.cfm (accessed
November 2015).

  

23.7 GraphPad Prism license agreement

PLEASE READ CAREFULLY:  GRAPHPAD SOFTWARE, LLC ("GRAPHPAD") IS WILLING TO
LICENSE THE SOFTWARE IDENTIFIED ABOVE ONLY UPON THE CONDITION THAT YOU
ACCEPT ALL OF THE TERMS CONTAINED IN THIS SOFTWARE LICENSE AGREEMENT
(THE "AGREEMENT").  BY CHECKING  "I AGREE TO THE GRAPHPAD LICENSE
AGREEMENT" ON THE ACTIVATION DIALOG, OR BY INSTALLING, UPLOADING,
ACCESSING OR OTHERWISE USING ALL OR ANY PORTION OF THE SOFTWARE, YOU
AGREE TO BE LEGALLY BOUND BY THIS AGREEMENT.  IF YOU ARE AGREEING TO
THESE TERMS ON BEHALF OF A COMPANY OR OTHER LEGAL ENTITY, YOU REPRESENT
THAT YOU HAVE THE LEGAL AUTHORITY TO BIND SUCH ENTITY TO THESE TERMS,
AND ALL REFERENCES TO "YOU" SHALL APPLY TO SUCH ENTITY.  IF YOU DO NOT
HAVE SUCH AUTHORITY, OR IF YOU DO NOT WISH TO BE BOUND BY THE TERMS OF
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THIS AGREEMENT, THEN DO NOT INSTALL, UPLOAD, ACCESS OR OTHERWISE USE THE
SOFTWARE.

DEFINITIONS.  "Software" means the computer program identified above, and in which
this Agreement is embedded, and any updates or error corrections thereto provided by
GraphPad.  "Computer" means computers, including desktop or laptop computers, or
file servers, used for general computing functions (such as, but not limited to, word
processing, e-mail, general purpose Internet browsing and office suite productivity
tools).  "Authorized Number of Computers" means the number of Computers that the
Software may be loaded as shown by the quantity of licenses purchased by you as
indicated on your invoice for the Software. "You" means you personally if you license
the Software for yourself, or the company or other legal entity for which you license the
Software (but not the affiliates, subsidiaries or other related legal entities of such
company or legal entity).

LICENSE AND TERM.  Subject to the terms and conditions of this Agreement, GraphPad
grants to you a nonexclusive, nontransferable, limited license to install and use the
Software. The term of the license depends on what you downloaded or purchased. 

(a) The free trial (demo) license may be used for a period of 30 days from the date that
you receive it. After that, it may be used to view (but not edit) Prism files. Any attempt
to defeat the time-control disabling function in the Software is a material breach of this
Agreement and a violation of intellectual property law.

(b) A perpetual license does not expire, and may only be terminated by GraphPad if you
violate the terms of this Agreement. Upgrades to newer versions are not included. Each
perpetual license may be installed on one computer. If that computer is used
exclusively by one person and not shared with others, then that person may also install
the Software on a second computer, also used exclusively by him or her.

(c) A personal subscription lasts for the period of time for which you subscribed as
indicated on your invoice for the Software, and may only be earlier terminated by
GraphPad if you violate the terms of this Agreement. A personal subscription may be
installed and activated twice, on computers used solely by the subscriber.  Upgrades to
newer versions during the term of the license are included. You acknowledge that (i)
your right to install and use the Software is limited to the term of your subscription, (ii)
the Software is designed to cease to function upon expiration of the term of your
subscription if the subscription is not renewed, and (iii) you may generally renew your
subscription, but the terms upon which the Software may be licensed upon a renewal
are subject to change by GraphPad at its sole discretion.  Any attempt to defeat the
time-control disabling function in the Software is a material breach of this Agreement
and a violation of intellectual property law. 

(d) A group subscription license lasts for the period of time for which you subscribed as
indicated on your invoice for the Software, and may only be earlier terminated by
GraphPad if you violate the terms of this Agreement.  Your subscription is to activate
the software on an authorized number of computers. Upgrades to newer versions
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during the term of the subscription are included. You acknowledge that (i) your right to
install and use the Software is limited to the term of your subscription, (ii) the Software
is designed to cease to function upon expiration of the term of your subscription if the
subscription is not renewed, and (iii) you may generally renew your subscription, but
the terms upon which the Software may be licensed upon a renewal are subject to
change by GraphPad at its sole discretion.  Any attempt to defeat the time-control
disabling function in the Software is a material breach of this Agreement and a violation
of intellectual property law.

USE OF PRIOR VERSIONS IF YOU UPGRADED. If you purchased your license as an
upgrade from a prior version, you not transfer your license for the prior version to
another computer or to anyone else. 

INSTALLATION AND USAGE.  You may install and use the Software on up to the
Authorized Number of Computers.  THIS IS NOT A CONCURRENT USER LICENSE.  The
Authorized Number of Computers includes each Computer that at any time is or has
been given access to the Software, regardless of whether such Computer is running the
Software at a particular point in time.

AUDITS.  To ensure compliance with this Agreement, you agree that upon reasonable
notice, GraphPad or GraphPad’s authorized representative shall have the right to
inspect and audit your use of the Software.  Any such inspection or audit shall be
conducted during regular business hours at your facilities or electronically, either by
GraphPad or by representatives authorized by GraphPad for this purpose. If such
inspections or audits disclose that you have installed or permitted access to the
Software in a manner that is not permitted under this Agreement, then (i) you are liable
to pay for any unpaid license fees as well as the reasonable costs of the audit; and (ii)
the license grant with respect to the Software will terminate immediately. Any
information obtained by GraphPad or GraphPad’s authorized representative during the
course of such inspection and audit will be used and disclosed by GraphPad solely for
purposes of such inspection and audit and for enforcement of GraphPad’s rights under
this Agreement and applicable law, unless other uses or disclosures are required under
applicable law. Nothing in this Section shall be deemed to limit any legal or equitable
remedies available to GraphPad for violation of this Agreement or applicable law.

MANDATORY ACTIVATION AND LICENSE CONFIRMATION. Activation associates the
use of the software with a specific computer. You must activate Prism before using it
the first time. Prism will confirm the activation each time you launch it. During
activation (and activation confirmation), the software will send information about the
software and the device to GraphPad. This information includes the version, the serial
number, the Internet protocol address of the device, and information derived from the
hardware configuration of the device.  BY USING THE SOFTWARE, YOU CONSENT TO
THE TRANSMISSION OF THIS INFORMATION. UNLESS THE SOFTWARE IS ACTIVATED,
YOU HAVE NO RIGHT TO USE THE SOFTWARE. This is to prevent its unlicensed use.
YOU ARE NOT PERMITTED TO BYPASS OR CIRCUMVENT ACTIVATION. You must
activate every computer from which Prism is used.
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GENERAL RESTRICTIONS.  You agree and acknowledge that, unless enforcement is
prohibited by applicable law (and then only to the extent prohibited by applicable law),
the following actions are expressly prohibited:

(a) You may not (and may not permit any third party to) decompile, disassemble or
reverse engineer the Software.

(b) You may not modify, translate, adapt, arrange or create derivative works of the
Software or the User Documentation.

(c) You may not sell, transfer, rent, lease, loan, or otherwise distribute all or any portion
of the Software, the User Documentation or any other rights granted to you in this
Agreement.

(d) Except as otherwise expressly provided in this Agreement, you may not allow access
to the Software or the User Documentation over the Internet, including, without
limitation, in connection with a web hosting, commercial time sharing, service bureau,
or similar service.

(e) You may not remove, alter or obscure any copyright or other proprietary notices,
labels or marks from the Software or the User Documentation.

(f) You may not otherwise install, access or otherwise use or copy the Software or the
User Documentation other than in strict compliance with the terms of this Agreement.

(g)You may not use the Software in medical diagnosis or treatment, or in applications
or systems where the Software's failure to perform can reasonably be expected to
result in significant physical injury, property damage, or loss of life.  

(h) You may not attempt to to reduce the number of licenses that you need by use
multiplexing or pooling (hardware or software to pool connections, reroute
information, or reduce the number of devices or users that directly access or use the
software).

(i) You may not install the Software on network servers, and may not use any kind of
remote access software to control and view the software running on one computer from
another computer or terminal.

ALL RIGHTS RESERVED.  Title to and ownership of the Software, the User
Documentation and all related intellectual property are retained by GraphPad.  The
Software is confidential and the Software and the User Documentation are copyrighted.
 The Software and the User Documentation are licensed to you, not sold.  All rights of
every kind that are not expressly granted to you in this Agreement are entirely and
exclusively reserved to GraphPad.

LIMITED WARRANTY.  GraphPad warrants that, as of the date on which the Software is
delivered to you and for thirty (30) days thereafter, the Software will provide the
features and functions generally described in the User Documentation and that the
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media on which the Software is furnished, if any, will be free from defects in materials
and workmanship under normal use.  Except for the foregoing, the Software and the
User Documentation are provided "AS IS."  All warranty claims must be made during
such thirty (30) day period.  GraphPad’s entire liability and your exclusive remedy will
be, at GraphPad’s option, to attempt to correct or work around errors, to replace the
defective media on which the Software is furnished, if any, or to refund the license fees,
if any, paid by you and terminate this Agreement.  

DISCLAIMER OF WARRANTY.  EXCEPT AS SPECIFIED IN THIS AGREEMENT, GRAPHPAD
MAKES, AND YOU RECEIVE, NO WARRANTIES, EXPRESS OR IMPLIED WITH RESPECT
TO THE SOFTWARE AND THE USER DOCUMENTATION.  ANY STATEMENTS OR
REPRESENTATIONS ABOUT THE SOFTWARE AND ITS FUNCTIONALITY IN THE USER
DOCUMENTATION OR ANY COMMUNICATION WITH YOU CONSTITUTE TECHNICAL
INFORMATION AND NOT AN EXPRESS WARRANTY OR GUARANTEE.  IN ADDITION,
GRAPHPAD SPECIFICALLY DISCLAIMS ANY OTHER WARRANTY INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND NONINFRINGEMENT.  WITHOUT LIMITING THE
FOREGOING, GRAPHPAD DOES NOT WARRANT THAT THE OPERATION OF THE
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.  SOME JURISDICTIONS DO
NOT ALLOW LIMITATIONS ON IMPLIED WARRANTIES, SO THE FOREGOING MAY NOT
APPLY TO YOU.  THIS LIMITED WARRANTY GIVES YOU SPECIFIC RIGHTS.  OTHER
RIGHTS, WHICH VARY FROM JURISDICTION TO JURISDICTION, MAY APPLY TO YOU. 

LIMITATION OF LIABILITY.  IN NO EVENT SHALL GRAPHPAD HAVE ANY LIABILITY FOR
ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES; LOSS OF
PROFITS, REVENUE, OR DATA; BUSINESS INTERRUPTION, OR COST OF COVER.  IN
ADDITION, IN NO EVENT SHALL THE LIABILITY OF GRAPHPAD FOR ANY DAMAGES
ARISING OUT OF OR IN CONNECTION WITH THE SOFTWARE, USER DOCUMENTATION,
OR THIS AGREEMENT EXCEED THE AMOUNT PAID OR PAYABLE BY YOU FOR THE
SOFTWARE.  THE LIMITATIONS OF LIABILITY IN THIS SECTION SHALL APPLY TO THE
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW TO ANY DAMAGES, HOWEVER
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, WHETHER DERIVED FROM
CONTRACT, TORT (INCLUDING, BUT NOT LIMITED TO, NEGLIGENCE) OR OTHERWISE,
EVEN IF GRAPHPAD HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND
REGARDLESS OF WHETHER THE LIMITED REMEDIES AVAILABLE HEREUNDER FAIL OF
THEIR ESSENTIAL PURPOSE. 

EXPORT REGULATIONS.  All Software and User Documentation delivered under this
Agreement are subject to United State export control laws and may be subject to export
or import laws and regulations of other countries.  You agree not to export the Software
or the User Documentation in violation of United States or other applicable export
control laws.

U.S. GOVERNMENT RESTRICTED RIGHTS.  If the Software is being acquired by or on
behalf of the United States government or a United States government prime contractor
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or subcontractor, the Software and the User Documentation are provided with the same
commercial license rights as are described elsewhere in this Agreement.

GOVERNING LAW.  This Agreement shall be governed by and construed and enforced in
accordance with the laws of the State of California, U.S.A. without giving effect to the
conflict of laws principles thereof, excluding the UN Convention on Contracts for the
International Sale of Goods.

ENTIRE AGREEMENT.  This Agreement sets forth the entire understanding of you and
GraphPad relating the subject matter hereof and supersedes any and all other previous
or contemporaneous communications, agreements, representations, warranties or
advertising with respect to the Software and User Documentation.

SEVERABILITY.  The invalidity or unenforceability of any provision of this Agreement
shall not affect the validity or enforceability of any other provision of this Agreement.  If
any provision of this Agreement shall be held invalid or unenforceable in part, the
remaining portion of such provision, together with all other provisions of this
Agreement, shall remain valid and enforceable and continue in full force and effect to
the fullest extent consistent with law.

NO WAIVER.  No term or provision hereof will be considered waived, and no breach
excused, unless such waiver is in writing signed on behalf of the party against whom
the waiver is asserted. No waiver (whether express or implied) will constitute a
consent to, waiver of, or excuse of any other, different, or subsequent breach.

LANGUAGE.  The English language version of this Agreement is legally binding in case
of any inconsistencies between the English version and any translations.

23.8 Training

GraphPad offers a wide selection of materials to help you learn how to use
Prism most effectively. In addition to the written guides (User Guide,
Curve-Fitting Guide, and Statistics Guide), you can explore our ever-
growing library of video tutorials for Prism here. These videos cover a
range of topics including just getting started with Prism, more detailed
looks at statistical analyses that Prism offers, and tips on most effectively
presenting your data.

For additional information on Prism training, please feel free to reach out
to us at support@graphpad.com

https://www.graphpad.com/data-analysis-resource-center/#video-tutorials
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Index
- 5 -
5 number summary     382

- A -
Adding a new data table     224

Adding comments to a script     624

Adding data to graph     344

Adding pictures     570

Adding text     564

Adding text with Word     567

Additional gridlines     507

Additional ticks     507

Aligning objects     573

Alignment guides     573

alpha channel     592

Analysis chains     197

Analysis constants, hooking     308

Analysis parameters     304

Analyze dialog     298

Analyzing data, analysis constants     308

Analyzing data, chaining analyses     303

Analyzing data, changing inputs and choices     304

Annotating graphs and layouts     190

Annotating graphs and layouts, highlighting     192

Annotating graphs and layouts, lines and boxes    
568

Annotating graphs and layouts, text     564

Antilog transform     320

AppleScript     650

Apply button     346, 347

ApplyColorScheme command     628

Arithmetic series, inserting     236

Arranging objects     573

Arrows     568

Assigning graphs to a layout     550

Audio notes     190

Autocomplete     246, 249

Automatic backups     132

Automating with scripts     621

Automating work     308

Automator     650

Autosave (Mac)     138

Axes origin     545

Axes, logarithmic     528

Axes, offsetting     541

Axis limits     497

Axis numbering     498

Axis of bar graph     397

Axis titles     513

Axis, hiding     502

- B -
Backing up Prism projects     132

Backup preferences     194

Backups     132

Bar graphs, don't use log Y axis     531

Bar graphs, which table?     226

Baseline of bar graph     397

Baseline, removing     325

Batch processing. Prism Magic.     348

Beep command     646

Blue italics -- outliers     255

BMP, importing     570

box and whisker plot     382

Box and whiskers     400

Box around graph     541

Boxes     568

boxplot     382

Bring to back     573

Bring to front     573

- C -
Cadmus     592

Center on page     539

Chained analyses     197

Chaining analyses     303

Change all data sets     346

Changing a data table format     240

Changing analyses     304

Changing decimal places on data table     253

Changing graph type     344

Changing subcolumns on data table     240

Changing X to Y     328

Characters     570

Choose colors     366

Circles     568
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Citing Prism     673

Clear     366

Clear background     598

ClearTable command     628

Clone a graph     176

Cloning a layout     549

Close command     630

CloseOutput  command     639

CMYK     366

CMYK vs. RGB     595

Color code cells     191

Color models     595

Color schemes     362

Colors, choosing     366

Column data tables     212

Column math     325

Column titles     246

Column wdiths     253

Combining projects     168

Command line switches     668

Commands, scripting     623

Comments, addiing to a script     624

Compatibility between Prism and other programs    
166

Compatibility between Prism versions     166

Compressed format     164

Constants, hooking analysis constants     308

Contingency data tables     216

Contract     674

Control space shortcut     259

Copy and paste     603

Copy command     634

Copying between projects     168

Copying problems     194

Courses in Prism     679

Create series     236

Createlog command     646

CSV files, importing     277

Ctrl key shortcut     259

Ctrl-space shortcut     259

Custom colors     366

Custom ticks     507

- D -
Data analysis     303, 304

Data objects, changing     265

Data objects, creating     281

Data sets on graph     344

Data table, decimal places     253

Data tables - changing the format     240

Data tables - Column     212

Data tables - Contingency     216

Data tables - Grouped     214

Data tables - Parts of whole     220

Data tables - starting or duplicating     224

Data tables - Survival     218

Data tables - Which one for a bar graph     226

Data tables - XY     208

Data tables vs. projects     224

Data tables, column titles     246

Data tables, excluding values     255

Data tables, key concepts     204

Data tables, printing     608

Data tables, row titles     249

Data tables, sorting     251

Data, pasting from Excel (Mac)     275

Data, pasting from Excel (Windows)     272

Data, pasting from text files     277

Data+results folder     197

Date axes     518

Decimal places     253

Decimals, rounding     260

Decimating rows     329

Default preferences     194

Del key shortcut     259

DeleteAllDataSets command     628

Deleting data from graph     344

Deleting sheets     184

Depth charts     558

Dictated notes     190

Directories  of templates, methods and example
files     662

Discontinuous axis     504

donut charts     490

Dragging graph to layout     554

Drawing     568

Duplicate family     175

DuplicateDataTable command     627

DuplicateFamily command     627

Duplicating a data table     224

- E -
Elapsed time     516

Electronic notebook     170
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ELN     170

Emailing files     169

Embedding and linking data     265

Embedding and linking, data objects     281

Embedding fonts     596

Embedding results     307

Embellishing a graph     568

EMF or WMF format     603

EMF vs. WMF     194

EMF, exporting     585

EndTable command     638

Enter key shortcut     259

EPS files and fonts     596

EPS, exporting     585

Equations, adding to graph     570

Equations, adding your own set     664

Error bars on survival graphs     377

Error bars, choosing     400

Error bars, horizontal     378

Example graphs     176

Examples, saving in a lab     662

Examples, scripting     614

Excel files, importing     279

Excel, working with (Mac)     275

Excel, working with (Windows)     272

Exchanging X and Y values     320, 328

Excluding outliers     255

Excluding values     255

Export graphs and layouts     585

ExportBMP command     636

ExportEPS command     636

Exporting files     171

Exporting graphs and layouts     600

Exporting multiple sheets     185

ExportJPG command     636

ExportPCX command     636

ExportPICT command     636

ExportPNG command     636

ExportTable command     637

ExportTIF command     636

ExportWMF command     636

- F -
Families of related sheets     197

Family folder     197

Family of sheets, duplicating     175

FAQ, tech support     671

Fence, inner     382

File formats     164

File locations     194

File locations, templates, methods, examples     662

Files, format compatibility     166

Files, sending     169

Fire wall     668

five number summary     382

Flipping - transposing - a data table     328

Flipping error bars to horizontal     378

Flipping pages. Landscape vs. portrait     350

Floating notes     190

Folders of templates, methods and example files    
662

Font, changing     564

Fonts in EPS files     596

Fonts on graphs     361

Fonts, embedding     596

ForEach command     625

Format Axes     541

Format Axis dialog     347

Format Graph dialog     346

Format graph, Column     420

Format graph, Grouped     440, 463

Format graph, XY     400

Fraction of total     331

Frame of graph     541

Freezing a sheet     188

Freezing results     305

Freezing sheets     305

Front-to-back order of data sets     406

Frozen results     305

Full screen     161

- G -
Gallery, printing from     607

Gallery, view and choose sheets     152

Gallery, working with multiple sheets     185

Gaps in axis     504

Generate a series of X values     236

Geometric series, inserting     236

Getting around     150

Getting started     12

Global changes     346

GoTo command     623

Grand mean     459

Grand median     459
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Graph faster     411

Graph frame     541

Graph legends     560

Graph origin     545

Graph paper, making     543

Graph shape     353

Graph size     353

Graph tooltips     158

Graph type, changing     344

Graph, adding to layout     554

Graphics, importing     570

Graphing, use column titles     246

Graphing, use row titles     249

Graphs, cloning     176

Graphs, exporting to file     585

Graphs, exporting to Word or PowerPoint     600

Grid lines, equally spaced on axis     543

Grids, for alignment     573

Grouped data tables     214

Grouping     573

Guides, for alignment     573

- H -
Hardware requirements     667

hh:mm:ss     516

Hidden toolbars     161

Highlight cells     191

Highlighting sheets     192

Hooking analysis constants     308

Horizontal error bars     378

Horizontal vs. vertical graphs     350

- I -
Import command     631

Importing Excel files     279

Importing options, filter     284

Importing options, info & notes     289

Importing options, placement     288

Importing options, source     281

Importing options, view     283

Importing text files     279

ImportLink command     631

Individual replicates, plotting     379, 400

Info sheets     188

Inner fence     382

Insert and maintain link to data objects     281

Insert data only     281, 283

Insert object     603

InsertData command     633

InsertDataLink command     633

Inserting pictures and objects     570

- J -
JPEG, exporting     585

JPG, importing     570

- K -
Key concept - data tables     204

Key concept - linking and embedding data     265

Keyboard shortcuts     259

- L -
Lab Archives     170

Lab notebook     170

LabArchives     170

LabArchives server     665

Landscape vs. portrait     350

Landscape vs. portrait. Graphs.     609

Landscape vs. portrait. Tables     608

Launching scripts Excel     655

Launching scripts from outside of Prism     652

Launching scripts using MacScript, Automator, or
AppleScript     650

Layout legends     560

Layout tooltips     158

Layout, adding anther graph     554

Layouts     550

Layouts, creating     549

Layouts, exporting     600

Layouts, exporting to file     585

Learning Prism     12

Left panel, navigator     150

Legends     560

License agreement     674

Limits of axis     497

Line of identity     413

Lines     568

Link     603

Linked analyses     197
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Linking and embedding data     265

Linking and embedding, data objects     281

Locking a sheet     188

Locking a table, freezing     305

Locking in position     573

Log axes     528

Log transform     320

- M -
Mac differences, no OLE     603

Mac vs. Windows, compatibility     166

Macros, scripts     621

MacScript     650

Magic, Make graphs consistent     348

Magnifier     159

Major ticks     501

Make Graphs Consistent     348

Managing sheets     184

Master legends     560

Merging     168

Method file     178

Method vs. template     180

Methods, applying     178

Methods, saving in a lab     662

Microsoft Equation Editor     570

Microsoft Excel files, importing     279

Microsoft Excel, pasting data from (Mac)     275

Microsoft Excel, pasting data from (Windows)    
272

Microsoft Office     603

Microsoft Office, sending to     194

Minor ticks     501

Missing toolbars     161

Monte Carlo simulations with scripts     616

Moving between sheets     150

Moving graphs     168

Moving objects     573

Multiple graphs, exporting     585

Multiple graphs, on layout     550

Multiple sheet selection     185

- N -
Navigator     150

Navigator tooltips     197

Next     625

NextRow command     638

Nonspecific, subtracting     325

Normalizing     327

Notebook, LabArchives     170

Notes, floating     190

Nudging, XY graphs     409

Numbering of axis     498

Numbers, rounding     260

- O -
Object     603

Objects     573

Objects, importing     570

Office     603

Offset axes     541

Offsetting or nudging data sets     409

OLE     603

One-click export     600

One-grouping variable tables     212

Open command     630

OpenOutput command     638, 639

Options     194

Options, saving     164

Order of rows in data tables     251

Orientation of graphs     609

Orientation of tables when printed     608

Origin of graph     545

Orphaned results     305

Outliers     255

outliers, in box-and-whisker plots     382

- P -
Page layouts     550

Page layouts, creating     549

Parameters dialog, returning to     304

parts of whole graphs     490

Parts of whole tables     220

Paste command     634

Paste link     603

Paste special     603

Paste special options, filter     284

Paste special options, info & notes     289

Paste special options, placement     288

Paste special options, source     281

Paste special options, view     283
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Pasting data from Excel (Mac)     275

Pasting data from Excel (Windows)     272

Pasting data from files     277

PCX, importing     570

PDF, exporting     585

Percentage of total     331

Phone support, why we don't offer     671

PICT, exporting     585

PICT, importing     570

Pictures, importing     570

pie charts     490

Ping pong button     197

Placing a graph in a layout     550

PNG, exporting     585

PNG, importing     570

Pointers     122

Portrait vs. landscape     350

Portrait vs. landscape. Graphs.     609

Portrait vs. landscape. Tables.     608

Positioning     573

Posters     550

Posters, printing     609

PowerPoint     603

PowerPoint, sending to     194

PowerPoint. One-click export to.     600

Precision, rounding errors     260

Preference files, individual     661

Preferences     194

Print buttons     607

Print command     623

Print vs. Quick print     607

Printing data tables     608

Printing multiple sheets     185

Printing. Landscape vs. portrait. Graphs.     609

Printing. Landscape vs. portrait. Tables.     608

Prism 3, compatibility with     166

Prism 4, compatibility with     166

Prism gallery, view and choose sheets     152

Prism Gallery, working with multiple sheets     185

Prism Magic. Make graphs consistent     348

Prism Navigator     150

Problems with copying and pasting     194

Process colors     595

Projects vs. data tables     224

Projects, merging and splitting     168

Pruning rows     329

Publishing     585

PZF     164

PZFX     164

- Q -
QC lines     507

Questions, tech support     671

Quick print vs. Print     607

Quick start     12

- R -
Range of axis     497

Rapid Inspector     592

RecalcAll command     646

Reciprocal transform     320

Recording     190

Recovering     132

Reference     673

Regenerate     625

Related sheets     197

Removing a baseline     325

Removing data from graph     344

Renaming sheets     184

Replacing data on graph     344

Replicates, plotting     400

Replicates, plotting individual     379

Resize layout     555

Results, embedding     307

Results, freezing     305

Results, orphaned     305

Reverse order of data sets     350

Reversing row order     251

Revert (Mac)     138

RGB     366

RGB vs. CMYK     595

Right Y axis     358

Rotating graphs. Horizontal vs. vertical     350

Rotating titles     513

Rotating -transposing - a data table     328

Rounding     260

Row titles     249

Row titles, XY     408

Running scripts from Excel     655

Running scripts from outside of Prism     652

Running scripts using MacScript, Automator, or
AppleScript     650
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- S -
Save command     630

Saved examples     176

Saved method     178

Saving options     164

Saving templates, methods, and examples files in a
lab     662

Saving work     132

Scale bars, axis     502

Scaling factor     555

Scatter plots, which table?     230

Script syntax     621

Scripts, examples     614

Scripts, launching from other programs     652

Scripts, running from Excel     655

Scripts, running using MacScript, Automator, or
AppleScript     650

Scripts, running within Prism     649

Search for sheets     197

Second  Y axis     358

Section tabs     197

Segmental axis     504

Selected sheets     185

Send to back     573

Send to front     573

Send to Word or PowerPoint     600

Sending files     169

Sending to office     194

SendToPP command     646

SendToWord command     646

Sequence of X values     236

Series, inserting     236

Set Sheet Title command     623

SetAxisLimits command     628

SetAxisTitle command     628

SetGraphTitle command     628

SetInfo command     635

SetPath command     630

SetProjectName command     646

SetScriptDialogTitle command     646

SetValueToInfo command     635

SetYReplicates command     628

Shape of graph     353

Shapes     568

Shared examples     176

Sharing Prism in a lab     658

Sheets     184

Sheets, freezing     305

Shift-enter shortcut     259

Shift-space shortcut     259

Shortcuts     259

Show sheets of one type     152

Show toolbars     161

Size of graph     353

skip     344

Skipping rows     329

Slide sorter view -- Gallery     152

SmartDraw     570

Snapping, text     564

Software license agreement     674

Sorting data tables     251

Sorting sheets     184

speed graphing     344

Speed graphing mode     411

Splitting     168

Spot colors     595

Starting a new data table     224

Sticky notes     190

Stretch an axis     353

Strikethough over numbers -- outliers     255

Subcolumn formats     240

Support     671

Survival data tables     218

Survival graphs     484

Syntax, scripting     635

Syntax, scripts     621

System Preferences     138

System requirements     667

- T -
Tab key shortcut     259

Table CSV command     638

Table for a bar graph     226

Table for a scatter plot     230

Table HTML command     638

Table Prism command     638

Table SQL command     638

Table Text command     638

Table XML command     638

Tables, printing     608

Tables. Data tables in Prism     204

Tabs, move between sections     197

Technical support     671
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Telephone support, why we don't offer     671

Template vs. method     180

Templates     179

Templates, saving in a lab     662

Text     564

Text boxes     564

Text files, importing     279

Text files, working with     277

Text on graphs     361

Text. Using Word to add formatted text.     567

Themes. Color schemes     362

Three segment axis     504

Ticks     501

TIF, exporting     585

TIF, importing     570

Time axes     516

Tips     122

Titles of columns     246

Titles of rows     249

Titles on axes     513

Tooltips     197

Tooltips, for navigation     158

Tours     12

Training     679

Transforming     320

Transparency     366

Transparent background     598

Transposing data as you paste (Mac)     275

Transposing data as you paste (Windows)     272

Transposing data tables     328

Tree on left, navigator     150

Tukey method for box and whisker plot     382

Turbo graphing mode     411

Two grouping variable tables     214

Two segment axis     504

TXT files, importing     277

Type of graph, changing     344

- U -
Uncompressed     164

Ungrouping     573

Units, transforming to change     320

Using different parameters     304

Using Prism in a lab     658

- V -
Versions (Mac)     138

Versions of Prism     166

Vertical vs. horizontal graphs     350

View importing option     283

View toolbars     161

Viewing Prism files     169

- W -
Wand, wizard to analyze data     178

WBlock command,WTBlock command     642

WCell command     639

WCol command     639

WDate command     639

Welcome dialog     115

What's new     45

What's new: heat maps     48

whiskers     382

Widths of columns     253

Windows differences, OLE     603

Windows vs. Mac, compatibility     166

WMF or EMF format     603

WMF, exporting     585

WMF, importing     570

Word     603

Word, sending to     194

Word, using to add formatted text     567

Word. One-click export to.     600

Working with multiple projects     168

Working with multiple sheets     185

Working with sheets     184

Working with text files     277

WRow command     639

WSheet command     639

WTable command     638

WTCol command     639

WText command     639

WTitle  command     639

WTSheet command     639

- X -
X and Y, transposing     328

X values, regular sequence     236
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XLS files, importing     279

XML     164

XY data tables     208

- Y -
Y axis, adding one on right     358

Yellow highlighter     192

- Z -
Zooming     159, 573
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